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Welcome to Desktop Video!

We hope you share our dream for the television industry to become a truly 
creative industry by allowing anyone to have access to the highest quality video.

Previously high end television and post production required investment in millions 
of dollars of hardware, however with Blackmagic video hardware, even 10 bit 
uncompressed is now easily affordable. We hope you get years of use from your 
new UltraStudio, DeckLink or Intensity and have fun working with some of the 
world’s hottest television and design software!

This instruction manual should contain all the information you’ll need on 
installing your Blackmagic video hardware. If you're installing a PCI Express 
card, it’s always a good idea to ask a technical assistant for help if you have not 
installed hardware cards into computers before. As Blackmagic video hardware 
uses uncompressed video and the data rates are quite high, you’ll need fast disk 
storage and a high-end computer.

We think it should take you approximately 10 minutes to complete installation.  
Before you install Blackmagic video hardware, please check our website at 
www.blackmagicdesign.com and click the support page to download the 
latest updates to this manual and Desktop Video driver software. Lastly, please 
register your Blackmagic video hardware when downloading software updates. 
We would love to keep you updated on new software updates and new 
features. Perhaps you can even send us your latest show reel of work completed 
on your Blackmagic video hardware and any suggestions for improvements to 
the software. We are constantly working on new features and improvements, so 
we would love to hear from you!

Grant Petty
CEO Blackmagic Design

http://www.blackmagicdesign.com
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Introducing Desktop Video
Blackmagic Design's Desktop Video software works in conjunction with your UltraStudio, DeckLink, Intensity 
or Teranex hardware. The Desktop Video software includes drivers, plugins and applications like Blackmagic 
Media Express. Desktop Video also integrates seamlessly with your favorite Adobe, Apple, Autodesk and 
Avid software!

This manual takes you through computer system requirements, installing hardware and software and using 
your favorite third party software. 

System Requirements
The computer requires at least 4 GB of  RAM. PCIe x1 lane cards should work in any slot. PCIe x4 lane cards 
require a x4 lane or faster slot.

Mac OS X
Desktop Video software runs on the latest Mountain Lion and Mavericks versions of Mac OS X.

If your Blackmagic video hardware connects to your computer via a PCI Express slot, then an Intel-based 
Mac Pro is required.

If your Blackmagic video hardware connects to your computer via Thunderbolt, then an Intel-based Mac 
with a Thunderbolt™ port is required.

Windows
Desktop Video runs exclusively on 64-bit versions of Windows, with the latest service pack installed. Both 
Windows 7 and Windows 8 are supported.

If your Blackmagic video hardware connects to your computer via Thunderbolt, an Intel-based PC with a 
Thunderbolt port is required.

If your Blackmagic video hardware connects to your computer via USB 3.0, a USB 3.0 port using a Renesas 
chipset is required.

Linux
Desktop Video runs on 32-bit and 64-bit x86 computers running Linux 2.6.23 or higher. Please refer to the 
release notes for the latest list of supported Linux distributions, package formats and software dependencies.

Getting Started
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Installing your Blackmagic Video Hardware
If your Blackmagic video hardware connects via Thunderbolt, go straight to the Thunderbolt section. 
Thunderbolt ports are found on the latest Mac OS X and Windows computers.

If your Blackmagic video hardware connects via USB 3.0, go straight to the USB 3.0 section.  
Blackmagic's USB 3.0 video products require a compatible Windows PC.

Installing a Blackmagic PCIe Card
Step 1. Remove the power plug from your computer and ensure that you are statically discharged.

Step 2. Insert your Blackmagic PCIe card into an appropriate slot in your computer and push it firmly into 
place. If you have a DeckLink Optical Fiber card, the fiber optic module needs to be removed 
prior to insertion.

Step 3. If your Blackmagic PCIe card includes a HDMI bracket, insert the bracket into a spare slot. Secure 
the PCIe card and HDMI bracket with screws and loop the HDMI cables around any other installed 
cards and plug them into the rear of the DeckLink card. 

Step 4. Replace the cover of your computer and connect any supplied breakout cables. If you have a 
DeckLink Optical Fiber card, reinsert the fiber optic module. Reconnect the power and start up 
the computer.

Install a Blackmagic PCIe card in a spare slot. A HDMI bracket can 
be installed in any spare port and connects to the rear of the card 
with the supplied HDMI cables.

Connect the breakout cable if one is supplied with your 
Blackmagic card. Some models also include a HDMI 
bracket as pictured above.
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Connecting Blackmagic Video Hardware with Thunderbolt
Step 1. If your Blackmagic video hardware includes an external power supply, connect it to the unit and 

switch on the power.

Step 2. Connect a Thunderbolt cable between the unit and a Thunderbolt port on your computer. 
Alternatively, you can connect to your computer's Thunderbolt disk array.

Step 3. If Desktop Video software has previously been installed and offers to update the internal software, 
click Update and follow any onscreen instructions.

Step 4. If a breakout cable is supplied, connect it to the Blackmagic video hardware and plug the 
connectors into your video equipment.

Connecting Blackmagic Video Hardware with USB 3.0
Step 1. If your Blackmagic video hardware includes an external power supply, connect it to the unit and 

switch on the power.

Step 2. Connect a SuperSpeed USB 3.0 cable between the unit and a dedicated USB 3.0 port on your 
computer.

Step 3. If Desktop Video software has previously been installed and offers to update the internal software, 
click Update and follow any onscreen instructions.

Step 4. If a breakout cable is supplied, connect it to the Blackmagic video hardware and plug the 
connectors into your video equipment.

Thunderbolt™ and USB 3.0 products connect to your computer 
with a single Thunderbolt or USB 3.0 cable.

The UltraStudio 4K features two Thunderbolt 2™ ports so if your 
computer only has a single Thunderbolt™ port, you can use the 
additional port to attach a RAID or other device.

PUSH

PUSH
PUSH
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Installing the Blackmagic Design Software

Applications, Plugins and Drivers
The table below lists the applications, plugins and drivers that are included when you install the desktop 
video software.

Mac OS X Windows Linux

Blackmagic Desktop Video 
drivers

Blackmagic Desktop Video 
drivers

Blackmagic Desktop Video 
drivers

Blackmagic Design system 
preference

Blackmagic Design Control Panel Blackmagic Design Control Panel

Blackmagic Design LiveKey Blackmagic Design LiveKey Blackmagic Media Express

Blackmagic Media Express Blackmagic Media Express Blackmagic AVI codecs

Blackmagic QuickTime™ codecs Blackmagic AVI and QuickTime™ 
codecs

Blackmagic Disk Speed Test Blackmagic Disk Speed Test

Adobe® Premiere Pro® CC, After 

Effects® CC, Photoshop® CC 
presets and plug-ins

Adobe® Premiere Pro® CC, After 

Effects® CC, Photoshop® CC 
presets and plug-ins

Apple Final Cut Pro™ X plug-ins Avid Media Composer plug-in

Avid Media Composer plug-in eyeon Fusion plug-ins
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Mac OS X Installation
Make sure you have administrator privileges before installing any software.

Step 1. Ensure you have the very latest driver. Visit www.blackmagicdesign.com/support

Step 2. Open the “Desktop Video Installer” folder from the disc or downloaded disk image and launch 
the “Desktop Video Installer” installer.

Step 3. Click the Continue, Agree and Install buttons to install the software.

Step 4. Restart your computer to enable the new software drivers.

Automatic Updates
When your Mac restarts the software will check the internal software version of your hardware. If the internal 
software version does not match the driver version, you will be prompted to update the internal software. 
Click OK to start the update and restart your Mac to complete the process.

Windows Installation
Step 1. Ensure you have the very latest driver. Visit www.blackmagicdesign.com/support

Step 2. Open the “Desktop Video” folder and launch the “Desktop Video” installer.

Step 3. The drivers will now be installed on your system. An alert will appear: “Do you want to allow the 
following program to install software on this computer?” Click Yes to continue.

Step 4. You will see a dialog bubble saying “found new hardware” and the hardware wizard will appear. 
Select “install automatically” and the system will find the required Desktop Video drivers. Another 
dialog bubble will appear saying “your new hardware is ready for use.”

Step 5. Restart your computer to enable the new software drivers.

Automatic Updates
When your computer restarts the software will check the internal software version of your hardware. If the 
internal software version does not match the driver version, you will be prompted to update the internal 
software. Click OK to start the update and restart your computer to complete the process.

Desktop Video Installer for Mac

Desktop Video Installer for Windows

http://www.blackmagicdesign.com/support
http://www.blackmagicdesign.com/support
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Linux Installation
Step 1. Download the latest Desktop Video software for Linux from www.blackmagicdesign.com/support

Step 2. Open the “Desktop Video” folder and locate and open the “Desktop Video” package for your 
Linux distribution.

Step 3. Click the "Install" button and wait for the progress bar to complete.

Step 4. If there are messages about missing dependencies, ensure they are installed first and then rerun 
the Desktop Video installer.

Step 5. When finished, the installer will return to the same screen.

Step 6. Restart the computer to enable the drivers or type the following command:

 # modprobe blackmagic

If you cannot find a native Desktop Video package for your Linux distribution, or if you prefer to install from 
a command line, refer to the ReadMe file for detailed installation instructions.

Updates
After your computer has restarted, the drivers will check the Blackmagic video hardware to see what internal 
software the hardware contains. If the internal software version does not match the driver version, Desktop 
Video will prompt you to update. To find out the card ID of any cards that need updating, open the terminal 
and type the following command:

# BlackmagicFirmwareUpdater status

A message similar to the following will appear:

/dev/blackmagic/card0 [DeckLink HD Extreme 3] UPDATED
/dev/blackmagic/card1 [DeckLink HD Extreme 3] NEEDS_UPDATE

Note the ID of the card that needs to be updated and then update the firmware by typing:

# BlackmagicFirmwareUpdater update <card_id> (1 in this case)

Desktop Video software ready to be installed from 
the Ubuntu Software Center.

http://www.blackmagicdesign.com/support
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Capturing and Playing back Video 
It's a good idea to run a quick test to ensure you can successfully capture and play back video. 

Setting-Up
Step 1. Connect a video monitor or TV to the video output of your Blackmagic video hardware.

Step 2. Connect a video source to the video input of your Blackmagic video hardware.

Step 3. Use the Blackmagic system preferences to set your video and audio connections for input and 
output. See the "Using Blackmagic System Preferences" section for details.

Testing Video Capture
Step 1. Go to Media Express>Preferences on Mac OS X or Edit>Preferences on Windows or Linux and 

select a project format that matches your video source. Also choose a capture file format and 
storage location.

Step 2. Close the Preferences and click on the Log and Capture tab. Your video source will appear in the 
preview pane of Media Express.

Step 3. Click Capture to perform the capture test. Click Capture again to finish the test.

Testing Video Playback
Step 1. Click on the Playback tab.

Step 2. Double-click the test clip and the video will appear on the monitor connected to the output of 
your Blackmagic video hardware. Audio output can also be monitored.

Camera Outputs

HDTV

Click the "Capture" button to commence recording.

Connect a video monitor and source to your Blackmagic video 
hardware.
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Launching Blackmagic System Preferences
Blackmagic system preferences provide a central location for configuration settings.

 � On Mac OS X, open the System Preferences and click the Blackmagic Design icon.

 � On Windows 7 and Windows 8, open the Control Panel and click on the “Hardware and Sound” 
category and then click the Blackmagic Design Control Panel.

 � On Linux, go to "Applications" and then "Sound and Video" and double-click the Blackmagic 
Control Panel.

Different Blackmagic video hardware models have different features. Only those system preferences 
supported by your hardware model will be active.

The following section guides you on adjusting the Blackmagic system preferences.

Blackmagic Design system preferences in Mac OS X Blackmagic Design Control Panel in Windows Blackmagic Design Control Panel in Ubuntu Linux

Using Blackmagic System Preferences
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The Settings Tab

Set output 
Set the video and audio output connections for your Blackmagic video hardware. Some models allow you to 
choose between component analog video, S-Video or composite analog video. And some models feature 
switchable audio outputs which allow you to choose between analog and AES/EBU.

Set input 
Set the video and audio input connections for your Blackmagic video hardware. Your hardware may 
support some or all of the following combinations:

 � SDI Video & SDI Audio
 � SDI Video & AES/EBU Audio
 � SDI Video & Analog XLR Audio
 � Optical SDI Video & Optical SDI Audio
 � HDMI Video & HDMI Audio
 � HDMI Video & AES/EBU Audio
 � HDMI Video & Analog XLR Audio
 � Component Video & AES/EBU Audio
 � Component Video & Analog XLR Audio
 � Composite & AES/EBU Audio
 � Composite & Analog XLR Audio
 � S-Video & AES/EBU Audio
 � S-Video & Analog XLR Audio

Use video setup in NTSC 
Select the 7.5 IRE setup for the NTSC composite video used in the USA and some other countries. Select 
the 0 IRE setup if you’re working in Japan or other countries that don’t use the 7.5 IRE setup. PAL and high 
definition formats do not use this setting.

Video and Audio output connections.

Video and Audio input connections.

Select either 7.5 IRE or 0 IRE setup for NTSC composite video.
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Use 4:4:4 SDI on video output when possible 
Select this setting when outputing 4:4:4 video. 1080p50/60 video will always be output as 4:2:2. When 4:4:4 
video output is enabled, the following features are not available:

 � simultaneous HD and down converted SD video output
 � down converted analog video output

Use 3/6Gb SDI not Dual Link SDI output
Select this setting to use single link 3G or 6G SDI when using high bandwidth formats such as 1080p60, 4:4:4 
or when using 4K formats.

Use 1080p not 1080PsF
Select this setting to output true progressive frame video instead of progressive segmented frame.

Remove field jitter when video is paused
Select this setting to eliminate field flicker when interlaced video is paused on old CRT monitors by displaying 
a single field. This option is not recommended for modern flat screens.

Use LTC Timecode input
Select this setting to read timecode from the LTC input instead of the SDI stream.

Tick the checkbox to output 4:4:4 video.

Tick the checkbox  to use single link 3G or 6G SDI.

Tick the checkbox  to output true 1080 progressive frame video.

Tick the checkbox  to eliminate field flicker from CRT monitors.

Tick the checkbox  to read timecode from the LTC input.
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Set default video standard as
To use broadcast monitoring with Final Cut Pro X, set the video standard to match your Final Cut Pro X 
project.

To capture video on Windows with a program supporting Windows Driver Model (WDM), set the default 
video standard to match the capture standard. You usually set the video standard within the preferences 
of the WDM program, however, try using the Blackmagic Design Control Panel if you encounter problems.

When not playing video, send
This setting determines whether your hardware will output the Last Frame Played or Black when you switch 
out of an application and video is no longer being played.

Some Blackmagic models include Look Up Tables (LUTs) and you can use the Last Played Frame option 
to observe the effect of any changes to the LUT. Enabling or disabling the feature requires a restart of the 
computer.

Display HDMI 3D as
This setting determines the 3D format of your HDMI monitoring. The selections include: Frame Packing, 
Side by Side, Line by Line, Top and Bottom, Left Eye or Right Eye.

Set Reference output timing
If you have reference connected but your picture is rolling, adjust the slider until the picture locks. A reference 
signal may also known as genlock, black burst, house sync or tri-sync.

Select the 3D format of your HDMI monitoring.

Set the default video standard to match your Final Cut Pro X 
project or to capture with your WDM program.

When not playing video you have the option of sending the Last 
Frame Played or Black.

Adjust the Reference timing slider until the picture locks.
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The Processing Tab

Select output processing
This setting allows real time down conversion during playback. Select the desired option from the menu.

Some hardware models support simultaneous down conversion on output such as HD & SD or 2K & SD. 
Simultaneous down conversion introduces a 2 frame delay on the SD-SDI output. Adjust your editing 
software's timecode offset to ensure frame accuracy when inserting or assembling to tape.

Analog video outputs are also down converted. Component analog video can be switched between HD 
or SD output. To view component analog SD video, select "Enable Conversion on Analog Output", when 
"Simultaneous HD and SD Output" is also selected.

Select input processing
This setting allows real time down conversion and up conversion during capture. Select the desired option 
from the menu.

Output HD 23.98PsF at HD 59.94i (Windows only)
This setting will apply a 3:2 pulldown sequence so that HD 23.98 PsF video is output as HD 59.94i. The film 
frame rate of 23.98 fps is quite common but support in SDI and analog monitors is rare, while almost all HD 
monitors support HD 59.94i.

Set A-frame VITC reference
This setting allows you to enter the A-frame number when removing 3:2 pulldown from NTSC video while 
capturing at 23.98fps. The wrong A-frame will produce an incorrect presentation of fields and frames.

Capture VANC input line
These settings allow 3 line timecode, VITC subtitle info or any other VANC data to be preserved during 
capture. To preserve VANC data, tick the check box for video line you wish to capture. Line 1 needs to be 
enabled for lines 2 and 3 to function.

Select the output processing from the menu.

Tick the checkbox to output HD 23.98PsF at HD 59.94i

Set the A-Frame VITC Reference when performing 3:2 pulldown.

Tick the checkboxes to capture lines of VANC data.
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The Video Levels Tab
Calibrate Analog Video In
These settings adjust the analog video input. Use the sliders to adjust Video, Chroma, Cb and Cr levels. 
Ideally you would adjust these settings in conjunction with Blackmagic Ultrascope. The Calibrate Analog 
Video In settings are only available if the "Set input" option in the Settings tab is set to analog video input.

Calibrate Analog Video Out
These settings adjust the analog video output. Use the sliders to adjust Video, Chroma, Cb and Cr levels. 
Ideally you would adjust these settings in conjunction with Blackmagic Ultrascope.

Use Betacam YUV Levels 
Blackmagic products use SMPTE component analog levels by default as almost all modern video equipment 
use SMPTE levels. Enable the checkbox "Use Betacam YUV Levels" if working with Sony Betacam SP decks.

The Audio Levels Tab
Set Analog Audio Input Levels
These settings adjust the gain for the analog audio inputs. 

Set Analog Audio Output Levels 
These settings adjust the gain for the analog audio outputs. 

Set AES/EBU Input Ref Level
These settings adjust the gain for the AES/EBU audio inputs. While analog audio channels can be adjusted 
independently, AES/EBU audio channels are adjusted simultaneously.

Set AES/EBU Output Ref Level
These settings adjust the gain for the AES/EBU audio outputs. While analog audio channels can be adjusted 
independently, AES/EBU audio channels are adjusted simultaneously. 

Use HiFi Audio Levels
Professional analog audio levels with XLR connectors are standard on UltraStudio and DeckLink models. 
To connect consumer audio equipment, enable "Use HiFi Audio Levels" and use an XLR to RCA adapter. 

The sliders adjust Video and Chroma levels for analog video. 

The sliders adjust the gain for analog and AES/EBU audio. 
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After Effects® CC

How to Preview Video
To display your After Effects® CC composition in real-time through your Blackmagic hardware, go to 
Preferences > Video Preview. Select Blackmagic Video Output and the appropriate Output Mode. You can 
now use a broadcast monitor to view your After Effects compositions in the correct video colorspace.

To listen to audio through your Blackmagic hardware, go to System Preferences in  
Mac OS X or Control Panel in Windows and set Blackmagic Audio as your default sound output device. 
In After Effects, go to Preferences>Audio Hardware and make sure your audio output is now set to  
System Default Input/Output on Mac OS X or Blackmagic Audio on Windows.

Rendering
When you have completed your composition, you will need to render to a codec supported by your 
Blackmagic video hardware. You can render a DPX image sequence or any of the following codecs:

Other codecs including ProRes and DVCPRO HD will be available if you have Final Cut Pro installed.

Other codecs including DVCPRO HD and DVCPRO50 will be available if you have Adobe® Premiere Pro® 
CC installed.

After Effects® CC

“Output Module Settings” rendering options

“Video Preview” preferences

 � Blackmagic RGB 10 bit (uncompressed)
 � Apple Uncompressed YUV 10 bit 4:2:2
 � Apple Uncompressed YUV 8 bit 4:2:2

 � Apple Photo - JPEG (compressed)
 � Apple DV - NTSC (compressed)
 � Apple DV - PAL (compressed)

 � Blackmagic 10 bit 4:4:4 (uncompressed)
 � Blackmagic 10 bit 4:2:2 (uncompressed)
 � Blackmagic HD 8 bit 4:2:2 (uncompressed)

 � Blackmagic SD 8 bit 4:2:2 (uncompressed)
 � Blackmagic 8 bit MJPEG (compressed)

AVI codecs on Windows

 � Blackmagic RGB 10 bit (uncompressed)
 � Blackmagic 10 bit (uncompressed)
 � Blackmagic 8 bit (uncompressed)

 � Apple Photo-JPEG (compressed)
 � Apple DV - NTSC (compressed)
 � Apple DV - PAL (compressed)

QuickTime codecs on Windows

QuickTime codecs on Mac OS X

Using your Favorite 3rd Party Software
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Photoshop® CC

How to Import and Export Video Frames

Import an image into Photoshop® CC
Step 1. From Photoshop® CC select File > Import > Blackmagic Image Capture.

Step 2. Select the “Video Input Format” and the “Image Bit Depth” and then click Image Import.

Export an image from Photoshop® CC
Step 1. Select File > Export > Blackmagic Image Export.

Step 2. Select Video Output Format and then click Export Image.

Once you have set the “Import” or “Export” options, subsequent Imports and Exports will not display 
the settings window. However, you can still change your settings, by holding the Option [Mac] or Ctrl 
[Win] key, when selecting import or export.

Import Image

Export Image

Photoshop® CC
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Adobe® Premiere Pro® CC

Setting Up a Blackmagic Design Project
Step 1. Create a New Project and click on the Scratch Disks tab and set the desired Location and Name 

for your project.

Step 2. Set the locations for your captured video, captured audio, video previews and audio previews.

Step 3. If your graphics card is supported by Adobe® Premiere Pro® CC's Mercury Playback Engine, the 
Renderer option will be available and you should switch it to "Mercury Playback Engine GPU 
Acceleration".

Step 4. Set the Capture Format to Blackmagic Capture and click on the Settings [Mac] or Properties [Win] 
button to reveal the Blackmagic Capture Settings for your project. Set the desired Video Standard 
and Video Format and click OK.

Step 5. The New Sequence window will appear. Select the desired Blackmagic preset, give the sequence 
a name and then click OK.

Device Control
Many Blackmagic Design capture and playback models feature RS-422 device control for controlling decks. 
Blackmagic Device Control needs to be selected each time a new project is created. Go to Preferences > 
Device Control and select "Blackmagic Device Control".

Playback
Playback settings need to be selected each time a new project is created by going to Preferences  > 
Playback. The default player is Adobe Player but the Audio Device needs to be switched to "Blackmagic 
Playback".

Under "Video Device," enable the checkbox for "Blackmagic Playback" and ensure the other checkboxes 
are cleared and click OK.New Sequence

Adobe® Premiere Pro® CC
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Capture
To capture choose: File > Capture [F5]

To immediately capture, or to capture from a non-controllable device, click the red record button [G].

If you wish to log the clip using RS-422 deck control, enter the desired In and Out points using either the Set 
In and Set Out buttons, or manually by typing the timecode and clicking Log Clip. The empty clip will now 
appear in the Project window. Repeat this until you have logged all of the clips you wish to batch capture. 
Then choose: File > Batch Capture [F6]. To set handles on the clips, enable the option to Capture with 
handles and type the number of additional frames you require at the start and end of each clip.

Export to Tape 
To export to tape via RS-422 deck control, select the sequence you require and then choose File >  
Export > Tape

Insert editing requires unbroken timecode over the full length of the project which is to be laid to tape.

In assemble mode the tape needs only to be “blacked” until a point just beyond the start time of the 
project. As assemble editing erases the tape ahead of the record heads, it should not be used where other 
projects already exist on the tape after the out point of your edit.

When editing to tape, the software waits at the first frame of your project for the deck to drop into record 
at the predetermined timecode. Should you find that either the first frame of your program is repeated or 
lost, during the edit to tape procedure, you will need to adjust the playback offset to bring the deck and 
computer in sync. You should only need to do this once with any combination of deck and computer and 
the correct setting will be retained.

Now, simply enter the desired in point and offsets if required, and click OK [Mac] or Export [Win].

Capture

Export to Tape
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Apple Final Cut Pro X

Apple Final Cut Pro X
You can use the broadcast monitoring feature of Final Cut Pro X 10.0.4 and later to output your video through 
Blackmagic video hardware. You can also use two computer monitors for the Final Cut Pro X interface.

Setting Up Final Cut Pro X
Step 1. Ensure you are running Final Cut Pro X 10.0.4 or later with the latest version of Mac OS X Mountain 

Lion or Mavericks.

Step 2. Open the System Preferences and click on Blackmagic Design. Go to the setting, "Set default 
video standard as" and then set the same standard that you will use in your Final Cut Pro X 
project, e.g. HD 1080i59.94. The standard should be the same as the video format of your clips.

Step 3. Launch Final Cut Pro X and create a new project.

Step 4. Type a name and choose a location for the new project.

Step 5. Set the Video Properties to Custom and then set the format, resolution and frame rate to match 
the default video standard set in the Blackmagic Design Desktop Video system preferences.

Step 6. Set the Audio and Render Properties to Custom. Set the audio channels to Stereo or else you can 
choose Surround for 6 audio channels. Set the audio sample rate to the television rate of 48kHz. 
Set the render format to the same format as your video clips. Final Cut Pro X defaults to using 
ProRes compression but you can switch this to Uncompressed 10-bit 4:2:2 for an uncompressed 
workflow. Click OK to complete the creation of your new project.

Step 7. Go to the Final Cut Pro menu, choose Preferences and then click the Playback tab. Ensure the A/V 
Output menu has selected "Blackmagic" and the same video standard as your project and then 
close the Preferences.

Step 8. Go to the Window menu and select A/V Output to enable video output via your Blackmagic 
video hardware.

If you wish to monitor audio via your Blackmagic video hardware, open the System Preferences,  
click the Sound icon, click the Output tab and then select "Blackmagic Audio" for the sound output.

Step 6. Set the Audio and Render Properties to Custom.

Step 2. Set the default video standard in the System Preferences 
to match your Final Cut Pro X project.
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Playback
Step 1. Import some clips in to your new project.

Step 2. You can now use the Final Cut Pro X timeline on your computer monitor and view the video 
preview on the monitor or TV connected to the output of your Blackmagic Design video hardware.

Capturing Video and Audio
You can use Blackmagic Media Express to capture video and audio with your Blackmagic Design video 
hardware. Once you have captured the clips, you can import them in to Final Cut Pro X for editing.

When capturing clips with Media Express, make sure you choose one of the video formats which is also 
supported by Final Cut Pro X, i.e.: Apple ProRes 4444, Apple ProRes 422 (HQ), Apple ProRes 422 or 
Uncompressed 10-bit 4:2:2.

Editing to Tape
Once you have completed a project in Final Cut Pro X, you can render the project to a movie file and then 
use Blackmagic Media Express to master the movie to tape with your Blackmagic Design video hardware.

Step 1. Select your clips from the timeline in Final Cut Pro X.

Step 2. Go to the Share menu and choose Export Movie.

Step 3. In the Export Movie window, leave Export on "Current Settings" and also set Include to "Video 
and Audio". Click "Next".

Step 4. Open Media Express and import the clip that was exported from Final Cut Pro X.

Step 5. Refer to the Blackmagic Media Express section of this manual for "Editing video and audio files 
to tape".

Step 3. In the Export Movie window, leave Export on "Current 
Settings" and also set Include to "Video and Audio".
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Avid Media Composer

Avid Media Composer
Avid Media Composer captures and plays back standard definition and high definition video and audio 
with Blackmagic video hardware and also supports RS-422 deck control. Blackmagic plug-ins for Media 
Composer are automatically installed if Media Composer is installed before the Desktop Video software.

Setting Up
Step 1. Launch Media Composer and the Select Project dialog box will appear.

Step 2. Choose  your preferred User Profile if you have previously created one.

Step 3. Select the folder in which you want to create the project: Private, Shared or External.

Step 4. Click the New Project button.

Step 5. Type a project name and set the project options including Format, Color Space and Stereoscopic. 
Click OK. The color space and stereoscopic settings can be changed later in the Format tab of the 
project. 

Step 6. Double-click the project name in the Select Project dialog box. The Media Composer interface 
will appear along with the project window for your new project. You have completed setting up 
your project.

Playback
As a quick test to make sure everything is connected correctly, go to the Media Composer Editing Guide 
and follow the section entitled "Importing Color Bars and Other Test Patterns". Double-click the imported 
file to play it in a pop-up monitor. You should now see the image on both your computer monitor and your 
Blackmagic output.

If you can’t see any video on your Blackmagic output, check the connections again and ensure you have the 
correct output settings configured within the Blackmagic Design system preferences by choosing Tools > 
Hardware Setup from within Media Composer.

If using a single computer monitor, open the Blackmagic Design 
system preferences and send Black when not playing video.

Step 5. Type a project name and set the project options.
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Capture from Non-Controllable devices
Many video sources including all kinds of modern cameras and disk recorders, as well as old cameras and 
VHS tape players, do not have any device control. To capture video without deck control:

Step 1. Choose Tools > Capture to open the Capture Tool.

Step 2. Click the Toggle Source button so that the button's icon of a deck shows a red circle-slash symbol. 
This symbol indicates that deck control has been disabled.

Step 3. Set the Video and Audio input menus to "Blackmagic".

Step 4. Select the video source track (V) and the audio source tracks (A1, A2, ...) you wish to capture.

Step 5. Use the Bin menu to select a Target Bin from the list of open bins.

Step 6. From the Res (resolution) menu, choose which compressed or uncompressed codec you wish to 
use for your captured clips. For uncompressed 8-bit video, select "1:1" or "1:1 10b" for 10-bit.

Step 7. Select the disk storage for your captured video and audio. Use the Single/Dual Drive Mode button 
to choose if video and audio will be stored together on a single drive or on separate drives. Select 
the target drive(s) for your captured media from the Target Drives menu(s).

Step 8. Click the "Tape Name?" button at the bottom of the window to open the Select Tape dialog box.  
Select the desired tape, or alternatively add a new one and click OK.

Step 9. Ensure your video and audio source is ready or playing and then click the Capture button. The 
Capture button will flash red while recording. Click the Capture button again to end the capture.

Step 2. Set up the Capture Tool to capture video without deck 
control by clicking the Toggle Source button.
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Capture from Controllable Devices with UltraStudio, DeckLink and Teranex
If you have a deck that connects via RS-422, you will need to configure the deck settings before performing 
a capture with deck control.

Step 1. From your project window, click the Settings tab and double-click on Deck Configuration.

Step 2. In the Deck Configuration dialog box, click Add Channel and then set the Channel Type to Direct 
and the Port to RS-422 Deck Control. Click OK and choose "No" when asked, "Do you want to 
autoconfigure the channel now?"

Step 3. Click Add Deck and then select your brand and model of deck from the Device menus and also 
set the desired preroll. Click OK and then Apply.

Step 4. Under the Settings tab, double-click on Deck Preferences.

Step 5. If you plan to make assemble edits to tape, enable the option to "Allow assemble edit & crash 
record for digital cut". If this option is left unchecked, you will only be able to perform insert edits.

Step 6. Enable the option to "Relax coincidence point detection" and set other settings as needed.  
Click OK. You have completed setting up the RS-422 connection to your deck.

To test the remote connection ensure an RS-422 serial cable is connected between your Blackmagic video 
hardware and the deck. Set the deck to Remote. Open the Capture Tool and use the standard J, K, L 
shortcut keys to control the deck. If a deck name appears in italics or "NO DECK" is displayed, click the 
menu and select Check Decks until the deck is listed without italics and deck control is re-established.

To capture with deck control on-the-fly:

Step 1. Choose Tools > Capture to open the Capture Tool.

Step 2. The Capture/Log Mode button should show the CAP icon. If this button displays a LOG icon, click 
the button to switch to capture mode and the CAP icon should appear.

Step 3. The Toggle Source button should show the icon of a deck. If a red circle-slash symbol is present, 
click the button to enable deck control and make the red symbol disappear.

Step 4. Configure video and audio input, video and audio source tracks, target bin, res, target drive and 
tape name the same way as in "Capture from non-controllable devices".

Step 5. Use the Deck Controller Window in the Capture Tool to cue the tape and start playing.

Step 6. Click the Capture button. The Capture button will flash red while recording. Click the Capture 
button again to end the capture.

Step 6. In the Deck Preferences, enable the option to "Relax 
coincidence point detection".

Set the CAP and Toggle Source buttons to use deck control. Use 
the Deck Controller Window to cue the tape and start playing.
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Batch Capture with UltraStudio and DeckLink
To log clips for batch capture:

Step 1. Choose Tools > Capture to open the Capture Tool.

Step 2. Click on the Capture/Log Mode button so it displays the LOG icon.

Step 3. Configure video and audio input, video and audio source tracks, target bin, res, target drive and 
tape name the same way as in "Capture from non-controllable devices".

Step 4. Use the Deck Controller Window, or use the standard j, k, l shortcut keys, to shuttle backwards, 
pause and shuttle forwards on the deck and locate the video you want to capture.

Step 5. Click the Mark IN/OUT button, to the left of the LOG button. The icon will alternate between IN 
and OUT so you only have to click the one button to mark all your in and out points.  This can be 
more convenient that using the separate Mark IN and Mark OUT buttons in the Deck Controller 
Window. Alternatively use the "i" and "o" keys on the keyboard to mark in and out points.

Step 6. When you have finished logging in and out points, open the logging bin, select the clips you want 
to capture.

Step 7. Choose Clip > Batch Capture, select the desired options in the resulting dialog box and click OK.

Recording to Tape with UltraStudio and DeckLink
Once you have captured your clips, dragged them in to the timeline, edited them and applied and rendered 
any effects, you will want to record the completed project to tape.

Step 1. Double-click on a sequence, in your project bin, to open it into the Timeline window.

Step 2. Choose Output > Digital Cut to open the Digital Cut Tool.

Step 3. Set Output Mode to Real-Time, Bit Depth to 10-bit, and Deck Control to Remote.

Step 4. From the Edit Menu, choose to Insert Edit or Assemble Edit for precise edits onto a timecode 
striped tape. Alternatively choose Crash Record for an easy way to record. If Insert Edit is the 
only option, go to the Settings tab in your project, double-click on Deck Preferences and enable 
"Allow assemble edit & crash record for digital cut".

Step 5. If a deck name appears in italics or "NO DECK" is displayed, click the menu and select Check 
Decks until the deck is listed without italics and deck control is re-established.

Step 6. Press the Play Digital Cut button (red triangle icon) to record your sequence to tape.

Step 5. Click on the Mark IN/OUT button or use the "i" and "o" 
keys on the keyboard to mark in and out points.

The Digital Cut Tool is used for recording to tape.
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Autodesk Smoke

Autodesk Smoke 2013 Extension 1
Autodesk Smoke brings together editing, compositing and 3D effects into a single workspace. Smoke 
captures and plays back standard definition and high definition video and audio with Blackmagic video 
hardware and also supports RS-422 deck control. Before installing Autodesk Smoke, make sure that both 
the Blackmagic Design drivers and your video device are properly installed.

Smoke's broadcast monitoring allows you to output video through Blackmagic hardware.

Installation
Step 1. Launch Smoke and the Project and User Settings window will appear. Choose your Project and 

User if you have previously created them. Otherwise, create a new project and/or user.

Step 2. Set the project settings to match your delivery settings, i.e., 1080HD. Most of these settings can 
be changed later during your session.

Step 3. Choose your intermediate format, such as ProRes 422 or even Uncompressed for your project 
generated media. Remember to choose a format that your storage can handle.

Step 4. Click the Create button.

Setting Up Hardware
It’s a good idea to follow the steps below when you are preparing for a VTR session.

Step 1. Connect the outputs of your VTR to the inputs of your Blackmagic capture and playback device. 
Connect the outputs of your Blackmagic capture and playback device to the inputs of your VTR.

Step 2. Connect an RS-422 deck control cable from the serial port on your VTR to the remote control port 
of your Blackmagic Design capture and playback device. 

Step 3. Set your VTR to remote. 

Step 4. Connect a sync generator to the sync input of the VTR to ensure frame-accurate capture. If you 
have a separate audio device, an audio sync signal must be connected to it as well.

Type a project name and set the project options.
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Setting Up a VTR
Before starting Autodesk Smoke, you must use a utility called Smoke Setup to select the model of the VTR(s) 
in your facility and its appropriate timing settings.

Step 1. Go to Applications>Autodesk>Smoke>Utilities and open Smoke Setup.

Step 2. In the General tab, make sure that Video Device and Audio Device are set to BMD.

Step 3. In the VTR tab, enable the VTR model and the timings you want to use with Autodesk Smoke. 
Enable the rows with live NTSC or live PAL to enable crash-record or live output.

Step 4. Click Apply and close Smoke Setup.

Capture from Controllable Devices with UltraStudio and DeckLink
Autodesk Smoke can be configured to capture from controllable VTRs with RS-422 deck control.

Step 1. Select a folder in the Media Library where you want the captured clip to be created.

Step 2. Select File>Capture from VTR. The VTR Capture module appears.

Step 3. Cue the tape to the start frame of the clip you want to capture.

Step 4. Select the video and audio channels you wish to record. The buttons will turn red to let you know 
which tracks are enabled.

Step 5. Enter In and Out points in the In and Out fields. 

Step 6. Click Capture to start the capture. The timecode field will turn green to indicate that capture is in 
progress.

Step 7. End the capture at any time by clicking anywhere over the Preview window. The clip will 
automatically be saved to the location that you selected before entering the VTR Input module.

Ensure Video Device and Audio Device are set to BMD in the 
Smoke Setup utility.

Select timing settings for your VTR using the VTR tab in the 
Smoke Setup utility.

Video and audio tracks turn red when enabled for capture from 
your VTR.
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Recording to Tape with UltraStudio and DeckLink
Load a clip into the VTR Output module and set the In and Out points for the output clip. If needed, you can 
also enable the options to offset the start frame for output and to apply a letterbox overlay.

Step 1. Select File>Output to VTR.

Step 2. Choose the clip(s) to output from the Media Library. You can also select a folder if you wish to 
output its contents in one session. The VTR Output module appears.

Step 3. Select the VTR in the Device Name box. The preview window displays the video from the tape in 
the selected VTR.

Step 4. Make sure that the correct video track and audio channel buttons are enabled so that the 
corresponding video track and audio channels are output to tape.

Step 5. Enable or disable All Audio in the Clip Output menu. When All Audio is enabled, every audio 
channel will be converted to the format on your tape, not just the ones you enabled.

Step 6. Click preview to watch the clip before outputting.

Step 7. To output the selected clip starting at any frame other than the first one, enter the start timecode 
in the Start Offset field.

Step 8. Set the In and Out points for clip output.

Step 9. To output the clip to the VTR, select Insert from the Output box. The clips with Status selected 
will be output to tape. During output, the status of each clip will be updated to Pending, Output,  
and then Done.

Step 10. Cue to the In timecode and then select Play to check that the transfer was successful.

Step 11. When you are finished, click EXIT Output Clip to close the module.

Step 3. Your VTR should be selectable in the drop down list.

Clips you have selected to output appear in a list with their 
current status. 

Set your In and Out points, then select Insert from the Output 
dropdown menu. 
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Crash-Record and Live Output
Autodesk Smoke allows you to capture a live video signal or crash-record a clip by using a tablet pen or a 
mouse to start and stop the clip input or output process. When you choose this form of capture, Autodesk 
Smoke checks the available space on your Autodesk Media Storage device to determine the available 
space, which varies depending on your preferred intermediate format.

Also, if you are using a device that does not support remote control via RS-422, such as a camera, VCR, or 
any other device, use the Live NTSC or PAL option to capture, and the Live Video option to output clips.

To crash-record a live video signal:
Step 1. Choose a folder from the Media Library where you would like the captured clip to be created.

Step 2. Select File>Capture from VTR. The VTR Capture module appears.

Step 3. From the VTR Device box, select Live NTSC or Live PAL. The incoming live video signal appears 
in the preview window.

Step 4. Select the Start On Pen mode. End the capture by using Stop On Pen or Stop On Frames. 
Traditionally, Autodesk Smoke was operated with a tablet and pen, hence the Start On Pen 
terminology.

When Stop On Pen is selected for capture stop mode, the out point and the duration timecode fields will be 
updated to show the longest possible clip that can be recorded on your Autodesk Media Storage device. 
The capture will either end when you click anywhere on the screen or when your storage fills up.

Step 5. Enter the clip name and enable the video tracks and audio channels that you want to capture.

Step 6. Make sure you are receiving the live video signal.

Step 7. Press Play on the video device.

Step 8. Select Process to begin capturing.

Step 9. Click anywhere on the screen to end capturing in Stop On Pen mode. 

Enable the rows with live NTSC or live PAL to enable crash-record 
or live output.
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To output a live video signal:
Step 1. Select File>Output to VTR.

Step 2. Select the clip(s) to output from the Media Library. You can also select a folder to output its 
contents. The VTR Output module appears.

Step 3. From the VTR Device box, select Live NTSC or Live PAL.

The Start Mode box is unavailable. With Live Video output, you must use Start On Pen mode. You can use 
Stop On Pen or Stop On Frames to end the output.

Step 4. Set output options. For example, enter the clip name and enable the video tracks and audio 
channels that you want to capture. 

Step 5. On the device receiving the signal, start the recording, or take any action required to enable the 
reception of the signal from Autodesk Smoke.

Step 6. Select Process to begin the output on Autodesk Smoke.

Step 7. Click anywhere on the screen to end the output in Stop On Pen mode.

Use Start On Pen mode when outputting live video.

Select Live PAL or Live NTSC when outputting a live video signal.
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DaVinci Resolve 10

Select your desired format from the "Video capture and 
playback" menu.

DaVinci Resolve 10 and Live Grading
Desktop Video 10 allows simultaneous capture and playback on the UltraStudio 4K and DeckLink 4K 
Extreme. This is great for users who want to use the Live Grading feature within DaVinci Resolve 10, as it 
means you don’t require two separate devices for input and output.

When using live grading on-set, simply connect the output of the camera to the input of your Blackmagic 
hardware. Then connect the hardware's output to an on-set monitor for grading evaluation and viewing.

Setting Up
Step 1. Launch Resolve and from the Preferences menu, select the "Video I/O and GPU" tab and select 

your hardware from the “For Resolve Live use” option. Save your preferences and restart Resolve 
to apply your changes.

Step 2. Start a project and from within the Project Settings window, set the resolution and frame rate to 
match your camera.

Step 3. In the Project Settings window, go to the "Deck Capture and Playback" tab and select your 
desired format from the "Video capture and playback" menu.

Step 4. Go to the Edit page and right click in the Timeline window and select “Create New Timeline”.

Step 5. From the Color menu, select "Resolve Live On/Off". You should now see live video within the 
Viewer and a bright red “Resolve Live” button will appear above the video.

Using Resolve Live
Step 1. In Resolve Live mode, the Freeze button (snowflake icon) freezes the current incoming video 

frame, so you can grade it without being distracted by motion occurring during the shoot. When 
you’ve made the adjustment, you can unfreeze playback in preparation for grabbing a snapshot.

Step 2. Once you’re happy with a grade, clicking the Snapshot button (camera icon) saves a snapshot 
of the current still in the Viewer, the incoming timecode value, and your grade into the Timeline. 
Snapshots are simply one-frame clips.

You can refer to the DaVinci Resolve 10 manual for more information on Resolve Live.
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What is Blackmagic Media Express?
Blackmagic Media Express software is included with every UltraStudio, DeckLink and Intensity as well as 
every ATEM Switcher, Blackmagic Camera, H.264 Pro Recorder, Teranex Processor and Universal Videohub. 
Media Express 3 is a great tool when you don’t need the complexity of NLE software but simply want to 
capture, play back and output clips to tape. 

Capturing Video and Audio files

Setting Up a Project
Before capturing any clips in Media Express, you will need to select the settings for your project. 

Step 1. Go to Media Express>Preferences or Edit>Preferences on Windows or Linux. The project formats 
listed will vary depending upon whether your Blackmagic video hardware supports features such 
as Ultra HD 4K video or stereoscopic 3D video.

Step 2. Select from a range of compressed and uncompressed capture formats or even a DPX image 
sequence from the Capture File Format drop down menu. Video will be captured in the chosen 
format and saved as a QuickTime movie.

Step 3. Set the storage location for your captured video and audio. 

Step 4. Choose whether to stop capture or playback if dropped frames are detected.

Standard definition projects use the 4:3 aspect ratio unless you enable the Anamorphic SD 16:9 checkbox. 

Applications will normally stop playing video if you send them to the background. Tick the checkbox 
"Continue playback when in the background" if you want Media Express to keep playing video when you 
open another application in the foreground.

The final options relate to tape decks with RS-422 deck control and include pre-roll and timecode offsets.
Use the Preferences window to set video format, file format, 
storage location and other settings.

Blackmagic Media Express
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Capture
Capturing video is easy and all you need to do is connect a video source, set the Media Express preferences 
and press the Capture button.

Step 1. Start by connecting your video source to an input of your Blackmagic video hardware and check 
that the Blackmagic system preferences are set to the same video input, e.g. SDI, HDMI or analog.

Step 2. Open Media Express and set its preferences to the project video format and capture file format.

Step 3. Click the red Log and Capture tab and enter a description into the Description field.

Step 4. Click the "+" button next to the Description to add it to the automatic Name field. Click the "+" 
button next to any of the other fields that you wish to add to the Name field.

 � To increment the value in each of these fields, click the corresponding clapper board icon. 
Alternatively, type directly into any field to customize its name and number.

 � The text in the automatic Name field will be applied to the clip(s) which are about to be captured.

 � To log the clip as a favourite, click the "star" icon next to the Name field.

 � For a clip name confirmation prompt to appear before every capture, click the "!" icon next to 
the Name field.

Step 5. Set the desired number of audio channels to be captured.

Step 6. Click the “Capture” button to start recording. To stop the capture and keep the clip, click the 
“Capture” button again. Alternatively, press esc to be prompted to delete or save the clip. The 
captured clips are added to the Media List.

Logging clips
Ensure an RS-422 serial cable is connected between your Blackmagic video hardware and the deck.  
Ensure the deck's Remote/Local switch is set to Remote. Use the standard j, k, l shortcut keys to shuttle 
backwards, pause and shuttle forwards.

Click the Mark In button to mark the In point, or use the shortcut key i.

Click the Mark Out button to mark the Out point, or use the shortcut key o.

Click the Log Clip button to log the clip, or use the shortcut key p. The entry should now appear in the 
Media List with a red X in its icon to indicate the media is offline.

Set the desired number of audio channels to be captured.

Enter a description for your video.

Click the "Capture" button to begin capturing.
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Batch Capture
After logging a clip, you can click the Clip button to capture a single clip.

To capture multiple clips, continue logging the clips for batch capture.

Select the logged clips in the Media List and do one of the following:

 � Click the Batch button.
 � Right-click on the selection and select Batch Capture.
 � Go to the File menu and choose Batch Capture.

Media Express will capture the clip from the In to the Out timecode.

DPX Capture
If you want to capture a DPX image sequence rather than a movie file, open the Media Express preferences 
and set the Capture File Format to DPX 10-Bit RGB.

 � Create a DPX project by setting the capture file format to DPX.
 � Capture.

When the capture has been completed, a single thumbnail will appear in the Media List representing the 
entire frame sequence. The sequence of DPX frames will be stored in its own folder in your disk storage. 
Audio will be stored in a .wav file in the same folder.

By default, DPX captures are assumed to be from YUV sources. If you need to capture from an RGB source, 
disable the "Capture to DPX from a YUV source".

If you want the DPX frame numbers to be based on the timecode of the captured video, rather than just 
starting from zero, enable the option to "Use absolute frame numbering when capturing DPX".

If you aren't performing long DPX captures, you may wish to reduce the number of zeroes in the frame 
numbers by changing the option, "When capturing DPX files, use (2-8) digit numbers in the frame count".

DPX capture preferences
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3D Capture
When Media Express is used with a Blackmagic video hardware model that supports dual-stream 3D,  
you can create left and right eye 3D video clips by capturing 2 streams of HD-SDI video simultaneously.

 � Create a 3D project which matches the frame rate of your dual stream 3D video source.
 � Ensure you have 2 discrete HD-SDI video inputs to the Blackmagic video hardware.
 � Capture.

When capturing and logging dual stream 3D in Media Express, the clip name will be applied to the left 
eye video. The right eye video will be appended with ‘_right’ text. For example, if you name the stereo clip 
“Clip 1”, the left eye clip will be called “Clip 1.mov” and the right eye clip will be called “Clip 1_right.mov”.

The Media List presents an eye-catching indication that the captured clip is a 3D clip:

 � In Thumbnail view, the left and right eye clips are connected by a 3D indicator and presented as 
a single, large icon.

 � In Timecode List view, the left and right eye clips are listed on two lines and linked together by a 
3D indicator.

Select a project video format with "3D" in its name to capture 
dual-stream stereoscopic 3D video clips.

In Thumbnail view, the left and right eye clips are connected by a 
3D indicator and presented as a single, large icon.

In Timecode List view, the left and right eye clips are listed on two 
lines and linked together by a 3D indicator.
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Playing back Video and Audio Files

Importing clips
You can play back your video and audio files after importing media into Media Express in any of  
the following ways:

 � Double-click an empty area of the Media List.
 � Right-click an empty area of the Media List and select Import Clip from the contextual menu.
 � Go to the File menu, select Import and then Media Files.

Select the video and audio clip(s) you wish to import from the Open Video Clip dialog box. The clips will 
appear in the Scratch area of the Media List. If you have created your own bins in the Media List, you can 
drag the clips into the desired bin.

To import directly to a bin, right-click within the desired bin and select Import Clip from the contextual menu.

If the files being imported do not match the frame rate and size of existing clips in the Media List, you will 
be prompted to create a new project and to save the current project.

Media Express also supports the import of multichannel audio-only files recorded at 48kHz in the 
uncompressed WAVE (.wav) and AIFF (.aif) formats.

Another way to import media is to use an XML file exported from Final Cut Pro. Go to the File menu, select 
Import and then Final Cut Pro XML. Open the desired XML and all the bins and media from the Final Cut 
Pro project will appear in the Media List.

Media Express also supports the import of CMX EDL files to batch capture clips using EDL files from 
other video software. Go to the File menu, select Import and then CMX EDL. Select the EDL and open it.  
The logging information will appear in the Media List. Select the logged clips and perform a batch capture 
to import the clips from your deck.

Playing back single and multiple clips
To play back a single clip, double-click the clip in the Media List. Alternatively, select the clip in the Media List 
and press the space bar on your keyboard or the play button in the transport controls.

To play back multiple clips, select the clips in the Media List and then press the space bar on your keyboard 
or the play button in the transport controls.

Your video will play back in the video preview pane of Media Express and on all the video outputs of your 
Blackmagic video hardware. During playback, the audio channels being monitored can be switched on or 
off via the track enable/disable buttons.

You can import media directly, or import with an XML or EDL.

You can use the transport controls to play, stop, jump to the next 
or previous clip and loop playback.
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Browsing Media

Thumbnail view
Thumbnails are the most intuitive way to display your clips. Hover your mouse over the clip's thumbnail 
and then click on the popup info icon at the bottom-right of the thumbnail. Click the info bubble to hide it.

List view
You can view your clips in Timecode List view by clicking on the Timecode List button at the top-right of the 
Media List. Use the horizontal scroll bar to view all the columns of information for your clips.

Creating and using bins
To create a bin, right click an empty spot in the Media List and select "Create Bin". Name the new bin.

You can move clips around by dragging the clip icons to the desired bin.  If you want a clip to appear in more 
than one bin, import the same clip again by right-clicking on the bin and choosing "Import Clip".

By default, logged clips appear in the Scratch. If you want to log clips and have them appear in a new bin, 
right-click the new bin and choose "Select As Log Bin".

Creating and using favorites
In the Log and Capture tab, click the "star" icon next to the Name field if you want to log a clip as a favorite.

In the Playback tab, clicking the "star" icon will make the clip a favorite if it is selected in the Media List. Click 
the "star" icon again to deselect it as a favorite.

Clips marked as favorites will show a yellow star in their icon in Timecode List view and Thumbnail view.

Once you have marked clips as favorites, click on the "Show only favorites" button at the top of the Media 
list. The star icon will turn yellow. All clips will be hidden except for those marked as favorites. 

Linking an audio clip to a video clip
To link an audio clip to a video clip in the Media List:

 � Select a video clip which contains no audio channels.
 � Right-click on the video clip and select ‘Link Audio File’ from the contextual menu.

You can now play back the combined clip or master it to tape.

In the Media List, choose to view your clips in Timecode List view 
or Thumbnail view. Click the Favorites button to show only your 
favorite clips. Type in the Search field to find your favorite clips.

Click a thumbnail's popup info icon to view the info bubble.

In the Log and Capture tab, click the "star" icon next to the 
Name field if you want to log the clip as a favorite.
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Deleting clips and bins
To delete clips, select the unwanted clips and press the forward delete button on your keyboard. This will 
only delete the clips from the Media List and they will safely remain on your disk storage.

To delete bins, right-click within a bin and choose "Delete Bin". This action will delete the bin and any clips it 
contained. This will only delete the clips from the Media List and they will safely remain on your disk storage.

Creating a 3D clip
To add a stereoscopic 3D clip to the Media List:

 � Select a 3D project video format that is the same frame rate as your 3D media.
 � Import the ‘left eye’ file into the Media List.
 � Right-click on the left eye file and select "Set Right Eye Clip" from the contextual menu. If the 

right eye clip was previously captured by Media Express, the right eye video will be appended 
with ‘_right’ text.

The Media List presents a highly visible indication that the imported clip is a 3D clip. The left and right eye 
clips are displayed side by side in the Video Preview window, indicating a 3D video project.

If you find the left and right eyes of a 3D stereo clip have been loaded the wrong way around:

 � Right-click the 3D clip in the Media List.
 � Select ‘Swap Eyes’ from the contextual menu.

Searching the Media List
Clips can easily be found in a project by typing the name of your clips in the Search field at the top of the 
Media List. When used in conjunction with the favorites feature, the search will be confined to your favorite 
clips so you will see a shorter list of found clips.

Select a 3D project video format.

The Media List presents a highly visible indication that the 
imported clip is a 3D clip.

Type in the Search field to find clips.

The Media List presents a highly visible indication that the  
video and audio clips are linked.

Deleting clips and bins
To delete clips, select the unwanted clips and press the forward delete button on your keyboard. This will 
only delete the clips from the Media List and they will safely remain on your disk storage.

To delete bins, right-click within a bin and choose "Delete Bin". This action will delete the bin and any clips it 
contained. This will only delete the clips from the Media List and they will safely remain on your disk storage.

Creating a 3D clip
To add a stereoscopic 3D clip to the Media List:

 � Select a 3D project video format that is the same frame rate as your 3D media.
 � Import the ‘left eye’ file into the Media List.
 � Right-click on the left eye file and select "Set Right Eye Clip" from the contextual menu. If the 

right eye clip was previously captured by Media Express, the right eye video will be appended 
with ‘_right’ text.

The Media List presents a highly visible indication that the imported clip is a 3D clip. The left and right eye 
clips are displayed side by side in the Video Preview window, indicating a 3D video project.

If you find the left and right eyes of a 3D stereo clip have been loaded the wrong way around:

 � Right-click the 3D clip in the Media List.
 � Select ‘Swap Eyes’ from the contextual menu.

Searching the Media List
Clips can easily be found in a project by typing the name of your clips in the Search field at the top of the 
Media List. When used in conjunction with the favorites feature, the search will be confined to your favorite 
clips so you will see a shorter list of found clips.
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Editing Video and Audio Files to Tape
While we usually talk about mastering or editing to "tape", it doesn't matter if your deck uses tapes or disks. 
To master your clips:

 � Select the clips you want to send to tape.
 � Click the blue Edit to Tape tab.
 � Set the In point and type of edit.
 � Master to tape.

Selecting clips to master
From the Media List, select the clips you wish to master to tape. You can even insert multichannel audio-only 
clips to replace the master audio track on a master tape. If you only want to send your favorite clips to tape, 
click the favorite (star) icon at the top of the Media List to show your favorites and hide all other clips. Then 
select the favorite clips you wish to send to tape.

Insert and Assemble to tape
Click the blue Edit to Tape tab. Enter the In point of the tape by entering timecode into the In point field, 
or by cueing the tape to the desired point via the transport control and then clicking the Mark In button.

If no Out point is entered, Media Express will set the duration of the edit to the total length of the clips in 
the Media List. If an out point is defined, Media Express will stop recording once the Out point timecode is 
reached, even if some clips have not been output.

Choose to master to tape using Assemble or Insert edit. Then press the Master button.

Preview mode mimics the edit process but does not record to tape. This mode lets you check the edit point. 
Preview edit operations should always be checked on monitors connected directly to the output of the 
deck. This lets you view the video already on tape in conjunction with the new video. 

If Record Inhibit is enabled either on the deck or on the tape, Media Express will report this when you click 
the Master button. Disable Record Inhibit before trying again.

Select the video and audio channels you wish to output via the track enable/disable buttons. Deselect the 
video channel if you only want to output audio.

Click the favorite (star) icon at the top of the Media List to show 
only your favorites.

Two clips have been selected for output to tape.

Set the desired number of audio channels to be mastered.
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What is Blackmagic Design Disk Speed Test?
Blackmagic Disk Speed Test measures the read and write performance of storage media in video frame 
sizes. Disk Speed Test is included free with any Blackmagic Design product installation on Mac OS X and 
Windows or can be downloaded free from our website. Access the Disk Speed Test settings by clicking on 
the Settings button (the gear icon), located just above the Start button.

Select Target Drive
Click Select Target Drive and ensure you have Read and Write permissions.

Save Screenshot
Click Save Screenshot to save a screenshot of the results. 

Stress
The stress level can be set between 1GB and 5GB in 1GB increments. 5GB is the default setting and will 
provide the most accurate results.

Disk Speed Test Help
Click Disk Speed Test Help to launch the PDF manual for Disk Speed Test. 

About Disk Speed Test
About Disk Speed Test displays which version of the Disk Speed Test you are running.

Start
Click the Start button to commence the disk speed test. Disk Speed Test will write and then read a temporary 
file to the selected target drive. Disk Speed Test will continue writing and reading until you stop the test by 
clicking the Start button again.

Will it Work?
The “Will it Work?” panel shows common video formats and displays a check mark or cross to indicate if 
disk performance is adequate. Be sure to do several test cycles to reveal any video formats for which the 
disk performance might be marginal. If a video format exhibits a check mark switching between a cross, it 
indicates that the disk storage cannot reliably support the video format.

How Fast?
The “How Fast?” results panel shows the frame rates your drive can achieve and should be read in conjunction 
with the “Will it Work?” panel. If the “Will it Work?” panel shows a green check mark for 2K 1556@25fps 
in 10 Bit YUV 4:2:2, but the “How Fast?” panel shows that a maximum of 25fps will be supported, the disk 
storage performance is too marginal to be reliable.

Open the Settings menu by clicking the gear icon.

Blackmagic Disk Speed Test
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How Fast? 

This panel shows results 
in frames per second (fps)

Settings 

Click this button to 
access the settings before 
running a disk speed test

Will it Work? 

This panel shows which 
video formats can be 
supported by your disk 
storage

START

Click this button once to 
start the disk speed test. 
Click again to stop the test
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Getting Help
The quickest way to obtain help is to check the latest support material for your specific hardware at the 
Blackmagic Design online support pages.

Blackmagic Design Online Support Pages
The latest manual, software and support notes can be found at: www.blackmagicdesign.com/support

Contacting Blackmagic Design Support
If you can't find the help you need in our support material, you can email us by using the "Send request" 
button on the support page of your specific hardware. Alternatively, you can call your nearest Blackmagic 
Design support office at: www.blackmagicdesign.com/company

Checking the Version Currently Installed
To check which version of Desktop Video software is installed on your computer, open the Blackmagic 
Design Desktop Video system preferences. The version number appears in the title bar.

 � On Mac OS X, open the System Preferences to locate the Blackmagic Design icon. Click the 
Blackmagic Design icon to reveal the version number.

 � On Windows 7 and Windows 8, open the Control Panel and click on the “Hardware and Sound” 
category to reveal the Blackmagic Design Control Panel. Click the Blackmagic Design Control 
Panel to reveal the version number.

 � On Linux, go to "Applications" and then "Sound and Video" to locate the Blackmagic Control 
Panel. Open the control panel to reveal the version number.

How to Get the Latest Updates
After checking the version of Desktop Video installed on your computer, please visit the Blackmagic Support 
Center at www.blackmagicdesign.com/support to check for the latest updates. While it is advisable to run 
the latest updates, you should avoid updating software when in the middle of an important project.

Help

http://www.blackmagicdesign.com/support
http://www.blackmagicdesign.com/company
http://www.blackmagicdesign.com/support
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Developing Custom Software using Blackmagic Design Hardware
The DeckLink SDK is available for developers to control Blackmagic video hardware with their own custom 
software. The DeckLink SDK supports the UltraStudio, DeckLink, Multibridge and Intensity products.

The DeckLink SDK provides both low-level control of hardware and high-level interfaces to allow developers 
to easily perform common tasks. The DeckLink SDK supports technologies including:

 � Apple QuickTime
 � Microsoft DirectShow
 � Apple Core Media
 � DeckLink API

Downloading the Free Blackmagic Design SDK
The DeckLink SDK can be downloaded at: www.blackmagicdesign.com/support/sdks/

Joining the Blackmagic Design Developer List
The Blackmagic Developer mailing list is designed for technical questions regarding technologies used by 
Blackmagic Design, such as QuickTime, Core Media, DirectShow, codecs, APIs and SDKs. The free mailing 
list is a forum where developers can discuss ideas and problems with other developers. Any subscriber may 
reply and the Blackmagic Design engineers will also respond when appropriate. You can subscribe to the 
mailing list at: http://lists.blackmagicdesign.com/mailman/listinfo/bmd-developer

If it is not obvious from your domain name that you are a developer, we may request a brief outline of your 
software. As the list is designed solely for developers, we endeavor to keep it free of spam and viruses, non-
development questions and employment agents or sales people promoting products. 

Contacting Blackmagic Design Developer Assistance
If you wish to ask questions off the list, please contact us at: developer@blackmagicdesign.com

Developer Information

http://www.blackmagicdesign.com/support/sdks/


Warnings49

Caution: Risk of Electric Shock
On the UltraStudio 4K enclosure you will see a yellow warning label marked ‘Caution: Risk of Electric Shock’. 
This is intended to warn users that there may be the presence of uninsulated “dangerous” voltage within 
the UltraStudio 4K enclosure which may be of sufficient magnitude to constitute a risk of electric shock to 
the user. Blackmagic Design advises you not to open the UltraStudio 4K unit, but rather contact your nearest 
Blackmagic Design service center should assistance be required.

Achtung: Stromschlaggefahr
Auf dem UltraStudio 4K-Gehäuse befindet sich ein gelbes Warnetikett mit der Aufschrift 'Caution:  
Risk of Electric Shock’. Dieses warnt den Benutzer vor einer möglichen, nicht isolierten, "gefährlichen" 
Spannung innerhalb des UltraStudio 4K-Gehäuses, die einen Elektroschock verursachen kann. Blackmagic 
Design empfiehlt das Gehäuse des UltraStudio 4K nicht selbst zu öffnen, sondern bei Hilfebedarf das 
nächstgelegene Blackmagic Design Servicecenter zu kontaktieren.

Attention: Risque de choc électrique
Sur le boîtier du UltraStudio 4K, vous verrez une étiquette d’avertissement de couleur jaune sur laquelle est 
inscrit « Attention : Risque de choc électrique ». Cette mise en garde est destinée à avertir les utilisateurs 
de la présence possible d’une tension « dangereuse » non isolée à l’intérieur du boîtier du UltraStudio 4K, 
laquelle tension pouvant avoir une amplitude suffisante pour constituer un risque de choc électrique à 
l’utilisateur. Blackmagic Design vous déconseille donc d’ouvrir l’unité UltraStudio 4K, et vous recommande 
de contacter votre centre de service Blackmagic Design le plus proche en cas de nécessité.

Caution label

Warnetikett

Avertissement

Warnings
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Limited Warranty
Blackmagic Design warrants that UltraStudio, DeckLink and Multibridge family products will be free from 
defects in materials and workmanship for a period of 36 months from the date of purchase excluding 
connectors, cables, cooling fans, fiber optic modules, fuses, keyboards and batteries which will be free from 
defects in materials and workmanship for a period of 12 months from the date of purchase. Blackmagic 
Design warrants that Intensity family products will be free from defects in materials and workmanship for 
a period of 12 months from the date of purchase. If a product proves to be defective during this warranty 
period, Blackmagic Design, at its option, either will repair the defective product without charge for parts 
and labor, or will provide a replacement in exchange for the defective product.

In order to obtain service under this warranty, you the Customer, must notify Blackmagic Design of the 
defect before the expiration of the warranty period and make suitable arrangements for the performance 
of service. The Customer shall be responsible for packaging and shipping the defective product to a 
designated service center nominated by Blackmagic Design, with shipping charges pre paid. Customer 
shall be responsible for paying all shipping changes, insurance, duties, taxes, and any other charges for 
products returned to us for any reason. 

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or 
inadequate maintenance and care. Blackmagic Design shall not be obligated to furnish service under 
this warranty: a) to repair damage resulting from attempts by personnel other than Blackmagic Design 
representatives to install, repair or service the product, b) to repair damage resulting from improper 
use or connection to incompatible equipment, c) to repair any damage or malfunction caused by the 
use of non Blackmagic Design parts or supplies, or d) to service a product that has been modified or 
integrated with other products when the effect of such a modification or integration increases the time or 
difficulty of servicing the product. THIS WARRANTY IS GIVEN BY BLACKMAGIC DESIGN IN LIEU OF ANY 
OTHER WARRANTIES, EXPRESS OR IMPLIED. BLACKMAGIC DESIGN AND ITS VENDORS DISCLAIM 
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
BLACKMAGIC DESIGN’S RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE 
WHOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR ANY INDIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER BLACKMAGIC DESIGN 
OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES. BLACKMAGIC 
DESIGN IS NOT LIABLE FOR ANY ILLEGAL USE OF EQUIPMENT BY CUSTOMER. BLACKMAGIC IS 
NOT LIABLE FOR ANY DAMAGES RESULTING FROM USE OF THIS  PRODUCT. USER OPERATES THIS 
PRODUCT AT OWN RISK. 

© Copyright 2014 Blackmagic Design. All rights reserved. ‘Blackmagic Design’, ‘DeckLink’, ‘HDLink’, ‘Workgroup Videohub’, ‘ Videohub’, 
‘DeckLink’, ‘Intensity’ and ‘Leading the creative video revolution’ are registered trademarks in the US and other countries. All other company and 
product names may be trade marks of their respective companies with which they are associated.

Thunderbolt and the Thunderbolt logo are trademarks of Intel Corporation in the U.S. and/or other countries.

Warranty



オペレーション マニュアル

Desktop Video

Linux™

Windows™

Mac OS X™

2014年6月
日本語

http://www.blackmagicdesign.com


Welcome52

ようこそ！
私たちは、 誰もが最高品質の映像を使用できるようにすることで、 テレビ業界を真にクリエ 
イティブな業界にするという夢を、 ユーザーの皆様と共有できればと考えています。 

過去のハイエンド・テレビおよびポストプロダクションにおいては、 使用するハードウェアに
何百万ドルも投資する必要がありました。 しかし、 Blackmagicのビデオハードウェアは非
常にお求めになりやすい価格である上、 10-bitの非圧縮映像でさえお気軽にご利用いただ
けます。 ユーザーの皆様には、 新しくなったUltraStudio、 DeckLink、 Intensityを長くご
愛顧いただき、 世界中で人気の高いテレビ番組やデザイン・ソフトウェアなどで利用いただ
けることを願っています。 

このマニュアルには、 Blackmagicビデオハードウェアのインストールに必要なすべての情
報が記載されています。 PCI Expressをインストールされる際は、 過去にハードウェアカー
ドをコンピューターにインストールされたご経験がある場合を除き、 専門技術者からの助
言を得られることをお勧め致します。 Blackmagicビデオハードウェアは非圧縮ビデオを取
り扱う上、 データの転送速度も非常に速いため、 高速ディスクストレージおよびハイエンド
のコンピューターが必要となります。 

インストールが完了するまでにかかる時間は5分ほどです。 Blackmagicビデオハードウェ
アをインストールされる前に、 弊社のウェブサイトwww.blackmagicdesign.com/jpのサ
ポートページで最新バージョンのマニュアルとDesktop Videoドライバ・ソフトウェアをダ
ウンロードしてください。 また、 ソフトウェアのアップデートをダウンロードされる際は、 お
使いのBlackmagicビデオハードウェアをご登録いただきますようお願い致します。 ソフト 
ウェアの新しいアップデートや新機能について、 随時お知らせ致します。 Blackmagicビデ
オハードウェアを使用して制作された最新の映像がありましたらご送付ください。 また、 こ
のソフトウェアの改善に関するご提案がありましたらご連絡ください。 私たちは、 常に新機
能の開発および製品の改善に努めていますので、 ユーザーの皆様からご意見をいただけれ
ば幸いです。 

グラント・ペティ
Blackmagic Design CEO 
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Desktop Videoについて
Blackmagic DesignのDesktop Videoソフトウェアは、 お使いのUltraStudio、 DeckLink、 Intensity、 Teranex
ハードウェアと連動して動作します。 Desktop Videoソフトウェアには、 ドライバ、 プラグイン、 さらにBlackmagic 
Media Expressなどのアプリケーションが含まれています。 またDesktop Videoは、 ユーザーお気に入りのAdobe、 
Apple、 Autodesk、 Avidなどのソフトウェアとのシームレスな統合が可能です！

このマニュアルには、 コンピューターのシステム要件、 ハードウェア/ソフトウェアのインストール方法、 お気に入りの 
サードパーティ製ソフトウェアの使用方法が記述されています。 

システム要件
お使いのコンピューターには、最低4GBのRAMが搭載されている必要があります。 PCIe x1レーンカードはどのスロッ
トでも動作しますが、 PCIe x4レーンカードはx4レーンまたはそれ以上のスロットに挿入する必要があります。 

Mac OS X
Desktop Videoソフトウェアは、 最新バージョンのMountain LionまたはMarvericksがインストールされたMac 
OS Xで動作します。 

Blackmagicビデオハードウェアとコンピューターの接続にPCI Expressスロットを使用する場合は、 Intelベースの
Mac Proが必要です。 

Blackmagicビデオハードウェアとコンピューターの接続にThunderboltを使用する場合は、 Thunderbolt™ポート
を搭載したIntelベースのMac Proが必要です。

Windows
Desktop Videoは、 最新バージョンのサービスパックがインストールされた64-bit版Windowsでのみ動作します。 
Windows 7および8をサポートしています。 

Blackmagicビデオハードウェアとコンピューターの接続にThunderboltを使用する場合は、 Thunderboltポートを
搭載したIntelベースのPCが必要です。 

Blackmagicビデオハードウェアとコンピューターの接続にUSB 3.0を使用する場合は、 Renesasチップセットを使
用するUSB 3.0ポートが必要です。

Linux
Desktop Videoは、 2.6.23以降のLinuxを起動している32-bit/64-bit x86コンピューターで動作します。 対応する
Linuxディストリビューション、 パッケージフォーマット、 ソフトウェアの依存性の最新リストについては、 リリースノー
トを参照してください。 

はじめに
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Blackmagicビデオハードウェアをインストール
Blackmagicビデオハードウェアの接続にThunderboltを使用する場合は、 Thunderboltに関するセクションに進ん
でください。 Thunderboltポートは、 最新のMac OS XおよびWindowsコンピューターに搭載されています。 

Blackmagicビデオハードウェアの接続にUSB 3.0を使用する場合は、 USB 3.0に関するセクションに進んでくださ
い。 BlackmagicのUSB 3.0対応ビデオ製品を使用するには、 互換性のあるWindows PCが必要です。

Blackmagic PCIeカードをインストール
ステップ 1. コンピューターの電源プラグを抜き、 さらに身体の静電気を放電してください。

ステップ 2. Blackmagic PCIeカードをお使いのコンピューターの適切なスロットに挿入し、 正しい位置までしっかりと
押し込みます。 DeckLink Optical Fiberカードを使用する場合は、 カードを挿入する前に光ファイバーモ
ジュールを取り外します。

ステップ 3. お使いのBlackmagic PCIeカードにHDMIブラケットが付いている場合は、 ブラケットをスペアスロットに
挿入します。 挿入したPCIeカードとHDMIブラケットをネジで固定します。 HDMIケーブルは他にインストー
ルされているいずれかのカードに巻き付け、 DeckLinkカードの後部に接続します。 

ステップ 4. コンピューターのカバーを取り付け、 同梱のブレイクアウトケーブルを接続します。 DeckLink Optical 
Fiberカードを使用する場合は、 光ファイバーモジュールを再び挿入します。 再び電源を接続して、 コン
ピューターを起動します。 Blackmagic PCIeカードをスペアスロットにインストールします。 

HDMIブラケットは任意のスペアポートにインストールでき、 同梱
のHDMIケーブルを使用してカードの後部に接続できます。 

Blackmagicカードにブレイクアウトケーブルが同梱されている場
合は、 そのケーブルを接続します。 いくつかのモデルではHDMIブ
ラケットも同梱されています（上の図参照）。 
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BlackmagicビデオハードウェアをThunderboltで接続
ステップ 1. お使いのBlackmagicビデオハードウェアに外部電源が同梱されている場合は、 その電源でハードウェアを

接続し、 スイッチをオンにします。

ステップ 2. Thunderboltケーブルを使用して、 お使いのコンピューターのThunderboltポートとハードウェアを接続し
ます。 また、 お使いのコンピューターのThunderboltディスクアレイに接続することも可能です。

ステップ 3. Desktop Videoソフトウェアがすでにインストールされており、 内部ソフトウェアをアップデートをする場合
は、 「Update」をクリックして画面の指示に従ってください。

ステップ 4. ブレイクアウトケーブルが同梱されている場合は、 そのケーブルをBlackmagicビデオハードウェアに接続
し、 そのコネクターをビデオ機器に接続します。

BlackmagicビデオハードウェアをUSB 3.0で接続
ステップ 1. お使いのBlackmagicビデオハードウェアに外部電源が同梱されている場合は、 その電源でハードウェアを

接続し、 スイッチをオンにします。

ステップ 2. SuperSpeed USB 3.0ケーブルを使用して、 お使いのコンピューターのUSB 3.0専用ポートにハードウェ
アを接続します。

ステップ 3. Desktop Videoソフトウェアがすでにインストールされており、 内部ソフトウェアをアップデートをする場合
は、 「Update」をクリックして画面の指示に従ってください。

ステップ 4. ブレイクアウトケーブルが同梱されている場合は、 そのケーブルをBlackmagicビデオハードウェアに接続
し、 そのコネクターをビデオ機器に接続します。

Thunderbolt™およびUSB 3.0対応製品は、 1本の
ThunderboltまたはUSB 3.0ケーブルでコンピューターに接続
できます。 

UltraStudio 4KはThunderbolt 2™ポートを2系統搭載してい
るため、 お使いのコンピューターにThunderboltポートが1系統
しかない場合は、 使用していない方のポートでRAIDや他のデバ
イスと接続できます。 

PUSH

PUSH
PUSH
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Blackmagic Designソフトウェアをインストール
アプリケーション、 プラグイン、 ドライバー
下の表は、 Desktop Videoソフトウェアをインストールする際に含まれるアプリケーション、 プラグイン、 ドライバーの
リストです。 

Mac OS X Windows Linux

Blackmagic Desktop 
Videoドライバ

Blackmagic Desktop 
Videoドライバ

Blackmagic Desktop 
Videoドライバ

Blackmagic Design
システム環境設定

Blackmagic Design 
Control Panel

Blackmagic Design 
Control Panel

Blackmagic Design LiveKey Blackmagic Design LiveKey Blackmagic Media Express

Blackmagic Media Express Blackmagic Media Express Blackmagic AVIコーデック

Blackmagic QuickTime™

コーデック
Blackmagic AVI/
QuickTime™コーデック

Blackmagic Disk Speed Test Blackmagic Disk Speed Test

Adobe® Premiere Pro®、 After 
Effects® CC、 Photoshop® CC
プリセットおよびプラグイン

Adobe® Premiere Pro®、 After 
Effects® CC、 Photoshop® CC
プリセットおよびプラグイン

Apple Final Cut Pro™ 
Xプラグイン

Avid Media Composerプラグイン

Avid Media Composerプラグイン eyeon Fusionプラグイン
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Mac OS Xにインストール
ソフトウェアをインストールする前に、 管理者権限があることを確認してください。 

ステップ 1. 最新のドライバーを使用していることを www.blackmagicdesign.com/jp/support で確認します。

ステップ 2. ディスクまたはダウンロードしたディスクイメージから「Desktop Video Installer」フォルダを開き、 
「Desktop Video Installer」インストーラーを起動します。

ステップ 3. 「Continue」、 「Agree」、 「Install」ボタンをクリックして、 ソフトウェアをインストールします。

ステップ 4. コンピューターを再起動して、 新しいソフトウェアドライバを有効にします。

自動アップデート
Macを再起動するたびに、 ソフトウェアがハードウェアの内部ソフトウェアのバージョンを確認します。 内部ソフト 
ウェアとドライバーのバージョンが一致しない場合は、 内部ソフトウェアをアップデートをするよう指示が表示され 
ます。 「OK」をクリックしてアップデートを開始し、 Macを再起動してアップデートを完了させます。

Windowsにインストール
ステップ 1. 最新のドライバーを使用していることを www.blackmagicdesign.com/jp/support で確認します。

ステップ 2. 「Desktop Video」フォルダを開き、 「Desktop Video」インストーラーを起動します。 

ステップ 3. システムにドライバーがインストールされます。 「次のプログラムにこのコンピュータへのソフトウェアのイン
ストールを許可しますか？」 という警告が表示されるので、 「はい」をクリックします。

ステップ 4. 「新いデバイスの発見」というダイアログとハードウェア・ウィザードが表示されます。 「ドライバを自動で検
索してインストール」を選択すると、 必要なDesktop Videoドライバをシステムが検出します。 その後、 「デ
バイスの使用準備が整いました」というダイアログが表示されます。

ステップ 5 コンピューターを再起動して、 新しいソフトウェアドライバを有効にします。

自動アップデート
コンピューターを再起動するたびに、 ソフトウェアがハードウェアの内部ソフトウェアのバージョンを確認します。 内部
ソフトウェアとドライバーのバージョンが一致しない場合は、 内部ソフトウェアをアップデートをするよう指示が表示さ
れます。 「OK」をクリックしてアップデートを開始し、 コンピューターを再起動してアップデートを完了させます。 

MacのDesktop Video Installer

WindowsのDesktop Video Installer
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Linuxにインストール
ステップ 1. www.blackmagicdesign.com/support で最新のLinux用のDesktop Videoソフトウェアをダウンロー

ドします。 

ステップ 2. 「Desktop Video」フォルダを開き、 お使いのLinuxディストリビューション用の「Desktop Video」パッ
ケージを開きます。

ステップ 3. 「Install」ボタンをクリックし、 プログレスバーが完了するのを待ちます。

ステップ 4. 依存関係に関するエラーメッセージ（Missing Dependencies）が表示される場合は、 それらが先にインス
トールされていることを確認してからDesktop Videoインストーラーを再起動します。

ステップ 5. 終了すると、 インストーラーが通常の画面に戻ります。

ステップ 6. コンピューターを再起動してドライバーを有効にするか、 次のコマンドを入力します。

 # modprobe blackmagic

お使いのLinuxディストリビューション用のDesktop Videoのネイティブ・パッケージが見つからない場合、 またはコマン
ドラインを使用してインストールしたい場合は、 ReadMeファイルを参照してインストール方法に関する詳細を確認してく
ださい。

アップデート
コンピューターが再起動すると、 ドライバーはBlacmagicビデオハードウェアをチェックし、 ハードウェアの内部ソフト
ウェアを確認します。 内部ソフトウェアのバージョンがドライバーのバージョンと一致しない場合、 Desktop Videoに
よってアップデートの指示が表示されます。 アップデートが必要なカードのカードIDを確認するには、 ターミナルを開
き、 次のコマンドを入力します。 

# BlackmagicFirmwareUpdater status

以下のようなメッセージが表示されます。 

/dev/blackmagic/card0 [DeckLink HD Extreme 3] UPDATED

/dev/blackmagic/card1 [DeckLink HD Extreme 3] NEEDS_UPDATE

アップデートする必要のあるカードのIDに注意して、 次を入力してファームウェアをアップデートします。 

# BlackmagicFirmwareUpdater update1（この例では1）

Ubuntu Software Centerからのインストール準備が整った
Desktop Video
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ビデオのキャプチャー・再生 
ビデオをきちんとキャプチャー・再生できるかどうかを確認するため、 簡単なテストを行うことをお勧めします。

セットアップ
ステップ 1. ビデオモニターまたはテレビをBlackmagicビデオハードウェアのビデオ出力に接続します。

ステップ 2. ビデオソースをBlackmagicビデオハードウェアのビデオ入力に接続します。

ステップ 3. Blackmagicシステム環境設定で、 ビデオ/オーディオの入出力の接続設定を行います。 設定の詳細につい
ては、 「Blackmagicシステム環境設定の使用」を参照してください。

ビデオのキャプチャーをテストする
ステップ 1. Mac OSではExpress > Preferencesの順に、 WindowsおよびLinuxではEdit > Preferencesの順に進

み、 お使いのビデオソースと一致するプロジェクトフォーマットを選択します。 さらに、 キャプチャーするファ
イルフォーマットと保存先を選択します。

ステップ 2. 「Preferences」を閉じ、 「Log and Caputure」タブをクリックします。 Media Expressのプレビューウィ
ンドウにビデオソースが表示されます。

ステップ 3. 「Capture」をクリックしてキャプチャーのテストを行います。 もう一度「Capture」をクリックして、 テストを
終了します。

ビデオの再生をテストする
ステップ 1. 「Playback」タブをクリックします。

ステップ 2. テスト用にキャプチャーしたクリップをダブルクリックすると、 Blackmagicビデオハードウェアの出力に接
続したモニターにビデオが表示されます。 オーディオ出力も同時にモニタリングできます。

Camera Outputs

HDTV

「Capture」ボタンをクリックしてキャプチャーを開始

モニターおよびビデオソースをBlackmagicビデオハードウェア
に接続
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Blackmagicのシステム環境設定を開く
Blackmagicのシステム環境設定では、 主なコンフィギュレーションの設定が可能です。

 � Mac OS Xでは、 システム環境設定を開き、 Blackmagic Designアイコンをクリックします。

 � Windows 7およびWindows 8では、 コントロールパネルを開き、 「ハードウェアとサウンド」カテゴリーをクリッ
クして「Blackmagic Design Control Panel」をクリックします。

 � Linuxでは、 「アプリケーション」から「サウンドとビデオ」に行き、 「Blackmagic Control Panel」をクリックし
ます。

Blackmagicハードウェアは各モデルにより機能が異なります。 お使いのハードウェアモデルによってサポートされてい
るシステム環境設定のみ使用が可能です。 

次のセクションは、 Blackmagicシステム環境設定の使い方に関する説明です。

Mac OS XのBlackmagic Designシステム環境設定 WindowsのBlackmagic Design Control Panel Ubuntu LinuxのBlackmagic Design Control Panel

Blackmagicシステム環境設定の使用
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設定タブ（Settings）

出力設定（Set output）
Blackmagicビデオハードウェアのビデオ/オーディオ出力を設定します。 いくつかのモデルでは、 コンポーネントアナログ
ビデオ（Component）、 Sビデオ（S-Video）、 コンポジットアナログビデオ（Composit (Y Out)）から選択できます。  
また、 オーディオ出力をアナログまたはAES/EBUから選択できるモデルもあります。 

入力設定（Set input）
Blackmagicビデオハードウェアのビデオ/オーディオ入力を設定します。 お使いのハードウェアは、 以下の組み合わせの
すべて（または一部）をサポートしています。 

 � SDI Video & SDI Audio

 � SDI Video & AES/EBU Audio

 � SDI Video & Analog XLR Audio

 � Optical SDI Video & Optical SDI Audio

 � HDMI Video & HDMI Audio

 � HDMI Video & AES/EBU Audio

 � HDMI Video & Analog XLR Audio

 � Component Video & AES/EBU Audio

 � Component Video & Analog XLR Audio

 � Composite & AES/EBU Audio

 � Composite & Analog XLR Audio

 � S-Video & AES/EBU Audio

 � S-Video & Analog XLR Audio

NTSCのセットアップレベルを選択する（Use video setup in NTSC） 
アメリカやその他の国 で々使用されるコンポジットビデオには7.5 IREを選択します。 日本など7.5 IREセットアップが使用
されていない国の場合は、 0 IREを選択します。 PALおよびHDフォーマットでは、 この設定は使用しません。

ビデオおよびオーディオ出力の接続

ビデオおよびオーディオ入力の接続

NTSCコンポジットビデオのセットアップを7.5 IREまたは0 IRE
から選択
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可能な場合はビデオ出力に4:4:4 SDIを使用（Use 4:4:4 SDI on video output 
when possible） 
4:4:4ビデオを出力する場合はこの設定を選択します。 1080p50/60ビデオは常に4:2:2で
出力されます。 4:4:4ビデオ出力を有効にすると、 以下の機能が無効になります。

 � HDおよびダウンコンバートSDビデオの同時出力

 � ダウンコンバート・アナログビデオ出力

デュアルリンクSDI出力ではなく3/6Gb SDI出力を使用（Use 3/6Gb SDI not Dual 
Link SDI output）
この設定を選択すると、 1080p60や4:4:4などの高帯域フォーマットや4Kフォーマットを使用する際に、 シングルリン
ク3G/6G SDIが使用できます。

1080PsFではなく1080pを使用（Use 1080p not 1080PsF）
この設定を選択すると、 プログレッシブ・セグメント・フレーム・ビデオではなく、 プログレッシブ・フレーム・ビデオが出
力できます。 

ビデオを一時停止中にフィールドジッタを削除（Remove field jitter when video is 
paused）
この設定を選択すると、 従来のCRTディスプレイでインターレースビデオを停止した際にひとつのフィールドのみを表
示し、 フィールドフリッカーを避けることができます。 このオプションは、 近年のフラットスクリーン向けのものではあり
ません。 

LTCタイムコード入力を使用（Use LTC Timecode input）
この設定を選択すると、 SDIストリームではなくLTC入力からタイムコードを読み込みます。

4:4:4ビデオを出力するボックスをチェック

シングルリンク3G/6G SDIを使用するボックスをチェック

1080プログレッシブ・フレーム・ビデオを出力するボックスを 
チェック

CRTモニターのフィールドフリッカーを除去するボックスを 
チェック

LTC入力からタイムコードを読み込むボックスをチェック
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ビデオ規格設定（Set default video standard as）
Final Cut Pro Xのブロードキャストモニタリング機能を使用する場合は、 Final Cut Pro Xのプロジェクトと一致す
るビデオ規格を選択します。 

Windowsで、 Windows Driver Model（WDM）対応アプリケーションを使用してビデオをキャプチャーする場合
は、 アプリケーションのキャプチャーフォーマットと同じビデオ規格をデフォルトに設定します。 通常、 ビデオ規格は
WDM対応アプリケーションのシステム環境設定で設定できますが、 うまく設定できない場合はBlackmagic Design 
Control Panelを使用してください。 

ビデオを再生していない場合 ～を全てのビデオ出力へ送信（When not playing video, 
send）
この設定では、 アプリケーションを閉じ、 ビデオが再生されていない際に、 お使いのハードウェアが「Last Frame 
Played（最後に再生されたフレーム）」と「Black（ブラック画面）」のどちらを送信するかを選択します。 

Blackmagicのいくつかのモデルはルックアップテーブル（LUT）を搭載しているため、 「Last Frame Played」を選択
すれば、 LUTに変更を加えた際、 効果が確認できます。 この選択を有効/無効にするには、 コンピューターを再起動す
る必要があります。 

HDMI 3D表示の設定（Display HDMI 3D as）
この設定では、 HDMIモニタリングの3Dフォーマットを決定します。 フォーマットは、 Frame Packing、 Side by 
Side、 Line by Line、 Top and Bottom、 Left Eye、 Right Eyeから選択できます。 

リファレンス出力タイミングの設定（Set reference output timing）
リファレンスを接続していても映像が乱れる場合は、 映像が安定するようスライダーを調整してください。 リファレンス
信号は、 ゲンロック、 ブラックバースト、 ハウスシンク、 3値シンクと呼ばれることもあります。 

HDMIモニタリングの3Dフォーマットを選択

Final Cut Pro XプロジェクトのフォーマットまたはWDM対応ア
プリケーションのキャプチャーフォーマットに合わせてデフォルト
のビデオ規格を設定

ビデオを再生していない時に送信する画像を「Last Frame 
Played」または「Black」から選択

映像が安定するようリファレンスタイミングスライダーを調整
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処理タブ（Processing）

出力処理の設定（Select output processing）
この設定で、 再生中のリアルタイム・ダウンコンバージョンが可能になります。 メニューの中から、 使用したいオプショ
ンを選択します。 

いくつかのハードウェアモデルでは、 HDとSD、 2KとSDなどの同時ダウンコンバージョン出力（Simultaneous HD 
and SD、 Simultaneous 2K and SDなど）がサポートされています。 同時ダウンコンバージョンでは、 SD-SDI出力
で2フレームのディレイが発生します。 インサート編集やアッセンブル編集を行う場合は、 お使いの編集ソフトウェアの
タイムコードオフセットを使用してフレーム精度を調整してください。 

アナログビデオ出力もダウンコンバートされます。 コンポーネントアナログビデオは、 HDまたはSDで出力の切り替え
が可能です。 コンポーネントアナログSDビデオを出力するには、 「Simultaneous HD and SD Output」が選択され
た状態で「Enable Conversion on Analog Output」を選択してください。 

入力処理の設定（Select input processing）
この設定で、 キャプチャー中のリアルタイム・ダウンコンバージョンおよびアップコンバージョンが可能になります。  
メニューの中から、 使用したいオプションを選択します。 

HD 23.98PsFをHD 59.94iで出力（Output HD 23.98PsF as HD 59.94i）
：WIndowsのみ
この設定では、 3:2プルダウンシーケンスを使用し、 HD 23.98 PsFをHD 59.94iで出力します。 ほとんどのHDモニ
ターがHD 59.94iに対応していますが、 フィルムのフレームレートである23.98fpsは、 一般的なフレームレートであ
るにも関わらず、 多くのSDI/アナログモニターでサポートされていません。 

AフレームのVITCリファレンス設定（Set A-frame VITC reference）
この設定では、 NTSCビデオから3:2プルダウンを除去しながらキャプチャーする場合の、 Aフレームの番号を入力し
ます。 Aフレームの番号が誤っていると、 フィールドやフレームが正確に表示されません。 

VANC入力ラインのキャプチャー設定（Capture VANC input line）
この設定で、 3ライン・タイムコード、 VITC字幕情報、 他のあらゆるVANCデータをキャプチャー時に保持します。 
VANCデータを保存するには、 キャプチャーしたいビデオラインのボックスにチェックを入れます。 ライン2および3を
使用するには、 ライン1が有効になっている必要があります。 

メニューから出力処理を選択

ボックスにチェックを入れ、 HD 23.98PsFをHD 59.94iで出力

3:2プルダウンを実行する際のAフレームのVITCリファレンスを
設定

VANCデータをキャプチャーするラインのボックスにチェック
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ビデオレベルタブ（Video Levels）

アナログビデオ入力のキャリブレーション（Calibrate Analog Video In）
これらの設定で、 アナログビデオ入力のキャリブレーションを行います。 スライダーを使用して、 ビデオ（Video）、 クロ
マ（Chroma）、 CbおよびCrの値を調整してください。 これらの設定には、 Blackmagic Ultrascopeの使用が最適で
す。 アナログビデオ入力のキャリブレーションは、 設定（Settings）タブの「入力設定（Set input）」がアナログビデオ
入力に設定されている場合のみ利用可能です。 

アナログビデオ出力のキャリブレーション（Calibrate Analog Video Out）
これらの設定で、 アナログビデオ出力のキャリブレーションを行います。 スライダーを使用して、 ビデオ（Video）、 クロマ

（Chroma）、 CbおよびCrの値を調整してください。 これらの設定には、 Blackmagic Ultrascopeの使用が最適です。

BetacamのYUVレベルを使用（Use Betacam YUV Levels）  
現在、 多くのビデオ機器がSMPTEレベルを使用しているため、 Blackmagic製品はデフォルトでSMPTEコンポー
ネントアナログレベルを使用する設定になっています。 Sony Betacam SPデッキを使用している場合は、 「Use 
Betacam YUV Levels」のチェックボックスを有効にしてください。 

オーディオレベルタブ（Audio Levels）
アナログオーディオ入力の設定（Set Analog Audio Input Levels）
これらの設定で、 アナログオーディオ入力のゲインを調整します。 

アナログオーディオ出力レベルの設定（Set Analog Audio Output Levels）  
これらの設定で、 アナログオーディオ出力のゲインを調整します。 

AES/EBU入力のリファレンスレベルの設定（Set AES/EBU Input Ref Level） 
これらの設定で、 AES/EBUオーディオ入力のゲインを調整します。 アナログオーディオチャンネルは個別に調整でき
るのに対し、 AES/EBUオーディオチャンネルはまとめての調整になります。

AES/EBU出力のリファレンスレベルの設定（Set AES/EBU Output Ref Level） 
これらの設定で、 AES/EBUオーディオ出力のゲインを調整します。 アナログオーディオチャンネルは個別に調整でき
るのに対し、 AES/EBUオーディオチャンネルはまとめての調整となります。  

HiFiオーディオレベルの使用（Use HiFi Audio Levels）
UltraStudioおよびDeckLinkモデルでは、 XLRコネクターのプロ仕様アナログオーディオレベルが基準になっていま
す。 民生用オーディオ機器を接続する場合は、 「Use HiFi Audio Levels」を有効にし、 XLR-RCAアダプターを使用
してください。 

スライダーを使用して、 アナログビデオのビデオ（Video）およびク
ロマ（Chroma）の値を調整

スライダーを使用して、 アナログおよびAES/EBUオーディオのゲ
インを調整
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After Effects® CC

ビデオの再生方法
Blackmagicハードウェアを使用してAfter Effects® CCの合成をリアルタイムで表示するには、 環境設定 > ビデオ
プレビューを選択します。 「Blackmagic Video Output」を選択して、 適切な出力モード（Output Mode）を選択し
ます。 After Effects® CCの合成が、 正しいビデオカラースペースで放送用モニターに表示されます。 

Blackmagicハードウェアを使用してオーディオを聞くには、 Mac OS Xでは「システム環境設定」、 Windowsで 
は「コントロールパネル」を開き、 サウンドを出力する装置を「Blackmagic Audio」に設定します。 After Effect® CC
では、 環境設定 > オーディオハードウェアを選択し、 オーディオ出力の設定がMac OS Xでは「システムデフォルト入
力/出力（System Default Input/Output）」、 Windowsでは「Blackmagic Audio」になっていることを確認します。 

レンダリング
合成作業が終わったら、 お使いのBlackmagicビデオハードウェアがサポートしているコーデックにレンダリングする
必要があります。 DPXイメージシーケンスまたは以下のコーデックでレンダリングできます。 

ProResやDVCPRO HDなど他のコーデックは、 Final Cut Proがインストールされている場合に利用可能です。 

DVCPRO HDやDVCPRO50など他のコーデックは、 Adobe® Premiere Pro® CCがインストールされている場合
に利用可能です。 

After Effects® CC

レンダリングの「出力モジュール設定」オプション

環境設定の「ビデオプレビュー」画面  � Blackmagic 10-bit 4:4:4（非圧縮）
 � Blackmagic 10-bit 4:2:2（非圧縮）
 � Blackmagic HD 8 bit 4:2:2（非圧縮）

 � Blackmagic SD 8 bit 4:2:2（非圧縮）
 � Blackmagic 8-bit MJPEG（圧縮）

WindowsのAVIコーデック

 � Blackmagic RGB 10-bit（非圧縮）
 � Blackmagic 10-bit（非圧縮）
 � Blackmagic 8-bit（非圧縮）

 � Apple Photo - JPEG（圧縮）
 � Apple DV - NTSC（圧縮）
 � Apple DV - PAL（圧縮）

WindowsのQuickTimeコーデック

 � Blackmagic RGB 10-bit（非圧縮）
 � Apple非圧縮YUV 10-bit 4:2:2
 � Apple非圧縮YUV 8-bit 4:2:2

 � Apple Photo - JPEG（非圧縮）
 � Apple DV - NTSC（圧縮）
 � Apple DV - PAL（圧縮）

Mac OS XのQuickTimeコーデック
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Photoshop® CC

ビデオフレームの読み込み/書き出し

Photoshop® CCにイメージを読み込む
ステップ 1. Photoshop® CCで、 ファイル > 読み込み > Blackmagicイメージのキャプチャー（Blackmagic Image 

Capture）を選択します。 

ステップ 2. 「ビデオ入力フォーマット（Video Input Format）」と「イメージビット深度（Image Bit Depth）」を選択し、 
「イメージを読み込む（Import Image）」をクリックします。

Photoshop® CCでイメージを書き出す
ステップ 1. ファイル > 書き出し > Blackmagicイメージの書き出し（Blackmagic Image Export）を選択します。

ステップ 2. ビデオ出力フォーマットを選択し、 「イメージを書き出す（Export Image）」をクリックします。

一度「読み込み」または「書き出し」の設定が完了すると、 それ以降の「読み込み」および「書き出し」では設定ウィンドウ
は表示されません。 設定を変更したい場合は、 Macでは「Option」、 Windowsでは「Ctrl」を押しながら読み込み/書
き出しを選択します。

イメージの読み込み（Import Image）

イメージの書き出し（Export Image）

Photoshop® CC
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Adobe® Premiere Pro® CC

Blackmagic Designプロジェクトのセットアップ
ステップ 1. 新規プロジェクトを作成し、 「スクラッチディスク」タブをクリックします。 プロジェクトの場所と名前を設定

します。

ステップ 2. 「キャプチャしたビデオ」、 「キャプチャしたオーディオ」、 「ビデオプレビュー」、 「オーディオプレビュー」の
場所を設定します。 

ステップ 3. Adobe® Premiere Pro® CCのMercury Playback Engineがサポートしているグラフィックカードを使
用している場合、 「レンダラー」の選択が可能です。 「Mercury Playback Engine - GPU高速処理」を選
択します。

ステップ 4. 「キャプチャ形式」に「Blackmagic Capture」を選択し、 Macでは「Settings」、 Windowsでは
「Properties」をクリックして、 Blackmagicキャプチャー設定（Blackmagic Capture Settings）を開
きます。 ビデオ規格（Video Standard）とビデオ形式（Video Format）を選択して、 「OK」をクリックしま
す。 

ステップ 5. 新規シーケンスのウィンドウが表示されたら、 使用するBlackmagicプリセットを選択し、 シーケンスに名前
をつけて「OK」をクリックします。 

デバイスコントロール
Blackmagic Designのキャプチャー・再生機器の多くがRS-422デバイスコントロールに対応しており、 デッキの
コントロールが可能です。 新規プロジェクトを作成するたびに、 Blackmagicデバイスコントロールを選択する必要
があります。 環境設定 > デバイスコントロールへ進み、 「Blackmagicデバイスコントロール（Blackmagic Device 
Control）」を選択します。 

再生
再生の設定は、 新規プロジェクトを作成するたびに行う必要があります。 環境設定 > 再生を選択します。 「初期設定
のプレイヤー」は「Adobeプレイヤー」に設定されています。 「オーディオデバイス」を「Blackmagic Playback」に切り
替えます。 

「ビデオデバイス」の欄では、 「Blackmagic Playback」のボックスにチェックを入れ、 他のボックスにチェックが入っ
ていないことを確認してから「OK」をクリックします。 

新規シーケンス

Adobe® Premiere Pro® CC
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キャプチャー
キャプチャーを行うには、 ファイル > キャプチャを選択します。 

すぐにキャプチャーする、 またはコントロールできないデバイスからキャプチャーする場合は、 キャプチャボタン（赤い
ボタン）をクリックします。 

RS-422デッキコントロールを使用してクリップをログしたい場合は、 「インを設定」または「アウトを設定」ボタンを使
用して、 イン/アウト点を入力します。 または、 タイムコードを直接入力して、 「ログクリップ」をクリックします。 プロジェ
クトウィンドウに空のクリップが表示されます。 この作業を続け、 バッチキャプチャーしたいすべてのクリップをログしま
す。 終わったら、 ファイル > バッチキャプチャを選択します。 クリップの予備フレーム（ハンドル）を設定するには、 「予
備フレームを含めてキャプチャ」を有効にし、 各クリップの開始/終了点に追加するフレームの数を入力します。 

テープへ書き出し
RS-422デッキコントロールを使用して書き出しを行うには、 必要なシーケンスを選択して、 ファイル > 書き出し >  
テープの順に選択します。 

インサート編集を行うには、 テープに記録するプロジェクト全体をカバーする連続したタイムコードが必要です。 

アセンブル編集モードでは、 プロジェクトの開始点までをブラックにする必要があります。 アセンブル編集では、 記録
ヘッドに先行してテープが消去されるため、 テープ上にあるプロジェクトの終了点より後に他のプロジェクトが記録して
ある場合は、 この編集を行うべきではありません。 

テープへの編集を行う際、 Adobe® Premiere Pro® CCは、 事前に設定したタイムコードからデッキが録画を開始す
るまでプロジェクトの最初のフレームで待ちます。 テープへの編集過程において、 プログラムの最初のフレームがリピー
トまたは消失してしまう場合は、 再生オフセットを調整してデッキとコンピューターを同期させる必要があります。 この
作業は一度行えば、 あらゆるデッキとコンピューターの組み合わせにおいて正しい設定が保持されます。 

同期が完了したら、 イン点および必要に応じてオフセットを入力し、 Macでは「OK」、 Windowsでは「書き出し」を 
クリックします。 

キャプチャー

テープへ書き出し
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Apple Final Cut Pro X

Apple Final Cut Pro X
10.0.4以降のFinal Cut Pro X に搭載されるブロードキャストモニタリング機能を使用して、 Blackmagicビデオハード
ウェアでビデオを出力することができます。 また、 Final Cut Pro Xのインターフェースに2台のコンピューターモニターを
使用することも可能です。 

Final Cut Pro Xのセットアップ
ステップ 1. Mac OS X Mountain LionまたはMarvericksの最新バージョンで、 10.0.4以降のFinal Cut Pro Xを起

動します。 

ステップ 2. システム環境設定を開き、 Blackmagic Designをクリックします。 設定（Settings）タブに行き、 「ビデオ規
格設定（Set default video standard as）」を、 Final Cut Pro Xプロジェクトで使用するのと同じ規格に
設定します（例：HD 1080i59.94）。 規格は、 クリップのビデオフォーマットと同一のものにします。

ステップ 3. Final Cut Pro Xを起動し、 新規プロジェクトを作成します。 

ステップ 4. 新規プロジェクトに名前をつけて、 保存場所を指定します。

ステップ 5. 「ビデオのプロパティ」で「カスタム」を選択します。 さらにフォーマット、 解像度、 レートを、 Blackmagic 
Design Desktop Videoの環境設定で設定したデフォルトのビデオ規格と合わせて設定します。

ステップ 6. 「オーディオとレンダリングのプロパティ」を「カスタム」に設定します。 「オーディオチャンネル」を「ステレオ」
に、 または6チャンネル・オーディオを使用する場合は「サラウンド」に設定します。 「オーディオサンプルレー
ト」を、 テレビのレートである48kHzに設定します。 「レンダリングフォーマット」は、 使用するビデオクリップ
と同じフォーマットに設定します。 Final Cut Pro XのデフォルトはProRes圧縮になっていますが、 非圧縮
ワークフロー用に非圧縮10-bit 4:2:2に切り替えることも可能です。 「OK」をクリックして、 新規プロジェク
トの作成を終了します。

ステップ 7. Final Cut Proメニューを開き、 「環境設定」を選択して「再生」タブをクリックします。 「A/V出力」メニューに
「Blackmagic」が選択されていることを確認し、 自分のプロジェクトと同じビデオ規格が選択されているこ
とを確認して環境設定を閉じます。

ステップ 8. 「ウィンドウ」メニューで「A/V出力」を選択し、 Blackmagicビデオハードウェアからのビデオ出力を有効に
します。

お使いのBlackmagicビデオハードウェアを介してオーディオをモニタリングしたい場合は、 「システム環境設定」を開
いて「サウンド」アイコンをクリックし、 「出力」タブでサウンドの出力に「Blackmagic Audio」を選択します。.

ステップ 6. 「オーディオとレンダリングのプロパティ」を「カスタ
ム」に設定

ステップ 2. システム環境設定で、 Final Cut Pro Xで使用するプ
ロジェクトと同じビデオ規格をデフォルトに設定
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再生
ステップ 1. 新規プロジェクトにクリップを読み込みます。

ステップ 2. お使いのコンピューターモニターでFinal Cut Pro Xのタイムラインを使用し、 Blackmagic Designビデオ
ハードウェアの出力に接続したモニターやテレビにビデオのプレビューを表示できます。

ビデオ/オーディオのキャプチャー
Blackmagic Media Expressを使用して、 Blackmagic Designビデオハードウェアからビデオやオーディオをキャ
プチャーできます。 キャプチャーしたクリップは、 Final Cut Pro Xに読み込んで編集できます。 

Media Expressを使用してクリップをキャプチャーする際、 Final Cut Pro Xでもサポートされているビデオ形式（例： 
Apple ProRes 4444、 Apple ProRes 422 (HQ)、 Apple ProRes 422、 非圧縮10-bit 4:2:2）を必ず選択して
ください。 

テープに編集
Final Cut Pro Xでプロジェクトが完成したら、 そのプロジェクトをムービーファイルにレンダリングし、 Blackmagic 
Media ExpressとBlackmagic Designビデオハードウェアを使用してテープにマスタリングできます。 

ステップ 1. Final Cut Pro Xのタイムラインからクリップを選択します。

ステップ 2. 「共有」メニューへ行き、 「ムービーを書き出す」を選択します。

ステップ 3. ムービーの書き出しウィンドウで、 「書き出し」を「現在の設定」に、 「対象」を「ビデオをオーディオ」に設定
します。 「次へ」をクリックします。

ステップ 4. Media Expressを開き、 Final Cut Pro Xで書き出したクリップを読み込みます。

ステップ 5. 同マニュアルのBlackmagic Media Expressセクション内「ビデオ/オーディオファイルをテープに編集」の
項目を参照してください。

ステップ 3. ムービーの書き出しウィンドウで、 「書き出し」を「現
在の設定」に、 「対象」を「ビデオをオーディオ」に設定



お気に入りのサードパーティ製ソフトウェアの使用73

Avid Media Composer

Avid Media Composer
Avid Media Composerでは、 Blackmagicビデオハードウェアを使用してSD/HDのビデオおよびオーディオをキャ
プチャー・再生できます。 また、 RS-422デッキコントロールもサポートされています。 コンピューターにすでにMedia 
Composerがインストールされていれば、 Desktop VideoをインストールするとMedia Composer用のBlackmagicプ
ラグインが自動でインストールされます。 

セットアップ
ステップ 1. Media Composerを起動すると、 「プロジェクト選択」ダイアログボックスが表示されます。

ステップ 2. 以前にユーザープロファイルを作成している場合は、 使用するプロファイルを選択します。

ステップ 3. プロジェクトを保存するフォルダを「プライベート」、「共有」、「エクスターナル」から選択します。

ステップ 4. 「新規プロジェクト」ボタンをクリックします。

ステップ 5. プロジェクトの名前を入力し、 フォーマット、 カラースペース、 ステレオスコピックなどプロジェクトのオプ 
ションを設定します。 「OK」をクリックします。 カラースペースとステレオスコピックの設定は、 後にプロジェ
クトの「フォーマット」タブでも変更できます。 

ステップ 6. 「プロジェクト選択」ダイアログボックスで作成したプロジェクト名をダブルクリックします。 Media 
Composerのインターフェースと新規プロジェクトのプロジェクトウィンドウが表示されます。 プロジェクト
のセットアップの完了です。

再生
すべてが適切に接続されていることを簡単に確認するには、 「Media Composer Editing Guide」の「Importing Color 
Bars and Other Test Patterns」セクションを参照してください。 読み込んだファイルをダブルクリックして、 ポップアッ
プ・モニターで再生します。 コンピューターのモニターおよびBlackmagicビデオハードウェアの出力の両方にイメージが
表示されます。 

Blackmagicビデオハードウェアの出力にビデオが表示されない場合は、 接続を再度チェックし、 Media Composer
でツール > ハードウェアセットアップを選択し、 Blackmagic Designシステム環境の出力が正しく設定されているこ
とを確認してください。

1台のコンピューターモニターのみを使用する場合は、 
Blackmagic Designの環境設定画面を開き、 ビデオを再生して
いない場合に「Black」を送信するよう設定

ステップ 5. プロジェクト名を入力してオプションを設定
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コントロールできないデバイスからキャプチャー
従来型のカメラやVHSテーププレーヤーだけでなく、最新型のカメラやディスクレコーダーなど、多くのビデオソースが
デバイスコントロールに対応していません。 デバイスコントロールなしでビデオをキャプチャーするには、 以下のステッ
プに従います。

ステップ 1. ツール > キャプチャを選択し、 「キャプチャツール（Capture Tool）」を開きます。

ステップ 2. トグルソースボタンをクリックすると、 デッキアイコンのボタンに赤い丸と斜線が表示されます。 この赤い丸
と斜線は、 デッキコントロールが無効であることを意味します。

ステップ 3. 「ビデオ（Video）」および「音声（Audio）」のボックスに、 それぞれ「Blackmagic」を選択します。

ステップ 4. 使用したいビデオのソーストラック（V）とオーディオのソーストラック（A1、 A2、... ）を選択します。

ステップ 5. 「ビン（Bin）」メニューで、 保存先に指定するビンをリストから選択します。

ステップ 6. 「Res（解像度）」メニューで、 キャプチャーしたクリップに使用したい圧縮/非圧縮コーデックを選択します。 
非圧縮8-bitビデオには「1：1」、 10-bitビデオには「1：1 10b」を選択します。

ステップ 7. キャプチャーしたビデオやオーディオを保存するディスク記憶装置を選択します。 シングル/デュアル・ドライ
ブモード・ボタンを使用して、 ビデオとオーディオをひとつのドライブにまとめて保存するか、 別 の々ドライ
ブに保存するかを選択します。 対象ドライブメニューで、 キャプチャーしたメディアを保存するドライブを選
択します。

ステップ 8. ウィンドウ最下部の「テープ名？（Tape Name?）」ボタンをクリックし、 「テープ選択（Select Tape）」ダイア
ログボックスを開きます。 

ステップ 9. ビデオおよびオーディオソースの準備が整っている、 または再生中であることを確認して、 「キャプチャ」ボタ
ンをクリックします。 キャプチャ中はキャプチャボタンが赤く点滅します。 キャプチャボタンを再度クリックし
て、 キャプチャを終了します。

ステップ 2. キャプチャツールのトグルソースボタンをクリックし
て、 デッキコントロールを使用せずにビデオをキャプチャーでき
るよう設定
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UltraStudio/DeckLink/Teranexを使用して、コントロールできるデバイスからキャプチャー
RS-422で接続したデバイスを使用する場合は、 デッキコントロールを使用してキャプチャーする前に、 デッキの設定
を行う必要があります。 

ステップ 1. プロジェクトウィンドウで「設定」タブをクリックし、 「デッキコンフィギュレーション」をダブルクリックします。

ステップ 2. 「デッキコンフィギュレーション」ダイアログボックスで、 「チャンネル追加」をクリックし、 チャンネルタイプ
を「Direct」に、 ポートを「RS-422 Deck Control」に設定します。 「OK」をクリックして、 「今すぐチャンネ
ルを自動設定しますか？（Do you want to autoconfigure the channel now?）」と表示されたら、 「いい
え」を選択します。

ステップ 3. 「デッキ追加」をクリックして、 使用するデッキのブランドとモデルをデバイスメニューから選択し、 さらにプ
リロールを設定します。 「OK」、 「適用」の順にクリックします。

ステップ 4. 設定タブで、 「デッキ初期設定」を選択します。

ステップ 5. アセンブル編集を行う場合は、 「デジタルカットでアセンブル編集とクラッシュレコードを許可（Allow 
assemble edit & crash record for digital cut）」オプションを有効にします。 この機能が無効の状態で
は、 インサート編集しか使用できません。

ステップ 6. 「コインシデンスポイント検出を緩める（Relax coincidence point detection）」オプションを有効にし、 
必要であれば他の設定も行います。 「OK」をクリックします。 お使いのデッキへのRS-422接続のセットアッ
プが完了しました。

リモート接続をテストするために、 BlackmagicビデオハードウェアとデッキがRS-422シリアルケーブルで接続されて
いることを確認してください。 デッキをリモートに設定してください。 キャプチャツールを開き、 標準のJ、 K、 Lショート
カットキーを使用してデッキをコントロールします。 デッキの名前がイタリック体（斜字体）で表示される、 または「デッ
キなし（NO DECK）」と表示される場合は、 メニューをクリックし、 デッキがイタリック体でなく表示され、 デッキコント
ロールが再度確立されるまで「デッキ検索（Check Decks）」を選択します。 

デッキコントロールを使用してオンザフライでキャプチャする：

ステップ 1. ツール > キャプチャの順に選択し、 「キャプチャツール」を開きます。

ステップ 2. キャプチャ/ログモードボタンに「CAP」アイコンが表示されていることを確認します。 このボタンに「LOG」ア
イコンが表示されている場合は、 ボタンをクリックしてキャプチャモードに切り替え、 「CAP」アイコンを表示
します。

ステップ 3. トグルソースボタンにデッキアイコンが表示されていることを確認します。 斜線入りの赤い丸印が表示され
る場合は、 ボタンをクリックしてデッキコントロールを有効にし、 赤い丸印が表示されないようにします。

ステップ 4. 「コントロールできないデバイスからキャプチャー」のセクションで説明されているのと同様の方法で、 ビデ
オ/オーディオ入力、 ビデオ/オーディオのソーストラック、 保存先ビン、 Res（解像度）、 保存先ドライブ、  
テープ名を設定します。

ステップ 5. キャプチャツールのデッキコントロールウィンドウを使用して、 テープの頭出しを行い、 再生します。 

ステップ 6. キャプチャボタンをクリックします。 キャプチャ中はキャプチャボタンが赤く点滅します。 キャプチャを終了す
るには、 キャプチャボタンを再度クリックします。 

ステップ 6. デッキ初期設定（Deck Preferences）で、 「コイ
ンシデンスポイント検出を緩める（Relax coincidence point 
detection）」オプションにチェック

CAPボタン/トグルソースボタンを設定してデッキコントロールを
使用、 デッキコントロールウィンドウでテープの頭出しと再生
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UltraStudio/Decklinkを使用したバッチキャプチャ
以下の手順で、 バッチキャプチャ用にクリップをログします。

ステップ 1. ツール > キャプチャの順に選択し、 「キャプチャツール」を開きます。

ステップ 2. キャプチャ/ログモードボタンをクリックして、 「LOG」アイコンを表示します。

ステップ 3. 「コントロールできないデバイスからキャプチャー」のセクションで説明されているのと同様の方法で、 ビデ
オ/オーディオ入力、 ビデオ/オーディオのソーストラック、 保存先ビン、 Res（解像度）、 保存先ドライブ、  
テープ名を設定します。

ステップ 4. デッキコントロールウィンドウ、 あるいは標準のJ、 K、 Lショートカットキーを使用してデッキを前後にシャト
ルまたは一時停止し、 キャプチャーしたい位置にビデオを合わせます。

ステップ 5. LOGボタンの左側にある、 イン/アウト点ボタン（Mark IN/OUT）をクリックします。 アイコンはインとアウト
で交互に切り替わるので、 1つのボタンをクリックするだけでイン点およびアウト点が設定できます。 デッキ
コントロールウィンドウのイン点およびアウト点ボタンを使用すれば、 より簡単にイン/アウト点が設定でき
ます。 また、 キーボードの「I」と「O」キーでも、 イン/アウト点を設定することが可能です。

ステップ 6. イン/アウト点を設定したら、 ビンを開いて、 キャプチャーしたいクリップを選択します。

ステップ 7. クリップ > バッチキャプチャを選択し、 ダイアログボックスが表示されたらオプションを選択、 「OK」を 
クリックします。

UltraStudio/Decklinkを使用してテープに記録
クリップをキャプチャーした後、 タイムラインへドラッグし、 編集、 エフェクトの適用、 レンダリングが終わったら、 完成
したプロジェクトをテープに記録できます。

ステップ 1. プロジェクトビンのシーケンスをダブルクリックして、 タイムラインウィンドウで開きます。

ステップ 2. アウトプット > デジタルカットを選択し、 「デジタルカットツール」を開きます。

ステップ 3. 出力モードを「Real-Time」に、 ビット深度を「10-bit」に、 デッキコントロールを「リモート」に設定します。

ステップ 4. 編集メニューでインサート編集またはアセンブル編集を選択すると、 タイムコードがストライプされたテー
プへの正確な編集が可能です。 または、 クラッシュレコードを選択すれば、 簡単なレコーディングが可能で
す。 インサート編集しか選択できない場合は、 プロジェクトの設定タブに行き、 デッキの初期設定（Deck 
Preferences）をダブルクリックして「デジタルカットでアセンブル編集とクラッシュレコードを許可（Allow 
assemble edit & crash record for digital cut）」を有効にします。

ステップ 5. デッキの名前がイタリック体で表示される、 または「デッキなし（NO DECK）」と表示される場合は、  
メニューをクリックし、 デッキがイタリック体ではない形式で表示され、 デッキコントロールが再度確立
されるまで「デッキ検索（Check Decks）」を選択します。

ステップ 6. デジタルカット再生ボタン（赤い三角形のアイコン）を押して、 シーケンスをテープに記録します。

ステップ 5. イン/アウト点ボタンをクリックするかキーボードの「I」
と「O」キーを使用して、 イン/アウト点を設定

デジタルカットツールを使用してテープに記録
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Autodesk Smoke

Autodesk Smoke 2013 Extension 1
Autodesk Smokeは、 編集、 合成、 3Dエフェクトなどの作業を1つのワークスペースで実行できるソフトウェアで
す。 Smokeでは、 Blackmagicビデオハードウェアを使用してSD/HDのビデオおよびオーディオをキャプチャー・再生
できます。 また、 RS-422デッキコントロールもサポートされています。 Autodesk Smokeをインストールする前に、 
Blackmagic Designドライバーとお使いのビデオデバイスが正しくインストールされていることを確認します。 

Smokeのブロードキャストモニタリングを使用すると、 Blackmagicハードウェアを通してビデオを出力できます。 

インストール
ステップ 1. Smokeを起動すると、 「Project and User Settings」ウィンドウが表示されます。 以前に作成したプロ 

ジェクト（Project）およびユーザー（User）がある場合は、 それらを選択します。 以前に作成していない場合
は、 新規プロジェクト/ユーザーを作成します

ステップ 2. デリバリーするファイル形式に応じて、 プロジェクトの設定を行います（例：1080HD）。 ここで行う設定の
多くは、 後にセッションの途中でも変更が可能です。 

ステップ 3. プロジェクトで生成するメディアの中間フォーマットをProRes 422や非圧縮などから選択します。 必ずお
使いのストレージが対応するフォーマットを選択してください。 

ステップ 4. 「Create」ボタンをクリックします。

ハードウェアのセットアップ
VTRセッションの準備は、 以下のステップに沿って行うことをお勧めします。

ステップ 1. VTRの出力を、 お使いのBlackmagicキャプチャー・再生デバイスの入力に接続します。 Blackmagicキャプ
チャー・再生デバイスの出力を、 VTRの入力に接続します。

ステップ 2. RS-422デッキコントロール・ケーブルを使用して、 VTRのシリアルポートとBlackmagic Designキャ
プチャー・再生デバイスのリモートコントロールポートを接続します。

ステップ 3. VTRをリモートに設定します。

ステップ 4. VTRの同期入力にシンクジェネレーターを接続すると、 フレームアキュレートなキャプチャーが得られます。 
独立したオーディオデバイスを使用する場合は、 必ずそのオーディオデバイスにオーディオ同期信号を接続
します。

プロジェクト名を入力してオプションを設定
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VTRのセットアップ
Autodesk Smokeを開始する前に、 Smoke Setupユーティリティーを使用して作業環境のVTRモデルと適切なタ
イミングセッティングを選択する必要があります。 

ステップ 1. Applications > Autodesk > Smoke > Utilitiesを選択し、 「Smoke Setup」を開きます。

ステップ 2. Generalタブで、 「Video Device」および「Audio Device」が「BMD」に設定されていることを確認します。

ステップ 3. VTRタブで、 Autodesk Smokeで使用したいVTRモデルとタイミングを有効にします。 「Live NTSC」また
は「Live PAL」の列を有効にして、 クラッシュレコードまたはライブ出力を有効にします。

ステップ 4. 「Apply」をクリックして、 Smoke Setupを閉じます。

UltraStudio/DeckLinkを使用して、コントロールできるVTRからキャプチャー
RS-422デッキコントロールを使用してコントロールできるVTRからキャプチャーするようAutodesk Smokeを設定
することも可能です。

ステップ 1. キャプチャーしたクリップの保存先を、 Media Libraryのフォルダから選択します。

ステップ 2. File > Capture from VTRを選択します。 VTRキャプチャー（VTR Capture）モジュールが表示されます。

ステップ 3. テープの頭出し機能を使用して、 キャプチャーを開始するフレームに合わせます。

ステップ 4. 記録したいビデオおよびオーディオを選択します。 ボタンが赤く点灯し、 現在有効になっているトラックが
確認できます。

ステップ 5. 「In」および「Out」のフィールドに、 イン/アウト点を入力します 

ステップ 6. 「Capture」をクリックしてキャプチャーを開始します。 タイムコードのフィールドが緑色になり、 キャプ 
チャー中であることが確認できます。

ステップ 7. プレビューウィンドウをクリックして、 いつでもキャプチャーを終了できます。 クリップは、 VTR Input 
モジュールを入力する前に選択した保存先に自動で保存されます。

Smoke Setupユーティリティーの「Video Device」および
「Audio Device」が「BMD」に設定されていることを確認

Smoke SetupユーティリティーのVTRタブで、 VTRのタイミン
グセッティング（Timing）を設定

VTRからのキャプチャーが有効になっているビデオおよびオー 
ディオトラックが赤く点灯
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UltraStudio/Decklinkを使用してテープに記録
VTR Outputモジュールにクリップをロードして、 出力クリップのイン（In）およびアウト（Out）点を設定します。 必要に
応じて、 開始フレームのオフセットや、 レターボックスオーバーレイの適用などのオプションを有効にします。

ステップ 1. File > Output to VTRを選択します。

ステップ 2. 出力するクリップをMedia Libraryから選択します。 フォルダのコンテンツを1回のセッションで出力したい
場合は、 フォルダごと選択することも可能です。 VTR出力（VTR Output）モジュールが表示されます。

ステップ 3. デバイス名（Device Name）ボックスで、 使用するVTRを選択します。 選択したVTRのテープのビデオがプ
レビューウィンドウに表示されます。

ステップ 4. 正しいビデオトラックボタンおよびオーディオチャンネルボタンが有効になっており、 それぞれ対応するビデ
オトラックおよびオーディオチャンネルがテープに出力されていることを確認します。

ステップ 5. クリップ出力（Clip Output）メニューで、 「All Audio」を有効または無効にします。 「All Audio」を有効にす
ると、 有効にしたオーディオチャンネルだけでなく、 すべてのオーディオチャンネルがテープのフォーマット
に変換されます。

ステップ 6. 「Preview」をクリックして、 実際に出力する前にクリップを確認します。

ステップ 7. 選択したクリップを第1フレーム以外のフレームから開始して出力する場合は、 「開始オフセット（Start 
Offset）」フィールドに開始タイムコードを入力します。

ステップ 8. イン点（In）とアウト点（Out）を設定します

ステップ 9. クリップをVTRに出力するには、 出力（Output）ボックスで「Insert」を選択します。 ステータス（Status）
が「selected」になっているクリップがテープに出力されます。 出力中は、 各クリップのステータスが

「Pending」、 「Output」、 「Done」の順に更新されます。

ステップ 10. タイムコードのイン点を頭出しして再生（Play）を選択し、 テープにきちんと記録されていることを確認し
ます。 

ステップ 11. 終わったら、 「EXIT Output Clip」をクリックしてVTR出力モジュールを閉じます。

ステップ 3. 使用するVTRをドロップダウンリストから選択

出力に選択したクリップと現在の状態がリストに表示 

イン点（In）とアウト点（Out）を設定し、 出力ドロップダウンメ 
ニューで「Insert」を選択 
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クラッシュレコードとライブ出力
Autodesk Smokeでは、 タブレットペンやマウスを使用してクリップの入出力を開始/停止して、 ライブビデオ信号の
キャプチャーやクリップのクラッシュレコードが可能です。 このキャプチャー方法を選択すると、 Autodesk Smokeは
Autodesk Media Storageデバイスの保存領域をチェックして、 使用できる領域を確認します。 使用可能領域は、 
使用する中間フォーマットによって異なります。 

また、 使用するカメラ、 VCR、 その他のデバイスがRS-422でのリモートコントロールに対応していない場合は、 
「Live NTSC」または「Live PAL」を使用してキャプチャーを行い、 クリップの出力には「Live Video」を使用してくだ
さい。 

ライブビデオ信号のクラッシュレコードを行うには、 次のステップに従います。 
ステップ 1. キャプチャーしたクリップを保存するフォルダをMedia Libraryから選択します。

ステップ 2. File > Capture from VTRを選択します。 VTRキャプチャーモジュールが表示されます。

ステップ 3. VTRデバイス（VTR Device）ボックスで、 「Live NTSC」または「Live PAL」を選択します。 入力されている
ライブビデオ信号がプレビューウィンドウに表示されます。

ステップ 4. 「Start On Pen」モードを選択します。 「Stop On Pen」または「Stop On Frames」を使用してキャプ 
チャーを終了します。 Autodesk Smokeの操作には従来よりタブレットとペンが使用されていたため、 

「Start On Pen」という言葉が使用されています。

キャプチャーストップモードに「Stop On Pen」を選択すると、 タイムコードフィールドのアウト点（Out）および長さ
（Duration）が更新され、 Autodesk Media Storageデバイスに記録できる最大の長さが表示されます。 スクリー
ン上をクリックするか、 または保存領域がいっぱいになると、 キャプチャーが終了します。

ステップ 5. クリップ名を入力し、 キャプチャーしたいビデオトラックおよびオーディオチャンネルを有効にします。

ステップ 6. ライブビデオ信号を受信していることを確認します

ステップ 7. ビデオデバイスの再生（Play）を押します。

ステップ 8. 「Process」を選択して、 キャプチャーを開始します。 

ステップ 9. スクリーン上をクリックして、 Stop On Penモードのキャプチャーを終了します。 

「Live NTSC」または「Live PAL」の列を有効にして、 クラッシュ
レコードまたはライブ出力を有効にする
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次のステップに従い、 ライブビデオ信号を出力します。 
ステップ 1. File > Output to VTRを選択します。 

ステップ 2. 出力するクリップをMedia Libraryから選択します。 フォルダごと選択して中のコンテンツを出力することも
可能です。 VTR出力モジュールが表示されます。

ステップ 3. VTRデバイス（VTR Device）ボックスで、 「Live NTSC」または「Live PAL」を選択します。

スタートモード（Start Mode）ボックスは利用できません。 「Live Video」出力では、 「Start On Pen」モードのみ使
用可能です。 「Stop On Pen」または「Stop On Frames」を使用して、 出力を終了します。

ステップ 4. 出力の設定を行います。 （例：クリップ名を入力し、 キャプチャーしたいビデオトラックおよびオーディオチャ
ンネルを有効にします。 ）  

ステップ 5. 信号を受信しているデバイスで、 記録を開始するか、 またはAutodesk Smokeからの信号を受信するため
に必要な作業を行います。

ステップ 6. 「Process」選択して、 Autodesk Smokeの出力を開始します。

ステップ 7. スクリーン上をクリックして、 「Stop On Pen」モードのキャプチャーを終了します。
ライブビデオを出力する場合は、 「Start On Pen」モードを使用

ライブビデオ信号を出力する場合は、 「Live PAL」または「Live 
NTSC」を選択



お気に入りのサードパーティ製ソフトウェアの使用82

DaVinci Resolve 10

使用したいフォーマットを「Video capture and playback」メ 
ニューから選択

DaVinci Resolve 10とLive Grading
Desktop Video 10を使用すると、 UltraStudio 4KおよびDeckLink 4K Extremeでの同時キャプチャー・再生が可
能です。 入力・出力にそれぞれ別のデバイスを用意する必要がなくなるため、 この機能はDaVinci Resolve 10でLive 
Grading機能を使用するユーザーにとって非常に便利です。 

オンセットでLive Gradingを使用する場合は、 カメラの出力をBlackmagicハードウェアの入力に接続します。 さらに
Blackmagicハードウェアの出力をオンセット・モニターに接続して、 グレーディングの評価と確認が可能です。

セットアップ
ステップ 1. DaVinci Resolveを起動してPreferencesメニューから「Video I/O and GPU」タブを選択し、 「For 

Resolve Live use」オプションからお使いのハードウェアを選択します。 設定を保存し、 Resolveを再起動
して変更を適用させます。

ステップ 2. Project Settingsウィンドウからプロジェクトを開始し、 解像度（Resolution）とフレームレート（Frame 
Rate）をお使いのカメラに合わせて設定します。

ステップ 3. Project Settingsウィンドウの「Deck Capture and Playback」タブで、 「Video capture and 
playback」メニューからフォーマットを選択します。

ステップ 4. EditページのTimelineウィンドウを右クリックし、 「Create New Timeline」を選択します。

ステップ 5. Colorメニューで、 「Resolve Live On/Off」を選択します。 ビューアにライブビデオが表示され、 「Resolve 
Live」ボタン（明るい赤色）がビデオ上部に表示されます。

Resolve Liveを使用する
ステップ 1. Resolve Liveモードでは、 「Freeze」ボタン（雪の結晶のアイコン）で現在受信中のビデオフレームをフリー

ズできるため、 撮影中に生じる動きに気を取られることなくグレーディングが行えます。 調整が済んだら、 
再生を再開してスナップショットの取り込みに備えられます。

ステップ 2. 満足できるグレーディングが得られたら、 「Snapshot」ボタン（カメラのアイコン）をクリックして、 現在 
ビューアに表示されているスチルのスナップショット、 受信タイムコードの値、 作成したグレーディングをタ
イムライン（Timeline）に保存できます。 スナップショットは、 ワンフレームのクリップです。

Resolve Liveについての詳しい説明は、 DaVinci Resolve 10マニュアルを参照してください。
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Blackmagic Media Expressとは
Blackmagic Media Expressソフトウェアは、 すべてのUltraStudio、 DeckLink、 Intensityシリーズだけでなく、 
すべてのATEM Switcher、 Blackmagic Camera、 H.264 Pro Recorder、 Teranex Processor、 Universal 
Videohubにも同梱されています。 Media Express 3は、 複雑なノンリニア編集ソフトウェアを避け、 クリップをテー
プに簡単にキャプチャー、 再生、 出力したい場合に最適なツールです。

ビデオ/オーディオファイルのキャプチャー

プロジェクトのセットアップ
Media Expressでクリップをキャプチャーする前に、 プロジェクトの設定を選択する必要があります。

ステップ 1. Media Express > Preferences、 または、 編集（Edit）> Preferencesを選択します（Windows/Linux）。 
リストに表示されるフォーマットは、 お使いのBlackmagicビデオハードウェアのUltra HD 4Kやステレオス
コピック3Dなどへの対応/非対応により異なります。

ステップ 2. 「Capture File Format」ドロップダウンメニューを使用して、 様々な圧縮/非圧縮キャプチャーフォー 
マットまたはDPXイメージシーケンスから選択します。 選択したフォーマットでビデオがキャプチャーされ、 
QuickTimeムービーで保存されます。

ステップ 3. キャプチャーしたビデオおよびオーディオを保存するディスク記憶装置を選択します。 

ステップ 4. コマ落ちが検出された際にキャプチャーまたは再生を停止するかどうかを選択します。

SD品質のプロジェクトは、 「Use Anamorphic SD 16:9」チェックボックスを有効にしている場合を除き、 4:3アスペ
クトレシオに設定されます。

ビデオアプリケーションは、 通常、 バックグラウンドにまわるとビデオの再生を停止します。 フォアグラウンドに他のア
プリケーションを開いてもMedia Expressにビデオの再生を続けさせたい場合は、 「Continue playback when in 
the background」チェックボックスにチェックを入れてください。 

画面下部のオプションはRS-422デッキコントロール対応のテープデッキに関連するもので、 プリロールやタイムコー
ドオフセットの設定を行います。Preferencesウィンドウを使用して、 ビデオフォーマット、 ファイ

ルフォーマット、 保存場所などを設定

Blackmagic Media Express
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メディアリスト 検索フィールドタイムコードリスト、 サムネイル、 お気に入りビュー VTR/デッキタイムコード ビデオプレビュー

クリップビン キャプチャーオプション トランスポートコ
ントロール

Grab Still 
Frameボタン

プロジェクト名、 ビデオフォーマット、 フレームレート リモート・インジ
ケーター

ログ情報マークイン/マークアウト オーディオ 
メーター

オーディオチャンネ
ル有効/無効
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キャプチャー
ビデオのキャプチャーは簡単です。 必要な作業は、 ビデオソースを接続してMedia Expressの環境設定を行い、 

「Capture」ボタンを押すだけです。

ステップ 1. ビデオソースをBlackmagicビデオハードウェアの入力に接続し、 Blackmagicシステム環境設定で同じビ
デオ入力（例：SDI、 HDMI、 アナログ）が設定されていることを確認します。

ステップ 2. Media Expressを開き、 環境設定画面（Preferences）で「Project Video Format」および「Capture 
File Format」を設定します。

ステップ 3. 「Log and Capture」タブ（赤いタブ）をクリックし、 「Description」フィールドに情報を入力します。 

ステップ 4. 「Description」フィールドの横にある「＋」ボタンをクリックし、 入力した情報を「Name」フィールドに追加
します。 他のフィールドの情報を「Name」フィールドに追加したい場合は、 各フィールドの横の「＋」ボタン
をクリックします。

各フィールドの数値を増加するには、 各フィールド横のカチンコアイコンをクリックします。 また、 フィールドに直接入力し、 
名前や数値をカスタマイズすることも可能です。 

「Name」フィールドのテキストは、 これからキャプチャーするクリップに適用されます。 

クリップをお気に入りとしてログしたい場合は、 「Name」フィールドの横にある星アイコンをクリックします。 

毎回キャプチャーする前にクリップ名を確認するウィンドウを表示させたい場合は、 「Name」フィールドの横にある「！」アイ
コンをクリックします。

ステップ 5. キャプチャーするオーディオチャンネルの番号を設定します。

ステップ 6. 「Capture」ボタンをクリックして、 キャプチャーを開始します。 キャプチャーを終了してクリップを保存する
場合は、 もう一度「Capture」ボタンをクリックします。 または、 「esc」キーを押すと、 クリップの消去/保存
が選択できます。 キャプチャーしたクリップはメディアリストに追加されます。

クリップのロギング
BlackmagicビデオハードウェアとデッキがRS-422シリアルケーブルで接続されていることを確認してください。 ま
た、 デッキのリモート/ローカル切替スイッチが、 リモートに設定されていることを確認してください。 標準のJ、 K、 L 
ショートカットキーを使用して、 前後にシャトルまたは一時停止してください。 

「Mark In」ボタンをクリックしてイン点（In）を設定するか、 またはショートカットキー「I」を使用してください。 

「Mark Out」ボタンをクリックしてアウト点（In）を設定するか、 またはショートカットキー「O」を使用してください。 

「Log Clip」ボタンをクリックしてクリップのログを行うか、 またはショートカットキー「P」を使用してください。 ロギン
グしたクリップがメディアリストに表示されます。 クリップのアイコンには赤いX印がついており、 そのメディアがオフラ
インであることが確認できます。

キャプチャーするオーディオチャンネル番号を設定

ビデオに関する情報を入力

「Capture」ボタンをクリックしてキャプチャーを開始
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バッチキャプチャー
クリップのロギングが終わったら、 「Clip」ボタンをクリックしてクリップを1つずつキャプチャーできます。 

複数のクリップをキャプチャーするには、 それらのクリップのロギングを行い、 バッチキャプチャーを実行します。 

ロギングの済んだクリップをメディアリストから選択し、 以下のいずれかの操作を行ってください。

 � 「Batch」ボタンをクリックする

 � 選択したクリップを右クリックして、 「Batch Capture」を選択する

 � 「File」メニューから「Batch Capture」を選択する

Media Expressがタイムコードのイン点（In）からアウト点（Out）までクリップをキャプチャーします。

DPXキャプチャー
ムービーファイルではなくDPXイメージシーケンスでキャプチャーしたい場合は、 Media Expressの「Preferences」
を開き、 「Capture File Format」を「DPX 10-Bit RGB」に設定します。

 � 「Capture File Format」をDPXに設定して、 DPXプロジェクトを作成します。 

 � キャプチャーを実行します。 

キャプチャーが終了すると、 フレームシーケンス全体を表すサムネイルがメディアリストに表示されます。 DPXフレーム
のシーケンスは、 ディスク記憶装置の専用のフォルダに保存されます。 オーディオは同じフォルダ内に.wavファイルで
保存されます。 

デフォルトでは、 DPXキャプチャーはYUVソースから行われる設定になっています。 RGBソースからキャプチャーする
必要がある場合は、 「Capture to DPX from a YUV source」を無効にします。 

DPXフレーム番号を、 ゼロから開始するのではなく、 キャプチャーしたビデオのタイムコードに応じた番号にしたい場
合は、 「Use absolute frame numbering when capturing DPX」オプションを使用します。 

実行するDPXキャプチャーが短い場合は、 「When capturing DPX files, use (2-8) digit numbers in the 
frame count」オプションの設定を変更して、 フレーム番号のゼロの数を減らすことができます。

DPXキャプキャーの設定
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3Dキャプチャー
Media Expressを使用するBlackmagicビデオハードウェアがデュアルストリーム3Dに対応している場合は、 HD-
SDIビデオの2ストリームを同時にキャプチャーして、 左右両眼画像による3Dビデオクリップを作成できます。

 � お使いのデュアルストリーム3Dビデオソースのフレームレートと適合する3Dプロジェクトを作成します。 

 � BlackmagicビデオハードウェアにHD-SDIビデオが個別で2系統入力されていることを確認します。 

 � キャプチャーを実行します。 

Media Expressでデュアルストリーム3Dのキャプチャーおよびロギングを行う場合、 設定したクリップ名は左眼用ビ
デオに適用されます。 右眼用ビデオのクリップ名には「_right」が付加されます。 例えば、 クリップに「Clip 1」という名
前をつけた場合、 左眼用クリップは「Clip 1.mov」となり、 右眼用クリップは「Clip 1_right.mov」となります。 

メディアリストには、 キャプチャーしたクリップが3Dクリップであることが分かりやすく表示されます。 

 � サムネイルビューでは、 左右眼用の両クリップは3Dインジケーターでつなげられ、 ひとつの大きなアイコンとして
表示されます。 

 � タイムコードリストビューでは、 左右眼用の各クリップが2ラインに表示され、 3Dインジケーターでつなげられ
ます。

デュアルストリーム・ステレオスコピック3Dビデオクリップをキャ
プチャーする場合は、 プロジェクトのビデオフォーマットに「3D」
がついたフォーマットを選択

サムネイルビューでは、 左右眼用の両クリップは3Dインジケー 
ターでつなげられ、 ひとつの大きなアイコンで表示

タイムコードリストビューでは、 左右眼用の各クリップが2ライン
に表示され、 3Dインジケーターでつなげられる
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お気に入り
選択

Grab Still 
Frameボタン

クリップ情報 オーディオチャンネ
ル有効/無効

メディアリスト 検索フィールドタイムコードリスト、 サムネイル、 お気に入りビュー VTR/デッキタイムコード ビデオプレビュー

クリップビンプロジェクト名、 ビデオフォーマット、 フレームレート マークイン/マー
クアウト

トランスポート
コントロール

リモート・インジ
ケーター

オーディオ 
メーター
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ビデオ/オーディオファイルの再生

クリップのインポート
Media Expressにインポートしたビデオやオーディオは、 以下のいずれかの方法で再生できます。

 � メディアリスト内の何もない部分をダブルクリックする

 � メディアリスト内の何もない部分で右クリックし、 コンテキストメニューから「Import Clip」を選択する

 � 「File」メニューから、 「Import」、 「Media Files」の順に選択する

インポートしたいクリップを「Open Video Clip」ダイアログボックスから選択してください。 選択したクリップがメディ
アリストの「Scratch」欄に表示されます。 メディアリストにビンを作成してある場合は、 クリップを好きなビンにドラッ
グできます。 

メディアを直接ビンにインポートしたい場合は、 そのビンを右クリックし、 コンテキストメニューで「Import Clip」を選
択してください。 

インポートしたファイルがメディアリストの既存のクリップのフレームレート/サイズと一致しない場合は、 新規プロジェ
クトを作成し、 現在のプロジェクトを保存するよう指示されます。 

Media Expressは、 48kHzで非圧縮WAVE（.wav）およびAIFF（.aif）フォーマットで記録された複数チャンネルの 
オーディオファイルのインポートにも対応しています。 

メディアをインポートするもうひとつの方法に、 Final Cut ProでエクスポートしたXMLファイルを使用する方法があ
ります。 「File」メニューから、 「Import」、 「Media Files」の順に選択します。 使用したいXMLファイルを開くと、 もと
のFinal Cut Proプロジェクトのすべてのビンとメディアがメディアリストに表示されます。 

Media ExpressはCMX EDLファイルのインポートにも対応しており、 他のビデオ編集ソフトウェアからのEDLファイ
ルを使用してクリップのバッチキャプチャーを行うことも可能です。 「File」メニューから、 「Import」、 「CMX EDL」の
順に選択します。 EDLファイルを選択して開きます。 メディアリストにログ情報が表示されます。 ロギングされたクリッ
プを選択してバッチキャプチャーを実行し、 デッキからクリップをインポートします。

単一/複数のクリップの再生
1つのクリップを再生する場合は、 メディアリスト内の再生したいクリップをダブルクリックしてください。 または、 メデ
ィアリストのクリップを選択し、 キーボードのスペースバーまたはトランスポートコントロールの再生ボタンを押してく
ださい。 

複数のクリップを再生する場合は、 メディアリスト内の再生したいクリップを選択し、 キーボードのスペースバーまたは
トランスポートコントロールの再生ボタンを押してください。 

Media ExpressのビデオプレビューウィンドウおよびBlackmagicビデオハードウェアのすべてのビデオ出力でビデオ
が再生されます。 再生中、 各トラックの有効/無効ボタンで、 モニタリングするオーディオチャンネルのオン/オフを切り
替えられます。 

メディアを直接またはXML/EDLでインポート

トランスポートコントロールを使用して、 再生、 停止、 次/前のク
リップへ移動、 ループ再生をコントロール
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Browsing Media

サムネイルビュー
サムネイルビューでは、 最も直感的な形式でクリップを表示できます。 マウスのカーソルをクリップのサムネイルの上に
合わせ、 サムネイルの右下に表れる情報アイコンをクリックしてください。 吹き出しをクリックすると情報が隠れます。

リストビュー
メディアリストの上部右側にあるタイムコードリストボタンをクリックすると、 クリップをタイムコードリストビューで表
示できます。 水平方向のスクロールバーを使用して、 各クリップに関する情報がすべて確認できます。

ビンの作成と使用
ビンを作成するには、 メディアリスト内の何もない場所で右クリックし、 「Create Bin」を選択します。 新しいビンに名
前をつけます。 

クリップアイコンをドラッグして、 クリップを好きなビンに移動できます。 クリップを2つ以上のビンで表示したい場合
は、 2つめのビンを右クリックして「Import Clip」を選択し、 同じクリップを再度インポートしてください。 

デフォルトでは、 ログされたクリップは「Scratch」欄に表示されます。 ログしたクリップを新しいビン内に表示したい場
合は、 その新しいビンを右クリックして「Select As Log Bin」を選択してください。

お気に入りの作成と使用
「Log and Capture」タブでは、 「Name」フィールドの横にある星アイコンをクリックすると、 クリップをお気に入りと
してログできます。 

「Playback」タブでは、 星アイコンをクリックすると、 メディアリストで選択されているクリップをお気に入りとしてログ
できます。 星アイコンを再度クリックすると、 クリップがお気に入りから外れます。 

お気に入りに指定されたクリップは、 タイムコードリストビューおよびサムネイルビューでアイコンに黄色い星が表示さ
れます。 

クリップをお気に入りに指定したら、 メディアリスト上部の「Show only favorites」ボタンをクリックします。 星アイコ
ンが黄色になります。 お気に入りに指定したクリップ以外のクリップが非表示になります。

オーディオクリップとビデオクリップをリンク
以下の手順で、 メディアリスト内のオーディオクリップとビデオクリップをリンクできます。

 � オーディチャンネルを含まないビデオクリップを選択する

 � そのビデオクリップを右クリックして、 コンテクストメニューから「Link Audio File」を選択する

リンクしたクリップを再生できます。 また、 リンクしたクリップをテープにマスタリングすることも可能です。

メディアリストでは、 クリップの表示をタイムコードビューまたは
サムネイルビューから選択できます。 お気に入りボタンをクリック
すると、 お気に入りのクリップのみを表示できます。 「Search」 
フィールドに入力し、 お気に入りのクリップを検索できます。 

サムネイルのポップアップ情報アイコンをクリックすると、 情報が
吹き出しで表示されます。 

「Log and Capture」タブでは、 「Name」フィールド横の星アイ
コンをクリックして、 クリップをお気に入りとしてログできます。
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3Dプロジェクトビデオフォーマットを選択

メディアリストはインポートしたクリップが3Dクリップであること
を分かりやすく表示

「Search」フィールドに入力してクリップを検索

メディアリストはビデオクリップとオーディオクリップがリンクして
いることを分かりやすく表示

クリップとビンの削除
クリップを削除するには、 削除したいクリップを選択し、 キーボードの「Forward Delete」ボタンを押してください。 こ
の作業で削除されるのはメディアリスト内のクリップのみで、 ディスク上に保存されたクリップはそのまま残ります。 

ビンを削除するには、 削除したいビンを右クリックし、 「Delete Bin」を選択してください。 この作業で、 ビンおよびビ
ンの中に含まれるすべてのクリップが削除されます。 この作業で削除されるのはメディアリスト内のクリップのみで、  
ディスク上に保存されたクリップはそのまま残ります。

3Dクリップの作成
メディアリストにステレオスコピック3Dクリップを追加する場合は、 以下の手順に従います。

 � 使用する3Dメディアと同じフレームレートの3Dプロジェクトビデオフォーマットを選択します。 

 � メディアリストに「左眼用」ファイルをインポートします。 

 � インポートした左眼用ファイルを右クリックし、 コンテクストメニューから「Set Right Eye Clip」を選択します。  
右眼用クリップがすでにメディアリストにキャプチャーされている場合は、 右眼用クリップの名前に「_right」が付
加されます。 

メディアリストでは、 インポートしたクリップが3Dクリップであることが非常に分かりやすく表示されます。 左右両眼用
クリップはビデオプレビューウィンドウに並んで表示されるため、 3Dビデオプロジェクトであることが確認できます。 

3Dステレオクリップの画像が左右反対にロードされている場合は、 以下の操作を行います。 

 � メディアリストに表示されている使用中の3Dクリップを右クリックする

 � コンテクストメニューから「Swap Eyes」を選択する

メディアリスト内の検索
各プロジェクトのクリップは、 メディアリスト上部の検索フィールドにクリップ名を入力して、 簡単に探し出すことができ
ます。 お気に入り機能と合わせて使用すると、 検索の対象がお気に入りのクリップに限定されるため、 検出されるクリッ
プのリストが短くなります。 
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テープに 
マスタリング

記録モード オーディオチャン
ネル有効/無効

マークイン/マークアウト
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ビデオ/オーディオファイルをテープに編集
「テープ」にマスタリングおよび編集をするいう表現を多用していますが、 お使いのデッキがテープまたはディスクのど
ちらを使用していても問題ありません。 クリップのマスタリングは以下の手順で行います。 

 � テープに送信するクリップを選択する

 �  「Edit to Tape」タブ（青いタブ）をクリックする

 � イン点（In）と編集の種類を設定する

 � テープにマスタリングする

マスタリングするクリップを選択
テープにマスタリングしたいクリップをメディアリストから選択します。 複数チャンネルを持つオーディオのみのクリップ
を書き込んで、 マスターテープのマスターオーディオトラックを書き換えることも可能です。 お気に入りのクリップのみ
をテープに送信したい場合は、 メディアリスト上部のお気に入り（星）アイコンをクリックしてお気に入りのクリップのみ
を表示し、 その他のクリップを非表示にします。 さらに、 テープに送信するお気に入りクリップを選択します。 

テープへのインサート編集とアセンブル編集
「Edit to Tape」タブ（青いタブ）をクリックします。 イン点（In）フィールドにタイムコードを入力するか、 またはトラン
スポートコントロールでテープを任意のポイントに合わせて「Mark In」ボタンをクリックして、 テープのイン点を入力し
ます。 

アウト点（Out）が入力されていない場合、 Media Expressは、 編集の長さをメディアリストのクリップの全長に合わせ
て設定します。 アウト点が指定されている場合は、 Media Expressはタイムコードがアウト点に到達した時点で（まだ
出力されていないクリップがある場合でも）レコーディングを停止します。 

テープへのマスタリングにアセンブル編集（Assemble）とインサート編集（Insert）のどちらを行うかを選択します。 
「Master」ボタンを押します。 

「Preview」モードでは編集の過程を実際に見て確認できますが、 テープへは記録されません。 このモードでは編集
点が確認できます。 編集のプレビューは、 必ずデッキの出力に直接接続されているモニターで確認してください。 これ
により、 すでにテープに記録されているビデオと新しいビデオを同時に確認できます。 

デッキまたはテープの「記録禁止（Record Inhibit）」が有効になっている状態で「Master」ボタンをクリックする
と、 Media Expressは記録できないことを報告します。 もう一度「Master」ボタンを押す前に、 記録禁止（Record 
Inhibit）を無効にしてください。 

トラックの有効/無効ボタンで、 出力するビデオおよびオーディオチャンネルを選択します。 オーディオチャンネルのみ
を出力したい場合は、 ビデオチャンネルを非選択にします。 

メディアリスト上部のお気に入り（星）アイコンをクリックしてお気
に入りのクリップのみを表示

テープへの出力に2つのクリップが選択されている

マスタリングするオーディオチャンネル番号を設定
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What is Blackmagic Design Disk Speed Test?
Blackmagic Disk Speed Testは、 記録メディアの読み込み（Read）と書き込み（Write）の性能をフレームサイ
ズごとに測定できるアプリケーションです。 Disk Speed Testは、 あらゆるBlackmagic製品をMac OS Xおよび
Windowsにインストールする際に無償でインストールされます。 また、 弊社のウェブサイトからも無償でダウンロード
できます。 Disk Speed Testの設定を行うには、 「Start」ボタンの上にある「Settings」ボタン（ギアのアイコン）をク 
リックしてください。 

ターゲットのドライブを選択
「Select Target Drive」をクリックして、 読み込み/書き込みの許可があることを確認してください。 

スクリーンショットを保存
「Save Screenshot」をクリックして、 測定結果のスクリーンショットを保存できます。 

Stress
Stressのレベルは、 1GBから5GBの間で1GB単位で設定できます。 デフォルトでは、 最も正確な測定結果が得られ
る5GBに設定されています。 

Disk Speed Testヘルプ
「Disk Speed Test Help」をクリックすると、 Disk Speed Testの操作説明書（PDF）を確認できます。 

Disk Speed Testについて
「About Disk Speed Test」では、 起動しているDisk Speed Testのバージョンを表示できます。 

Start
「Start」ボタンをクリックすると、 ディスクスピードの測定が開始されます。 Disk Speed Testは事前に選択されたター
ゲットドライブに一時的なファイルを書き込み、 さらにそのファイルの読み込みを行います。 もう一度「Start」ボタンをク
リックして測定を停止するまで、 Disk Speed Testは書き込みと読み込みを継続します。 

Will it Work?
「Will it Work?」パネルには一般的なビデオフォーマットが一覧表示されています。 チェックマークまたはバツ印によっ
て、 各フォーマットに対してディスク性能が十分であるか否かが確認できます。 測定は必ず数回繰り返し、 ディスク性能
が対応できる限界のビデオフォーマットを確認してください。 結果がチェックマークとバツ印で切り替わってしまうビデ
オフォーマットは、 お使いのディスクストレージの対応が確実ではありません。

How Fast?
「How Fast?」パネルには、 お使いのドライブが対応できる最大フレームレートが表示されます。 「Will it Work?」パ
ネルと合わせて確認してください。 仮に「Will it Work?」パネルの「2K 1556@25fps」「10 Bit YUV 4:2:2」の欄に
緑のチェックマークが表示されていても、 「How Fast?」パネルに表示される最大対応フレームレートが25fpsであれ
ば、 ディスクストレージの性能が限界に達するため確実には信頼できません。

ギアのアイコンをクリックしてSettingsメニューを開く

Blackmagic Disk Speed Test
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How Fast? 

このパネルでは、 フ 
レーム毎秒（fps）で結
果が表示されます。

Settings 

ディスクスピードの測定を行
う前に、 このボタンをク 
リックして設定を行います。 

Will it Work? 

このパネルでは、 お使い
のディスクストレージが
対応できるビデオフォー
マットが確認できます。

START

このボタンをクリックす
るとディスクスピードの
測定が始まります。 ボタ
ンをもう一度クリックし
て、 測定を停止します。
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サポートを利用する
すぐに情報が欲しい方は、 Blackmagic Designオンラインサポートページで、 お使いハードウェアに関する最新のサ
ポート情報を確認できます。 

Blackmagic Designオンラインサポートページ
最新のマニュアル、 ソフトウェア、 サポートノートは、 www.blackmagicdesign.com/jp/supportのBlackmagic サ
ポートセンターで確認できます。

Blackmagic Designサポートへ連絡する
サポートページで必要な情報を得られなかった場合は、 お使いのハードウェアのサポートページにある「リクエストを
送信」ボタンでリクエストをメール送信してください。 あるいは、 Blackmagic Designオフィスに電話でお問い合わせ
ください。 各国のオフィスはこちらのページを参照してください。 www.blackmagicdesign.com/jp/company

現在インストールされているバージョンを確認する
お使いのコンピューターにインストールされているDesktop Videoソフトウェアのバージョンを確認するには、 
Blackmagic Design Desktop Videoのシステム環境設定を開いてください。 タイトルバーにバージョン番号が表示
されます。

 � Mac OS Xでは、 システム環境設定を開き、 Blackmagic Designアイコンをクリックします。 Blackmagic 
Designのアイコンをクリックして、 バージョン番号を確認してください。 

 � Windows 7およびWindows 8では、 コントロールパネルを開き、 「ハードウェアとサウンド」カテゴリーをクリッ
クして「Blackmagic Design Control Panel」を開きます。 Blackmagic Design Control Panelをクリックし
て、 バージョン番号を確認してください。 

 � Linuxでは、 「アプリケーション」、 「サウンドとビデオ」の順に進むと、 Blackmagic Control Panelがあります。 
Blackmagic Design Control Panelを開いて、 バージョン番号を確認してください。 

最新のソフトウェアを入手する
お使いのコンピューターにインストールされているDesktop Videoのバージョンを確認したら、 Blackmagicサポー
トセンター（www.blackmagicdesign.com/jp/support）で最新のソフトウェア・アップデートをチェックしてくださ
い 常に最新のソフトウェアを使用することを推奨しますが、 重要なプロジェクトの実行中は、 ソフトウェアのアップ 
デートは行わない方がよいでしょう。 

ヘルプライン

http://www.blackmagicdesign.com/support
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Blackmagic Designハードウェアをコントロールするカスタムソフトウェアを開発する
自分自身でカスタマイズしたソフトウェアでBlackmagicビデオハードウェアをコントロールできる、 DeckLink SDK
がご利用頂けます。 DeckLink SDKは、 UltraStudio、 DeckLink、 Multibridge、 Intensityシリーズをサポートして
います。 

DeckLink SDKは、 使い勝手のよいハードウェアコントロール、 高レベルのインターフェースで、 一般的なタスクを実
行できます。 DeckLink SDKは、 以下のテクノロジーをサポートしています。 

 � Apple QuickTime

 � Microsoft DirectShow

 � Apple Core Media

 � DeckLink API

Blackmagic Design SDKを無償でダウンロード
DeckLink SDKは、 http://www.blackmagicdesign.com/jp/support/sdks でダウンロードできます。 

Blackmagic Designデベロッパーリストに加わる
Blackmagicデベロッパー・メーリングリストは、 QuickTime、 Core Media、 DirectShow、 コーデック、 API、 
SDKなどBlackmagic Designが使用するテクノロジーに関する技術的な質問のためのものです。 この無料のメーリ
ングリストは、 デベロッパーが他のデベロッパーとアイデアや問題点などについて意見交換ができるフォーラムです。 
あらゆる参加者が返信でき、 適切な場合にはBlackmagic Designのエンジニアも回答します。 メーリングリストへの
登録は、 http://lists.blackmagicdesign.com/mailman/listinfo/bmd-developer で行います。 

デベロッパーであることがドメイン名から判断できない場合は、 お使いのソフトウェアの概略を要求する場合がありま
す。 このメーリングリストはデベロッパーだけのためのものであるため、 スパムやウイルス、 開発に関係のない質問が一
切なく、 人材紹介会社や製品の宣伝を行う営業者などが入らないよう努めます。 

Blackmagic Designデベロッパーサポートへの連絡
リストを使用せずに質問したい場合は、 developer@blackmagicdesign.com にご連絡ください。

デベロッパーの皆様へ
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Caution: Risk of Electric Shock
On the UltraStudio 4K enclosure you will see a yellow warning label marked ‘Caution: Risk of Electric Shock’. 
This is intended to warn users that there may be the presence of uninsulated “dangerous” voltage within 
the UltraStudio 4K enclosure which may be of sufficient magnitude to constitute a risk of electric shock to 
the user. Blackmagic Design advises you not to open the UltraStudio 4K unit, but rather contact your nearest 
Blackmagic Design service center should assistance be required.

警告：製品本体を解体しないでください。 感電の危険性があります。
Blackmagic Designは、 UltraStudio 4K本体を開かないよう警告します。 UltraStudio 4Kには、 「Caution: Risk 
of Electric Shock」と表示された黄色い警告ラベルが同梱されています。 これは、 ユーザーに対して、 UltraStudio 
4K本体内部に、 非絶縁の「危険」電圧が含まれている可能性を警告するものです。 この電圧はユーザーに感電のリス
クをもたらす可能性があります。 技術的なサポートが必要な場合は、 Blackmagic Designサポートセンターまでお問
い合わせください。

Caution label

警告ラベル

注意
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限定保証
Blackmagic Designは、 お買い上げの日から36ヶ月間、 UltraStudio、 DeckLink、 Multibridgeシリーズ製品の
部品および仕上がりについて瑕疵がないことを保証します。 但し、 コネクター、 ケーブル、 冷却ファン、 光ファイバー
モジュール、 ヒューズ、 キーボード、 バッテリーについては、 それらの部品および仕上がりに瑕疵がないことに対する
保証は12ヶ月間です。 Blackmagic Designは、 お買い上げの日から12ヶ月間、 Intensityシリーズ製品の部品およ
び仕上がりについて瑕疵がないことを保証します。 この保証期間内に製品に瑕疵が見つかった場合、 Blackmagic 
Designは弊社の裁量において部品代および人件費無料で該当製品の修理、 あるいは製品の交換のいずれかで対応
いたします。 

この保証に基づいたサービスを受ける際、 お客様は必ず保証期限終了前にBlackmagic Designに瑕疵を通知し、 適
応する保証サービスの手続きを行ってください。 お客様の責任において不良品を梱包し、 Blackmagic Designが指
定するサポートセンターへ配送料前払で送付いただきますようお願い致します。 理由の如何を問わず、 Blackmagic 
Designへの製品返送のための配送料、 保険、 関税、 税金、 その他すべての費用はお客様の自己負担となります。 

不適切な使用、 または不十分なメンテナンスや取扱いによる不具合、 故障、 損傷に対しては、 この保証は適用されま
せん。 Blackmagic Designはこの保証で、 以下に関してサービス提供義務を負わないものとします。 a）製品のイン 
ストールや修理、 サービスを行うBlackmagic Design販売代理人以外の者によって生じた損傷の修理、 b）不適切
な使用や互換性のない機器への接続によって生じた損傷の修理、 c）Blackmagic Designの部品や供給品ではない
物を使用して生じたすべての損傷や故障の修理、 d）改造や他製品との統合により時間増加や製品の機能低下が生じ
た場合のサービス。 この保証は Blackmagic Designが保証するもので、 明示または黙示を問わず他の保証すべてに
代わるものです。 Blackmagic Designとその販売社は、 商品性と特定目的に対する適合性のあらゆる黙示保証を拒
否します。 Blackmagic Designの不良品の修理あるいは交換の責任が、 特別に、 間接的、 偶発的、 または結果的に
生じる損害に対して、 Blackmagic Designあるいは販売社がそのような損害の可能性についての事前通知を得てい
るか否かに関わらず、 お客様に提供される完全唯一の救済手段となります。 Blackmagic Designはお客様による機
器のあらゆる不法使用に対して責任を負いません。 Blackmagic Designは本製品の使用により生じるあらゆる損害
に対して責任を負いません。 使用者は自己の責任において本製品を使用するものとします。 

© Copyright 2014 Blackmagic Design 著作権所有、 無断複写・転載を禁じます。 「Blackmagic Design」、 「DeckLink」、 「HDLink」、 
「Workgroup Videohub」、 「Videohub」、 「Intensity」、 「Leading the creative video revolution」は、 米国ならびにその他諸国での
登録商標です。 その他の企業名ならびに製品名全てはそれぞれ関連する会社の登録商標である可能性があります。 

ThunderboltおよびThunderboltのロゴは、 米国またはその他諸国のIntel Corporationの登録商標です。 

保証
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Bienvenue

Nous espérons que vous partagez le même rêve que nous : c'est-à-dire que l'industrie 
télévisée soit un lieu créatif qui permette à chacun d'avoir accès à la plus haute qualité 
vidéo qui soit.

Par le passé, la télévision et la post-production haut de gamme nécessitaient un 
investissement au niveau du matériel qui représentait des millions de dollars. Toutefois, 
grâce au matériel vidéo Blackmagic, même la vidéo non compressée 10 bits est à 
présent financièrement abordable. Nous espérons que vous profiterez de votre nouveau 
UltraStudio, DeckLink ou Intensity pendant des années et que vous aurez du plaisir à 
travailler avec les logiciels de montage et de design les plus fabuleux au monde !

Ce manuel d’instruction contient toutes les informations dont vous aurez besoin pour 
installer votre matériel vidéo Blackmagic. Lorsque vous installez une carte PCI Express, il est 
judicieux de demander l'aide d'un technicien si c'est la première fois que vous installez une 
carte matériel dans un ordinateur. Comme le matériel vidéo Blackmagic prend en charge 
de la vidéo non compressée et que les débits de données sont assez élevés, vous aurez 
besoin d'un disque de stockage rapide et d'un ordinateur haut de gamme.

L'installation devrait vous prendre environ 10 minutes.  Avant d'installer  
du matériel vidéo Blackmagic, veuillez consulter notre site Internet  
www.blackmagicdesign.com et notre page d'assistance pour télécharger les dernières 
mises à jour de ce manuel et les derniers pilotes Desktop Video. Finalement, veuillez 
enregistrer votre matériel vidéo Blackmagic lorsque vous téléchargez des mises à jour 
logicielles. Nous souhaitons ainsi vous garder informés des nouvelles mises à jour et des 
nouvelles fonctionnalités du logiciel. Si vous le désirez, vous pouvez même nous faire 
parvenir votre dernière bande démo réalisée à l'aide de votre matériel vidéo Blackmagic 
ainsi que toute suggestion nous permettant d'améliorer le logiciel. Nous travaillons 
constamment sur de nouvelles fonctionnalités et nous efforçons d’améliorer nos services en 
permanence : c’est pourquoi nous aimerions avoir votre avis !

Grant Petty
CEO Blackmagic Design
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Présentation de Desktop Video
Le logiciel Desktop Video de Blackmagic Design fonctionne conjointement avec votre matériel UltraStudio, DeckLink, 
Intensity ou Teranex. Ce dernier inclut des pilotes, plug-ins et applications telles que Blackmagic Media Express. Desktop 
Video s'intègre aussi parfaitement avec vos logiciels Adobe, Apple, Autodesk et Avid favoris !

Ce manuel vous guidera à travers la configuration système requise, l'installation du matériel et du logiciel ainsi que 
l'utilisation de votre logiciel tiers de prédilection. 

Configuration système requise
L'ordinateur doit posséder au moins 4 GB de RAM. Les cartes PCIe x 1 ligne devraient fonctionner dans n'importe 
quel logement. Les cartes PCIe x 4 lignes nécessitent un logement pouvant prendre en charge 4 lignes ou plus rapide.

Mac OS X
Le logiciel Desktop Video est compatible avec les dernières versions Mountain Lion et Mavericks de Mac OS X.

Si votre matériel vidéo Blackmagic se connecte à votre ordinateur via un logement PCI Express, un Mac Pro Intel 
est requis.

Si votre matériel vidéo Blackmagic se connecte à votre ordinateur via Thunderbolt, un Mac Intel équipé d'un port 
Thunderbolt™ est requis.

Windows
Desktop Video fonctionne exclusivement sur les versions 64 bits de Windows, lorsque le dernier service pack a été 
installé. Windows 7 et Windows 8 sont tous deux pris en charge.

Si votre matériel vidéo Blackmagic se connecte à votre ordinateur via Thunderbolt, un PC Intel équipé d'un port 
Thunderbolt™ est requis.

Si votre matériel vidéo Blackmagic se connecte à votre ordinateur via USB 3.0, un port USB 3.0 avec un chipset Renesas 
est requis.

Linux
Desktop Video fonctionne avec les ordinateurs x86 32 bits ou 64 bits sous Linux 2.6.23 ou version plus récente. Veuillez 
vous référer aux notes de mise à jour pour obtenir la liste la plus récente des distributions, formats de paquet et 
dépendances logicielles Linux compatibles.

Mise en route
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Installer votre matériel vidéo Blackmagic
Si votre matériel vidéo Blackmagic se connecte via Thunderbolt, référez-vous directement à la section Thunderbolt. Les 
ordinateurs Mac OS X et Windows les plus récents sont équipés de ports Thunderbolt.

Si votre matériel vidéo Blackmagic se connecte via USB 3.0, référez-vous directement à la section USB 3.0. 

Les produits vidéo USB 3.0 de Blackmagic requièrent un PC Windows compatible.

Installer une carte PCIe Blackmagic
Étape 1. Retirer la fiche secteur de votre ordinateur et assurez-vous que vous êtes déchargé de toute électricité 

statique.

Étape 2. Insérez votre carte PCIe Blackmagic dans un logement approprié de votre ordinateur et poussez-la 
fermement en place. Si vous possédez une carte DeckLink Optical Fiber, le module fibre optique doit être 
retiré avant l'insertion.

Étape 3. Si votre carte PCIe Blackmagic comprend une équerre HDMI, insérez l'équerre dans un logement disponible. 
Sécurisez la carte PCIe et l'équerre HDMI avec des vis, passez les câbles HDMI autour des autres cartes 
installées et branchez-les à l'arrière de la carte DeckLink. 

Étape 4. Remettez le capot de votre ordinateur en place et connectez les câbles épanouis fournis. Si vous possédez 
une carte DeckLink Optical Fiber, réinsérez le module fibre optique. Reconnectez la fiche d'alimentation et 
rebranchez l'ordinateur.

Installez une carte PCIe Blackmagic dans un logement disponible. 
Une équerre HDMI peut être installée dans n'importe quel port 
disponible et se connecte à l'arrière de la carte au moyen des câbles 
HDMI fournis.

Connectez le câble épanoui s'il a été fourni avec votre carte Blackmagic. 
Certains modèles comprennent également une  
équerre HDMI comme le montre l'image ci-dessus.
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Connecter du matériel vidéo Blackmagic avec Thunderbolt
Étape 1. Si votre matériel vidéo Blackmagic comprend une alimentation externe, connectez-la à l'appareil et mettez 

ce dernier en marche.

Étape 2. Connectez un câble Thunderbolt entre l'appareil et le port Thunderbolt de votre ordinateur. Vous pouvez 
également le connecter à la baie de stockage Thunderbolt de votre ordinateur.

Étape 3. Si le logiciel Desktop Video a été préalablement installé et vous propose une mise à jour du logiciel interne, 
cliquez sur Update et suivez les instructions affichées à l'écran.

Étape 4. Si un câble épanoui est fourni, connectez-le au matériel vidéo Blackmagic et branchez les connecteurs à 
votre équipement vidéo.

Connecter du matériel vidéo Blackmagic avec USB 3.0
Étape 1. Si votre matériel vidéo Blackmagic comprend une alimentation externe, connectez-la à l'appareil et mettez 

ce dernier en marche.

Étape 2. Connectez un câble USB 3.0 SuperSpeed entre l'appareil et le port USB 3.0 dédié sur votre ordinateur.

Étape 3. Si le logiciel Desktop Video a été préalablement installé et vous propose une mise à jour du logiciel interne, 
cliquez sur Update et suivez les instructions affichées à l'écran.

Étape 4. Si un câble épanoui est fourni, connectez-le au matériel vidéo Blackmagic et branchez les connecteurs à 
votre équipement vidéo.

Les produits Thunderbolt™ et USB 3.0 se connectent à votre 
ordinateur au moyen d'un seul câble Thunderbolt ou USB 3.0.

L'UltraStudio 4K est doté de deux ports Thunderbolt 2™. Si votre 
ordinateur ne possède qu'un seul port Thunderbolt™, vous pouvez 
utiliser le port supplémentaire pour connecter un RAID ou un autre 
appareil.

PUSH

PUSH
PUSH
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Installer le logiciel de Blackmagic Design

Applications, plug-ins et pilotes
Le tableau ci-dessous dresse une liste des applications, plug-ins et pilotes inclus lors de l'installation du logiciel  
Desktop Video.

Mac OS X Windows Linux

Pilotes Blackmagic Desktop Video Pilotes Blackmagic Desktop Video Pilotes Blackmagic Desktop Video

Préférences système Blackmagic 
Design

Blackmagic Design Control Panel Blackmagic Design Control Panel

Blackmagic Design LiveKey Blackmagic Design LiveKey Blackmagic Media Express

Blackmagic Media Express Blackmagic Media Express Codecs Blackmagic AVI

Codecs Blackmagic QuickTime™ Codecs Blackmagic AVI et 

QuickTime™

Blackmagic Disk Speed Test Blackmagic Disk Speed Test

Préréglages et plug-ins Adobe® 

Premiere Pro® CC, After Effects® CC 

et Photoshop®

Préréglages et plug-ins Adobe® 

Premiere Pro® CC, After Effects® CC 

et Photoshop®

Plug-ins Apple Final Cut Pro™ X Plug-in Avid Media Composer

Plug-in Avid Media Composer Plug-ins Fusion d'Eyeon
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Installation sur Mac OS X
Avant de pouvoir installer le moindre logiciel, il vous faut bénéficier des privilèges d'administrateur.

Étape 1. Assurez-vous de disposer du dernier pilote. Consultez www.blackmagicdesign.com/support

Étape 2. Ouvrez le dossier intitulé « Desktop Video Installer » à partir du disque ou de l'image du disque téléchargée 
et lancez le programme d'installation « Desktop Video Installer ».

Étape 3. Cliquez sur les touches Continue, Agree et Install pour installer le logiciel.

Étape 4. Redémarrez votre ordinateur pour activer les nouveaux pilotes du logiciel.

Mises à jour automatiques
Lors du redémarrage de votre Mac, le logiciel vérifiera la version du logiciel interne de votre matériel. Si la version du 
logiciel interne ne correspond pas à la version du pilote, il vous sera demandé de mettre le logiciel interne à jour. Cliquez 
sur OK pour commencer la mise à jour et redémarrez votre Mac pour mener à bien l'opération.

Installation sur Windows
Étape 1. Assurez-vous de disposer du dernier pilote. Consultez www.blackmagicdesign.com/support

Étape 2. Ouvrez le dossier intitulé « Desktop Video » et lancez le programme d'installation « Desktop Video ».

Étape 3. Les pilotes s'installent à présent sur votre système. Une alerte vous demandant de confirmer l'installation du 
logiciel sur votre ordinateur va s'afficher : “Do you want to allow the following program to install software on 
this computer?”  Cliquez sur Yes pour continuer.

Étape 4. Une boîte de dialogue apparaîtra ensuite pour vous informer que du nouveau matériel a été détecté et 
l'assistant ajout de matériel va s'afficher. Sélectionnez "install automatically" (installation automatique) et le 
système détectera les pilotes Desktop Video requis. Une autre boîte de dialogue vous indiquera ensuite que 
votre nouveau périphérique est prêt à être utilisé.

Étape 5. Redémarrez votre ordinateur pour activer les nouveaux pilotes du logiciel.

Mises à jour automatiques
Lors du redémarrage de votre ordinateur, le logiciel vérifiera la version du logiciel interne de votre matériel. Si la version 
du logiciel interne ne correspond pas à la version du pilote, il vous sera demandé de mettre le logiciel interne à jour. 
Cliquez sur OK pour commencer la mise à jour et redémarrez votre ordinateur pour mener à bien l'opération.

Programme d'installation Desktop Video pour Mac

Programme d'installation Desktop Video pour Windows
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Installation sur Linux
Étape 1. Téléchargez la dernière version du logiciel Desktop Video pour Linux sur  

www.blackmagicdesign.com/support

Étape 2. Ouvrez le dossier intitulé « Desktop Video », repérez et ouvrez le paquet « Desktop Video » pour votre 
distribution Linux.

Étape 3. Cliquez sur le bouton « Install » et attendez que la barre de progression soit terminée.

Étape 4. Si vous obtenez des messages concernant des dépendances manquantes, vérifiez tout d'abord qu'elles ont 
bien été installées et réexécutez ensuite le programme d'installation Desktop Video.

Étape 5. Lorsque l'opération est terminée, le programme d'installation vous renverra au même écran.

Étape 6. Redémarrez l'ordinateur pour activer les pilotes ou saisissez la commande suivante :

 # modprobe blackmagic

Si vous ne trouvez pas de paquet natif Desktop Video pour votre distribution Linux, ou si vous préférez effectuer 
l'installation à partir d'une ligne de commande, référez-vous au fichier ReadMe pour obtenir des instructions 
d'installation plus détaillées.

Mises à jour
Après le redémarrage de votre ordinateur, les pilotes vérifieront le matériel vidéo Blackmagic pour voir quel logiciel 
interne le matériel contient. Si la version du logiciel interne ne correspond pas à la version du pilote, Desktop Video vous 
demandera une mise à jour. Pour trouver le numéro d'identification de la carte qui doit être mise à jour, ouvrez le terminal 
et saisissez la commande suivante :

# BlackmagicFirmwareUpdater status

Un message qui ressemble à cela apparaîtra à l'écran :

/dev/blackmagic/card0 [DeckLink HD Extreme 3] UPDATED (mis à jour)
/dev/blackmagic/card1 [DeckLink HD Extreme 3] NEEDS_UPDATE (doit être mis à jour) 

Notez le numéro d'identification de la carte qui doit être mise à jour puis mettez à jour le firmware en saisissant :

# BlackmagicFirmwareUpdater update <card_id> (1 dans ce cas de figure)

Le logiciel Desktop Video est prêt à être installé à partir  
de l'Ubuntu Software Center.
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Capturer et lire de la vidéo
Il est judicieux d'effectuer un test rapide pour vous assurer que vous arrivez à capturer et à lire de la vidéo.

Installation
Étape 1. Connectez un moniteur vidéo ou une télévision à la sortie vidéo de votre matériel vidéo Blackmagic.

Étape 2. Connectez une source vidéo à l'entrée vidéo de votre matériel vidéo Blackmagic.

Étape 3. Utilisez les préférences système de Blackmagic pour configurer vos connexions vidéo et audio pour l'entrée 
et la sortie. Référez-vous à la section « Utilisation des préférences système de Blackmagic » pour obtenir de 
plus amples informations.

Tester la capture vidéo
Étape 1. Allez sur Media Express>Preferences sur Mac OS X, ou Edit>Preferences sur Windows ou Linux puis 

sélectionnez un format de projet qui correspond à votre source vidéo. Choisissez également un format pour 
le fichier de capture et un emplacement de stockage.

Étape 2. Fermez les Préférences et cliquez sur l'onglet intitulé Log and Capture. Votre source vidéo apparaîtra dans 

la fenêtre de prévisualisation de Media Express.

Étape 3. Cliquez sur le bouton Capture pour effectuer le test de capture. Cliquez sur le même bouton pour terminer 
le test.

Tester la lecture vidéo
Étape 1. Cliquez sur l'onglet Playback.

Étape 2. Double-cliquez sur le clip test et la vidéo apparaîtra sur le moniteur connecté à la sortie de votre matériel 
vidéo Blackmagic. La sortie audio peut également être contrôlée.

Camera Outputs

HDTV

Cliquez sur le bouton « Capture » pour commencer l'enregistrement.

Connectez un moniteur vidéo et une source à votre matériel  
vidéo Blackmagic.
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Lancer les préférences système de Blackmagic
Les préférences système de Blackmagic procurent un emplacement central pour la configuration des paramètres.

 � Sur Mac OS X, ouvrez les préférences système et cliquez sur l'icône Blackmagic Design.

 � Sur Windows 7 et Windows 8, ouvrez le Panneau de configuration et cliquez sur la catégorie « Matériel et 
audio » puis cliquez sur « Blackmagic Design Control Panel ».

 � Sur Linux, allez sur « Applications » puis sur « Son et vidéo » et double-cliquez sur l'intitulé Blackmagic  

Control Panel.

Chaque modèle de matériel vidéo Blackmagic possède des fonctionnalités différentes. Seules les préférences système 
compatibles avec votre modèle seront actives.

La section suivante vous guidera à travers la configuration des préférences système de Blackmagic.

Préférences système de Blackmagic Design sur Mac OS X Panneau de configuration Blackmagic Design sur Windows Panneau de configuration Blackmagic Design sur Ubuntu de Linux

Utilisation des préférences système de Blackmagic
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Onglet Settings (paramètres)

Configurer les connexions de sortie (set output) 
Configurez les connexions de sortie vidéo et audio pour votre matériel vidéo Blackmagic. Certains modèles vous 
permettent de choisir entre de la vidéo composante analogique, de la S-Video ou de la vidéo composite analogique. 
D'autres modèles comprennent des sorties audio commutables qui vous permettent de choisir entre de l'audio 

analogique ou AES/EBU.

Configurer les connexions d'entrée (set input)  
Configurez les connexions d’entrée vidéo et audio pour votre matériel vidéo Blackmagic. Votre matériel peut prendre 
en charge certaines ou toutes les combinaisons suivantes :

 � Vidéo SDI et Audio SDI

 � Vidéo SDI et Audio AES/EBU

 � Vidéo SDI et Audio analogique XLR

 � Vidéo SDI fibre optique et Audio SDI fibre optique

 � Vidéo HDMI et Audio HDMI

 � Vidéo HDMI et Audio AES/EBU

 � Vidéo HDMI et Audio analogique XLR

 � Vidéo composante et Audio AES/EBU

 � Vidéo composante et Audio analogique XLR

 � Composite et Audio AES/EBU

 � Composite et Audio analogique XLR

 � S-Video et Audio AES/EBU

 � S-Video et Audio analogique XLR

Niveau de noir de la vidéo en NTSC 
Configurez le niveau de noir sur 7,5 IRE pour la vidéo composite NTSC utilisée aux USA et dans quelques autres pays. 
Sélectionnez le paramètre 0 IRE si vous travaillez au Japon ou dans des pays qui n'utilisent pas la configuration 7,5 IRE. 
Ce paramètre n'est pas applicable pour les formats PAL et haute définition.

Connexions de sortie vidéo et audio.

Connexions d'entrée vidéo et audio.

Faites votre sélection entre 7,5 IRE et 0 IRE pour la vidéo 
composite NTSC.
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Utiliser le format SDI 4:4:4 sur la sortie vidéo si possible
Sélectionnez ce paramètre lorsque vous acheminez de la vidéo 4:4:4. La vidéo 1080p50/60 sera toujours acheminée au 
format 4:2:2. Lorsque la sortie vidéo en 4:4:4 est activée, les fonctionnalités suivantes ne sont pas disponibles :

 � sorties vidéo HD et SD down-convertie simultanées

 � sortie vidéo analogique down-convertie

Utiliser un signal de sortie SDI 3/6Gb non pas un signal SDI Dual Link
Sélectionnez ce paramètre pour utiliser le format 3G ou 6G SDI Single Link lorsque vous utilisez des formats à haute 
bande passante tels que 1080p60 et 4:4:4 ou des formats 4K.

Utiliser le format 1080p non pas le format 1080PsF
Sélectionnez ce paramètre pour acheminer de la véritable vidéo progressive au lieu de vidéo progressive à image 
segmentée.

Supprimer la gigue lors d'une mise en pause de la vidéo
Sélectionnez ce paramètre pour éliminer le papillotement de la trame lorsque de la vidéo entrelacée est mise en pause 
sur les vieux moniteurs CRT en affichant une seule trame. Cette option n'est pas recommandée pour les écrans plats 
modernes.

Utiliser l'entrée timecode LTC
Sélectionnez ce paramètre pour lire le timecode à partir de l'entrée LTC au lieu du flux SDI.

Cochez cette case pour acheminer de la vidéo 4:4:4.

Cochez cette case pour utiliser de la vidéo 3G ou 6G SDI Single Link.

Cochez cette case pour acheminer de la véritable vidéo 
progressive 1080.

Cochez cette case pour éliminer le papillotement de la trame sur les 
moniteurs CRT.

Cochez cette case pour lire le timecode à partir de l'entrée LTC.
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Configurer la norme vidéo par défaut
Pour faire du monitoring broadcast avec Final Cut Pro X, configurez la norme vidéo qui correspond à votre projet Final 
Cut Pro X.

Pour capturer de la vidéo sur Windows avec un programme qui prend en charge le WDM, configurez la norme vidéo 
par défaut en la faisant correspondre à la norme de capture. La norme vidéo est en général configurée à partir des 
préférences du programme WDM, toutefois, utilisez le Panneau de configuration Blackmagic Design en cas de 

problème.

Lorsque la vidéo n'est pas en lecture, envoyer...
Ce paramètre détermine si le matériel va acheminer la dernière image lue (last frame played) ou du noir (black) lorsque 
vous quittez une application et qu'il n'y a plus de vidéo en lecture.

Certains modèles Blackmagic comprennent des tables de correspondance (LUT) et l'option « Last Played Frame » vous 
permet d'observer les effets causés par les changements apportés à la LUT. L'activation ou la désactivation de cette 
fonction nécessite un redémarrage de l'ordinateur.

Afficher la vidéo HDMI 3D en tant que...
Ce paramètre détermine le format 3D de votre monitoring HDMI. Faites votre choix entre les options : Frame Packing, 
Side by Side, Line by Line, Top and Bottom, Left Eye ou Right Eye.

Configurer la synchronisation de la sortie de référence
Si un signal de référence est connecté mais que votre image se déplace verticalement, ajustez le curseur jusqu'à ce que 
l'image se stabilise. Le signal de référence peut également être appelé genlock, black burst, house sync ou tri-sync.

Sélectionnez le format 3D de votre monitoring HDMI.

Configurez la norme vidéo par défaut pour la faire correspondre à 
votre projet Final Cut Pro X ou pour faire de la capture avec votre 
programme WDM.

Lorsqu'il n'y a pas de vidéo en lecture, vous avez le choix d'envoyer la 
dernière image lue ou du noir.

Ajustez le curseur jusqu'à ce que l'image se stabilise.
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Onglet Processing (traitement)

Sélection du traitement du signal de sortie
Ce paramètre permet une down-conversion en temps réel durant la lecture. Sélectionnez l'option désirée à partir 
du menu.

Certains modèles de matériel prennent en charge une down-conversion simultanée des signaux telle que HD et SD ou 
2K et SD. La down-conversion simultanée engendre un décalage de 2 images sur le signal de sortie SD-SDI. Ajustez le 
décalage de timecode de votre logiciel de montage pour garantir une précision à l'image près lors de l'insertion ou de 
l'assemblage sur bande.

Les sorties vidéo analogiques sont également down-converties. La vidéo composante analogique peut être commutée 
entre un signal de sortie HD ou SD. Pour visualiser de la vidéo composante analogique SD, sélectionnez la fonction  
« Enable Conversion on Analog Output » (activer la conversion sur le signal de sortie analogique), lorsque la fonction  
« Simultaneous HD and SD Output » (acheminer de la HD et SD simultanément) est également sélectionnée.

Sélection du traitement du signal d'entrée
Ce paramètre permet une down-conversion et une up-conversion en temps réel durant la capture. Sélectionnez l'option 
désirée à partir du menu.

Acheminer de la HD 23,98PsF en tant que HD 59,94i (uniquement sur Windows)
Ce paramètre appliquera un pulldown 3:2 afin que la vidéo HD 23,98 PsF soit acheminée en tant que HD 59,94i. La 
fréquence d'image de film de 23,98 i/s est assez courante mais elle est rarement prise en charge par les moniteurs SDI 
et analogiques, alors que presque tous les moniteurs HD prennent en charge la HD 59,94i.

Configurer la référence VITC de l'image A
Ce paramètre vous permet de saisir le numéro de l'image A (A-frame) lors de la suppression du pulldown 3:2 de la vidéo 

NTSC pendant la capture à 23,98 i/s. La mauvaise image A produira une présentation erronée des trames et des images.

Capturer les lignes VANC du signal d'entrée
Ces paramètres permettent à 3 lignes représentant le timecode, les informations VITC relatives aux sous-titres ou 
n'importe quelles autres données auxiliaires verticales (VANC) d'être conservées pendant la capture. Pour conserver les 
données VANC, cochez la case représentant la ligne vidéo que vous souhaitez capturer. La ligne 1 doit être activée pour 
que les lignes 2 et 3 fonctionnent.

Sélectionnez le traitement du signal de sortie à partir du menu.

Cochez cette case pour acheminer de la HD 23,98PsF en tant que HD 
59,94i

Configurez la référence VITC de l'image A lorsque vous effectuez un 
pulldown 3:2.

Cochez ces cases pour capturer les lignes de données VANC.
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Onglet Video Levels (niveaux de la vidéo)
Calibrer l'entrée vidéo analogique
Ces paramètres ajustent l'entrée vidéo analogique. Utilisez les curseurs pour ajuster les niveaux Video, Chroma, Cb 
(couleur bleue) et Cr (Couleur rouge). Il est préférable d'ajuster ces paramètres conjointement avec le Blackmagic 
Ultrascope. Les paramètres de calibrage de l'entrée vidéo analogique ne sont disponibles que si l'option « Set input » 
située dans l'onglet Settings est configurée sur entrée vidéo analogique.

Calibrer la sortie vidéo analogique
Ces paramètres ajustent la sortie vidéo analogique. Utilisez les curseurs pour ajuster les niveaux Video, Chroma, Cb 
(couleur bleue) et Cr (Couleur rouge). Il est préférable d'ajuster ces paramètres conjointement avec le Blackmagic 
Ultrascope.

Utiliser les niveaux YUV Betacam 
Les produits Blackmagic prennent en charge les niveaux composante analogique SMPTE par défaut car la plupart du 
matériel vidéo moderne utilise des niveaux conformes aux normes SMPTE. Activez la case « Use Betacam YUV Levels » 
si vous travaillez avec des magnétoscopes Betacam SP de Sony.

Onglet Audio Levels (niveaux audio)
Configurer les niveaux des entrées audio analogique
Ces paramètres ajustent le gain des entrées audio analogique. 

Configurer les niveaux des sorties audio analogique 
Ces paramètres ajustent le gain des sorties audio analogique. 

Configurer le niveau de référence des signaux d'entrée AES/EBU
Ces paramètres ajustent le gain des entrées audio AES/EBU. Bien que les canaux audio analogiques puissent être 
ajustés de manière indépendante, les canaux audio AES/EBU s'ajustent simultanément.

Configurer le niveau de référence des signaux de sortie AES/EBU
Ces paramètres ajustent le gain des sorties audio AES/EBU. Bien que les canaux audio analogiques puissent être ajustés 
de manière indépendante, les canaux audio AES/EBU s'ajustent simultanément. 

Utiliser des niveaux audio HiFi
Les modèles UltraStudio et DeckLink sont pourvus de connecteurs XLR offrant des niveaux audio analogique 
professionnels. Pour connecter du matériel audio grand public, activez la fonction « Use HiFi Audio Levels » et utilisez 
un adaptateur XLR vers RCA. 

Les curseurs permettent d'ajuster les niveaux Video et Chroma de la 
vidéo analogique. 

Les curseurs ajustent le gain de l'audio analogique et AES/EBU. 
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After Effects® CC

Prévisualiser de la vidéo
Pour afficher votre composition After Effects® CC en temps réel sur votre matériel Blackmagic, allez sur Préférences > 
Prévisualisation vidéo.  Sélectionnez la sortie vidéo Blackmagic et le mode de sortie approprié. Vous pouvez à présent 
utiliser un moniteur broadcast pour visualiser vos compositions After Effects® CC dans l'espace colorimétrique vidéo 
approprié.

Pour écouter de l'audio sur votre matériel Blackmagic, allez sur les préférences système de Mac OS X ou le panneau 
de configuration de Windows et configurez Blackmagic Audio en tant que périphérique de sortie audio par défaut. 
Dans After Effects® CC, allez sur Préférences > Matériel Audio et assurez-vous que votre signal de sortie audio est bien 
configuré sur « Entrée/sortie par défaut du système » sur Mac OS X ou « Blackmagic Audio » sur Windows.

Faire un rendu
Lorsque votre composition est terminée, il vous faudra faire un rendu avec un codec pris en charge par votre matériel 
vidéo Blackmagic. Vous pouvez faire un rendu d'une séquence d'image DPX ou de n'importe lequel des codecs suivants : 

Les autres codecs y compris ProRes et DVCPRO HD seront disponibles si vous avez installé Final Cut Pro.

Les autres codecs y compris DVCPRO HD et DVCPRO50 seront disponibles si vous avez installé Adobe® 
Premiere Pro® CC.

After Effects® CC

Options de rendu « Paramètres du module de sortie »

Préférences de la prévisualisation vidéo  � Blackmagic 10 bit 4:4:4 (non compressé)

 � Blackmagic 10 bit 4:2:2 (non compressé)

 � Blackmagic HD 8 bit 4:2:2 (non compressé)

 � Blackmagic SD 8 bit 4:2:2 (non compressé)

 � Blackmagic 8 bit MJPEG (compressé)

Codecs AVI sur Windows

 � Blackmagic RGB 10 bit (non compressé)

 � Blackmagic 10 bit (non compressé)

 � Blackmagic 8 bit (non compressé)

 � Apple Photo - JPEG (compressé)

 � Apple DV - NTSC (compressé)

 � Apple DV - PAL (compressé)

Codecs QuickTime sur Windows

 � Blackmagic RGB 10 bit (non compressé)

 � Apple Uncompressed YUV 10 bit 4:2:2

 � Apple Uncompressed YUV 8 bit 4:2:2

 � Apple Photo - JPEG (compressé)

 � Apple DV - NTSC (compressé)

 � Apple DV - PAL (compressé)

Codecs QuickTime sur Mac OS X

Utiliser votre logiciel tiers favori
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Photoshop® CC

Importer et exporter des images vidéo

Importer une image dans Photoshop® CC

Étape 1. Sur Photoshop® CC, sélectionnez la fonction de capture d'image Blackmagic à partir du menu Fichier > 
Importer.

Étape 2. Sélectionnez le format de l'entrée vidéo et la profondeur de bits de l'image puis cliquez sur Importer l'image.

Exporter une image de Photoshop® CC

Étape 1. Sélectionnez Fichier > Exporter > Exporter une image Blackmagic.

Étape 2. Sélectionnez le format de la sortie vidéo puis cliquez sur Exporter l'image.

Une fois que les options d'importation et d'exportation ont été configurées, la fenêtre de paramètres ne s'affichera 
plus lors d'importations et d'exportations ultérieures. Toutefois, vous pouvez toujours changer vos paramètres en 
maintenant enfoncée la touche Option (Mac) ou Ctrl (Windows) lors de la sélection d'importations ou d'exportations.

Importer une image

Exporter une image

Photoshop® CC
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Adobe® Premiere Pro® CC

Créer un projet Blackmagic Design
Étape 1. Créez un nouveau projet, cliquez sur l'onglet Scratch Disks (Disques de travail) et choisissez l'emplacement 

et le nom désirés pour votre projet.

Étape 2. Configurez l'emplacement de votre vidéo capturée, audio capturé, prévisualisations vidéo et prévisualisations 
audio.

Étape 3. Si votre carte graphique est compatible avec le moteur Mercury Playback Engine d'Adobe® Premiere Pro® 
CC, l'option de rendu sera disponible et il vous faudra sélectionner l'option « Mercury Playback Engine GPU 
Acceleration » (Accélération GPU Mercury Playback Engine).

Étape 4. Configurez le format d'acquisition sur acquisition Blackmagic et cliquez sur le bouton Paramètres (Mac) ou 
Propriétés (Windows) pour révéler les paramètres d'acquisition Blackmagic de votre projet. Choisissez le 
standard et le format vidéo et cliquez sur OK.

Étape 5. La fenêtre Nouvelle Séquence apparaîtra. Sélectionnez la préconfiguration Blackmagic désirée, donnez un 
nom à la séquence et cliquez sur OK.

Contrôle de périphérique
De nombreux modèles de matériel d'acquisition et de lecture Blackmagic Design comprennent un contrôle de 
périphérique RS-422 pour le contrôle des magnétoscopes. Le contrôle de périphérique Blackmagic doit être sélectionné 
à chaque fois qu'un nouveau projet est créé. Allez sur Préférences > Pilotage de matériel (Device Control) et sélectionnez 
le pilotage de matériel Blackmagic.

Lecture
Les paramètres de lecture doivent être sélectionnés à chaque fois qu'un nouveau projet est créé. Pour ce faire, il vous 
suffit d'aller sur Préférences > Lecture. Le lecteur par défaut est Adobe Player mais il vous faudra sélectionner la lecture 
Blackmagic (Blackmagic Playback) dans la section Matériel audio (Audio Device).

Dans la section Matériel vidéo (Video Device), cochez la case représentant la lecture Blackmagic et vérifiez que les autres 
cases ne sont pas activées puis cliquez sur OK.

Nouvelle séquence

Adobe® Premiere Pro® CC
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Acquisition
Pour capturer allez sous : Fichier > Acquisition [F5]

Pour une acquisition immédiate, ou une acquisition à partir de matériel non pilotable, cliquez sur le bouton 
d'enregistrement rouge [G].

Si vous souhaitez enregistrer le clip à l'aide du contrôle de périphérique RS-422, saisissez les points d'entrée et de 
sortie désirés à l'aide des boutons dédiés ou manuellement en saisissant le code temporel et en cliquant sur la touche 
Enregistrer l'élément (Log Clip). Le clip vide apparaîtra dans la fenêtre Projet. Répétez l'action jusqu'à ce que vous 
ayez enregistré tous les clips que vous souhaitez capturer en série. Puis choisissez : Fichier > Acquisition en série [F6]. 
Pour configurer des marges sur les clips, activez l'option d'acquisition avec marges et saisissez le nombre d'images 
supplémentaires requises au début et à la fin de chaque clip.

Exportation sur bande
Pour une exportation sur bande via le contrôle de périphérique RS-422, sélectionnez la séquence désirée et sélectionnez 
Fichier > Exportation > Exporter sur bande.

Le montage par insertion nécessite un timecode continu sur toute la longueur du projet qui va être enregistré sur 
bande.

En mode assemblage, la bande ne doit être noire que jusqu'à un point situé juste après le début du projet. Comme le 
montage par assemblage efface la bande située avant les têtes d'enregistrement, il ne devrait pas être utilisé lorsque 
d'autres projets existent déjà sur la bande après le point de sortie de votre montage.

Lors du montage sur bande, le logiciel attend à la première image de votre projet que le magnétoscope commence 
l'enregistrement au timecode prédéterminé. Au cas où la première image de votre programme aurait été répétée ou 
perdue durant la procédure de montage sur bande, il vous faudra ajuster le décalage de lecture pour synchroniser 
le magnétoscope et l'ordinateur. Vous n'aurez à le faire qu'une seule fois indépendamment du magnétoscope et de 
l'ordinateur car ce paramètre sera gardé en mémoire.

Il vous suffit à présent de saisir le point d'entrée et le décalage désirés et de cliquer sur OK (Mac) ou Exporter (Windows).

Acquisition

Exportation sur bande
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Apple Final Cut Pro X

Apple Final Cut Pro X
Vous pouvez utiliser la fonctionnalité de monitoring broadcast de Final Cut Pro X 10.0.4 et acheminer plus tard votre 
vidéo à du matériel vidéo Blackmagic. Vous pouvez également utiliser deux écrans d'ordinateur pour l'interface de 
Final Cut Pro X.

Configurer Final Cut Pro X
Étape 1. Vérifiez que vous êtes en possession de la version Final Cut Pro X 10.0.4 ou plus récente avec la dernière 

version de Mac OS X Mountain Lion ou Mavericks.

Étape 2. Ouvrez les préférences système et cliquez sur Blackmagic Design. Allez sur le paramètre permettant de 
configurer le standard vidéo par défaut (Set default video standard as) et choisissez le même standard que 
vous allez utiliser dans votre projet Final Cut Pro X, par ex. HD 1080i59.94. Le standard doit être identique à 
celui du format vidéo de vos clips.

Étape 3. Lancez Final Cut Pro X et créez un nouveau projet.

Étape 4. Saisissez un nom et choisissez un emplacement pour le nouveau projet.

Étape 5. Sous le paramètre Propriétés vidéo, choisissez l'option Personnalisées et configurez ensuite le format, la 
résolution et le débit correspondant au standard vidéo par défaut réglé dans les préférences système de 
Desktop Video.

Étape 6. Sous le paramètre Propriétés audio et de rendu, choisissez l'option Personnalisées. Configurez les canaux 
audio sur Stéréo. Vous pouvez également choisir l'option Surround pour 6 canaux audio. Configurez la 
fréquence d'échantillonnage audio sur 48kHz. Sous le paramètre Format du rendu, choisissez le même 
format que vos clips vidéo. Par défaut, Final Cut Pro X utilise de la compression ProRes mais vous pouvez 
modifier cela en sélectionnant le format 4:2:2 10 bits non compressé pour un workflow non compressé. 
Cliquez sur OK pour terminer la création de votre nouveau projet.

Étape 7. Allez sur le menu Final Cut Pro, choisissez Préférences et cliquez ensuite sur l'onglet Lecture. Vérifiez que le 
menu Sortie A/V affiche Blackmagic et que le standard vidéo est identique à celui de votre projet. Fermez les 
Préférences.

Étape 8. Allez dans le menu Fenêtre (Window) et sélectionnez l'option Sortie A/V pour activer la sortie vidéo via le 
matériel vidéo Blackmagic.

Si vous souhaitez faire du monitoring audio via le matériel vidéo Blackmagic, ouvrez les préférences système, cliquez sur 
l'icône son, puis cliquez sur l'onglet Sortie et sélectionnez l'audio Blackmagic en tant que sortie audio.

Étape 6. Sous le paramètre Propriétés audio et de rendu, choisissez 
l'option Personnalisées.

Étape 2. Configurez la norme vidéo par défaut qui correspond à votre 
projet Final Cut Pro X dans les préférences système.
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Lecture
Étape 1. Importez des clips dans votre nouveau projet.

Étape 2. Vous pouvez à présent utiliser la timeline Final Cut Pro X sur votre écran d'ordinateur et visualiser la 
prévisualisation de la vidéo sur l'écran ou sur une télévision connectée à la sortie de votre matériel vidéo 
Blackmagic Design.

Capturer de la vidéo et de l'audio
Vous pouvez utiliser le logiciel Blackmagic Media Express pour capturer de la vidéo et de l'audio à l'aide de votre 
matériel vidéo Blackmagic Design. Une fois les clips capturés, vous pouvez les importer dans Final Cut Pro X pour le 
montage.

Lorsque vous capturez des clips avec Media Express, il vous faudra choisir un des formats vidéo compatibles avec Final 
Cut Pro X, par ex. : Apple ProRes 4444, Apple ProRes 422 (HQ), Apple ProRes 422 ou 4:2:2 10 bits non compressé.

Montage sur bande
Une fois que vous avez terminé votre projet dans Final Cut Pro X, vous pouvez faire un rendu du projet puis utiliser 
Blackmagic Media Express pour faire un master sur bande à l'aide de votre matériel vidéo Blackmagic Design.

Étape 1. Sélectionnez vos clips à partir de la timeline de Final Cut Pro X.

Étape 2. À partir du menu Partager (Share), choisissez l'option Exporter le média (Export Movie).

Étape 3. Dans la fenêtre d'exportation du média, sous le paramètre Exporter choisissez l'option « Réglages actifs » 
(Current Settings) et sous le paramètre Inclure (Include), choisissez l'option Vidéo et audio. Cliquez sur « Page 
suivante » (Next).

Étape 4. Ouvrez Media Express et importez le clip qui a été exporté de Final Cut Pro X.

Étape 5. Veuillez vous référez à la section Blackmagic Media Express de ce manuel pour obtenir des informations sur 
le montage des fichiers vidéo et audio sur bande.

Étape 3. Dans la fenêtre d'exportation du média, sous le paramètre 
Exporter choisissez l'option « Réglages actifs » (Current Settings) et 
sous le paramètre Inclure (Include), choisissez l'option Vidéo et audio.
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Avid Media Composer

Avid Media Composer
Le logiciel Avid Media Composer capture et lit de l'audio et de la vidéo en définition standard et en haute définition 
avec le matériel vidéo Blackmagic. Ce dernier prend également en charge le contrôle de périphérique RS-422. Les 
plug-ins Blackmagic pour Media Composer sont automatiquement installés si Media Composer a été installé avant le 
logiciel Desktop Video.

Configuration
Étape 1. Lancez le logiciel Media Composer et la boîte de dialogue vous permettant la sélection de votre projet va 

apparaître.

Étape 2. Choisissez le profil d'utilisateur désiré si vous en aviez déjà créé un auparavant.

Étape 3. Sélectionnez le dossier dans lequel vous souhaitez créer le projet : Private (privé), Shared (partagé) ou External 
(externe).

Étape 4. Cliquez sur le bouton New Project (nouveau projet).

Étape 5. Saisissez un nom de projet et configurez les options du projet y compris le format, l'espace colorimétrique 
et la 3D stéréoscopique. Cliquez sur OK. Les paramètres Color space et Stereoscopic peuvent être changés 
ultérieurement dans l'onglet Format du projet. 

Étape 6. Double-cliquez sur le nom du projet dans la boîte de dialogue Select Project. L'interface Media Composer 
apparaîtra avec la fenêtre de projet pour votre nouveau projet. La configuration de votre projet est à présent 
terminée.

Lecture
Afin de vérifier que tout est connecté correctement, reportez-vous à la section du Guide de montage de Media 
Composer intitulée « Importation de barres de couleurs et autres mires de test ». Double-cliquez sur le fichier importé 
pour le lire dans une nouvelle fenêtre. Vous devriez à présent voir l'image sur votre écran d'ordinateur ainsi que sur votre 
sortie Blackmagic.

Si vous ne voyez pas de vidéo sur votre sortie Blackmagic, revérifiez les connexions et les paramètres de sortie dans les 
préférences système de Blackmagic Design. Pour ce faire, allez sur Tools > Hardware Setup au sein du logiciel Media 
Composer.

Si vous utilisez un seul écran d'ordinateur, ouvrez les préférences 
système de Blackmagic Design et choisissez d'envoyer du noir 
lorsqu'il n'y pas de vidéo en lecture.

Étape 5. Saisissez un nom de projet et configurez les options du projet.
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Capturer à partir de matériel non pilotable
De nombreuses sources vidéo, y compris différentes sortes de caméras modernes et d'enregistreurs à disque, ainsi que 
des caméras plus anciennes et des magnétoscopes VHS, ne possèdent pas de contrôle de périphérique. Pour capturer 
de la vidéo sans contrôle de périphérique, suivez les étapes ci-après :

Étape 1. Pour ouvrir la fenêtre Capture Tool (outil de capture), allez sur Tools > Capture.

Étape 2. Cliquez sur le bouton permettant la commutation de la source pour qu'un cercle barré rouge s'affiche sur le 
bouton icône du magnétoscope. Ce symbole indique que le contrôle de périphérique a été désactivé.

Étape 3. Configurez les menus d'entrée Video et Audio sur Blackmagic.

Étape 4. Sélectionnez la piste vidéo (V) et les pistes audio (A1, A2, ...)  que vous souhaitez capturer.

Étape 5. Utilisez le menu Bin (chutier) pour sélectionner un chutier cible à partir de la liste des chutiers ouverts.

Étape 6. À partir du menu Res (résolution), choisissez le codec compressé ou non compressé que vous souhaitez 
utiliser pour vos clips capturés. Pour de la vidéo 8 bits non compressée, sélectionnez « 1:1 » et « 1:1 10b » 
pour du 10 bits.

Étape 7. Sélectionnez le disque de stockage pour votre vidéo et votre audio capturés. Utilisez le bouton Single/Dual 
Drive Mode pour choisir si la vidéo et l'audio seront stockés ensemble sur le même disque ou sur des disques 
séparés. Sélectionnez ensuite le ou les disque(s) cible pour votre média capturé à partir du menu Target 
Drive.

Étape 8. Cliquez sur le bouton « Tape Name? » situé au bas de la fenêtre pour ouvrir la boîte de dialogue qui permet 
la sélection de la bande. Sélectionnez la bande désirée, ou ajoutez une nouvelle bande, puis cliquez sur OK.

Étape 9. Vérifiez que votre vidéo et source audio sont prêtes ou en lecture, puis cliquez sur le bouton de capture. Le 
bouton de capture rouge clignotera pendant l'enregistrement. Pour arrêter la capture, cliquez à nouveau sur 
le même bouton.

Étape 2. Configurez les paramètres de la fenêtre Capture Tool pour 
capturer de la vidéo sans contrôle de périphérique en cliquant sur le 
bouton permettant de commuter la source.
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Capturer à partir de matériel pilotable avec UltraStudio, DeckLink et Teranex
Si vous possédez un magnétoscope qui se connecte via RS-422, il vous faudra configurer les paramètres du magnétoscope 
avant d'effectuer une capture avec le contrôle de périphérique.

Étape 1. À partir de la fenêtre de votre projet, cliquez sur l'onglet Settings (paramètres) et double-cliquez sur Deck 
Configuration (configuration du magnétoscope).

Étape 2. Dans la boîte de dialogue Deck Configuration, cliquez sur l'option Add Channel (ajouter un canal) puis 
configurez le paramètre Channel Type (type de canal) sur Direct et le paramètre Port sur RS-422 Deck Control 
(contrôle de périphérique RS-422). Cliquez sur OK et sélectionnez « No » lorsqu'on vous demandera si vous 
souhaitez une configuration automatique du canal (Do you want to autoconfigure the channel now?).

Étape 3. Cliquez sur Add Deck (ajouter un magnétoscope) et sélectionnez ensuite la marque et le modèle de 
magnétoscope à partir du menu listant les appareils. Configurez également le paramètre Preroll (temps de 
démarrage). Cliquez sur OK et puis sur Apply (appliquer).

Étape 4. Sous l'onglet Settings, double-cliquez sur Deck Preferences (préférences du magnétoscope).

Étape 5. Si vous allez faire du montage sur bande par assemblage, activez la fonction « Allow assemble edit & crash 
record for digital cut ». Si vous ne sélectionnez pas cette option, vous ne pourrez qu'effectuer du montage 
par insertion.

Étape 6. Activez la fonction « Relax coincidence point detection » et configurez les autres paramètres si nécessaire. 
Cliquez sur OK. La configuration de la connexion RS-422 à votre magnétoscope est à présent terminée.

Pour tester la connexion à distance, assurez-vous qu'un câble série RS-422 est connecté entre votre matériel vidéo 
Blackmagic et le magnétoscope. Configurez le magnétoscope sur Remote. Ouvrez la fenêtre Capture Tool et utilisez les 
raccourcis clavier standard J, K, L pour contrôler le magnétoscope. Si le nom d'un magnétoscope apparaît en italique 
ou que le message « NO DECK » est affiché, cliquez sur le menu et sélectionnez l'option « Check Decks » (vérifier les 
magnétoscopes) jusqu'à ce que le magnétoscope ne soit plus listé en italique et que le contrôle de périphérique soit 
rétabli.

Pour capturer de la vidéo à la volée avec contrôle de périphérique :

Étape 1. Pour ouvrir la fenêtre Capture Tool (outil de capture), allez sur Tools > Capture.

Étape 2. Le bouton de mode Capture/Log devrait afficher l'icône CAP. Si ce bouton affiche l'icône LOG, cliquez sur 
ce dernier pour le mettre en mode capture; l'icône CAP devrait alors apparaître.

Étape 3. Le bouton permettant la commutation de la source devrait afficher l'icône magnétoscope. Si vous voyez 
un cercle rouge barré, cliquez sur le bouton pour activer le contrôle de périphérique et faire disparaître le 
symbole rouge.

Étape 4. Configurez les entrées vidéo et audio, les pistes des sources vidéo et audio, le chutier cible, la résolution, 
le disque cible et le nom de la bande comme décrit précédemment dans la section « Capturer à partir de 
matériel non pilotable ».

Étape 5. Utilisez la section de contrôle du magnétoscope située dans la fenêtre Capture Tool pour positionner la 
bande et commencer la lecture.

Étape 6. Cliquez sur le bouton de capture. Le bouton de capture rouge clignotera pendant l'enregistrement. Pour 
arrêter la capture, cliquez à nouveau sur le même bouton.

Étape 6. Dans la fenêtre relative aux préférences du magnétoscope, 
activez la fonction « Relax coincidence point detection ».

Configurez le bouton CAP et le bouton permettant la commutation 
de la source pour utiliser le contrôle de magnétoscope. Utilisez la 
section de contrôle du magnétoscope pour positionner la bande et 
commencer la lecture.
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Capturer en série avec UltraStudio et DeckLink
Pour enregistrer des clips pour l'acquisition en série :

Étape 1. Pour ouvrir la fenêtre Capture Tool (outil de capture), allez sur Tools > Capture.

Étape 2. Cliquez sur le bouton permettant la sélection du mode Capture/Log afin que ce dernier affiche l'icône LOG.

Étape 3. Configurez les entrées vidéo et audio, les pistes des sources vidéo et audio, le chutier cible, la résolution, 
le disque cible et le nom de la bande comme décrit précédemment dans la section « Capturer à partir de 
matériel non pilotable ».

Étape 4. Utilisez la section de contrôle du magnétoscope ou les raccourcis clavier standard j, k, l pour faire une avance 
ou un retour rapide de la vidéo, mettre la vidéo en pause et repérer la vidéo que vous souhaitez capturer.

Étape 5. Cliquez sur le bouton permettant de marquer les points d'entrée et de sortie; ce dernier est situé à gauche 
du bouton LOG. L'icône va alterner entre point d'entrée et point de sortie, ce qui vous permet de marquer 
tous vos points d'entrée et de sortie avec le même bouton.  Cette option peut s'avérer plus pratique que 
d'utiliser les boutons de point d'entrée et de sortie indépendants situés dans la section de contrôle du 
magnétoscope. Vous pouvez également utiliser les touches « i » et « o » de votre clavier pour marquer les 
points d'entrée et de sortie.

Étape 6. Lorsque vous avez terminé d'enregistrer les points d'entrée et de sortie, ouvrez le chutier d'enregistrement 
et sélectionnez les clips que vous souhaitez capturer.

Étape 7. Sélectionnez Clip > Batch Capture (acquisition en série), puis sélectionnez les options désirées dans la boîte 
de dialogue et cliquez sur OK.

Enregistrer sur bande avec UltraStudio et DeckLink
Une fois que vous avez capturé vos clips, que vous les avez déposés dans la timeline, édités et appliqué vos effets, vous 
pourrez enregistrer le projet terminé sur bande.

Étape 1. Double-cliquez sur une séquence dans le chutier de votre projet pour l'ouvrir dans la fenêtre timeline.

Étape 2. Sélectionnez Output > Digital Cut pour ouvrir l'outil Digital Cut.

Étape 3. Configurez le paramètre Output Mode (mode de sortie) sur Real-Time (temps réel), le paramètre Bit Depth 
(profondeur de bits) sur 10-bits et le paramètre Deck Control (contrôle de magnétoscope) sur Remote (à 
distance).

Étape 4. À partir du menu Edit, choisissez la fonction Insert Edit (montage par insertion) ou Assemble Edit (montage 
par assemblage) pour un montage précis sur une bande pistée. Vous pouvez également sélectionner la 
fonction Crash Record qui vous offre un moyen très facile d'enregistrer. Si seule l'option Insert Edit est 
disponible, allez sur l'onglet Settings (paramètres) de votre projet, double-cliquez sur Deck Preferences 
(préférences du magnétoscope) et activez la fonction « Allow assemble edit & crash record for digital cut ».

Étape 5. Si le nom d'un magnétoscope apparaît en italique ou que le message « NO DECK » est affiché, cliquez sur le 
menu et sélectionnez l'option « Check Decks » (vérifier les magnétoscopes) jusqu'à ce que le magnétoscope 
ne soit plus listé en italique et que le contrôle de périphérique soit rétabli.

Étape 6. Appuyez sur le bouton de lecture de l'outil Digital Cut (triangle rouge) pour enregistrer votre séquence sur 
bande.

Étape 5. Cliquez sur le bouton représentant les points d'entrée et 
de sortie ou utilisez les touches « i » et « o » de votre clavier pour 
marquer les points d'entrée et de sortie.

L'outil Digital Cut est utilisé pour l'enregistrement sur bande.
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Autodesk Smoke

Autodesk Smoke 2013 Extension 1
Le logiciel Autodesk Smoke réunit le montage, le compositing et les effets 3D dans un seul espace de travail. Smoke 
capture et lit de l'audio et de la vidéo en définition standard et en haute définition avec le matériel vidéo Blackmagic. Ce 
dernier prend également en charge le contrôle de périphérique RS-422. Avant d'installer le logiciel Autodesk Smoke, 
assurez-vous que les pilotes Blackmagic Design et votre matériel vidéo sont correctement installés.

Le monitoring broadcast de Smoke vous permet d'acheminer de la vidéo via le matériel Blackmagic.

Installation
Étape 1. Lancez Smoke et la fenêtre relative aux paramètres du projet et de l'utilisateur apparaîtra. Sélectionnez 

votre projet et l'utilisateur si vous les aviez créés auparavant. Le cas échéant, créez un nouveau projet et/ou 
utilisateur.

Étape 2. Configurez les paramètres du projet pour les faire correspondre aux paramètres de rendu, par ex., 1080HD. 
La plupart de ces paramètres peuvent être modifiés ultérieurement pendant votre session.

Étape 3. Choisissez votre format intermédiaire, tel que ProRes 422 ou même non compressé pour les médias générés 
par votre projet. N'oubliez pas de choisir un format que votre disque puisse prendre en charge.

Étape 4. Cliquez sur le bouton Create.

Installation du matériel
Il est judicieux de suivre les étapes suivantes lorsque vous vous préparez pour une session VTR.

Étape 1. Connectez les sorties de votre magnétoscope aux entrées de votre matériel d'acquisition et de lecture 
Blackmagic. Connectez les sorties de votre matériel d'acquisition et de lecture Blackmagic aux entrées de 
votre magnétoscope.

Étape 2. Connectez un câble de contrôle de périphérique RS-422 à partir du port série de votre magnétoscope au 
port de contrôle à distance de votre matériel d'acquisition et de lecture Blackmagic Design. 

Étape 3. Configurez votre magnétoscope sur Remote. 

Étape 4. Connectez un générateur de synchro à l'entrée de la synchronisation du magnétoscope pour garantir une 
capture précise à l'image près. Si vous possédez un appareil audio séparé, il vous faudra également lui 
connecter un signal de synchronisation audio.

Saisissez un nom de projet et configurez les options du projet.
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Configurer un magnétoscope
Avant de lancer Autodesk Smoke, il vous faut utiliser un utilitaire appelé Smoke Setup pour sélectionner le modèle de 
magnétoscope utilisé dans votre studio ainsi que la résolution et la fréquence d'image.

Étape 1. Allez sur Applications>Autodesk>Smoke>Utilities et ouvrez Smoke Setup.

Étape 2. Sous l'onglet General, assurez-vous que les paramètres Video Device et Audio Device sont configurés sur 
BMD.

Étape 3. Sous l'onglet VTR, sélectionnez le modèle de magnétoscope, la résolution et la fréquence d'image (timing) 
que vous souhaitez utiliser avec Autodesk Smoke. Activez les lignes affichant live NTSC ou live PAL pour 
permettre un enregistrement en mode direct ou une sortie en direct.

Étape 4. Cliquez sur Apply et fermez Smoke Setup.

Capturer à partir de matériel pilotable avec UltraStudio et DeckLink
Autodesk Smoke peut être configuré pour capturer à partir de magnétoscopes pilotables avec le contrôle de 
périphérique RS-422.

Étape 1. Dans la Media Library, sélectionnez le dossier où vous souhaitez que le clip capturé soit créé.

Étape 2. Sélectionnez File>Capture from VTR. Le module VTR Capture va apparaître.

Étape 3. Positionnez la bande sur l'image de départ du clip que vous souhaitez capturer.

Étape 4. Sélectionnez les canaux vidéo et audio que vous désirez enregistrer. Les boutons deviendront rouges pour 
vous indiquer les pistes activées.

Étape 5. Saisissez les points d'entrée et de sortie dans les champs In et Out. 

Étape 6. Cliquez sur le bouton de capture pour commencer la capture. Le champ du timecode deviendra vert pour 
vous indiquer que la capture est en cours.

Étape 7. Terminez la capture quand vous le souhaitez en cliquant n'importe où sur la fenêtre de prévisualisation. Le 
clip sera automatiquement sauvegardé à l'emplacement que vous aviez sélectionné avant d'entrer dans le 
module VTR Input.

Assurez-vous que les paramètres Video Device et Audio Device sont 
configurés sur BMD dans l'utilitaire Smoke Setup.

Sélectionnez les paramètres Timing pour votre VTR à l'aide de 
l'onglet VTR dans l'utilitaire Smoke Setup.

Les pistes vidéo et audio deviennent rouges lorsqu'elles sont activées 
pour une capture à partir de votre magnétoscope.
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Enregistrer sur bande avec UltraStudio et DeckLink
Téléchargez un clip dans le module VTR Output et configurez les points d'entrée et de sortie pour le clip de sortie. Si 
besoin est, vous pouvez également activer les options vous permettant de décaler l'image du début et d'appliquer le 
format Letterbox.

Étape 1. Sélectionnez File>Output to VTR.

Étape 2. Choisissez le ou les clips que vous souhaitez acheminer à partir de la Media Library. Vous pouvez également 
sélectionner un dossier si vous désirez acheminer son contenu dans une seule session. Le module VTR 
Output va apparaître.

Étape 3. Sélectionnez l'option VTR dans la boîte de sélection Device Name. La fenêtre de prévisualisation affiche la 
vidéo de la bande appartenant au magnétoscope sélectionné.

Étape 4. Assurez-vous que les boutons de la piste vidéo et des canaux audio sont activés pour que la piste vidéo et 
les canaux audio correspondants soient acheminés sur la bande.

Étape 5. Activez ou désactivez le paramètre All Audio dans le menu Clip Output. Lorsque le paramètre All Audio est 
activé, tous les canaux audio seront convertis au format de votre bande, et non pas seulement les canaux que 
vous avez activés.

Étape 6. Cliquez sur le bouton Preview pour prévisualiser le clip avant de l'acheminer.

Étape 7. Pour acheminer le clip sélectionné en commençant par n'importe quelle image autre que la première, 
saisissez le timecode de départ dans le champ Start Offset.

Étape 8. Configurez les points d'entrée et de sortie pour la sortie du clip.

Étape 9. Pour acheminer le clip au magnétoscope, sélectionnez l'option Insert dans la boîte de sélection Output. Les 
clips dont la colonne Status affiche « selected » seront acheminés sur la bande. Lors de l'acheminement, 
l'état de chaque clip sera mis à jour, en commençant par « Pending » puis « Output » et finalement « Done ».

Étape 10. Positionnez la bande sur le timecode du point d'entrée et sélectionnez Play pour vérifier que le transfert a 
réussi.

Étape 11. Lorsque vous avez terminé, cliquez sur EXIT Output Clip pour fermer le module.

Étape 3. Sélectionnez votre magnétoscope dans le menu déroulant.

Les clips que vous avez sélectionnés pour être acheminés ainsi que 
leur état actuel apparaissent sur une liste. 

Sélectionnez vos points d'entrée et de sortie, puis sélectionnez 
l'option Insert dans le menu déroulant Output. 
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Enregistrement instantané et sortie en direct
Autodesk Smoke vous permet de capturer un signal vidéo en direct ou d'enregistrer instantanément un clip et d'utiliser 
une tablette à stylet ou une souris pour commencer ou arrêter le processus d'entrée ou de sortie du clip. Lorsque vous 
choisissez cette forme de capture, Autodesk Smoke vérifie l'espace disponible sur votre matériel de stockage de médias 
Autodesk. Ce dernier peut varier selon le format intermédiaire choisi.

De plus, si vous utilisez un appareil qui ne prend pas en charge le contrôle à distance via RS-422, comme par exemple 
une caméra, un VCR ou tout autre appareil, utilisez l'option Live NTSC ou PAL pour la capture, et l'option Live Video 
pour acheminer les clips.

Pour enregistrer instantanément un signal vidéo en direct :

Étape 1. Choisissez un dossier dans la Media Library où vous souhaitez créer le clip capturé.

Étape 2. Sélectionnez File>Capture from VTR. Le module VTR Capture va apparaître.

Étape 3. À partir de la boîte de sélection VTR Device, sélectionnez Live NTSC ou Live PAL. Le signal vidéo en direct va 
apparaître dans la fenêtre de prévisualisation.

Étape 4. Sélectionnez le mode Start On Pen. Arrêtez la capture à l'aide des fonctions Stop On Pen ou Stop On 
Frames. Traditionnellement, Autodesk Smoke fonctionnait avec une tablette et un stylet (pen), c'est ce qui a 
donné le nom à ces fonctions.

Lorsque la fonction Stop On Pen est sélectionnée pour arrêter la capture, les champs « Out » et « Duration » seront mis 
à jour pour indiquer la longueur de clip maximale pouvant être enregistrée sur votre matériel de stockage de médias 
Autodesk. La capture s'arrêtera lorsque vous cliquerez n'importe où sur l'écran ou lorsque votre disque sera plein.

Étape 5. Saisissez le nom du clip et activez les pistes vidéo et les canaux audio que vous souhaitez capturer.

Étape 6. Assurez-vous que vous recevez le signal vidéo en direct.

Étape 7. Appuyez sur Play sur l'appareil vidéo.

Étape 8. Sélectionnez la fonction Process pour commencer la capture.

Étape 9. Cliquez n'importe où sur l'écran pour arrêter la capture en mode Stop On Pen. 

Activez les lignes affichant live NTSC ou live PAL pour permettre un 
enregistrement en mode direct ou une sortie en direct.
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Pour acheminer un signal vidéo en direct :

Étape 1. Sélectionnez File>Output to VTR.

Étape 2. Choisissez le ou les clips que vous souhaitez acheminer à partir de la Media Library. Vous pouvez également 
sélectionner un dossier pour acheminer son contenu. Le module VTR Output va apparaître.

Étape 3. À partir de la boîte de sélection VTR Device, sélectionnez Live NTSC ou Live PAL.

La boîte de sélection Start Mode n'est pas disponible. Avec une sortie vidéo en direct, il vous faut utiliser le mode Start 
On Pen. Vous pouvez utiliser les fonctions Stop On Pen ou Stop On Frames pour arrêter l'acheminement.

Étape 4. Configurez les options de sortie. Par exemple, saisissez le nom du clip et activez les pistes vidéo et les canaux 
audio que vous souhaitez capturer. 

Étape 5. Sur l'appareil qui reçoit le signal, commencez l'enregistrement ou faites le nécessaire pour activer la réception 
du signal provenant d'Autodesk Smoke.

Étape 6. Sélectionnez la fonction Process pour commencer à acheminer le signal sur Autodesk Smoke.

Étape 7. Cliquez n'importe où sur l'écran pour arrêter la sortie du signal en mode Stop On Pen.

Lorsque vous acheminez de la vidéo en direct, il vous faut utiliser le 
mode Start On Pen.

Sélectionnez Live PAL ou Live NTSC lorsque vous acheminez un 
signal vidéo en direct.
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DaVinci Resolve 10

Sélectionnez le format désiré à partir du menu « Video capture and 
playback ».

DaVinci Resolve 10 et étalonnage en direct
Desktop Video 10 permet une capture et une lecture simultanées sur UltraStudio 4K et DeckLink 4K Extreme. C'est idéal 
pour les utilisateurs qui souhaitent bénéficier de la fonctionnalité d'étalonnage en direct de DaVinci Resolve 10, car de 
ce fait, ils n'ont pas besoin de deux appareils distincts pour l'entrée et la sortie.

Lorsque vous faites de l'étalonnage en direct sur le plateau, il vous suffit de connecter la sortie de la caméra à l'entrée de 
votre matériel Blackmagic. Connectez ensuite la sortie du matériel à un moniteur de plateau pour évaluer l'étalonnage 
et la visualisation.

Configuration
Étape 1. Lancez le logiciel Resolve. À partir du menu Preferences, sélectionnez l'onglet « Video I/O and GPU » 

puis choisissez votre matériel à partir de l'option « For Resolve Live use ». Sauvegardez vos préférences et 
redémarrez Resolve pour faire appliquer vos changements.

Étape 2. Commencez un projet et à partir de la fenêtre Project Settings, configurez la résolution et la fréquence 
d'image correspondant à votre caméra.

Étape 3. Dans la fenêtre Project Settings, allez sur l'onglet « Deck Capture and Playback » et sélectionnez le format 
désiré à partir du menu « Video capture and playback ».

Étape 4. Allez sur la page Edit et faites un clic-droit dans la fenêtre Timeline, puis sélectionnez l'option « Create New 
Timeline ».

Étape 5. À partir du menu Color, sélectionnez l'option « Resolve Live On/Off ». Vous devriez à présent voir la vidéo en 
direct dans le Viewer et un bouton rouge lumineux « Resolve Live » apparaîtra au-dessus de la vidéo.

Utiliser Resolve Live
Étape 1. En mode Resolve Live, le bouton avec l'icône représentant un flocon fige l'image vidéo actuelle. Vous pouvez 

ainsi l'étalonner sans être distrait par le mouvement qui a lieu pendant le tournage. Lorsque vous avez 
effectué votre ajustement, vous pouvez recommencer la lecture et vous préparer à prendre un instantané.

Étape 2. Une fois que vous êtes satisfait de votre correction, vous pouvez sauvegarder un instantané de l'image 
fixe actuellement affichée dans le Viewer, la valeur du timecode entrant ainsi que votre correction dans la 
Timeline en cliquant sur le bouton représentant une caméra. Les instantanés sont tout simplement des clips 
qui ne comportent qu'une seule image.

Veuillez vous référer au manuel DaVinci Resolve 10 pour obtenir de plus amples informations sur Resolve Live.
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Qu'est-ce que le Media Express ?
Le logiciel Blackmagic Media Express est inclus avec les produits UltraStudio, DeckLink, Intensity, ATEM Switcher, 
Blackmagic Camera, H.264 Pro Recorder, Teranex Processor et Universal Videohub. Le logiciel Media Express 3 
est un outil très pratique lorsque vous désirez simplement capturer, lire et acheminer des clips sur bande et que 
vous n'avez pas besoin de la complexité d'un logiciel de montage non-linéaire.

Capturer des fichiers vidéo et audio

Création d'un projet
Avant de capturer un clip dans Media Express, il vous faudra sélectionner les paramètres de votre projet. 

Étape 1. Allez sur Media Express>Preferences sur Mac OS X, ou Edit>Preferences si vous utilisez Media Express avec 
Windows ou Linux. La liste des formats pour votre projet peut varier selon que votre matériel vidéo Blackmagic 
prend en charge des fonctionnalités telles que la vidéo Ultra HD 4K ou la vidéo 3D stéréoscopique.

Étape 2. Faites votre sélection entre toute une gamme de formats de capture compressés et non compressés ou 
même une séquence d'image DPX à partir du menu déroulant intitulé Capture File Format. La vidéo sera 
capturée au format choisi puis sauvegardée au format QuickTime.

Étape 3. Configurez l'emplacement de stockage pour votre vidéo et votre audio capturés. 

Étape 4. Choisissez si vous souhaitez arrêter la capture ou la lecture lorsqu'une perte d'images a été détectée.

Les projets en définition standard sont configurés au format 4:3 à moins que vous ne cochiez la case Use Anamorphic 
SD 16:9 (Utiliser le format SD anamorphosé 16:9). 

En général, les applications suspendent la lecture de la vidéo si vous les placez en arrière-plan. Si vous désirez que Media 
Express continue la lecture de la vidéo, même lorsque vous ouvrez une autre application en premier plan, sélectionnez 
la case intitulée « Continue playback when in the background ».

Les dernières options concernent les magnétoscopes munis du contrôle de périphérique RS-422 et comprennent les 
fonctions relatives au preroll et au décalage de timecode.

Utilisez la fenêtre Preferences pour configurer le format vidéo, le 
format de fichier, l'emplacement de stockage et d'autres paramètres.

Blackmagic Media Express
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Capture
Il est très facile de capturer de la vidéo. Il vous suffit de connecter une source vidéo, de régler les préférences de Media 
Express et d'appuyer sur le bouton Capture.

Étape 1. Commencez par connecter votre source vidéo à une entrée de votre matériel vidéo Blackmagic et vérifiez 
que les préférences système de Blackmagic sont configurées sur la même entrée vidéo, par ex. SDI, HDMI 
ou analogique.

Étape 2. Ouvrez Media Express et réglez le format vidéo et le format du fichier de capture pour votre projet dans la 
fenêtre Preferences.

Étape 3. Cliquez sur l'onglet rouge intitulé Log and Capture et saisissez une description dans le champ Description.

Étape 4. Cliquez sur le bouton "+" situé à côté de la description pour l'ajouter automatiquement au champ Name. 
Cliquez sur le bouton "+" situé à côté de tous les autres champs que vous désirez ajouter au champ Name.

 � Vous pouvez augmenter la valeur dans chacun de ces champs en cliquant sur l'icône « clap » correspondant. 
Vous pouvez également saisir du texte directement dans le champ désiré pour modifier son nom ou son 
numéro.

 � Le texte saisi dans le champ Name sera attribué au(x) clip(s) que vous vous apprêtez à capturer.

 � Pour enregistrer le clip en tant que favori, cliquez sur l'icône « étoile » située à côté du champ Name.

 � Si vous souhaitez qu'une confirmation du nom du clip apparaisse avant chaque capture, cliquez sur l'icône 
"!"  située à côté du champ Name.

Étape 5. Choisissez le nombre de canaux audio à capturer.

Étape 6. Cliquez sur le bouton « Capture » pour commencer l'enregistrement. Pour arrêter la capture et conserver le 
clip, cliquez à nouveau sur le bouton « Capture ». Vous pouvez également appuyer sur la touche esc pour 
qu'on vous demande si vous souhaitez effacer ou sauvegarder le clip. Les clips capturés seront ajoutés à la 
liste de médias.

Indexer des clips

Assurez-vous qu'un câble série RS-422 est connecté entre votre matériel vidéo Blackmagic et le magnétoscope. 

Vérifiez que le bouton Remote du magnétoscope est bien réglé sur Remote. Utilisez les raccourcis clavier standard j, k, l 
pour faire une avance ou un retour rapide de la vidéo et mettre la vidéo en pause.

Cliquez sur le bouton situé à côté du champ « In » pour marquer le point d'entrée, ou utilisez le raccourci i.

Cliquez sur le bouton situé à côté du champ « Out » pour marquer le point de sortie, ou utilisez le raccourci o.

Cliquez sur le bouton Log pour indexer le clip, ou utilisez le raccourci p. Le clip saisi devrait à présent apparaître dans la 
liste de médias et son icône devrait comporter un X rouge pour indiquer que le média n'est pas disponible.

Choisissez le nombre de canaux audio à capturer.

Saisissez une description de votre vidéo.

Cliquez sur le bouton « Capture » pour commencer la capture.
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Acquisition en série

Après avoir indexé un clip, vous pouvez cliquer sur le bouton Clip pour capturer un seul clip.

Pour capturer plusieurs clips, continuez à indexer les clips que vous souhaitez capturer en série.

Sélectionnez les clips indexés dans la liste de médias et effectuez l'une des actions suivantes :

 � Cliquez sur le bouton Batch.

 � Faites un clic-droit sur la sélection puis sélectionnez Batch Capture.

 � Allez sur le menu File et choisissez Batch Capture.

Media Express capturera le clip à partir du timecode du point d'entrée au timecode du point de sortie.

Capture DPX

Si vous souhaitez capturer une séquence d'images DPX plutôt qu'un fichier .mov, ouvrez les préférences de Media 
Express et configurez le format du fichier de capture (Capture File Format) sur DPX 10-Bit RGB.

 � Créez un projet DPX en configurant le format du fichier de capture sur DPX.

 � Capturez.

Lorsque la capture est terminée, une seule imagette apparaîtra dans la liste de médias. Cette dernière représentera 
la séquence d'images entière. La séquence d'images DPX sera stockée dans son propre dossier sur votre disque de 
stockage. L'audio sera stocké dans un fichier .wav au sein du même dossier.

Par défaut, les captures DPX sont supposées provenir de sources YUV. Si vous souhaitez capturer à partir d'une source 
RGB, il vous faudra désactiver l'option « Capture to DPX from a YUV source ».

Si vous désirez que les numéros d'image DPX soient basés sur le timecode de la vidéo capturée, plutôt que de 
commencer par zéro, activez l'option « Use absolute frame numbering when capturing DPX ».

Si vous n'effectuez pas de longues captures DPX, il est possible de réduire le nombre de zéros des numéros relatifs aux 
images en modifiant l'option « When capturing DPX files, use (2-8) digit numbers in the frame count ».

Préférences de capture DPX
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Capture 3D

Lorsque Media Express est utilisé avec du matériel vidéo Blackmagic qui prend en charge la 3D double flux,  
vous pouvez créer des clips vidéo pour l'oeil gauche et l'oeil droit en capturant 2 flux de vidéo HD-SDI simultanément.

 � Créez un projet 3D qui correspond à la fréquence d'image de votre source vidéo 3D double flux.

 � Assurez-vous que vous avez 2 entrées vidéo HD-SDI séparées connectées au matériel vidéo Blackmagic.

 � Capturez.

Lorsque vous capturez et indexez de la 3D double flux dans Media Express, le nom du clip sera appliqué à la vidéo oeil 
gauche. Le texte « _right » sera apposé au nom de la vidéo oeil droit. Par exemple, si vous nommez le clip stéréo « Clip 
1 », le clip oeil gauche sera nommé « Clip 1.mov » et le clip oeil droit sera nommé « Clip 1_right.mov ».

La liste de médias vous donne une indication claire que le clip capturé est un clip 3D :

 � En mode d'affichage Vignettes, les clips oeil gauche et oeil droit sont connectés par un indicateur 3D et 
présentés en tant qu'une seule et grande icône.

 � En mode d'affichage Liste par timecode, les clips oeil gauche et oeil droit sont listés sur deux lignes et liés 
par un indicateur 3D.

Sélectionnez un format vidéo qui contient « 3D » dans son nom pour 
capturer des clips vidéo en 3D stéréoscopique double flux.

En mode d'affichage Vignettes, les clips oeil gauche et oeil droit sont 
connectés par un indicateur 3D et présentés en tant qu'une seule et 
grande icône.

En mode d'affichage Liste par timecode, les clips oeil gauche et oeil 
droit sont listés sur deux lignes et liés par un indicateur 3D.
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Lecture de fichiers vidéo et audio

Importer des clips
Vous pouvez lire vos fichiers vidéo et audio après avoir importé des médias dans Media Express en suivant l'une des 
méthodes suivantes :

 � Double-cliquez dans une zone vide de la liste de médias.

 � Cliquez avec le bouton droit de la souris dans une zone vide de la liste de médias et sélectionnez la fonction 
Import Clip à partir du menu contextuel.

 � À partir du menu intitulé File, sélectionnez la fonction Import puis Media Files.

Sélectionnez le ou les clips vidéo et audio que vous souhaitez importer à partir de la boîte de dialogue intitulée Open 
Video Clip. Les clips apparaîtront alors dans la zone intitulée Scratch de la liste de médias. Si vous avez créé vos propres 
chutiers dans la liste de médias, vous pouvez glisser-déposer les clips dans le chutier désiré.

Si vous souhaitez importer des médias directement dans un chutier, cliquez avec le bouton droit de la souris dans le 
chutier désiré et sélectionnez la fonction Import Clip à partir du menu contextuel.

Si les fichiers importés ne coïncident pas avec la fréquence d'image et la taille des clips déjà existants dans la liste de 
médias, une boîte de dialogue apparaîtra et vous demandera si vous désirez créer un nouveau projet et sauvegarder le 
projet actuel.

Media Express prend également en charge l'importation exclusive de fichiers audio multi-canaux enregistrés à 48kHz 
aux formats WAVE (.wav) et AIFF (.aif) non compressés.

Une autre façon d'importer des médias est d'utiliser un fichier XML exporté à partir de Final Cut Pro. À partir du menu 
File, sélectionnez la fonction Import puis Final Cut Pro XML. Ouvrez le XML désiré et tous les chutiers et les médias du 
projet Final Cut Pro apparaîtront dans la liste de médias.

Media Express prend également en charge l'importation de fichiers CMX EDL pour capturer des clips en série en 
utilisant des fichiers EDL provenant d'autres logiciels vidéo. À partir du menu File, sélectionnez la fonction Import puis 
CMX EDL. Sélectionnez le fichier EDL et ouvrez-le. 

Les informations relatives au fichier apparaîtront dans la liste de médias. Sélectionnez les clips indexés et effectuez une 
acquisition en série pour importer les clips à partir de votre magnétoscope.

Lecture d'un ou de plusieurs clips
Pour lire un seul clip, double-cliquez sur le clip en question dans la liste de médias. Vous pouvez également sélectionner 
le clip dans la liste de médias et appuyer sur la barre d'espace de votre clavier ou le bouton lecture des commandes  
de transport.

Pour lire plusieurs clips, sélectionnez les clips dans la liste de médias et appuyez sur la barre d'espace de votre clavier ou 
le bouton lecture des commandes de transport.

La lecture de votre vidéo aura lieu dans la fenêtre de prévisualisation vidéo de Media Express et sur toutes les sorties 
vidéo de votre matériel vidéo Blackmagic. Durant la lecture, les canaux audio contrôlés peuvent être activés ou désactivés 
à l'aide des boutons d'activation et de désactivation situés sous les pistes audio.

Vous pouvez importer des médias directement, ou les importer avec 
un fichier XML ou EDL.

Grâce aux commandes de transport vous avez la possibilité de lire ou 
d'arrêter un clip, de passer au clip suivant ou au clip précédent et de 
lire vos clips en boucle.
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Parcourir vos médias

Mode Vignettes
Le mode Vignette est la façon la plus intuitive d'afficher vos clips. Passez votre souris au-dessus d'une vignette et cliquez 
ensuite sur l'icône d'information qui apparaîtra au bas à droite de la vignette. Cliquez sur la bulle d'information pour  
la minimiser.

Mode Liste par timecode
Vous pouvez afficher vos clips en mode Liste par timecode en cliquant sur le bouton représentant une liste situé en haut 
à droite de la liste de médias. Utilisez la barre de défilement horizontale pour visualiser toutes les colonnes d'information 
de vos clips.

Création et utilisation des chutiers
Pour créer un chutier, cliquez sur un emplacement vide de la liste de médias avec le bouton droit de la souris et 
sélectionnez l'option « Create Bin ». Nommez le nouveau chutier.

Vous pouvez déplacer vos clips en les faisant glisser dans le chutier désiré.  Si vous désirez qu'un clip apparaisse dans 
plus d'un chutier, importez le même clip à nouveau en cliquant sur le chutier à l'aide du bouton droit de la souris puis en 
choisissant l'option « Import Clip ».

Par défaut, les clips indexés apparaissent dans la section Scratch. Si vous désirez indexer des clips et les voir apparaître 
dans un nouveau chutier, faites un clic-droit sur le nouveau chutier et choisissez l'option « Select As Log Bin ».

Création et utilisation des favoris
Dans l'onglet Log and Capture, cliquez sur l'icône « étoile » située à côté du champ Name si vous désirez enregistrer un 
clip en tant que favori.

Dans l'onglet Playback, il vous faudra cliquer sur l'icône « étoile » lorsque le clip est sélectionné dans la liste de média 
pour qu'il soit enregistré en tant que favori. Cliquez à nouveau sur l'icône « étoile » si vous ne désirez plus que le clip soit 
considéré comme un favori.

L'icône des clips marqués en tant que favoris possédera une étoile en mode Liste par timecode et en mode Vignettes.

Cliquez sur le bouton Favoris situé sur le haut de la liste de médias pour n'afficher que vos clips favoris. L'icône  
« étoile » deviendra jaune. Tous les clips de votre liste de médias ne seront alors plus visibles sauf ceux qui avaient été 
préalablement marqués en tant que favoris. 

Associer un clip audio à un clip vidéo
Pour associer un clip audio à un clip vidéo dans la liste de médias :

 � Sélectionnez un clip vidéo qui ne contient pas de canal audio.

 � Faites un clic-droit sur le clip vidéo et sélectionnez l'option « Link Audio File » à partir du menu contextuel.

Vous pouvez à présent lire le clip combiné ou le masteriser sur bande.

Dans la liste de médias, choisissez entre le mode d'affichage Liste 
par timecode ou Vignettes. Cliquez sur le bouton favoris pour ne 
visualiser que vos clips favoris. Utilisez la fonction de recherche pour 
trouver vos clips favoris.

Cliquez sur l'icône d'information de la vignette pour visualiser sa bulle 
d'information.

Dans l'onglet Log and Capture, cliquez sur l'icône « étoile »  
située à côté du champ Name si vous désirez enregistrer un  
clip en tant que favori.
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Sélectionnez un format vidéo pour votre projet en 3D.

La liste de médias vous donne une indication claire que le clip 
capturé est un clip 3D.

Utilisez la fonction de recherche pour trouver des clips.

La liste de médias vous donne une indication claire que les clips vidéo 
et audio sont liés.

Supprimer des clips et des chutiers
Pour effacer des clips, sélectionnez les clips non-désirés et appuyez sur la touche "suppression avant" de votre clavier. 
Cette opération supprimera les clips de la liste de médias mais elle ne les supprimera pas de votre disque dur.

Pour supprimer des chutiers, faites un clic-droit dans le chutier et choisissez la fonction « Delete Bin ». Cette opération 
supprimera le chutier et tous les clips qu'il contient. Elle supprimera aussi les clips de la liste de médias mais pas de votre 
disque dur.

Créer un clip en 3D
Pour ajouter un clip en 3D stéréoscopique dans la liste de médias :

 � Sélectionnez un format vidéo pour votre projet en 3D, ce dernier doit avoir la même fréquence d'image que 
votre média 3D.

 � Importez le fichier « oeil gauche » dans la liste de médias.

 � Faites un clic-droit sur le fichier oeil gauche et sélectionnez l'option « Set Right Eye Clip » (configurer le clip 
oeil droit) à partir du menu contextuel. Si le clip oeil droit a été préalablement capturé par Media Express, le 
texte « _right » sera apposé à la vidéo oeil droit.

La liste de médias vous donne une indication claire que le clip capturé est un clip 3D. Les clips oeil gauche et oeil droit 
sont affichés côte à côte dans la fenêtre de prévisualisation vidéo, ce qui indique un projet vidéo en 3D.

Si vous vous apercevez que l'oeil gauche et l'oeil droit d'un clip stéréo 3D ont été téléchargés dans le mauvais sens :

 � Faites un clic-droit sur le clip 3D dans la liste de médias.

 � Sélectionnez l'option « Swap Eyes » à partir du menu contextuel.

Effectuer une recherche dans la liste de médias
Vous pouvez aisément retrouver des clips appartenant à un projet en saisissant le nom de vos clips dans la fonction 
de recherche qui se trouve sur le haut de la liste de médias. Lorsque cette fonction est utilisée en conjonction avec la 
fonction favoris, la recherche sera limitée à vos clips favoris, c'est pourquoi la liste de clips trouvés sera plus courte.
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Monter des fichiers vidéo et audio sur bande
Bien que l'on parle communément de master sur bande, cela n'a aucune importance si votre magnétoscope utilise une 
bande ou un disque. Pour masteriser vos clips :

 � Sélectionnez les clips que vous souhaitez envoyer sur bande.

 � Cliquez sur l'onglet bleu « Edit to Tape ».

 � Configurez le point d'entrée et le type de montage.

 � Enregistrez votre master sur bande.

Sélectionner les clips à masteriser
Choisissez le ou les clips que vous souhaitez masteriser à partir de la liste de médias. Vous pouvez même insérer des clips 
audio multi-canaux pour remplacer la piste audio principale sur la bande originale. Si vous souhaitez envoyer vos clips 
favoris sur bande, cliquez sur l'icône étoile située en haut de la liste de médias pour révéler vos clips favoris et masquer 
tous les autres. Puis, sélectionnez les clips favoris que vous désirez envoyer sur bande.

Insertion et assemblage sur bande
Cliquez sur l'onglet bleu Edit To Tape. Saisissez le point d'entrée de la bande en saisissant le timecode dans le champ In, 
ou en positionnant la bande sur le point désiré au moyen des commandes de transport puis en cliquant sur le bouton 
Mark In.

Si le point de sortie n'a pas été saisi, la durée du montage sera équivalente à la longueur totale des clips situés dans 
la liste de médias. Si un point de sortie a été défini, Media Express arrêtera l'enregistrement une fois le point de sortie 
atteint, même si certains clips n'auront pas encore été acheminés.

Choisissez d'effectuer un master sur bande à l'aide d'un montage par assemblage ou par insertion. Appuyez ensuite 
sur le bouton Master.

Le mode Preview simule le processus de montage mais n'enregistre rien sur la bande. Ce mode vous permet de vérifier 
le point de montage. La prévisualisation des opérations de montage devrait toujours être vérifiée sur des moniteurs 
directement connectés à la sortie du magnétoscope. Cela vous permet de visualiser la vidéo déjà présente sur la bande 
conjointement avec la nouvelle vidéo. 

Si le taquet de protection contre l'enregistrement du magnétoscope ou de la cassette est activé, Media Express vous 
l'indiquera lorsque vous cliquerez sur le bouton Master. Déplacez le taquet avant de réessayer.

Sélectionnez les canaux vidéo et audio que vous souhaitez acheminer au moyen des boutons permettant d'activer et de 
désactiver les pistes. Désélectionnez le canal vidéo si vous désirez acheminer uniquement de l'audio.

Cliquez sur l'icône étoile située en haut de la liste de médias pour 
n'afficher que vos clips favoris.

Deux clips ont été sélectionnés pour être acheminés sur bande.

Choisissez le nombre de canaux audio à masteriser.
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Qu'est-ce que le Blackmagic Disk Speed Test ?
Le Blackmagic Disk Speed Test mesure les performances de lecture et d'écriture des médias de stockage en formats 
d'image vidéo. Disk Speed Test est inclus gratuitement avec n'importe quelle installation de produit Blackmagic Design 
sur Mac OS X et Windows et peut être téléchargé à partir de notre site Internet. Accédez aux paramètres du Disk Speed 
Test en cliquant sur l'icône représentant une roue dentée, située juste au-dessus du bouton Start.

Sélectionner le disque cible

Cliquez sur la fonction Select Target Drive et assurez-vous de posséder les permissions de lecture et d'écriture.

Sauvegarder une capture d'écran

Cliquez sur la fonction Save Screenshot pour sauvegarder une capture d'écran des résultats. 

Fonction Stress

La fonction Stress peut être configurée entre 1GB et 5GB par tranches de 1 GB. 5GB est le paramètre par défaut et 
fournira les résultats les plus précis.

Disk Speed Test Help

Cliquez sur la fonction Disk Speed Test Help pour lancer la version PDF du manuel de Disk Speed Test.

À propos de Disk Speed Test

La fonction About Disk Speed Test affiche la version du Disk Speed Test en utilisation.

Bouton Start

Cliquez sur le bouton Start pour commencer une vérification de la vitesse du disque avec Disk Speed Test. Ce dernier 
écrira puis lira un fichier temporaire sur le disque cible sélectionné. Disk Speed Test continuera à écrire et à lire jusqu'à 
ce que vous arrêtiez le test en cliquant à nouveau sur le bouton Start.

Tableau « Will it Work? »

Le tableau « Will it Work? » liste les formats vidéo courants et affiche une coche ou une croix pour indiquer si la 
performance du disque est adéquate. Répétez le test plusieurs fois pour révéler les formats vidéo pour lesquels la 
performance du disque se situe sur la limite. Si un format vidéo présente tantôt une coche et tantôt une croix, cela vous 
indique que le disque de stockage ne peut pas prendre en charge le format vidéo de manière fiable.

Tableau « How Fast? »

Le tableau de résultats « How Fast? » affiche les fréquences d'images que votre disque peut atteindre et doit se lire 
conjointement avec le tableau  « Will it Work? ». Si le tableau « Will it Work? » affiche une coche verte sous le format 2K 
1556@25 en 10 bit YUV 4:2:2, mais que le tableau « How Fast? » révèle qu'une cadence maximale de 25 i/s sera prise en 
charge, la performance du disque de stockage n'est pas fiable.

Ouvrez le menu de configuration en cliquant sur l'icône de la  
roue dentée.

Blackmagic Disk Speed Test
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Tableau « How Fast? »

Ce tableau affiche les 
résultats en images par 
seconde (i/s)

Paramètres 

Cliquez sur ce bouton pour 
accéder aux paramètres 
avant d'exécuter une 
vérification de la vitesse  
du disque

Tableau « Will it Work? » 

Ce tableau affiche les 
formats vidéo qui peuvent 
être pris en charge par votre 
disque de stockage

Bouton START

Cliquez une fois sur ce 
bouton pour commencer la 
vérification de la vitesse du 
disque. Cliquez sur le même 
bouton pour terminer le test



Assistance145

Obtenir de l'assistance
Le moyen le plus rapide d'obtenir de l'aide est d'accéder aux pages d'assistance en ligne de Blackmagic Design et de 
consulter les dernières informations de support concernant votre matériel.

Pages d'assistance en ligne de Blackmagic Design
Vous trouverez les dernières versions du manuel, du logiciel et des informations d'assistance sur :  
www.blackmagicdesign.com/support

Contacter le service d'assistance de Blackmagic Design
Si vous ne parvenez pas à trouver l'aide dont vous avez besoin dans notre assistance en ligne, veuillez utiliser l'option  
« send request » (envoyer une demande) disponible sur la page d'assistance de votre matériel pour envoyer une 
demande d'assistance par email. Vous pouvez également contacter le service d’assistance du bureau de votre région sur :  
www.blackmagicdesign.com/company

Vérification du logiciel actuel
Pour vérifier quelle version du logiciel Desktop Video est installée sur votre ordinateur, ouvrez les préférences système 
de Blackmagic Design Desktop Video. Le numéro de version apparaît dans la barre de titre.

 � Sur Mac OS X, ouvrez les préférences système pour trouver l'icône Blackmagic Design. Cliquez sur l'icône 
Blackmagic Design pour connaître le numéro de version.

 � Sur Windows 7 et Windows 8, ouvrez le Panneau de configuration et cliquez sur la catégorie « Matériel et 
audio » pour révéler le Blackmagic Design Control Panel. Cliquez sur Blackmagic Design Control Panel pour 
connaître le numéro de version.

 � Sur Linux, allez sur « Applications » puis sur « Son et vidéo » pour trouver le Blackmagic Control Panel. Ouvrez 
le panneau de configuration pour connaître le numéro de version.

Comment obtenir les dernières mises à jour
Après avoir vérifié la version du logiciel Desktop Video installée sur votre ordinateur, veuillez visiter le centre d’assistance 
Blackmagic à l’adresse suivante www.blackmagicdesign.com/support pour vérifier les dernières mises à jour. Même 
s'il est généralement conseillé d'exécuter les dernières mises à jour, il est prudent d'éviter d'effectuer une mise à jour 
logicielle au milieu d'un projet important.

Assistance

http://www.blackmagicdesign.com/support
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Développer un logiciel personnalisé à l'aide de matériel Blackmagic Design
Le kit de développement DeckLink est disponible pour les développeurs qui souhaiteraient contrôler leur matériel 
vidéo Blackmagic au moyen de leur propre logiciel. Il prend en charge les produits UltraStudio, DeckLink, Multibridge 
et Intensity.

Le kit de développement DeckLink procure un contrôle de bas niveau du matériel ainsi que des interfaces de haut 
niveau pour permettre aux développeurs d'effectuer facilement les tâches les plus courantes. Le kit de développement 
DeckLink prend en charge les technologies suivantes :

 � Apple QuickTime

 � Microsoft DirectShow

 � Apple Core Media

 � DeckLink API

Télécharger gratuitement le kit de développement Blackmagic Design
Le SDK DeckLink peut être téléchargé sur : www.blackmagicdesign.com/support/sdks/

S'inscrire sur la liste de développeurs de Blackmagic Design
La liste de diffusion pour développeurs a été conçue par Blackmagic pour répondre aux questions techniques concernant 
les technologies utilisées par Blackmagic Design, telles que QuickTime, Core Media, DirectShow, codecs, APIs et SDKs. 
Cette liste de diffusion gratuite est un forum où les développeurs peuvent discuter de leurs idées et de leurs problèmes 
avec d'autres développeurs. Toute personne inscrite peut donner une réponse et les ingénieurs de Blackmagic Design 
apporteront également des commentaires si nécessaire. Vous pouvez vous inscrire sur la liste de diffusion en allant sur : 
http://lists.blackmagicdesign.com/mailman/listinfo/bmd-developer

S'il n'est pas évident que vous êtes développeur d'après votre nom de domaine, il se pourrait que nous vous demandions 
une brève description de votre logiciel. Comme la liste a été conçue uniquement pour les développeurs, nous nous 
efforçons de la conserver exempte de spam et de virus, de questions qui ne sont pas relatives au développement, 
d'agents de recrutement ainsi que de commerciaux qui font la promotion de leurs produits. 

Contacter l'assistance Blackmagic Design pour les développeurs
Si vous souhaitez nous poser des questions et que vous ne désirez pas le faire à partir de la liste, veuillez nous 
contacter à l'adresse suivante : developer@blackmagicdesign.com

Information sur le développeur
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Caution: Risk of Electric Shock
On the UltraStudio 4K enclosure you will see a yellow warning label marked ‘Caution: Risk of Electric Shock’. This is 
intended to warn users that there may be the presence of uninsulated “dangerous” voltage within the UltraStudio 4K 
enclosure which may be of sufficient magnitude to constitute a risk of electric shock to the user. Blackmagic Design 
advises you not to open the UltraStudio 4K unit, but rather contact your nearest Blackmagic Design service center should 
assistance be required.

Attention: Risque de choc électrique
Sur le boîtier du UltraStudio 4K, vous verrez une étiquette d’avertissement de couleur jaune sur laquelle est inscrit  
« Attention : Risque de choc électrique ». Cette mise en garde est destinée à avertir les utilisateurs de la présence 
possible d’une tension « dangereuse » non isolée à l’intérieur du boîtier du UltraStudio 4K, laquelle tension pouvant 
avoir une amplitude suffisante pour constituer un risque de choc électrique à l’utilisateur. Blackmagic Design vous 
déconseille donc d’ouvrir l’unité UltraStudio 4K, et vous recommande de contacter votre centre de service Blackmagic 
Design le plus proche en cas de nécessité.

Caution label

Avertissement

Avertissements
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Garantie limitée
Par la présente, Blackmagic Design garantit que les produits UltraStudio, DeckLink et Multibridge seront exempts 
de défauts matériels et de fabrication pendant une durée de 36 mois à compter de la date d'achat, ceci excluant les 
connecteurs, câbles, ventilateurs, modules à fibre optique, fusibles, claviers et batteries qui seront exempts de défauts 
matériels et de fabrication pendant une durée de 12 mois à compter de la date d'achat. Blackmagic Design garantit 
que les produits Intensity seront exempts de défauts matériels et de fabrication pendant une durée de 12 mois à 
compter de la date d'achat. Si un produit s’avère défectueux pendant la période de garantie, Blackmagic Design peut, 
à sa seule discrétion, réparer le produit défectueux sans frais pour les pièces et la main d’oeuvre, ou le remplacer.

Pour se prévaloir du service offert en vertu de la présente garantie, il vous incombe d’informer Blackmagic Design de 
l’existence du défaut avant expiration de la période de garantie, et de prendre les mesures nécessaires pour l’exécution 
des dispositions de ce service. Le consommateur a la responsabilité de s’occuper de l’emballage et de l'expédition 
du produit défectueux au centre de service nommément désigné par Blackmagic Design, en frais de port prépayé. Il 
incombe au Consommateur de payer tous les frais de transport, d’assurance, droits de douane et taxes et toutes autres 
charges relatives aux produits qui nous auront été retournés et ce quelle que soit la raison. 

La présente garantie ne saurait en aucun cas s’appliquer à des défauts, pannes ou dommages causés par une utilisation 
inappropriée ou un entretien inadéquat ou incorrect. Blackmagic Design n’a en aucun cas l’obligation de fournir 
un service en vertu de la présente garantie : a) pour réparer les dommages résultant de tentatives de réparations, 
d’installations ou tous services effectués par du personnel non qualifié par Blackmagic Design, b) pour réparer tout 
dommage résultant d'une utilisation inadéquate ou d'une connexion à du matériel incompatible, c) pour réparer 
tout dommage ou dysfonctionnement causé par l’utilisation de pièces ou de fournitures n’appartenant pas à la 
marque de Blackmagic Design, d) pour examiner un produit qui a été modifié ou intégré à d’autres produits quand 
l’impact d’une telle modification ou intégration augmente les délais ou la difficulté d’examiner ce produit. CETTE 
GARANTIE REMPLACE TOUTE GARANTIE EXPLICITE OU IMPLICITE. BLACKMAGIC DESIGN ET SES REVENDEURS 
DÉCLINENT EXPRESSEMENT TOUTE GARANTIE IMPLICITE DE COMMERCIALISATION OU D'ADAPTATION DANS 
QUELQUE BUT QUE CE SOIT. LA RESPONSABILITÉ DE BLACKMAGIC DESIGN POUR RÉPARER OU REMPLACER 
UN PRODUIT S'AVÉRANT DÉFECTUEUX CONSTITUE LA TOTALITÉ ET LE SEUL RECOURS EXCLUSIF PRÉVU ET 
FOURNI AU CONSOMMATEUR POUR TOUT DOMMAGE INDIRECT, SPÉCIFIQUE, ACCIDENTEL OU CONSÉCUTIF, 
PEU IMPORTE QUE BLACKMAGIC DESIGN OU SES REVENDEURS AIENT ÉTÉ INFORMÉS OU SE SOIENT RENDUS 
COMPTE AU PRÉALABLE DE L'ÉVENTUALITÉ DE CES DOMMAGES. BLACKMAGIC DESIGN NE PEUT ÊTRE TENU 
POUR RESPONSABLE DE TOUTE UTILISATION ILLICITE OU ABUSIVE DU MATÉRIEL PAR LE CONSOMMATEUR. 
BLACKMAGIC DESIGN N'EST PAS RESPONSABLE DES DOMMAGES RÉSULTANT DE L'UTILISATION DE CE 

PRODUIT. LE CONSOMMATEUR MANIPULE CE PRODUIT A SES SEULS RISQUES. 

© Copyright 2014 Blackmagic Design. Tous droits réservés. ‘Blackmagic Design’, ‘DeckLink’, ‘HDLink’, ‘Workgroup Videohub’, ‘ Videohub’, 
‘DeckLink’, ‘Intensity’ et ‘Leading the creative video revolution’ sont des marques déposées aux USA et dans d'autres pays. Tous les autres noms 
de société et de produits peuvent être des marques déposées de leurs sociétés respectives auxquelles ils sont associés.

Thunderbolt et le logo Thunderbolt sont des marques d'Intel Corporation aux USA et/ou dans d'autres pays.

Garantie
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Willkommen zu Desktop Video!

Wir verfolgen den Traum von einer Entwicklung der Fernsehbranche zu einer echten 
Kreativbranche, indem wir jedermann den Zugriff auf Video höchster Qualität ermöglichen, 
und wünschen Ihnen in diesem Sinne kreatives Schaffen.

Früher erforderten highendige Fernseh- und Postproduktionen Hardware-Investitionen 
in Millionenhöhe. Jetzt ist mit Blackmagic Videohardware sogar die Produktion von 
unkomprimiertem 10-Bit-Video durchaus erschwinglich. Wir wünschen Ihnen viele 
produktive Jahre mit Ihrem neuen UltraStudio, DeckLink oder Intensity und viel Freude an 
der Arbeit mit einer der weltweit angesagtesten Fernseh- und Kreativsoftwares!

Diese Bedienungsanleitung enthält alle für die Installation Ihrer Blackmagic 
Videohardware nötigen Informationen. Wer zum ersten Mal Hardware-Karten in einen 
Computer einbaut, ist bei der Installation einer PCI Express-Karte immer gut beraten, 
sich von einem technischen Assistenten helfen zu lassen. Da Blackmagic Videohardware 
unkomprimiertes Video mit entsprechend hohen Datenraten verwendet, brauchen Sie 
einen schnellen Festplattenspeicher und einen leistungsfähigen Computer.

Unserer Einschätzung nach sollte die komplette Installation nicht mehr als rund 10 
Minuten dauern. Bitte besuchen Sie vor der Installation von Blackmagic Videohardware 
unsere Website unter www.blackmagicdesign.com, klicken Sie auf die Support-Seite und 
laden Sie sich diese Bedienungsanleitung und die Desktop Video Treibersoftware in der 
aktuellsten Version herunter. Abschließend bitten wir Sie, sich beim Herunterladen von 
Software-Updates zu registrieren, da wir Sie gerne über künftige Software-Updates und 
neue Features informieren möchten. Wenn Sie Lust haben, schicken Sie uns vielleicht 
sogar Ihre aktuellste, mit Blackmagic Videohardware erstellte Demoaufnahme sowie 
Anregungen, wie wir die Software weiter verbessern könnten. Wir arbeiten ständig an 
neuen Features und Verbesserungen und würden uns freuen, von Ihnen zu hören!

Grant Petty
CEO Blackmagic Design
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Einleitung Desktop Video
Die Desktop Video Software von Blackmagic Design arbeitet in Verbindung mit Ihrer UltraStudio, DeckLink, Intensity 
oder Teranex Hardware. Die Desktop Video Software enthält Treiber, Plug-ins und Applikationen wie Blackmagic Media 
Express. Desktop Video integriert sich auch nahtlos mit Ihren bevorzugten Softwareprodukten von Adobe, Apple, 
Autodesk und Avid!

Diese Bedienungsanleitung gibt die Computer-Systemvoraussetzungen an und erklärt, wie Sie Hardware und Software 
installieren und Ihre bevorzugte Fremdhersteller-Software anwenden.

Systemvoraussetzungen
Sie brauchen einen Computer mit einem Arbeitsspeicher von mindestens 4 GB. PCIe x1-Lane-Karten dürften 
an jedem beliebigen Steckplatz funktionieren. Für PCIe x4-Lane-Karten ist ein x4 Lane-Steckplatz oder schneller 
erforderlich.

Mac OS X
Desktop Video Software läuft unter den aktuellsten Versionen von Mountain Lion und Mavericks des  
Mac OS-X-Betriebssystems.

Bei Anschluss Ihrer Blackmagic Videohardware an Ihren Computer über einen PCI-Express-Steckplatz ist ein  
Intel-basierter Mac Pro erforderlich.

Bei Anschluss Ihrer Blackmagic Videohardware an Ihren Computer über Thunderbolt brauchen Sie einen  
Intel-basierten Mac mit Thunderbolt™-Port.

Windows
Desktop Video läuft ausschließlich unter 64-Bit-Versionen von Windows, bei denen der aktuellste Service Pack installiert 
ist. Windows 7 und Windows 8 werden ebenfalls unterstützt.

Bei Anschluss Ihrer Blackmagic Videohardware an Ihren Computer über Thunderbolt brauchen Sie einen Intel-based PC 
mit Thunderbolt-Port.

Bei Anschluss Ihrer Blackmagic Videohardware an Ihren Computer über USB 3.0 ist ein USB-3.0-Port mit einem Renesas-
Chipsatz erforderlich.

Linux
Desktop Video läuft auf x86-Computern mit 32-Bit und 64-Bit unter Linux 2.6.23 oder höher. Bitte sehen Sie 
in den Versionshinweisen nach der aktuellsten Liste unterstützter Linux-Distributionen, Paketformaten und  
Software-Abhängigkeiten.

Erste Schritte
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Installation Ihrer Blackmagic Videohardware
Erfolgt der Anschluss Ihrer Blackmagic Videohardware über Thunderbolt, gehen Sie direkt zum Abschnitt über 
Thunderbolt. Die neuesten Mac OSX- und Windows-Computer sind mit Thunderbolt-Ports ausgestattet.

Erfolgt der Anschluss Ihrer Blackmagic Videohardware über USB 3.0, gehen Sie direkt zum Abschnitt über USB 3.0. Für 
Blackmagic Videoprodukte mit USB 3.0 ist ein kompatibler Windows PC erforderlich.

Installation einer Blackmagic PCIe Karte
Schritt 1. Ziehen Sie zur elektrostatischen Entladung den Netzstecker Ihres Computers aus der Steckdose.

Schritt 2. Führen Sie Ihre Blackmagic PCIe-Karte in einen geeigneten Steckplatz Ihres Computers ein und drücken Sie 
sie fest in Position. Bei Einsatz einer DeckLink Optical Fiber Karte muss das Glasfasermodul vor Einstecken 
der Karte entfernt werden.

Schritt 3. Ist Ihre Blackmagic PCIe Karte mit einer HDMI-Halterung ausgestattet, führen Sie die Halterung in einen 
freien Steckplatz ein. Schrauben Sie die PCIe-Karte und HDMI-Halterung fest. Führen Sie die HDMI-Kabel im 
Bogen um andere installierte Karten herum und stecken Sie sie von hinten in die DeckLink-Karte. 

Schritt 4. Setzen Sie die Abdeckung Ihres Computers wieder auf und schließen Sie mitgelieferte Breakout-Kabel an. 
Setzen Sie bei Einsatz einer DeckLink Optical Fiber Karte das Glasfasermodul wieder ein. Stecken Sie den 
Netzstecker wieder ein und fahren Sie den Computer hoch.Installieren Sie eine Blackmagic PCIe Karte in einem freien Steckplatz. Eine 

HDMI-Halterung ist an einem beliebigen freien Steckplatz installierbar 
und wird über die mitgelieferten HDMI-Kabel an der Kartenrückseite 
angeschlossen

Wenn Ihre Blackmagic Karte mit einem Breakout-Kabel geliefert wurde, 
schließen Sie es an. Einige Modelle werden zudem mit einer HDMI-
Halterung geliefert. Siehe Abbildung oben
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Anschließen von Blackmagic Videohardware mit Thunderbolt
Schritt 1. Verfügt Ihre Blackmagic Videohardware über ein externes Netzteil, schließen Sie es an das Gerät an und 

schalten Sie den Strom ein.

Schritt 2. Verbinden Sie das Gerät über ein Thunderbolt-Kabel mit einem Thunderbolt-Port an Ihrem Computer. 
Alternativ können Sie das Gerät auch an das Thunderbolt-Datenträger-Array Ihres Computers anschließen.

Schritt 3. Wenn Sie von einer bereits installierten Version der Desktop Video Software zur Aktualisierung der 
Produktsoftware aufgefordert werden, klicken Sie auf „Aktualisieren" und folgen Sie den Anweisungen auf 
dem Bildschirm.

Schritt 4. Schließen Sie, sofern vorhanden, das mitgelieferte Breakout-Kabel an die Blackmagic Videohardware an und 
verbinden Sie die Stecker mit Ihrem Videogerät.

Anschließen von Blackmagic Videohardware mit USB 3.0
Schritt 1. Verfügt Ihre Blackmagic Videohardware über ein externes Netzteil, schließen Sie es an das Gerät an und 

schalten Sie den Strom ein.

Schritt 2. Schließen Sie das Gerät über ein SuperSpeed USB-3.0-Kabel an einen dedizierten USB-3.0-Port Ihres 
Computers an.

Schritt 3. Wenn Sie durch eine bereits installierte Version der Desktop Video Software zur Aktualisierung der 
Produktsoftware aufgefordert werden, klicken Sie auf „Aktualisieren" und folgen Sie den Anweisungen auf 
dem Bildschirm.

Schritt 4. Schließen Sie, sofern vorhanden, das mitgelieferte Breakout-Kabel an die Blackmagic Videohardware an und 
verbinden Sie die Stecker mit Ihrem Videogerät.

Der Anschluss von Thunderbolt™- und USB-3.0-Produkten an Ihren 
Computer erfolgt über ein einziges Thunderbolt- oder USB-3.0-Kabel

Das UltraStudio 4K ist mit zwei Thunderbolt 2™-Ports ausgestattet. 
Falls Ihr Computer nur einen Thunderbolt™-Port hat, können Sie an 
den zusätzlichen Port des UltraStudios ein RAID oder anderes Gerät 
anschließen

PUSH

PUSH
PUSH
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Installation von Blackmagic Design Software

Applikationen, Plug-ins und Treiber
Die nachstehende Tabelle führt Applikationen, Plug-ins und Treiber auf, die zusammen mit der Desktop Video Software 
installiert werden.

Mac OS X Windows Linux

Blackmagic Desktop Videotreiber Blackmagic Desktop Videotreiber Blackmagic Desktop Videotreiber

Blackmagic Design 
Systemeinstellung

Blackmagic Design Control Panel Blackmagic Design Control Panel

Blackmagic Design LiveKey Blackmagic Design LiveKey Blackmagic Media Express

Blackmagic Media Express Blackmagic Media Express Blackmagic AVI Codecs

Blackmagic QuickTime™ Codecs Blackmagic AVI and QuickTime™ 
Codecs

Blackmagic Disk Speed Test Blackmagic Disk Speed Test

Voreinstellungen und Plug-ins für 
Adobe® Premiere Pro® CC, After 
Effects® CC und Photoshop® CC

Voreinstellungen und Plug-ins für 
Adobe® Premiere Pro® CC, After 
Effects® CC und Photoshop® CC

Apple Final Cut Pro™ X Plug-ins Avid Media Composer Plug-in

Avid Media Composer Plug-in eyeon Fusion Plug-ins
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Installation unter Mac OS X
Für die Installation von Software müssen Sie über Administratorrechte verfügen.

Schritt 1. Vergewissern Sie sich, dass Ihnen der aktuellste Treiber vorliegt. Besuchen Sie www.blackmagicdesign.com/
de/support

Schritt 2. Öffnen Sie den Ordner „Desktop Video Installer” von der Diskette oder dem heruntergeladenen 
Diskettenbild und starten Sie das Installationsprogramm „Desktop Video Installer”. 

Schritt 3. Klicken Sie auf die Schaltflächen „Weiter", „Zustimmen und Installieren", um die Software zu installieren.

Schritt 4. Fahren Sie Ihren Computer erneut hoch, um die neuen Softwaretreiber zu aktivieren.

Automatische Aktualisierungen
Beim Neustart Ihres Mac-Computers identifiziert die Software die auf Ihrer Hardware geladene Produktsoftwareversion. 
Stimmt diese nicht mit der Version des Treibers überein, werden Sie zur Aktualisierung der Produktsoftware aufgefordert. 
Klicken Sie auf OK, um mit der Aktualisierung zu beginnen oder fahren Sie Ihren Mac erneut hoch, um den Vorgang 
abzuschließen.

Installation unter Windows
Schritt 1. Vergewissern Sie sich, dass Ihnen der aktuellste Treiber vorliegt. Besuchen Sie www.blackmagicdesign.com/

de/support

Schritt 2. Öffnen Sie den Ordner „Desktop Video” und starten Sie das Installationsprogramm „Desktop Video”.

Schritt 3. Die Treiber werden jetzt in Ihrem System installiert. Es erscheint folgender Warnhinweis: „Möchten Sie dem 
nachstehenden Programm erlauben, Software auf diesem Computer zu installieren?" Klicken Sie auf „Ja", 
um fortzufahren.

Schritt 4. Es erscheint eine Dialogblase mit dem Hinweis „Neue Hardware gefunden" und dann der Hardware-
Assistent. Wählen Sie „Automatisch installieren” aus, damit das System die erforderlichen Desktop Video 
Treiber automatisch ausfindig macht. Dann erscheint eine weitere Dialogblase mit dem Hinweis „Ihre neue 
Hardware ist einsatzbereit".

Schritt 5. Fahren Sie Ihren Computer erneut hoch, um die neuen Softwaretreiber zu aktivieren.

Automatische Aktualisierungen
Beim Neustart Ihres Computers identifiziert die Software die auf Ihrer Hardware geladene Produktsoftwareversion. 
Unterscheidet sich die vorhandene Version der Produktsoftware von der des Treibers, werden Sie zur Aktualisierung der 
Produktsoftware aufgefordert. Klicken Sie auf OK, um mit der Aktualisierung zu beginnen und fahren Sie Ihren Computer 
erneut hoch, um den Vorgang abzuschließen.

Desktop Video Installer für Mac

Desktop Video Installer für Windows
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Installation unter Linux
Schritt 1. Laden Sie sich die aktuellste Desktop Video Software für Linux von www.blackmagicdesign.com/support 

herunter.

Schritt 2. Öffnen Sie den Ordner „Desktop Video”, machen Sie das Paket „Desktop Video” für Ihre Linux-Distribution 
ausfindig und öffnen Sie es.

Schritt 3. Klicken Sie auf die Schaltfläche „Installieren". Der Fortschrittsbalken zeigt die beendete Installation an.

Schritt 4. Wenn Meldungen über fehlende Abhängigkeiten angezeigt werden, installieren Sie diese und führen das 
Desktop Video Installationsprogramm erneut aus.

Schritt 5. Nach beendeter Installation wird wieder der vorherige Bildschirm angezeigt.

Schritt 6. Fahren Sie Ihren Computer erneut hoch, um die Treiber zu aktivieren oder tippen Sie den nachstehenden 
Befehl ein:

 # modprobe blackmagic

Falls Sie kein natives Desktop Video Paket für Ihre Linux-Distribution finden können oder Sie lieber über eine Befehlszeile 
installieren, lesen Sie detaillierte Installationsanweisungen in der ReadMe-Datei.

Updates
Nach erfolgtem Neustart Ihres Computers prüfen die Treiber die Blackmagic Videohardware auf vorhandene 
Produktsoftware. Unterscheidet sich die vorliegende Version der Produktsoftware von der des Treibers, fordert Desktop 
Video Sie zur Aktualisierung auf. Um die Kennung von zu aktualisierenden Karten herauszufinden, öffnen Sie die 
Benutzerstation und tippen Sie den nachstehenden Befehl ein:

# BlackmagicFirmwareUpdater status

Dann wird eine der nachstehenden ähnliche Meldung angezeigt:

/dev/blackmagic/card0 [DeckLink HD Extreme 3] UPDATED
/dev/blackmagic/card1 [DeckLink HD Extreme 3] NEEDS_UPDATE

Notieren Sie sich die Kennung der zu aktualisierenden Karte und aktualisieren Sie die Firmware, indem Sie Folgendes 
eintippen:

# BlackmagicFirmwareUpdater update <card_id> (in diesem Fall 1)

Desktop Video Software steht zur Installation aus dem Ubuntu Software 
Center bereit
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Erfassung und Wiedergabe von Video 
Es ist ratsam, sich anhand eines Schnelltests zu vergewissern, dass die Erfassung und Wiedergabe von Video 
einwandfrei sind. 

Einrichtung
Schritt 1. Schließen Sie einen Videomonitor oder Fernseher an den Videoausgang Ihrer Blackmagic 

Videohardware an.

Schritt 2. Schließen Sie eine Videoquelle an den Videoeingang Ihrer Blackmagic Videohardware an.

Schritt 3. Verwenden Sie die Blackmagic Systemeinstellungen, um Ihre Video- und Audioanschlüsse für die Ein- und 
Ausgabe einzurichten. Einzelheiten siehe Abschnitt „Anwendung der Blackmagic Systemeinstellungen".

Testen der Videoaufnahme

Schritt 1. Gehen Sie unter Mac OS X zu „Media Express“ > „Einstellungen“ oder unter Windows oder Linux zu 
„Bearbeiten“ > „Einstellungen“ und wählen Sie dort ein passendes Projektformat für Ihre Videoquelle aus. 
Wählen Sie außerdem ein Aufnahme-Dateiformat und einen Speicherstandort aus.

Schritt 2. Schließen Sie „Settings" (Einstellungen) und klicken Sie auf die Registerkarte „Log and Capture" (Indizieren 
und Erfassen). Ihre Videoquelle erscheint im Vorschaufenster von Media Express.

Schritt 3. Klicken Sie auf „Capture" (Erfassen), um den Videoerfassungstest durchzuführen. Klicken Sie zur Beendung 
des Tests erneut auf „Capture".

Testen der Videowiedergabe
Schritt 1. Klicken Sie auf die Registerkarte „Playback" (Wiedergabe).

Schritt 2. Doppelklicken Sie auf den Testclip. Das Video erscheint nun auf dem Monitor, der an den Ausgang Ihrer 
Blackmagic Videohardware angeschlossen ist. Die Audioausgabe lässt sich ebenfalls kontrollieren.

Camera Outputs

HDTV

Klicken Sie auf die „Capture"-Schaltfläche, um die Aufnahme zu starten

Schließen Sie einen Videomonitor und eine -quelle an Ihre Blackmagic 
Videohardware an
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Starten der Blackmagic Systemeinstellungen
Die Blackmagic Systemeinstellungen bieten einen zentralen Standort für Konfigurationseinstellungen.

 � Unter Mac OS X: Öffnen Sie „Systemeinstellungen" und klicken Sie auf das Blackmagic  
Design Symbol.

 � Unter Windows 7 und Windows 8: Öffnen Sie die Systemsteuerung, klicken Sie auf die Kategorie 
„Hardware und Sound” und dann auf das Blackmagic Design Control Panel.

 � Unter Linux: Gehen Sie zu „Anwendungen" und dann zu „Sound und Video". Führen Sie einen 
Doppelklick auf dem Blackmagic Control Panel aus.

Die verschiedenen Blackmagic Videohardware-Modelle weisen unterschiedliche Features auf. Es sind nur die von Ihrem 
Hardware-Modell unterstützten Systemeinstellungen aktiv.

Der nachstehende Abschnitt zeigt Ihnen, wie Sie die Blackmagic Systemeinstellungen anpassen.

Blackmagic Design Systemeinstellungen unter Mac OS X Blackmagic Design Control Panel unter Windows Blackmagic Design Control Panel unter Ubuntu Linux

Anwendung der Blackmagic Systemeinstellungen
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Die Einstellungs-Registerkarte (Settings)

Einstellung der Ausgabe (Set output)
Richten Sie die Anschlüsse für die Video- und Audioeingabe Ihrer Blackmagic Videohardware ein. Bei manchen 
Modellen haben Sie die Wahl zwischen analogen Komponentensignalen, S-Video oder analogen FBAS-Signalen. 
Manche Modelle weisen umschaltbare Audioausgänge auf, die Sie zwischen analog und AES/EBU auswählen lassen.

Einstellung der Eingabe (Set input)
Richten Sie die Anschlüsse für die Video- und Audioeingabe Ihrer Blackmagic Videohardware ein. Ihre Hardware 
unterstützt u. U. einige oder alle der nachstehenden Kombinationen:

 � SDI Video & SDI Audio (SDI-Video und SDI-Audio)

 � SDI Video & AES/EBU Audio (SDI-Video und AES/EBU-Audio)

 � SDI Video & Analog XLR Audio (SDI-Video und analoges XLR-Audio)

 � Optical SDI Video & Optical SDI Audio (Glasfaser-SDI-Video und Glasfaser-SDI-Audio)

 � HDMI Video & HDMI Audio (HDMI-Video und HDMI-Audio)

 � HDMI Video & AES/EBU Audio (HDMI-Video und AES/EBU-Audio)

 � HDMI Video & Analog XLR Audio (HDMI-Video und analoges XLR-Audio)

 � Component Video & AES/EBU Audio (Komponentensignale und AES/EBU-Audio)

 � Component Video & Analog XLR Audio (Komponentensignale und analoges XLR-Audio)

 � Composite & AES/EBU Audio (FBAS-Signale und AES/EBU-Audio)

 � Composite & Analog XLR Audio (FBAS-Signale und analoges XLR-Audio)

 � S-Video & AES/EBU Audio (S-Video und AES/EBU-Audio)

 � S-Video & Analog XLR Audio (S-Video und analoges XLR-Audio)

Video-Setup in NTSC verwenden (Use video setup in NTSC) 
Wählen Sie den Schwarzwert „At 7.5 IRE for use in the USA" für NTSC FBAS-Video aus, das in den USA und einigen 
anderen Ländern eingesetzt wird. Wählen Sie den Schwarzwert „At 0.0 IRE for use in Japan" beim Einsatz in Japan oder 
anderen Ländern aus, wo der Schwarzwert 7,5 IRE nicht verwendet wird. Für PAL- und High-Definition-Formate wird 
diese Einstellung nicht verwendet.

Video- und Audioausgabeanschlüsse

Video- und Audioeingabeanschlüsse

Wählen Sie für als Schwarzwert 7,5 IRE für NTSC FBAS-Video oder 0 IRE 
aus
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Video möglichst in 4:4:4: SDI ausgeben (Use 4:4:4 SDI on video output when possible) 
Wählen Sie diese Option für die Ausgabe von Video im Verhältnis 4:4:4 aus. Video im Format 1080p50/60 wird immer 
im Verhältnis 4:2:2 ausgegeben. Bei Aktivierung der Videoausgabe in 4:4:4 sind folgende Funktionen nicht verfügbar:

 �  simultane Ausgabe von HD- und abwärtskonvertiertem SD-Video

 �  Ausgabe von abwärtskonvertiertem Analogvideo

3 oder 6Gb SDI verwenden (Use 3/6Gb SDI not Dual Link SDI output)
Wählen Sie diese Einstellung für Single Link 3G oder 6G SDI bei Einsatz von Formaten mit hoher Bandbreite aus, z. B. 
1080p60, 4:4:4 oder bei Einsatz von 4K-Formaten.

1080p verwenden, nicht 1080PsF (Use 1080p not 1080PsF)
Wählen Sie diese Einstellung aus, um Video in echten progressiven Vollbildern anstatt in progressiven, segmentierten 
Vollbildern (Progressive segmented Frame) auszugeben.

Halbbildflimmern beim Pausieren entfernen (Remove field jitter when video is paused)
Wählen Sie diese Einstellung, damit beim Pausieren von Video mit Halbbildern (interlaced) auf alten CRT-Monitoren 
(Kathodenstrahl-Bildröhren) kein Kantenflimmern entsteht, indem nur ein Halbbild angezeigt wird. Für moderne 
Flachbildschirme wird diese Option nicht empfohlen.

Eingabe mit LTC-Timecode verwenden (Use LTC Timecode input)
Wählen Sie diese Einstellung aus, um den Timecode aus der LTC-Eingabe statt aus dem SDI-Datenstrom auszulesen.

Aktivieren Sie die Dialogbox, um Video in 4:4:4 auszugeben

Aktivieren Sie die Dialogbox, um Single Link 3G oder 6G SDI zu 
verwenden

Aktivieren Sie die Dialogbox, um Video in echten 1080 progressiven 
Vollbildern auszugeben

Aktivieren Sie die Dialogbox, um bei CRT-Monitoren Kantenflimmern zu 
eliminieren

Aktivieren Sie die Dialogbox, um den Timecode aus der LTC-Eingabe 
auszulesen
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Standardmäßige Videonorm vorgeben als (Set default video standard as)
Stellen Sie für Broadcast-Monitoring mit Final Cut Pro X eine mit Ihrem Final Cut Pro X-Projekt übereinstimmende 
Videonorm ein.

Stellen Sie die standardmäßige Videonorm zur Videoaufnahme unter Windows mit einem das Windows Driver Model 
(WDM) unterstützenden Programm so ein, dass sie mit der Aufnahmenorm übereinstimmt. Normalerweise wird die 
Videonorm in den Einstellungen des WDM-Programms vorgegeben. Falls dabei Probleme auftreten, versuchen Sie es 
über das Blackmagic Design Control Panel.

Wenn kein Video wiedergegeben wird... (When not playing video, send)
Diese Einstellung bestimmt, ob Ihre Hardware das zuletzt wiedergegebene Einzelbild (Last Frame Played) oder Schwarz 
(Black) ausgibt, wenn Sie aus einer Anwendung wegschalten und kein Video mehr abgespielt wird.

Manche Blackmagic Modelle beinhalten Wertetabellen, sogenannte Look Up Tables (LUTs) mit der Option „Last Played 
Frame", die anzeigt, wie sich vorgenommene Änderungen auf die LUT auswirken. Zur Aktivierung bzw. Deaktivierung 
dieser Funktion ist ein Neustart des Computers erforderlich.

HDMI 3D anzeigen als (Display HDMI 3D as)
Diese Einstellung bestimmt das 3D-Format für Ihr HDMI-Monitoring. Zur Auswahl stehen u. a. folgende Anzeigemodi: 
Frame-Packing (Anordnung untereinander), Side-by-Side (Nebeneinander), Line-by-Line (Zeile für Zeile), Top-and-
Bottom (Oben und unten), Left Eye (Linkes Auge) oder Right Eye (Rechtes Auge).

Timing der Ausgabereferenzausgabe vorgeben (Set Reference output timing)
Wenn Ihr Bild trotz angeschlossener Referenz läuft, justieren Sie den Schieberegler, bis das Bild einrastet. Ein 
Referenzsignal wird auch als Genlock, Black-Burst, House Sync (Haustakt) oder Tri-Sync bezeichnet.

Wählen Sie für Ihr HDMI-Monitoring das 3D-Format aus

Stellen Sie die Videonorm auf die Norm Ihres Final Cut Pro X-Projekts ein 
oder auf Aufnahme mit Ihrem WDM-Programm

Wird kein Video abgespielt, können Sie das zuletzt wiedergegebene 
Einzelbild (Last Frame Played) oder Schwarz (Black) senden

Justieren Sie den Referenzzeit-Schieberegler, bis das Bild einrastet
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Die Verarbeitungs-Registerkarte (Processing)

Ausgabeverarbeitung auswählen (Select output processing)
Diese Einstellung gestattet Echtzeit-Konvertierung während der Wiedergabe. Wählen Sie die gewünschte Option im 
Menü aus.

Manche Hardware-Modelle unterstützen die gleichzeitige Abwärtskonvertierung der Ausgabe, wie z. B. HD nach SD 
oder 2K nach SD. Bei simultaner Abwärtskonvertierung entsteht bei der SD-SDI-Ausgabe eine Verzögerung um zwei 
Frames. Passen Sie den Timecode-Versatz Ihrer Schnittsoftware an, damit beim Insert-Schnitt oder Assembling auf Band 
die Frame-Genauigkeit gewährleistet bleibt.

Analoge Videoausgaben werden ebenfalls abwärtskonvertiert. Analoges Komponentenvideo lässt sich zwischen HD- 
und SD-Ausgaben umschalten. Wählen Sie „Enable Conversion on Analog Output" bei gleichzeitig aktivierter Option 
„Simultaneous HD and SD Output" aus, um analoges Komponentenvideo in SD anzusehen.

Eingabeverarbeitung auswählen (Select input processing)
Diese Einstellung ermöglicht die Auf- und Aufwärtskonvertierung in Echtzeit bei der Aufnahme. Wählen Sie die 
gewünschte Option im Menü aus.

Option „Output HD 23.98PsF as HD 59.94i" (Nur Windows)
Bei dieser Einstellung wird eine 3:2 Pulldown-Sequenz angewendet und HD 23,98 PsF Video als HD 59,94i 
ausgegeben. Die Film-Framerate von 23,98 fps ist zwar recht gebräuchlich, wird aber selten von SDI- und 
analogen Monitoren unterstützt. Nahezu alle HD-Monitore unterstützen jedoch HD 59,94i.

Einstellen des A-Frames als VITC-Referenz (Set A-frame VITC reference)
Diese Einstellung gestattet die Eingabe der Nummer des A-Frames, um bei der Aufzeichnung in 23,98 fps das 3:2 
Pulldown von NTSC-Video rückgängig zu machen. Ein inkorrekter A-Frame verursacht die inkorrekte Darstellung von 
Halbbildern und Filmframes.

VANC-Eingabezeile aufnehmen (Capture VANC input line)
Diese Einstellungen gestatten die Beibehaltung von dreizeiligen Timecode- und VITC-Untertitelinfos sowie sonstigen 
VANC-Daten bei der Aufnahme. Um VANC-Daten beizubehalten, aktivieren Sie die Dialogbox für die aufzunehmende 
Videozeile. Zeile 1 muss aktiviert sein, damit Zeilen 2 und 3 funktionieren.

Wählen Sie Ausgabeverarbeitung im Menü aus

Aktivieren Sie die Dialogbox, um HD 23,98 PsF in HD 59,94i auszugeben

Geben Sie die A-Frame VITC-Referenz für das 3:2 Pulldown-Verfahren an

Aktivieren Sie die Dialogboxen zur Erfassung von VANC-Datenzeilen
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Die Videopegel-Registerkarte (Video Levels)
Analoge Videoeingabe kalibrieren (Calibrate Analog Video In)
Über diese Einstellungen wird die analoge Videoeingabe angepasst. Justieren Sie die Pegel für Video, Chroma, Cb und 
Cr mit den Schiebereglern. Idealerweise passt man diese Einstellungen in Verbindung mit einem Blackmagic Ultrascope 
an. Die Einstellungsoptionen „Calibrate Analog Video In" sind nur verfügbar, wenn die Option „Set input" (Eingabe 
einstellen) auf der Registerkarte „Settings" auf analoge Videoeingabe eingestellt ist.

Analoge Videoausgabe kalibrieren (Calibrate Analog Video Out)
Mit diesen Einstellungen wird die analoge Videoausgabe angepasst. Justieren Sie die Pegel für Video, Chroma, Cb 
und Cr mit den Schiebereglern. Idealerweise passt man diese Einstellungen in Verbindung mit einem Blackmagic 
Ultrascope an.

Betacam-YUV-Pegel verwenden (Use Betacam YUV Levels)  
Standardmäßig verwenden Blackmagic Produkte analoge Komponentensignalpegel gemäß SMPTE, da fast alle 
modernen Videogeräte mit SMPTE-Pegeln arbeiten. Aktivieren Sie für die Arbeit mit Sony Betacam SP MAZen die 
Dialogbox „Use Betacam YUV Levels".

Die Audiopegel-Registerkarte (Audio Levels)
Eingangspegel für Analogaudio einstellen (Set Analog Audio Input Levels)
Über diese Einstellungen wird die Verstärkung der analogen Audioeingänge angepasst.

Ausgangspegel für Analogaudio einstellen (Set Analog Audio Output Levels) 
Über diese Einstellungen wird die Verstärkung der analogen Audioausgänge angepasst. 

Einstellung des AES/EBU-Eingabereferenzpegels (Set AES/EBU Input Ref Level)
Über diese Einstellungen wird die Verstärkung der AES/EBU-Audioeingänge angepasst. Im Gegensatz zu analogen 
Audiokanälen, die unabhängig voneinander anpassbar sind, werden die AES/EBU-Audiokanäle gleichzeitig angepasst.

AES/EBU-Ausgabereferenzpegel einstellen (Set AES/EBU Output Ref Level)
Über diese Einstellungen wird die Verstärkung für die AES/EBU-Audioausgänge angepasst. Im Gegensatz zu analogen 
Audiokanälen, die unabhängig voneinander anpassbar sind, werden die AES/EBU-Audiokanäle gleichzeitig angepasst. 

HiFi-Audiopegel verwenden (Use HiFi Audio Levels)
Bei UltraStudio und DeckLink Modellen sind professionelle Analogaudiopegel der Standard mit XLR-Anschlüssen. Um 
Consumer-Audiogeräte anzuschließen, aktivieren Sie die Option „Use HiFi Audio Levels", und benutzen Sie einen XLR-
zu-RCA-Adapter. 

Über die Schieberegler werden die Video- und Chromapegel für 
Analogvideo justiert

Über die Schieberegler wird die Verstärkung für Analog- und AES/EBU-
Audio eingestellt
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After Effects® CC

So erfolgt die Vorschau von Video
Um Ihre mit Adobe After Effects® CC erstellte Komposition in Echtzeit über Ihre Blackmagic Hardware anzusehen, 
gehen Sie zu „Preferences“ > „Video Preview" („Einstellungen“ > „Videovorschau“). Wählen Sie die Ausgabeoption 
„Select Blackmagic Video Output" und den passenden Ausgabemodus (Output Mode) aus. Jetzt können Sie einen 
Broadcast-Monitor einsetzen, um Ihre After Effects® CC-Kompositionen im richtigen Videofarbraum anzusehen.

Um Ihr Audio über Ihre Blackmagic Hardware anzuhören, gehen Sie unter Mac OS X bzw. Windows zu den 
Systemeinstellungen und stellen Sie „Blackmagic Audio" als Ihr standardmäßiges Tonausgabegerät aus. Gehen Sie in 
After Effects® CC zu „Einstellungen" > „Audiohardware" und vergewissern Sie sich, dass Ihre Audioausgabe jetzt auf 
„System Default Input/Output" (Standardmäßige Eingabe/Ausgabe) unter Mac OS X oder auf „Blackmagic Audio" 
unter Windows eingestellt ist.

Rendering
Nach Fertigstellung Ihrer Komposition muss sie in einen von Ihrer Blackmagic Videohardware unterstützten Codec 
gerendert werden. Sie können eine DPX-Bildsequenz oder einen der folgenden Codecs rendern:

Weitere Codecs einschließlich von ProRes und DVCPRO HD sind verfügbar, sofern Final Cut Pro installiert ist.

Weitere Codecs einschließlich von DVCPRO HD und DVCPRO50 sind verfügbar, sofern Adobe® Premiere Pro® CC 
installiert ist.

After Effects® CC

Ausgabemodi für das Rendering (Output Module Settings) 

Einstellungen für die Videovorschau

 � Blackmagic 10 Bit 4:4:4 (unkomprimiert)

 � Blackmagic 10 Bit 4:2:2 (unkomprimiert)

 � Blackmagic HD 8 Bit 4:2:2 (unkomprimiert)

 � Blackmagic SD 8 Bit 4:2:2 (unkomprimiert)

 � Blackmagic 8 Bit MJPEG (umkomprimiert)

AVI-Codecs unter Windows

 � Blackmagic RGB 10 Bit (unkomprimiert)

 � Blackmagic 10 Bit (unkomprimiert)

 � Blackmagic 8 Bit (unkomprimiert)

 � Apple Photo-JPEG (komprimiert)

 � Apple DV – NTSC (komprimiert)

 � Apple DV – PAL (komprimiert)

QuickTime-Codecs unter Windows

 � Blackmagic RGB 10 Bit (unkomprimiert)

 � Apple unkomprimiert YUV 10 Bit 4:2:2

 � Apple unkomprimiert YUV 8 Bit 4:2:2

 � Apple Photo – JPEG (komprimiert)

 � Apple DV – NTSC (komprimiert)

 � Apple DV – PAL (komprimiert)

QuickTime-Codecs unter Mac OS X

Einsatz Ihrer favorisierten Fremdhersteller-Software
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Photoshop® CC

Videoframes importieren und exportieren

Importieren eines Bilds in Photoshop® CC

Schritt 1. Wählen Sie in Photoshop® CC „Datei" > „Importieren" > „Blackmagic-Bildaufnahme" aus.

Schritt 2. Wählen Sie „Videoeingabeformat” und „Bit-Farbtiefe des Bildes” aus und klicken Sie dann auf „Bild 
importieren".

Exportieren eines Bilds aus Photoshop

Schritt 1. Wählen Sie „Datei" > „Exportieren" > „Blackmagic-Bildexport aus".

Schritt 2. Wählen Sie das Videoausgabeformat aus und klicken Sie auf „Bild exportieren".

Nach Einstellung der Optionen für den „Import” oder „Export” werden spätere Im- und Exporte nicht mehr im 
Einstellungsfenster angezeigt. Ihre Einstellungen lassen sich jedoch weiterhin ändern, indem Sie bei der Auswahl 
von Import oder Export die Optionstaste (Mac) bzw. Strg-Taste (Windows) gedrückt halten.

Bild importieren

Bild exportieren

Photoshop® CC
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Adobe® Premiere Pro® CC

Einrichten eines Blackmagic Design Projekts
Schritt 1. Legen Sie ein neues Projekt an. Klicken Sie auf die Registerkarte „Scratch Disks" und geben Sie den 

gewünschten Standort und Namen für Ihr Projekt vor.

Schritt 2. Bestimmen Sie die Standorte für Ihr erfasstes Video und Audio sowie für Ihre Video- und Audiovorschauen.

Schritt 3. Wird Ihre Grafikkarte in Adobe® Premiere Pro® CC von der Mercury-Wiedergabe-Engine unterstützt, 
so steht die Option „Renderer" bereit. Schalten Sie diese auf die GPU-Beschleunigungsoption „Mercury 
Playback Engine GPU Acceleration" um.

Schritt 4. Stellen Sie das Aufnahmeformat (Capture Format) auf „Blackmagic Capture" ein und klicken Sie 
auf die Schaltfläche „Einstellungen" (Mac) oder „Eigenschaften" (Windows), um die Blackmagic 
Aufzeichnungseinstellungen für Ihr Projekt anzuzeigen. Stellen Sie die Videonorm und das Videoformat 
wunschgemäß ein und klicken Sie auf OK.

Schritt 5. Das Fenster „New Sequence" (Neue Sequenz) erscheint. Wählen Sie die gewünschte Blackmagic 
Voreinstellung aus, benennen Sie die Sequenz und klicken Sie auf OK.

Gerätesteuerung (Device Control)
Viele Aufnahme- und Wiedergabegeräte von Blackmagic Design verfügen über RS-422-Schnittstellen zur Steuerung 
von MAZen. Bei jeder neuen Projekterstellung muss die Gerätesteuerung „Blackmagic Device Control" aktiviert sein. 
Gehen Sie zu „Einstellungen" > „Gerätesteuerung" („Preferences“ > „Device Control“) und wählen Sie „Blackmagic 
Device Control" aus.

Wiedergabe (Playback)
Die Wiedergabeeinstellungen müssen für jede neue Projekterstellung ausgewählt werden, indem Sie zu „Einstellungen" 
> „Wiedergabe" gehen. Der Adobe Player ist der Default-Player. Das Audiogerät muss allerdings auf „Blackmagic 
Playback" eingestellt werden.

Aktivieren Sie die unter „Videogerät" angezeigte Dialogbox „Blackmagic Playback". Vergewissern Sie sich, dass die 
übrigen Dialogboxen deaktiviert sind und klicken Sie auf OK.

Neue Sequenz

Adobe® Premiere Pro® CC
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Erfassung
Um aufzunehmen, wählen Sie: „Datei" > „Erfassen" (File > Capture) [F5]

Um sofort aufzunehmen oder um von einem nicht-steuerbaren Gerät aufzunehmen, klicken Sie auf die rote 
Erfassungsschaltfläche [G].

Um einen Clip mittels RS-422-Decksteuerung zu indizieren, geben Sie die gewünschten In- und Out-Points anhand der 
Schaltflächen „In-Point setzen" und „Out-Point setzen" oder manuell ein, indem Sie den Timecode eingeben und auf 
„Clip aufzeichnen" (Adobe® Premiere Pro® CC: „Log" = „Aufzeichnen"; Blackmagic Design: „Log“ = „Indizieren“) 
klicken. Der leere Clip erscheint nun im Projektfenster. Wiederholen Sie dies, bis alle für Ihre Batchaufnahme gewünschten 
Clips indiziert sind. Wählen Sie dann „Datei" > „Batchaufnahme" („File“ > „Batch Capture“) [F6] aus. Um die Clips mit 
Griffen zu versehen, aktivieren Sie „Capture with handles" und tippen Sie die Anzahl der zusätzlichen Frames ein, die am 
Anfang und Ende eines jeden Clips hinzugefügt werden sollen.

Auf Band exportieren  
Um über RS-422-Decksteuerung auf Band zu exportieren, bestimmen Sie die gewünschte Sequenz und aktivieren Sie 
dann „Datei" > „Exportieren" > „Band" („File“ > „Export“ > „Tape“).

Der Insert-Schnitt erfordert einen durchgehenden Timecode für die gesamte Länge des auf Band auszugebenden 
Projekts.

Im Assemble-Modus müssen in das Band bis zu einem Punkt gleich nach dem Startzeitpunkt des Projekts bloß 
Schwarzbilder eingefügt werden. Beim Schnitt auf Band mittels Assembling wird das vor den Aufnahmeköpfen liegende 
Band gelöscht. Deshalb ist dieser Vorgang zu vermeiden, wenn auf dem Band nach dem Out-Punkt Ihres Schnitts bereits 
andere Projekte vorhanden sind.

Beim Schnitt auf Band wartet die Software am ersten Frame Ihres Projekts ab, bis die MAZ am vorgegebenen Timecode 
in den Aufnahmemodus übergeht. Wenn beim Schnitt-auf-Band-Vorgang der erste Frame Ihres Projekts wiederholt oder 
weggelassen wird, muss der Wiedergabe-Offset (Versatz) angepasst werden, um MAZ und Computer zu synchronisieren. 
Da die einmal eingegebene richtige Einstellung beibehalten wird, sollte dies für beliebige Kombinationen von MAZen 
und Computern nur einmal erforderlich sein.

Geben Sie bei Bedarf jetzt einfach den gewünschten In-Punkt und die Offsets an und klicken Sie auf „OK“ (Mac) oder 
„Exportieren“ (Windows).

Aufnahme

Auf Band exportieren
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Apple Final Cut Pro X

Apple Final Cut Pro X
Mit der Funktion „Broadcast-Monitoring" in der Version Final Cut Pro X 10.0.4 und höher können Sie Ihr Video 
über Blackmagic Videohardware ausgeben. Sie können auch zwei Computerbildschirme für die Final Cut Pro 
X-Bedienoberfläche einsetzen.

Einrichten von Final Cut Pro X
Schritt 1. Vergewissern Sie sich, dass auf Ihrem Computer die Version Final Cut Pro X 10.0.4 oder höher unter der 

aktuellsten Version von Mac OS X Mountain Lion oder Mavericks läuft.

Schritt 2. Öffnen Sie „Systemeinstellungen" und klicken Sie auf Blackmagic Design. Gehen Sie zur Einstellung 
„Standard-Videonorm vorgeben" (Set default video standard as) und geben Sie dann die gleiche Norm vor, 
die Sie für Ihr Final Cut Pro X-Projekt verwenden werden, z B. HD 1080i 59.94. Die vorgegebene Videonorm 
sollte dem Videoformat Ihres Clips entsprechen.

Schritt 3. Starten Sie Final Cut Pro X und legen Sie ein neues Projekt an.

Schritt 4. Tippen Sie einen Namen ein und bestimmen Sie den Standort für das neue Projekt.

Schritt 5. Stellen Sie die Videoeigenschaften auf „Benutzerdefiniert" (Custom) ein. Geben Sie für Format, Auflösung 
und Framerate die gleichen Werte vor, wie die in den Systemeinstellungen im Blackmagic Design Desktop 
Video für die Standard-Videonorm festgelegten.

Schritt 6. Stellen Sie die Audio- und Rendereigenschaften auf „Benutzerdefiniert" (Custom) ein. Stellen Sie die 
Audiokanäle auf „Stereo" ein oder wählen Sie alternativ „Surround" für sechs Audiokanäle aus. Stellen 
Sie die Audioabtastrate auf die Fernsehrate von 48 kHz ein. Stellen Sie das Renderformat auf das Format 
Ihrer Videoclips ein. Standardmäßig verwendet Final Cut Pro X ProRes-Kompression, was sich für einen 
unkomprimierten Workflow jedoch auf „Unkomprimiertes 10-Bit 4:2:2" umschalten lässt. Klicken Sie auf OK, 
um die Erstellung Ihres neuen Projekts fertigzustellen.

Schritt 7. Wählen Sie im Final Cut Pro-Menü „Einstellungen" (Preferences) aus und klicken Sie dann auf die 
Wiedergaberegisterkarte (Playback). Vergewissern Sie sich, dass im Menü „A/V-Ausgabe" (A/V Output) 
die Option „Blackmagic" und die gleiche Videonorm wie die Ihres Projekts aktiviert sind. Beenden Sie 
„Einstellungen" (Preferences).

Schritt 8. Gehen Sie zum Fenstermenü und wählen Sie „A/V-Ausgabe" (A/V Output) aus, um die Videoausgabe via 
Blackmagic Videohardware zu aktivieren.

Öffnen Sie zum Betreiben von Audiomonitoring über Ihre Blackmagic Videohardware „Systemeinstellungen" (System 
Preferences). Klicken Sie auf das Sound-Symbol und dann auf die Ausgaberegisterkarte. Geben Sie für die Tonausgabe 
„Blackmagic Audio" vor.

Schritt 6. Stellen Sie die Audio- und Rendereigenschaften auf 
„Benutzerdefiniert" (Custom) ein

Schritt 2. Stellen Sie die Standard-Videonorm in den Systemeinstellungen 
auf die Norm Ihres Final Cut Pro X-Projekts ein
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Wiedergabe (Playback)
Schritt 1. Importieren Sie einige Clips in Ihr neues Projekt.

Schritt 2. Jetzt können Sie die Final Cut Pro X-Timeline auf Ihrem Computerbildschirm verwenden und die 
Videovorschau auf einem an den Ausgang Ihrer Blackmagic Design Videohardware angeschlossenen 
Bildschirm oder TV ansehen.

Erfassen von Video- und Audio-Dateien
Für die Aufnahme von Video und Audio mit Ihrer Blackmagic Design Videohardware können Sie Blackmagic Media 
Express benutzen. Nach erfolgter Aufnahme der Clips können Sie diese nach Final Cut Pro X zum Schneiden importieren.

Vergewissern Sie sich beim Erfassen von Clips mit Media Express, dass Sie eines der auch von Final Cut Pro X 
unterstützten Videoformate ausgewählt haben, z. B.: Apple ProRes 4444, Apple ProRes 422 (HQ), Apple ProRes 422 
oder unkomprimiertes 10-Bit 4:2:2.

Schnitt auf Band
Nach Fertigstellung eines Projekts in Final Cut Pro X können Sie es als Filmdatei rendern und den Film dann mit 
Blackmagic Media Express unter Einsatz Ihrer Blackmagic Design Videohardware auf Band mastern.

Schritt 1. Wählen Sie Ihre Clips in der Timeline in Final Cut Pro X aus.

Schritt 2. Gehen Sie zum „Share"-Menü und wählen Sie „Als Film exportieren" (Export Movie) aus.

Schritt 3. Behalten Sie im Fenster „Als Film exportieren" die Option „Aktuelle Einstellungen" (Current Settings) bei 
und geben Sie im Fenster darunter außerdem die Option „Video und Audio" vor. Klicken Sie auf „Weiter" 
(Next).

Schritt 4. Öffnen Sie Media Express und importieren Sie den aus Final Cut Pro X exportierten Clip.

Schritt 5. Näheres siehe „Schnitt von Video- und Audiodateien auf Band" im Abschnitt über Blackmagic Media 
Express.

Schritt 3. Behalten Sie im Fenster „Als Film exportieren" (Export Movie) die 
Option „Aktuelle Einstellungen" (Current Settings) bei und geben Sie im 
Fenster darunter außerdem die Option „Video und Audio" vor
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Avid Media Composer

Avid Media Composer
Avid Media Composer kann Video und Audio in Standard Definition und High Definition mit Blackmagic Videohardware 
aufnehmen und wiedergeben. Die Software unterstützt außerdem RS-422-Decksteuerung. Wenn Media Composer zu 
einem früheren Zeitpunkt als die Desktop Video Software eingespielt wurde, werden automatisch Blackmagic Plug-ins 
für Media Composer installiert.

Einrichtung
Schritt 1. Starten Sie Media Composer. Das nun erscheinende Dialogfenster „Select Project" fordert Sie zur Auswahl 

eines Projekts auf.

Schritt 2. Wählen Sie Ihr bevorzugtes „User Profile" aus, wenn Sie bereits ein Anwenderprofil erstellt hatten.

Schritt 3. Wählen Sie den Ordner aus, in dem Sie Ihr Projekt anlegen wollen: „Private" (Privat), „Shared" (Freigegeben) 
oder „External" (Extern).

Schritt 4. Klicken Sie auf die Schaltfläche „New Project" (Neues Projekt).

Schritt 5. Geben Sie den Projektnamen und die Projektoptionen vor, einschließlich „Format", „Color Space" 
(Farbraum) und „Stereoscopic". Klicken Sie auf OK. Die Farbraum- und Stereoskopie-Einstellungen lassen 
sich später auf der Formatregisterkarte des Projekts ändern. 

Schritt 6. Doppelklicken Sie auf den Projektnamen in der „Select Project"-Dialogbox. Die Media Composer-
Bedienoberfläche erscheint zusammen mit dem Projektfenster für Ihr neues Projekt. Sie haben Ihr Projekt 
erfolgreich fertiggestellt.

Wiedergabe
Vergewissern Sie sich durch einen schnellen Test, dass alles richtig angeschlossen ist, indem Sie zur Schnittanleitung 
„Media Composer Editing Guide" gehen. Folgen Sie den Anweisungen zum Import von Farbbalken und anderen 
Testmustern im Abschnitt „Importing Color Bars and Other Test Patterns". Doppelklicken Sie auf die importierte Datei, 
um Sie in einem Pop-Up-Monitor wiederzugeben. Das Bild sollte jetzt auf Ihrem Computerbildschirm wie auch in Ihrer 
Blackmagic Ausgabe zu sehen sein.

Ist kein Video in Ihrer Blackmagic Ausgabe sichtbar, prüfen Sie die Anschlüsse erneut. Vergewissern Sie sich, dass die 
Ausgabeeinstellungen in den Blackmagic Design Systemeinstellungen richtig konfiguriert sind, indem Sie in Media 
Composer „Tools" > „Hardware Setup" auswählen.

Wird bloß ein Computerbildschirm benutzt, öffnen Sie die Blackmagic 
Design Systemeinstellungen und geben Sie „Black" (Schwarzbilder) aus, 
wenn kein Video wiedergegeben wird

Schritt 5. Geben Sie den Projektnamen und die Projektoptionen vor
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Erfassung von nicht steuerbaren Geräten
Viele Videoquellen haben keine Gerätesteuerung. Dies gilt auch für viele moderne Kameras und Festplattenrekorder 
ebenso wie für alte Kameras und VHS-Bandabspielgeräte. So wird Video ohne Decksteuerung aufgenommen:

Schritt 1. Wählen Sie „Tools" > „Capture" aus, um die Registerkarte „Capture Tool" (Aufnahmewerkzeug) zu öffnen.

Schritt 2. Klicken Sie auf das Rekordersymbol („Toggle Source" = Quelle umschalten), das nun als roter Kreis mit 
Schrägstrich erscheint. Dieses Symbol zeigt an, dass die Decksteuerung ausgeschaltet ist.

Schritt 3. Stellen Sie die Video- und Audioeingabemenüs auf „Blackmagic" ein.

Schritt 4. Wählen Sie die Videoquellspur (V) und die Audioquellspuren (A1, A2, ...) aus, die Sie aufnehmen wollen.

Schritt 5. Wählen Sie im „Bin"-Menü unter den offenen Bins eine „Target Bin" als Ziel aus.

Schritt 6. Wählen Sie im Menü „Res" (resolution = Auflösung) aus, welchen komprimierten oder unkomprimierten 
Codec Sie für Ihre aufgenommenen Clips verwenden wollen. Wählen Sie unkomprimiertes 8-Bit-Video „1:1" 
oder für 10-Bit „1:1 10b" aus.

Schritt 7. Geben Sie den Festplattenspeicher für Ihr aufgenommenes Video und Audio vor. Wählen Sie mit der 
Schaltfläche „Single/Dual Drive Mode" aus, ob Audio und Video zusammen auf einer Festplatte oder auf 
separaten Festplatten gespeichert werden sollen. Wählen Sie die Zielfestplatte(n) für Ihre aufgenommenen 
Medien im Zielfestplattenmenü(s) aus.

Schritt 8. Klicken Sie unten im Fenster auf die Schaltfläche „Tape Name?" (Name des Bands?), um die Dialogbox 
„Select Tape" (Band auswählen) zu öffnen. Wählen Sie das gewünschte Band aus oder fügen Sie ein neues 
hinzu und klicken Sie auf OK.

Schritt 9. Vergewissern Sie sich, dass Ihre Video- und Audioquelle zur Wiedergabe bereit ist und klicken Sie auf die 
„Capture"-Schaltfläche (Erfassen). Die „Capture"-Schaltfläche blinkt während der Aufnahme in Rot. Erneutes 
Klicken der „Capture"-Schaltfläche beendet die Aufnahme..

Schritt 2. Stellen Sie das „Capture Tool" zur Aufnahme von Video ohne 
Decksteuerung ein, indem Sie auf die „Toggle Source"-Schaltfläche klicken
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Erfassung von steuerbaren Geräten mit UltraStudio, DeckLink und Teranex
Bei Einsatz einer über RS-422 angeschlossenen MAZ müssen Sie die MAZ-Einstellungen konfigurieren, ehe Sie mittels 
Decksteuerung aufnehmen.

Schritt 1. Klicken Sie in Ihrem Projektfenster auf die Registerkarte „Settings" (Einstellungen) und doppelklicken Sie auf 
„Deck Configuration".

Schritt 2. Klicken Sie in der Dialogbox „Deck Configuration" auf „Add Channel" (Kanal hinzufügen) und stellen Sie 
den „Channel Type" (Kanaltyp) auf „Direct" und den Port auf „RS-422 Deck Control" ein. Klicken Sie auf 
OK und verneinen Sie die Frage, ob Sie den Kanal jetzt automatisch konfigurieren wollen („Do you want to 
autoconfigure the channel now?") mit „No".

Schritt 3. Klicken Sie auf „Add Deck" und wählen Sie Marke und Modell Ihrer MAZ in den „Device"-Menüs aus. Geben 
Sie auch den gewünschten Vorspann vor. Klicken Sie auf OK und dann auf „Apply" (Anwenden).

Schritt 4. Gehen Sie auf die Registerkarte „Settings" (Einstellungen) und doppelklicken Sie auf „Deck Preferences" 
(MAZ-Einstellungen).

Schritt 5. Um den Schnitt mittels Assembling auf Band zuzulassen, aktivieren Sie die Option „Allow assemble edit & 
crash record for digital cut" (Assemble-Schnitt zulassen und per Crash-Recording aufnehmen). Wenn diese 
Option deaktiviert bleibt, sind nur Insert-Schnitte möglich.

Schritt 6. Aktivieren Sie die Option „Relax coincidence point detection" (Ermittlung von Koinzidenzpunkten 
entschärfen). Klicken Sie auf OK. Die RS-422-Verbindung zu Ihrer MAZ ist jetzt erfolgreich eingerichtet.

Um die Fernverbindung zu testen, vergewissern Sie sich, dass Ihre Blackmagic Videohardware über ein serielles 
RS-422-Kabel an die MAZ angeschlossen ist. Stellen Sie die MAZ auf „Remote" (Fernsteuerung) ein. Öffnen Sie das 
„Capture Tool" (Aufnahmewerkzeug) und steuern Sie die MAZ über die üblichen Tastaturkürzel J, K, L. Erscheint 
der Name der MAZ in Kursivschrift oder es wird „No Deck" (Keine MAZ) angezeigt, wählen Sie „Check Decks" 
(MAZen prüfen), bis die MAZ ohne Kursivschrift aufgeführt wird und die Decksteuerung wiederhergestellt ist.

Spontane Erfassung über die Decksteuerung:

Schritt 1. Wählen Sie „Tools" > „Capture" aus, um die Registerkarte „Capture Tool" (Aufnahmewerkzeug) zu öffnen.

Schritt 2. Die Schaltfläche „Capture/Log Mode" (Erfassungs-/Indizierungsmodus) sollte jetzt das Aufnahmesymbol 
(CAP) anzeigen. Zeigt diese Schaltfläche ein LOG-Symbol (Indizieren) an, wechseln Sie den Aufnahmemodus 
per Klick auf die Schaltfläche. Es sollte nun das Aufnahmesymbol (CAP) erscheinen.

Schritt 3. Die Schaltfläche „Toggle Source" sollte jetzt das Symbol einer MAZ anzeigen. Wird ein roter Kreis mit 
Schrägstrich angezeigt, deaktivieren Sie die Decksteuerung per Klick auf die Schaltfläche. Dann verschwindet 
das rote Symbol.

Schritt 4. Konfigurieren Sie Video- und Audioeingabe, Video- und Audioquellspuren, Ziel-Bin, Auflösung (Res), 
Zielfestplatte und Bandnamen auf dieselbe Weise wie im Abschnitt „Erfassung von nicht steuerbaren 
Geräten" beschrieben.

Schritt 5. Verwenden Sie das auf der Registerkarte „Capture Tool" befindliche Decksteuerungsfenster, um das Band 
an den Cue-Punkt zu setzen und die Wiedergabe zu starten.

Schritt 6. Klicken Sie auf die „Capture"-Schaltfläche. Die „Capture"-Schaltfläche blinkt während der Aufnahme in Rot. 
Erneutes Klicken auf „Capture" beendet die Aufnahme.

Schritt 6. Aktivieren Sie in „Deck Preferences" (MAZ-Einstellungen) 
die Option „Relax coincidence point detection" (Ermittlung von 
Koinzidenzpunkten entschärfen)

Stellen Sie die Schaltflächen CAP und „Toggle Source" zum Einsatz von 
Decksteuerung ein. Verwenden Sie das Decksteuerungsfenster, um das 
Band an den Cue-Punkt zu setzen und die Wiedergabe zu starten
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Batchaufnahme mit UltraStudio und DeckLink
Indizierung von Clips für die Batchaufnahme:

Schritt 1. Wählen Sie „Tools" > „Capture" aus, um die Registerkarte „Capture Tool" (Aufnahmewerkzeug) zu öffnen.

Schritt 2. Klicken Sie auf die Schaltfläche „Capture/Log Mode" (Erfassungs-/Indizierungsmodus), sodass sie das LOG-
Symbol (Indizieren) anzeigt.

Schritt 3. Konfigurieren Sie Video- und Audioeingabe, Video- und Audioquellspuren, Ziel-Bin, Auflösung (Res), 
Zielfestplatte und Bandnamen auf dieselbe Weise wie im Abschnitt „Aufnahme von nicht steuerbaren 
Geräten" beschrieben.

Schritt 4. Benutzen Sie das Decksteuerungsfenster oder die gebräuchlichen Tastaturkürzel j, k und l, um mit der MAZ 
zurück zu spulen, zu pausieren und vorwärts zu spulen, und so das aufzunehmende Video aufzufinden.

Schritt 5. Klicken Sie links neben LOG auf die Schaltfläche „Mark IN/OUT" (In- und Out-Punkt markieren). Da das 
Symbol zwischen IN und OUT hin- und herwechselt, brauchen Sie nur auf eine Schaltfläche zu klicken, um 
alle Ihre In- und Out-Punkte zu markieren. Das geht einfacher als dies anhand der separaten Schaltflächen 
„Mark IN" und „Mark OUT" im Decksteuerungsfenster zu tun. Alternativ können Sie die In- und Out-Punkte 
anhand der „i"- und „o"-Tasten Ihres Keyboards setzen.

Schritt 6. Öffnen Sie nach erfolgter Indizierung der In- und Out-Punkte die LOG-Bin und wählen Sie dort die 
aufzunehmenden Clips aus.

Schritt 7. Wählen Sie „Clip" > „Batch Capture" (Batchaufnahme) aus. Aktivieren Sie die gewünschten Optionen in der 
Dialogbox und klicken Sie auf OK.

Aufnahme auf Band mit UltraStudio und DeckLink
Nachdem Sie Ihre Clips aufgezeichnet, in die Timeline verschoben, geschnitten, ggf. mit Effekten versehen und 
gerendert haben, werden Sie Ihr fertiges Projekt auf Band aufnehmen wollen.

Schritt 1. Doppelklicken Sie auf eine Sequenz in Ihrer Projekt-Bin, um sie im Timeline-Fenster zu öffnen.

Schritt 2. Wählen Sie „Output" > „Digital Cut" („Ausgabe“ > „Digitalschnitt“), um das „Digital Cut Tool" zu öffnen.

Schritt 3. Stellen Sie „Output Mode" (Ausgabemodus) auf „Real-Time", die Bit-Tiefe auf 10-Bit und „Deck Control" 
(Decksteuerung) auf „Remote" ein.

Schritt 4. Wählen Sie im „Edit Menu" (Schnittmenü) die Option „Insert Edit" (Insert-Schnitt) oder „Assemble Edit" 
(Assemble-Schnitt) für präzise Schnitte auf ein mit Timecode vorcodiertes Band aus. Alternativ können Sie 
auf einfache Art mittels „Crash Record" aufnehmen. Wenn als einzige Option „Insert Edit" verfügbar ist, 
gehen Sie zur Schaltfläche „Preferences" (Einstellungen) und doppelklicken Sie auf „Deck Preferences", um 
Assembling per Schnitt zuzulassen und per Crash-Recording aufzunehmen („Allow assemble edit & crash 
record for digital cut").

Schritt 5. Erscheint der MAZ-Name in Kursivschrift oder es wird „No Deck" (Keine MAZ) angezeigt, wählen Sie 
„Check Decks" (MAZen prüfen), bis die MAZ ohne Kursivschrift aufgeführt wird und die Decksteuerung 
wiederhergestellt ist.

Schritt 6. Klicken Sie auf die rote, dreieckige „Digital Cut"-Schaltfläche, um Ihre Sequenz auf Band aufzunehmen.

Schritt 5. Klicken Sie auf die Schaltfläche „Mark IN/OUT" oder markieren 
Sie die In- und Out-Punkte mithilfe der „i"- und „o"-Tasten Ihres Keyboards

Das „Digital Cut Tool" dient zur Aufnahme auf Band
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Autodesk Smoke

Autodesk Smoke 2013 Extension 1
Autodesk Smoke vereint Editing, Compositing und 3D-Effekte in einem einzigen Arbeitsbereich. Smoke kann Video 
und Audio in Standard Definition und High Definition mit Blackmagic Videohardware aufnehmen und wiedergeben. 
Die Software unterstützt außerdem RS-422-Decksteuerung. Vergewissern Sie sich, ehe Sie Autodesk Smoke einspielen, 
dass Ihre Blackmagic Design Treiber und Ihr Videogerät einwandfrei installiert sind.

Das Broadcast-Monitoring in Smoke gestattet Ihnen auch, Video über Blackmagic Hardware auszugeben.

Installation
Schritt 1. Starten Sie Smoke. Es erscheinen die Fenster „Project" (Projekt) und „User Settings" (Anwendereinstellungen). 

Wählen Sie, sofern vorher angelegt, die Option „Project and User" aus. Legen Sie andernfalls ein neues 
Projekt bzw. einen neuen Anwender an.

Schritt 2. Geben Sie die gleichen Einstellungen für Ihr Projekt wie für Ihre Ausgabe vor, beispielsweise 1080HD. Die 
meisten Einstellungen lassen sich später während Ihrer Session ändern.

Schritt 3. Wählen Sie Ihr Zwischenformat für die mit Ihrem Projekt generierten Medien aus. Beispielsweise ProRes 422 
oder sogar unkomprimiert. Denken Sie daran, ein Format auszuwählen, das Ihr Speichermedium handhaben 
kann.

Schritt 4. Klicken Sie auf die „Create"-Schaltfläche (Anlegen).

Einrichtung Ihrer Hardware
Es empfiehlt sich, zur Vorbereitung einer MAZ-Session den nachstehenden Schritten zu folgen.

Schritt 1. Schließen Sie die Ausgänge Ihrer MAZ an die Eingänge Ihres Blackmagic Aufnahme- und Wiedergabegeräts 
an. Schließen Sie die Ausgänge Ihres Blackmagic Aufnahme- und Wiedergabegeräts an die Eingänge Ihrer 
MAZ an.

Schritt 2. Verbinden Sie den seriellen Port Ihrer MAZ über ein RS-422-Decksteuerungskabel an den Remote-Port Ihres 
Blackmagic Aufnahme- und Wiedergabegeräts. 

Schritt 3. Stellen Sie Ihre MAZ auf Fernsteuerung ein.  

Schritt 4. Schließen Sie zur Gewährleistung framegenauer Aufnahmen einen Sync-Generator an den Sync-Eingang 
Ihrer MAZ an. Bei Einsatz eines separaten Audiogeräts muss auch ein Audio-Sync-Signal angeschlossen 
werden.

Geben Sie den Projektnamen und die Projektoptionen vor
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Einrichtung einer MAZ-Maschine
Ehe Sie Autodesk Smoke starten, müssen Sie mittels einer Utility namens Smoke Setup das Modell der in Ihrem Studio 
eingesetzten MAZ(en) sowie die entsprechenden Timing-Einstellungen (Auflösung und Framerate) vorgeben.

Schritt 1. Gehen Sie zu „Applications" > „Autodesk" > „Smoke" > „Utilities" und öffnen Sie „Smoke Setup".

Schritt 2. Vergewissern Sie sich auf der „General"-Registerkarte, dass „Video Device" (Videogerät) und „Audio 
Device" (Audiogerät) auf BMD eingestellt sind.

Schritt 3. Aktivieren Sie auf der „VTR"-Registerkarte das MAZ-Modell und die Timing-Vorgaben, die Sie mit Autodesk 
Smoke benutzen wollen. Aktivieren Sie die Zeilen mit Live-NTSC oder Live-PAL, um Crash-Record oder Live-
Ausgabe zu aktivieren.

Schritt 4. Klicken Sie auf „Apply" (Anwenden) und schließen Sie „Smoke Setup".

Erfassung von steuerbaren Geräten mit UltraStudio und DeckLink
Autodesk Smoke lässt sich konfigurieren, um von steuerbaren MAZ-Maschinen mit Decksteuerung aufzunehmen.

Schritt 1. Wählen Sie in „Media Library" (Medienbibliothek) einen Ordner aus, in dem Sie den aufgenommenen Clip 
anlegen wollen.

Schritt 2. Wählen Sie „File" > „Capture" („Datei“ > „Erfassen“) von MAZ aus. Das „VTR Capture"-Modul erscheint.

Schritt 3. Setzen Sie das Band an den Cue-Punkt mit dem ersten Einzelbild des aufzunehmenden Clips.

Schritt 4. Wählen Sie die Video- und Audiokanäle, die Sie aufnehmen wollen, aus. Die Schaltflächen schalten auf Rot 
und zeigen so an, welche Spuren aktiviert sind.

Schritt 5. Geben Sie die In- und Out-Punkte in den entsprechenden Feldern ein.  

Schritt 6. Klicken Sie auf „Capture", um mit der Aufnahme zu beginnen. Das Timecode-Feld leuchtet bei laufender 
Aufnahme grün auf.

Schritt 7. Mit einem Klick im „Preview"-Fenster (Vorschau) lässt sich die Aufnahme jederzeit beenden. Der Clip wird 
automatisch an Ihrem vor Eingabe des „VTR Input"-Moduls ausgewählten Standort gespeichert.

Vergewissern Sie sich, dass „Video Device" und „Audio Device" in 
„Smoke Setup" auf BMD eingestellt sind

Wählen Sie die Timing-Einstellungen für Ihre MAZ auf der „VTR"-
Registerkarte im Smoke-Setup-Dienstprogramm aus

Zur Aufnahme von Ihrer MAZ aktivierte Video- und Audiospuren leuchten 
rot auf
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Erfassung auf Band mit UltraStudio und DeckLink
Laden Sie einen Clip in das „VTR Output"-Modul und geben Sie die In- und Out-Punkte für den Ausgabe-Clip vor. Bei 
Bedarf lassen sich auch die Optionen zum Versatz des Startframes für die Ausgabe aktivieren und ein Letterbox-Overlay 
anwenden.

Schritt 1. Wählen Sie „File" > „Output to VTR" („Datei“ > „Ausgabe auf MAZ“) aus.

Schritt 2. Wählen Sie einen oder mehrere Clips aus, die aus „Media Library“ (Medienbibliothek) auszugeben sind. Sie 
können auch einen Ordner auswählen, wenn sein Inhalt in einer Session ausgegeben werden soll. Das „VTR 
Output"-Modul erscheint.

Schritt 3. Wählen Sie die MAZ im Gerätenamenfeld aus. Das Vorschaufenster zeigt das Video vom Band in der 
ausgewählten MAZ an.

Schritt 4. Vergewissern Sie sich, dass die richtigen Videospur- und Audiokanal-Schaltflächen aktiviert sind, damit die 
entsprechenden Videospuren und Audiokanäle auf Band ausgegeben werden.

Schritt 5. Aktivieren bzw. deaktivieren Sie „All Audio" (Alles Audio) im Menü „Clip Output" (Clip-Ausgabe). Ist „All 
Audio" aktiviert, wird jeder Audiokanal in das Format Ihres Bands umgewandelt und nicht nur die soeben 
von Ihnen aktivierten.

Schritt 6. Klicken Sie auf „Preview", um den Clip vor der Ausgabe anzusehen.

Schritt 7. Um den ausgewählten Clip beginnend mit einem anderen Frame als dem ersten auszugeben, legen Sie den 
Start-Timecode im Feld „Start Offset" fest.

Schritt 8.  Legen Sie die In- und Out-Punkte für die Clip-Ausgabe fest.

Schritt 9. Um einen Clip zur MAZ ausgegeben, wählen Sie „Insert" (Einfügen) im „Output"-Kästchen aus. Die Clips 
mit ausgewähltem Status („Status" > „Selected") werden auf Band ausgegeben. Während der Ausgabe 
wird der Status eines jeden Clips von „Pending" (Anstehend), „Output" (Ausgegeben) bis „Done" (Erledigt) 
aktualisiert.

Schritt 10. Springen Sie zum Cue-Punkt des In-Timecodes und wählen Sie „Play" (Wiedergabe) aus, um zu prüfen, ob 
der Transfer gelungen ist.

Schritt 11. Wenn Sie fertig sind, klicken Sie auf „EXIT Output Clip", um das Modul zu schließen.

Schritt 3. Ihre MAZ sollte in der Dropdown-Liste auswählbar sein

Zur Ausgabe ausgewählte Clips erscheinen unter Angabe ihres aktuellen 
Status als Liste 

Geben Sie die In- und Out-Punkte vor und wählen Sie dann „Insert" 
(Einfügen) im Aufklappmenü „Output" aus 
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Erfassung per Crash-Record und Live-Ausgabe
Autodesk Smoke gestattet Ihnen, einen Clip per Crash-Record oder ein Live-Videosignal aufzunehmen, indem Sie den 
Vorgang der Clipeingabe bzw. -ausgabe mit einem Tablet-Stift oder einer Maus starten bzw. beenden. Bei Auswahl dieser 
Aufnahmeart prüft Autodesk Smoke, ob die auf Ihrem Autodesk Media Storage Gerät verfügbare Speicherkapazität für 
Ihr bevorzugtes Zwischenformat ausreicht. Der dafür erforderliche Platz variiert je nach Format.

Wenn Ihr eingesetztes Gerät keine Fernsteuerung via RS-422 unterstützt, wie z. B. eine Kamera, MAZ oder sonstige 
Geräte, so verwenden Sie zur Aufnahme die Option „NTSC" oder „PAL" und zur Ausgabe von Clips die Option „Live 
Video".

Erfassung eines Live-Videosignals per Crash-Record:

Schritt 1. Wählen Sie in „Media Library“ (Medienbibliothek) einen Ordner aus, in dem Sie den aufgenommenen Clip 
anlegen wollen.

Schritt 2. Wählen Sie „File" > „Capture" („Datei“ > „Erfassen“) von MAZ aus. Das „VTR Capture"-Modul erscheint.

Schritt 3. Wählen Sie im Feld „VTR Device" (MAZ-Gerät) die Option „Live NTSC" oder „Live PAL" aus. Das eingehende 
Live-Videosignal erscheint im Vorschaufenster.

Schritt 4. Wählen Sie den Modus „Start On Pen" (Stift-ausgelöster Start). Beenden Sie die Aufnahme mit „Stop On 
Pen" (Beenden bei Stift) oder „Stop On Frames" (Beenden bei Frames). Die Terminologie „Start On Pen" 
stammt aus der Zeit, als Autodesk Smoke per Tablet-Computer und Stift bedient wurde.

Wenn „Stop On Pen" und somit der Aufnahmestopp-Modus aktiviert ist, werden Out-Punkt und Timecodefelder 
zur Vorgabe der Dauer aktualisiert und zeigen die maximale Länge des Clips an, den Ihr Autodesk Media Storage 
Gerät speichern kann. Die Aufnahme wird beendet, wenn Sie einen Klick auf dem Bildschirm ausführen oder Ihr 
Speichermedium voll ist.

Schritt 5. Geben Sie den Clipnamen ein und aktivieren Sie die Videospuren und Audiokanäle, die Sie  
aufnehmen wollen.

Schritt 6. Vergewissern Sie sich, dass das Live-Videosignal empfangen wird.

Schritt 7. Drücken Sie die Wiedergabetaste des Videogeräts.

Schritt 8. Wählen Sie „Process", um mit der Aufnahme zu beginnen.

Schritt 9. Führen Sie einen Klick auf dem Bildschirm aus, um die Aufnahme im „Stop On Pen"-Modus zu beenden. 

Markieren Sie die Zeilen mit Live-NTSC oder Live-PAL, um Crash-Record 
oder Live-Ausgabe zu aktivieren
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Ausgabe eines Live-Videosignals:

Schritt 1. Wählen Sie „File" > „Output to VTR" („Datei“ > „Ausgabe zur MAZ“) aus.

Schritt 2. Wählen Sie einen oder mehrere Clips aus, die aus „Media Library" (Medienbibliothek) auszugeben sind. Sie 
können auch einen Ordner auswählen, um seinen Inhalt auszugeben. Das „VTR Output"-Modul erscheint.

Schritt 3. Wählen Sie im Feld „VTR Device" (MAZ-Gerät) die Option „Live NTSC" oder „Live PAL" aus.

Das Kästchen „Start Mode" ist nicht verfügbar. Benutzen Sie bei Ausgabe von Live-Video den Modus „Start On Pen". 
Die Ausgabe lässt sich mit „Stop On Pen" (Beenden bei Stift) oder „Stop On Frames" (Beenden bei Frames) stoppen.

Schritt 4. Wählen Sie die Ausgabeoptionen aus. Geben Sie den Clipnamen ein und aktivieren Sie die Videospuren und 
Audiokanäle, die Sie aufnehmen wollen. 

Schritt 5. Starten Sie die Aufnahme, sobald das Gerät das Signal empfängt oder tun Sie, was sonst nötig ist, um den 
Signalempfang von Autodesk Smoke zu aktivieren.

Schritt 6. Wählen Sie „Process" aus, um die Ausgabe in Autodesk Smoke zu beginnen.

Schritt 7. Führen Sie irgendwo auf dem Bildschirm einen Klick aus, um die Aufnahme im „Stop On Pen"-Modus zu 
beenden.

Verwenden Sie bei Ausgabe von Livevideo den Modus „Start On Pen"

Wählen Sie zur Ausgabe eines Live-Videosignals „Live PAL" oder „Live 
NTSC" aus
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DaVinci Resolve 10

Wählen Sie das gewünschte Format im Menü „Video capture and 
playback" (Videoerfassung und Wiedergabe) aus

DaVinci Resolve 10 und Live-Grading
Desktop Video 10 ermöglicht die simultane Aufnahme und Wiedergabe mit UltraStudio 4K und DeckLink 4K Extreme. 
Das ist großartig für Anwender, die die Live-Grading-Funktion in DaVinci Resolve 10 benutzen wollen, da hierfür keine 
zwei separaten Geräte für die Ein- und Ausgabe erforderlich sind.

Beim Einsatz von Live-Grading am Set brauchen Sie bloß den Ausgang der Kamera mit dem Eingang Ihrer Blackmagic 
Hardware zu verbinden. Schließen Sie dann den Ausgang der Hardware an einen Monitor am Set an, um Gradings 
anzusehen und zu beurteilen.

Einrichtung
Schritt 1. Starten Sie Resolve aus dem Einstellungsmenü, rufen Sie die Registerkarte „Video I/O and GPU" (Videoein-/

ausgang und GPU) auf und wählen Sie unter „For Resolve Live use” Ihre Hardware aus. Speichern Sie Ihre 
Einstellungen und starten Sie Resolve neu, um Ihre Änderungen anzuwenden.

Schritt 2. Starten Sie ein Projekt im Fenster „Project Settings" (Projekteinstellungen), geben Sie die gleiche Auflösung 
und Framerate wie die Ihrer Kamera vor.

Schritt 3. Gehen Sie im Fenster „Project Settings" auf die Registerkarte „Deck Capture and Playback" (MAZ-Erfassung 
und Wiedergabe) und wählen Sie das gewünschte Format im Menü „Video capture and playback" 
(Videoerfassung und -wiedergabe) aus.

Schritt 4. Gehen Sie auf die „Edit"-Seite, führen Sie einen Rechtsklick im Timeline-Fenster aus und wählen Sie „Create 
New Timeline” (Neue Timeline erstellen) aus.

Schritt 5. Wählen Sie im „Color"-Menü (Farbe) die Option „Resolve Live On/Off" (Resolve Live Ein/Aus) aus. Es 
sollte jetzt Live-Video im Viewer zu sehen sein und die Schaltfläche „Resolve Live” in Rot über dem Video 
erscheinen.

Anwenden von Resolve Live
Schritt 1. Im Resolve Live Modus fixiert die „Freeze"-Schaltfläche (Schneeflockensymbol) den aktuell eingehenden 

Videoframe, damit Sie ihn graden können, ohne sich von Bewegungen während des Drehs ablenken zu 
lassen. Nach erfolgter Verfeinerung können Sie die Fixierung beim Playback rückgängig machen und so die 
Erstellung eines Schnappschusses vorbereiten.

Schritt 2. Wenn Sie mit dem Grading zufrieden sind, klicken Sie auf die Schnappschuss-Schaltfläche (Kamerasymbol), 
um einen Schnappschuss des aktuell im Viewer angezeigten Standbilds, den eingehenden Timecode-Wert 
und Ihr Grading in der Timeline zu speichern. Schnappschüsse sind aus einem Einzelbild bestehende Clips.

Näheres über Resolve Live finden Sie in der DaVinci Resolve 10 Bedienungsanleitung.
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Was ist Blackmagic Media Express?
Blackmagic Media Express Software ist im Lieferumfang der folgenden Produkte enthalten: UltraStudio, 
DeckLink, Intensity, ATEM Mischer, Blackmagic Kameras, H.264 Pro Recorder, Teranex Processor und Universal 
Videohub. Media Express 3 ist ein großartiges Werkzeug für alle, die ohne komplexe NLE-Software lediglich 
Clips aufnehmen, wiedergeben und auf Band ausgeben möchten. 

Erfassen von Video- und Audio-Dateien

Einrichten eines Projekts
Vor der Erfassung von Clips in Media Express müssen Sie zunächst die Einstellungen für Ihr Projekt auswählen. 

Schritt 1. Gehen Sie zu „Media Express" > „Preferences" bzw. unter Windows oder Linux zu „Bearbeiten" > 
„Einstellungen". Die jeweils aufgeführten Projektformate variieren je nach den unterstützten Funktionen 
Ihrer Blackmagic Videohardware wie z. B. Ultra HD 4K-Video oder stereoskopisches 3D-Video.

Schritt 2. Treffen Sie Ihre Wahl aus mehreren komprimierten und unkomprimierten Aufnahmeformaten oder sogar 
einer DPX-Bildsequenz aus dem Aufklappmenü „Capture File Format". Das Video wird im ausgewählten 
Format aufgenommen und als QuickTime-Film gespeichert.

Schritt 3. Geben Sie den Speicherstandort für Ihr aufgenommenes Video und Audio vor. 

Schritt 4. Bestimmen Sie, ob die Aufnahme oder Wiedergabe gestoppt werden soll, sobald ausgelassene Einzelbildern 
festgestellt werden.

Projekte in Standard Definition sind auf ein Seitenverhältnis von 4:3 eingestellt, sofern nicht die Dialogbox „Anamorphic 
SD 16:9" aktiviert ist. 

Normalerweise stoppen Anwendungen die Wiedergabe von Video, sobald sie in den Hintergrund geschickt werden. 
Wenn Media Express auch dann weiterhin Video abspielen soll, wenn Sie eine andere Anwendung im Vordergrund 
öffnen, aktivieren Sie die Dialogbox „Continue playback when in the background".

Die letzten Optionen beziehen sich auf MAZ-Maschinen mit RS-422-Decksteuerung und enthalten Offsets für Vorspann 
und Timecode.

Geben Sie im Einstellungsfenster (Preferences) Videonorm, Dateiformat, 
Speicherstandort und sonstige Einstellungen vor

Blackmagic Media Express
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Medienliste SuchfeldTimecode-Liste, Miniatur- und Favoritenansicht MAZ / Deck-Timecode Videovorschau

Clip-Bins Aufnahmeoptionen

Transportbedienelemente

Standbild 
erstellen

Projektname, Videoformat und  
Bildwechselrate

Fernanzeige

Indizierungsdaten

In-Punkt / 
Out-Punkt

Audiopegelmesser

Audiokanal  
aktivieren/deaktivieren
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Erfassung
Das Aufnehmen von Video ist einfach. Sie brauchen bloß eine Videoquelle anzuschließen, „Preferences" (Einstellungen) 
in Media Express vorzugeben und auf die „Capture"-Schaltfläche (Erfassen) zu klicken.

Schritt 1. Schließen Sie zunächst Ihre Videoquelle an einen Eingang Ihrer Blackmagic Videohardware an und 
vergewissern Sie sich, dass die Blackmagic Systemeinstellungen den Einstellungen für die Videoeingabe 
entsprechen, d. h. SDI, HDMI oder analog. 

Schritt 2. Öffnen Sie Media Express und stellen Sie „Preferences" (Einstellungen) auf das Projektvideoformat und das 
Aufnahmedateiformat ein.

Schritt 3. Klicken Sie auf die rote Registerkarte „Log and Capture" (Indizieren und Erfassen) und geben Sie in das 
„Description"-Feld eine Beschreibung ein.

Schritt 4. Klicken Sie auf die „+"-Schaltfläche neben „Description", um sie dem automatischen Namensfeld („Name") 
hinzuzufügen. Klicken Sie auf die „+"-Schaltfläche neben beliebigen anderen Feldern, die sie dem 
Namensfeld („Name“) hinzufügen möchten.

 � Die in diesen Feldern angezeigten Werte lassen sich per Klick auf das jeweilige Filmklappen-Symbol 
schrittweise anheben. Alternativ können Sie Namen und Nummer anpassen, indem Sie sie direkt in ein 
beliebiges Feld eingeben.

 � Der im automatischen Namensfeld („Name") befindliche Text wird auf den bzw. die aufzunehmenden 
Clips angewendet.

 � Um einen Clip als Favorit zu indizieren, klicken Sie auf das Stern-Symbol neben dem Namensfeld („Name“).

 � Damit vor jeder Erfassung eine Aufforderung zur Bestätigung des Clipnamens angezeigt wird, klicken Sie 
auf das „!"- Symbol neben dem Namensfeld.

Schritt 5. Versehen Sie die zu erfassenden Audiokanäle mit der gewünschten Nummer.

Schritt 6. Klicken Sie auf die „Capture”-Schaltfläche, um mit der Erfassung zu beginnen. Um die Erfassung zu 
beenden und den Clip beizubehalten, klicken Sie erneut auf „Capture”. Drücken Sie alternativ auf „Esc", 
um eine Aufforderung zur Löschung oder Speicherung des Clips abzurufen. Die erfassten Clips werden der 
Medienliste hinzugefügt.

Indizierung (Logging) von Clips

Vergewissern Sie sich, dass Ihre Blackmagic Videohardware über ein serielles RS-422-Kabel an die MAZ angeschlossen 
ist. Prüfen Sie, dass der Fern- bzw.  Lokalbedienungsschalter auf Fernbedienung steht. Benutzen Sie die üblichen 
Tastaturkürzel j, k und l, um zurück zu spulen, zu pausieren und vorwärts zu spulen.

Klicken Sie auf die Schaltfläche „Mark In", um den In-Punkt zu markieren oder tun Sie dies über das Tastaturkürzel „i".

Klicken Sie auf die Schaltfläche „Mark Out", um den Out-Punkt zu markieren oder tun Sie dies über das 
Tastaturkürzel „o".

Klicken Sie auf die Schaltfläche „Log Clip", um den Clip zu indizieren oder tun Sie dies über das Tastaturkürzel „p". 
Der Eintrag sollte in der Medienliste jetzt in einer mit einem roten X versehenen Symbolform erscheinen, was seinen 
Medienstatus als offline anzeigt.

Geben Sie die gewünschte Anzahl der zu erfassenden Audiokanäle ein

Geben Sie eine Beschreibung für Ihr Video ein

Klicken Sie auf die „Capture"-Schaltfläche, um mit der Aufnahme zu 
beginnen
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Batchaufnahme

Um mehrere Clips zu erfassen, fahren Sie mit der Indizierung von Clips für die Batchaufnahme fort.

Klicken Sie auf die „Capture"-Schaltfläche, um mit der Aufnahme zu beginnen.

Wählen Sie die indizierten Clips in „Media List“ (Medienliste) aus und folgen Sie einem der folgenden Schritte:

 � Klicken Sie auf die „Batch"-Schaltfläche.

 � Aktivieren Sie die Auswahl mit der rechten Maustaste und wählen Sie „Batch Capture" aus.

 � Gehen Sie zum Dateimenü (File) und wählen Sie „Batch Capture" aus.

Media Express nimmt den Clip dann vom In- bis zum Out-Timecode auf.

DPX-Aufnahme

Wenn Sie anstelle einer Filmdatei lieber eine DPX-Bildsequenz aufnehmen wollen, öffnen Sie „Preferences" 
(Einstellungen) in Media Express und stellen Sie das „Capture File Format" (Dateiaufnahmeformat) auf „DPX 10-Bit 
RGB" ein.

 � Legen Sie ein DPX-Projekt an, indem Sie das Dateiaufnahmeformat auf „DPX" einstellen.

 � Zeichnen Sie auf.

Nach fertiggestellter Aufnahme erscheint in „Media List“ (Medienliste) eine die gesamte Framesequenz repräsentierende 
Miniatur. Die aus DPX-Frames bestehende Sequenz wird in einem separaten DPX-Ordner in Ihrem Festplattenspeicher 
gespeichert. Audio wird in Form von .wav-Dateien ebenfalls in diesem Ordner gespeichert.

Standardmäßig wird angenommen, dass DPX-Aufnahmen aus YUV-Quellen stammen. Um aus einer RGB-Quelle 
aufzunehmen, deaktivieren Sie „Capture to DPX from a YUV source" (Aus einer YUV-Quelle nach DPX aufnehmen).

Wenn Sie die DPX-Framenummern auf den Timecode des aufgenommenen Videos basieren und nicht von Null 
anfangen wollen, aktivieren Sie die Option „Use absolute frame numbering when capturing DPX" (Bei der DPX-
Aufnahme absolute Framenummerierung verwenden).

Werden keine langen DPX-Aufnahmen vorgenommen, lässt sich die Anzahl der in den Framenummern enthaltenen 
Nullen reduzieren, indem Sie mit der Option „When capturing DPX files, use (2-8) digit numbers in the frame count" eine 
Framezählung mit bis zu acht Stellen vorgeben.

Einstellungen für die DPX-Aufnahme
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3D-Aufnahme

Bei Einsatz von Media Express mit einem Blackmagic Videohardwaremodell, das Dual-Stream-3D unterstützt, können 
Sie 3D-Videoclips für das rechte und für das linke Auge anlegen, indem Sie die beiden Datenströme des HD-SDI-Videos 
gleichzeitig aufnehmen.

 � Legen Sie ein 3D-Projekt mit einer Bildwechselrate an, die der Ihrer 3D-Videoquelle entspricht.

 � Vergewissern Sie sich, dass die Blackmagic Videohardware über zwei separate HD-SDI-Videoeingänge 
verfügt.

 � Zeichnen Sie auf.

Während der Erfassung und Indizierung von Dual-Stream-3D in Media Express erhält das Video für das linke Auge 
den Clipnamen. Das Video für das rechte Auge wird mit dem Nachsatz „_right" versehen. Beispiel: Wenn Sie einen 
Stereoclip „Clip 1” nennen, erhält der Clip für das linke Auge den Namen „Clip 1.mov” und der Clip für das rechte Auge 
„Clip 1_right.mov”.

In „Media List" (Medienliste) wird deutlich angezeigt, dass der aufgenommene Clip in 3D vorliegt:

 � In der Miniaturansicht sind die Clips für das rechte und das linke Auge mittels 3D-Indikator verknüpft und 
werden in Form eines einzelnen, großen Symbols angezeigt.

 � In der Ansicht „Timecode List" sind die Clips für das rechte und linke Auge in zwei Zeilen aufgeführt und 
mittels 3D-Indikator verknüpft.

Wählen Sie zur Erfassung von stereoskopischen 3D-Videoclips mit  
Dual-Stream ein Projektvideoformat aus, dessen Name „3D" enthält

In der Miniaturansicht sind die Clips für das rechte und das linke Auge 
mittels 3D-Indikator verknüpft und werden in Form eines einzelnen, 
großen Symbols angezeigt

In der Ansicht „Timecode List" sind die Clips für das rechte und linke Auge 
in zwei Zeilen aufgeführt und mittels 3D-Indikator verknüpft
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Favoritenauswahl

Standbild 
erstellen

Clip-Informationen Audiokanal  
aktivieren/deaktivieren

Medienliste (Media List) SuchfeldTimecode-Liste, Miniatur- und Favoritenansicht MAZ / Deck-Timecode Videovorschau

Clip-BinsProjektname, Videoformat und  
Bildwechselrate

In-Punkt / 
Out-Punkt

Transportbedienelemente

Fernanzeige

Audiopegelmesser
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Wiedergabe von Video- und Audiodateien

Importieren von Clips
Sie können Ihre Video- und Audiodateien nach erfolgtem Import nach Media Express auf verschiedene Weise 
wiedergeben:

 � Führen Sie einen Doppelklick in einem unbesetzten Bereich der „Media List" (Medienliste) aus.

 � Führen Sie einen Rechtsklick in einem unbesetzten Bereich der „Media List" aus und wählen Sie im 
Kontextmenü „Import Clip" aus.

 � Gehen Sie zum „File"-Menü (Datei), wählen Sie „Import" (Importieren) und dann „Media Files" 
(Mediendateien) aus.

Wählen Sie dann den bzw. die zu importierenden Video- und Audioclips aus der Dialogbox „Open Video Clip" aus. Die 
Clips werden im „Scratch"-Bereich der Medienliste angezeigt. Wenn Sie eigene Bins in der Medienliste erstellt haben, 
können Sie die Clips in die gewünschte Bin ziehen.

Um Medien direkt in eine Bin zu importieren, führen Sie einen Rechtsklick auf der gewünschten Bin aus und wählen Sie 
im Kontextmenü „Import Clip" aus.

Stimmen Bildwechselrate und Größe der importierten Dateien nicht mit den entsprechenden Werten der Clips in der 
Medienliste überein, werden Sie aufgefordert, ein neues Projekt anzulegen und das aktuelle Projekt zu speichern.

Media Express unterstützt auch den Import von mehrkanaligen Nur-Audio-Dateien, die mit 48 kHz in den unkomprimierten 
Formaten WAVE (.wav) und AIFF (.aif) aufgenommen wurden.

Des Weiteren ist es möglich, Medien in Form von XML-Dateien, die aus Final Cut Pro exportiert wurden, zu importieren. 
Gehen Sie zum „File"-Menü (Datei), wählen Sie „Import" (Importieren) und dann „Final Cut Pro XML" aus. Öffnen Sie 
die gewünschte XML-Datei. Dann erscheinen alle Bins und Medien des Final Cut Pro-Projekts in der Medienliste.

Media Express unterstützt auch den Import von CMX-EDL-Dateien für die Batchaufnahme von EDL-Dateien aus anderer 
Videosoftware. Gehen Sie zum „File"-Menü (Datei), wählen Sie „Import" (Importieren) und dann „CMX EDL" aus. 
Wählen Sie die EDL aus und öffnen Sie sie. Die Indizierungsdaten erscheinen nun in der Medienliste. Wählen Sie die 
indizierten Clips aus und importieren Sie Ihre Clips per Batchaufnahme von Ihrer MAZ.

Wiedergabe einzelner und mehrerer Clips
Um einen einzelnen Clip wiederzugeben, doppelklicken Sie in „Media List" (Medienliste) auf diesen Clip. Oder wählen 
Sie den Clip in „Media List" aus und drücken Sie auf Ihrem Keyboard die Leertaste oder klicken Sie auf die „Play"-
Schaltfläche der Transportsteuerung.

Um mehrere Clips wiederzugeben, wählen Sie diese Clips in „Media List" aus und drücken Sie dann auf Ihrem Keyboard 
die Leertaste oder klicken Sie auf die „Play"-Schaltfläche der Transportsteuerung.

Ihr Video wird im Videovorschaufenster von Media Express und auf allen Videoausgängen Ihrer Blackmagic Videohardware 
wiedergegeben. Während der Wiedergabe können die kontrollierten Audiokanäle mit den Schaltflächen „Track Enable/
Disable" ein- oder ausgeschaltet werden.

Sie können Medien direkt oder zusammen mit einer XML oder EDL 
importieren.

Anhand der Transportsteuerelemente können Sie Ihre Clips abspielen, 
stoppen, von einem Clip zum nächsten oder zurück zum vorherigen 
springen und Clips in Schleife abspielen



Blackmagic Media Express188

Medien browsen

Miniaturansicht
Am intuitivsten ist die Anzeige Ihrer Clips in Form von Miniaturen (Thumbnails). Schieben Sie Ihre Maus über die Miniatur 
des Clips und klicken Sie auf das unten rechts der Miniatur erscheinende Popup-Infosymbol. Klicken Sie auf die Infoblase, 
um sie zu verbergen.

Listenansicht
Sie können Ihre Clips in der „Timecode List"-Ansicht betrachten, indem Sie oben rechts von der „Media List" 
(Medienliste) auf die Schaltfläche „Timecode List" klicken. Benutzen Sie die horizontale Bildlaufleiste, um alle Spalten 
mit den Daten Ihres Clips anzusehen.

Bins anlegen und damit arbeiten
Um eine Bin für Ihre Clips anzulegen, führen Sie einen Rechtsklick auf einem unbesetzten Platz in „Media List" 
(Medienliste) aus und selektieren Sie „Create Bin". Benennen Sie die neue Bin.

Sie können Clips hin- und her bewegen, indem Sie die Clipsymbole in die gewünschte Bin ziehen. Soll ein Clip in mehr 
als einer Bin erscheinen, importieren Sie diesen Clip erneut, indem Sie die Bin mit der rechten Maustaste auswählen und 
„Import Clip" selektieren.

Standardmäßig erscheinen indizierte Clips im „Scratch"-Speicher. Sollen indizierte Clips in einer neuen Bin angezeigt 
werden, wählen Sie die neue Bin mit der rechten Maustaste aus und selektieren Sie „Select As Log Bin".

Favoriten erstellen und damit arbeiten
Um einen Clip als Favorit zu indizieren, klicken Sie auf der Registerkarte „Log and Capture" (Indizieren und Erfassen) auf 
das Sternsymbol.

Wird auf der „Playback"-Registerkarte das Sternsymbol angeklickt, bewirkt dies die Kennzeichnung eines in der 
Medienliste aktivierten Clips als Favorit. Um die Auswahl eines Clips als Favorit rückgängig zu machen, klicken Sie erneut 
auf das Sternsymbol. 

Als Favoriten markierte Clips werden in den Ansichten „Timecode List" und „Thumbnail" mit einem gelben Stern in 
ihrem Symbol angezeigt.

Klicken Sie nach erfolgter Markierung Ihrer Clips als Favorit auf die über „Media List" (Medienliste) befindliche 
„Favorites"-Schaltfläche. Das Sternsymbol wird nun gelb. Außer den als Favoriten markierten Clips werden alle in Ihrer 
Medienliste befindlichen Clips verborgen.

Einen Audioclip mit einem Videoclip verknüpfen
So verknüpfen Sie einen Audioclip mit einem in „Media List“ (Medienliste) befindlichen Videoclip:

 � Wählen Sie einen Videoclip ohne Audiokanäle aus.

 � Wählen Sie den Videoclip mit der rechten Maustaste aus und aktivieren Sie im Kontextmenü „Link Audio File" 
(Audiodatei verknüpfen).

Jetzt können Sie den kombinierten Clip wiedergeben oder ihn auf Band mastern.

In der Medienliste können Sie Clips wahlweise in der Ansicht „Timecode 
List" oder „Thumbnail" (Miniatur) betrachten. Klicken Sie auf die 
Schaltfläche „Favorites", um nur Ihre favorisierten Clips angezeigt zu 
bekommen. Geben Sie zum Auffinden von Clips entsprechende Infos in 
das Suchfeld ein

Klicken Sie auf das Popup-Infosymbol einer Miniatur, um den Inhalt ihrer 
Infoblase zu sehen

Um einen Clip als Favorit zu indizieren, klicken Sie auf der Registerkarte 
„Log and Capture" (Indizieren und Erfassen) das Sternsymbol an
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Löschen von Clips und Bins
Markieren Sie die zu löschenden Clips und drücken Sie auf Ihrem Keyboard die Löschtaste vorwärts. Dieser Vorgang 
löscht die Clips nur aus „Media List“ (Medienliste) und belässt sie unversehrt auf Ihrer Festplatte gespeichert.

Wählen Sie die zu löschenden Bins mit der rechten Maustaste aus und aktivieren Sie „Delete Bin”. Dies bewirkt die 
Löschung der Bin und aller darin enthaltenen Clips. Dieser Vorgang löscht die Clips nur aus der Medienliste und belässt 
sie unversehrt auf Ihrer Festplatte gespeichert.

Erstellung von 3D-Clips
So fügen Sie einen stereoskopischen 3D-Clip in „Media List“ (Medienliste) ein:

 � Wählen Sie ein Videoformat für Ihr 3D-Projekt aus, das die gleiche Framerate wie Ihre 3D-Medien aufweist.

 � Importieren Sie die Datei für das linke Auge („left eye") in die Medienliste.

 � Wählen Sie die Datei für das linke Auge mit der rechten Maustaste aus und aktivieren Sie im Kontextmenü 
„Set Right Eye Clip" (Clip für das rechte Auge anlegen). Wenn Media Express den Clip für das rechte Auge 
bereits aufgenommen hat, wird das Video für das rechte Auge mit dem Nachsatz „_right" versehen.

Die Medienliste zeigt deutlich an, dass es sich bei dem importierten Clip um einen 3D-Clip handelt. Die Clips für das 
linke und das rechte Auge erscheinen im Videovorschaufenster (Video Preview) nebeneinander. Dies zeigt an, dass es 
sich um ein 3D-Videoprojekt handelt.

Tun Sie Folgendes, wenn die Dateien für das linke und rechte Auge in einem 3D-Stereoclip verkehrt herum geladen sind:

 � Führen Sie einen Rechtsklick auf dem 3D-Clip in der Medienliste aus.

 � Wählen Sie im Kontextmenü „Swap Eyes" (Linkes und rechtes Auge vertauschen) aus.

Durchsuchen der Medienliste (Media List)
In einem Projekt befindliche Clips lassen sich durch Eingabe des Clip-Namens in das Suchfeld über „Media List" leicht 
ausfindig machen. Bei Einsatz zusammen mit der „Favorites"-Funktion bleibt die Suche auf Ihre favorisierten Clips 
beschränkt. Es wird eine entsprechend kürzere Liste gefundener Clips angezeigt.

Wählen Sie ein Videoprojekt-Format in 3D aus

Die Medienliste zeigt deutlich an, dass der importierte Clip ein 3D-Clip ist

Geben Sie zum Auffinden von Clips entsprechende Infos in das Suchfeld ein

Die Medienliste zeigt deutlich an, dass die Video- und Audioclips 
miteinander verknüpft sind
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Auf Band 
mastern

Aufzeichnungsmodi Audiokanal  
aktivieren/

deaktivieren

In-Punkt / 
Out-Punkt
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Schnitt von Video- und Audiodateien auf Band
Wir reden zwar über Mastern oder Schneiden auf „Band", es ist jedoch egal, ob Ihre MAZ mit Bändern oder Festplatten 
arbeitet. So mastern Sie Ihre Clips:

 � Wählen Sie die Clips aus, die Sie auf Band senden wollen.

 � Klicken Sie auf die blaue Registerkarte „Edit to Tape" (Auf Band schneiden).

 � Geben Sie den In-Punkt und den Schnitt-Modus vor.

 � Mastern Sie auf Band.

Auswahl der zu masternden Clips
Wählen Sie in „Media List“ (Medienliste) die auf Band zu masternden Clips aus. Sie können sogar Nur-Audioclips 
mit mehreren Kanälen einfügen, um die Master-Audiospur auf einem Masterband auszutauschen. Wenn Sie nur Ihre 
Favoritenclips auf Band senden wollen, klicken Sie auf das Favoritensymbol (Stern) über der Medienliste und verbergen 
Sie alle anderen Clips. Wählen Sie dann die Favoritenclips aus, die Sie auf Band senden wollen.

Insert- und Assemble-Schnitt auf Band
Klicken Sie auf die blaue Registerkarte „Edit to Tape" (Auf Band schneiden). Legen Sie den In-Punkt des Bands 
fest, indem Sie den Timecode in das In-Punktfenster eingeben oder indem Sie mithilfe der Transportsteuerung den 
gewünschten Cue-Punkt auf dem Band anspringen und dann auf die „Mark In"-Schaltfläche klicken.

Wenn kein Out-Punkt vorgegeben ist, setzt Media Express die Dauer des Schnitts auf die Gesamtlänge des Clips in 
„Media List“ (Medienliste) fest. Wenn ein Out-Punkt vorgegeben wurde, stoppt Media Express die Aufnahme bei 
Erreichen des Out-Punkt-Timecodes selbst dann, wenn nicht alle Clips ausgegeben wurden.

Wählen Sie Mastern auf Band per Assemble- oder Insert-Schnitt aus. Klicken Sie dann auf die „Master-Schaltfläche.

Der „Preview"-Modus ahmt den Schnittvorgang nach, nimmt aber keine Aufnahme auf Band vor. In diesem Modus 
können Sie den Schnittpunkt prüfen. Die Vorschau von Schnittvorgängen sollte immer über direkt an den MAZ-Ausgang 
angeschlossene Monitore geprüft werden. Dies ermöglicht die Ansicht von bereits auf Band befindlichem Video 
zusammen mit dem neuen Video. 

Ist auf der MAZ oder dem Band die Funktion „Record Inhibit" (Erfassung verbieten) aktiviert, meldet Media Express 
dies, wenn Sie auf die „Master"-Schaltfläche drücken. Deaktivieren Sie „Record Inhibit", ehe Sie es erneut versuchen.

Markieren Sie die auszugebenden Video- und Audiokanäle anhand der Schaltflächen zur Spuraktivierung bzw. 
-deaktivierung. Deaktivieren Sie den Videokanal, wenn nur Audio ausgegeben werden soll.

Klicken Sie auf das Favoritensymbol (Stern) über „Media List" 
(Medienliste), um nur Ihre Favoriten anzuzeigen

Es sind zwei Clips für die Ausgabe auf Band markiert

Geben Sie die gewünschte Anzahl der zu masternden Audiokanäle ein
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Was ist der Blackmagic Design Disk Speed Test?
Der Blackmagic Disk Speed Test ermittelt die Lese- und Schreibgeschwindigkeit von Speichermedien in Video-
Auflösungen und Framerates. Der Festplatten-Geschwindigkeitstest ist kostenfrei in allen Blackmagic Design 
Produktinstallationen unter Mac OS X und Windows enthalten. Er lässt sich auch kostenlos von unserer Website 
herunterladen. Greifen Sie auf die Einstellungen des Tests per Klick auf das unmittelbar über der Startschaltfläche 
befindliche Zahnradsymbol zu.

Auswahl der Zielfestplatte

Klicken Sie zur Auswahl der Zielfestplatte auf „Select Target Drive" und vergewissern Sie sich, dass Sie über Lese- und 
Schreibrechte verfügen.

Screenshot speichern

Klicken Sie auf „Save Screenshot", um ein Bildschirmfoto der Ergebnisse zu speichern. 

Belastung

Der Belastungspegel ist in Schritten von 1 GB zwischen 1 GB bis 5 GB einstellbar. Die Standard-Einstellung 5 GB liefert 
die akkuratesten Ergebnisse.

Hilfe mit dem Festplatten-Geschwindigkeitstest

Öffnen Sie per Klick auf „Disk Speed Test Help" die PDF-Bedienungsanleitung für den Festplatten-Geschwindigkeitstest. 

Über den Festplatten-Geschwindigkeitstest

Die Option „About Disk Speed Test" zeigt die auf Ihrem Computer installierte Version des Festplatten-
Geschwindigkeitstests an.

Start

Klicken Sie auf die Startschaltfläche, um den Test zu starten. Es wird eine temporäre Datei auf die Zielfestplatte 
geschrieben und dann gelesen. Der Disk Speed Test führt diesen Vorgang aus, bis Sie ihn durch erneutes Klicken der 
Startschaltfläche beenden.

Wird es funktionieren?

Das Fenster „Will it Work?” führt gebräuchliche Videoformate auf und zeigt anhand eines Häkchens oder Kreuzes 
an, ob die Festplattenleistung ausreicht. Nehmen Sie sicherheitshalber mehrere Testdurchläufe vor, um Videoformate 
zu identifizieren, für die die Festplattenleistung grenzwertig sein könnte. Erscheint ein Videoformat abwechselnd mit 
einem Häkchen oder Kreuz versehen, ist die Speicherkapazität für eine zuverlässige Unterstützung des Videoformats 
unzureichend.

Wie schnell?

Das Ergebnisfeld „How Fast?” zeigt an, welche Bildraten Ihre Festplatte erreicht und ist zusammen mit den Angaben im 
Fenster „Will it Work?” zu lesen. Wird im Fenster „Will it Work?” ein grünes Häkchen für 2K 1556 @ 25 fps in 10 Bit YUV 
4:2:2 angezeigt, im Fenster „How Fast?” hingegen, dass höchstens 25 fps unterstützt werden, ist die Speicherkapazität 
zu grenzwertig und damit unzuverlässig.

Öffnen Sie das Einstellungsmenü per Klick auf das Zahnradsymbol

Blackmagic Disk Speed Test (Festplatten-Geschwindigkeitstest) 
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Wie schnell?

„How Fast?" zeigt die 
Ergebnisse in Frames pro 
Sekunde (fps) an

Einstellungen 

Ein Klick auf diese 
Schaltfläche erlaubt  
den Zugriff auf die 
Einstellungen, ehe 
Sie einen Festplatten-
Geschwindigkeitstest 
vornehmen

Wird es funktionieren? 

„Will it work" zeigt an, 
welche Videoformate von 
Ihrem Festplatten-Speicher 
unterstützt werden

START

Einmaliges Klicken 
auf diese Schaltfläche 
startet den Festplatten-
Geschwindigkeitstest.  
Ein weiterer Klick beendet 
den Test
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So erhalten Sie Hilfe
Am schnellsten erhalten Sie Hilfe über die Online-Support-Seiten der Blackmagic Design Website. Sehen Sie dort nach 
der aktuellsten Support-Dokumentation für Ihre Hardware.

Blackmagic Design Online-Support-Seiten
Die aktuellste Bedienungsanleitung, Software und Support-Hinweise finden Sie unter:  
www.blackmagicdesign.com/support

Kontaktaufnahme mit Blackmagic Design Support
Sollte Ihnen unser Support-Material die gewünschte Hilfe nicht bieten, schicken Sie uns bitte eine E-Mail mit 
Ihrer Anfrage. Klicken Sie hierfür auf der Support-Seite für Ihre Hardware auf die Schaltfläche „Anfrage senden". 
Wenden Sie sich alternativ an eine der unter www.blackmagicdesign.com/company aufgeführten Blackmagic 
Design Support-Stellen.

Prüfen der aktuell installierten Softwareversion
Prüfen Sie die gegenwärtig auf Ihrem Computer installierte Version der Desktop Video Software, indem Sie die 
Systemeinstellungen von Blackmagic Design Desktop Video öffnen. Die Versionsnummer erscheint in der Titelzeile.

 � Unter Mac OS X: Öffnen Sie „Systemeinstellungen", um das Blackmagic Design Symbol aufzufinden. Klicken 
Sie auf das Blackmagic Design Symbol, um die Versionsnummer anzuzeigen.

 � Unter Windows 7 und Windows 8: Öffnen Sie die Systemsteuerung und klicken Sie auf die Kategorie 
„Hardware und Sound”, um das Blackmagic Design Control Panel abzurufen. Klicken Sie auf das Blackmagic 
Design Control Panel, um die Versionsnummer anzuzeigen.

 � Unter Linux: Gehen Sie zu „Anwendungen" und dann zu „Sound und Video", um zum Blackmagic Control 
Panel zu navigieren. Öffnen Sie die Systemsteuerung (Control Panel), um die Versionsnummer herauszufinden.

So bekommen Sie die aktuellsten Updates
Prüfen Sie zunächst die Versionsnummer der auf Ihrem Computer installierten Desktop Video Software. Sehen Sie dann 
im Blackmagic Support Center unter www.blackmagicdesign.com/support nach den neuesten Aktualisierungen. Es ist 
ratsam, die aktuellsten Updates zu laden. Allerdings sollte man Software-Updates möglichst nicht gerade mitten in 
einem wichtigen Projekt vornehmen.

Hilfe

http://www.blackmagicdesign.com/support
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Entwicklung von Individual-Software für Blackmagic Design Hardware
Der DeckLink Software Developer Kit ermöglicht Entwicklern, Blackmagic Videohardware mit eigener Software zu 
steuern. Der DeckLink SDK unterstützt die Produkte UltraStudio, DeckLink, Multibridge und Intensity.

Der DeckLink SDK liefert systemnahe (Low Level) Hardware-Steuerung sowie High-Level-Schnittstellen, anhand derer 
Entwickler gebräuchliche Aufgaben auf einfache Art ausführen können. Der DeckLink SDK unterstützt u. a. folgende 
Technologien:

 � Apple QuickTime

 � Microsoft DirectShow

 � Apple Core Media

 � DeckLink API

Download des kostenlosen Blackmagic Design SDK
Der DeckLink SDK steht unter www.blackmagicdesign.com/support/sdks/ zum Download bereit.

Anmeldung auf der Verteilerliste für Blackmagic Design Entwickler
Die Blackmagic Developer Verteilerliste befasst sich mit technischen Fragen über die von Blackmagic Design eingesetzten 
Technologien, beispielsweise QuickTime, Core Media, DirectShow, Codecs, APIs und SDKs. Die kostenlose Verteilerliste 
ist ein Forum für Developer, wo sie Ideen und Probleme untereinander diskutieren können. Jeder registrierte Teilnehmer 
darf antworten und, wo angemessen, ergreifen auch Blackmagic Design Ingenieure das Wort. Melden Sie sich hier auf 
der Verteilerliste an: http://lists.blackmagicdesign.com/mailman/listinfo/bmd-developer

Wenn Ihre Tätigkeit als Entwickler nicht aus Ihrem Domänenname hervorgeht, werden Sie ggf. um eine kurze 
Beschreibung Ihrer Software gebeten. Da dieser Verteiler ausschließlich für Entwickler gedacht ist, bemühen wir uns, sie 
frei von Spam und Viren zu halten und keine Fragen von Nicht-Entwicklern, Arbeitsvermittlern oder Verkaufsförderung 
betreibenden Leuten zuzulassen. 

Kontaktaufnahme mit Blackmagic Design Developer Assistance
Wenn Sie Ihre Fragen nicht über die Liste stellen wollen, schicken Sie uns bitte eine E-Mail an developer@
blackmagicdesign.com

Informationen für Entwickler
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Caution: Risk of Electric Shock
On the UltraStudio 4K enclosure you will see a yellow warning label marked ‘Caution: Risk of Electric Shock’. This is 
intended to warn users that there may be the presence of uninsulated “dangerous” voltage within the UltraStudio 4K 
enclosure which may be of sufficient magnitude to constitute a risk of electric shock to the user. Blackmagic Design 
advises you not to open the UltraStudio 4K unit, but rather contact your nearest Blackmagic Design service center should 
assistance be required.

Achtung: Stromschlaggefahr
Auf dem UltraStudio 4K-Gehäuse befindet sich ein gelbes Warnetikett mit der Aufschrift 'Caution:  
Risk of Electric Shock’. Dieses warnt den Benutzer vor einer möglichen, nicht isolierten, „gefährlichen" Spannung 
innerhalb des UltraStudio 4K-Gehäuses, die einen Elektroschock verursachen kann. Blackmagic Design empfiehlt, das 
Gehäuse des UltraStudio 4K nicht selbst zu öffnen, sondern bei Hilfebedarf das nächstgelegene Blackmagic Design 
Servicecenter zu kontaktieren.

Caution label

Warnetikett

Warnhinweise
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Eingeschränkte Garantie
Für Geräte der Produktfamilien UltraStudio, Decklink und Multibridge gewährt Blackmagic Design eine Garantie 
auf Material- und Verarbeitungsfehler von 36 Monaten ab Kaufdatum mit Ausnahme von Steckverbindern, Kabeln, 
Kühllüftern, Glasfasermodulen, Sicherungen, Tastaturen und Batterien, für die eine Garantie auf Material- und 
Verarbeitungsfehler von 12 Monaten ab dem Kaufdatum gewährt wird. Für Geräte der Intensity Produktfamilie gewährt 
Blackmagic Design eine Garantie auf Material- und Verarbeitungsfehler von 12 Monaten ab Kaufdatum. Sollte sich ein 
Produkt innerhalb dieser Garantiezeit als fehlerhaft erweisen, wird die Firma Blackmagic Design nach ihrem Ermessen 
das defekte Produkt entweder ohne Kostenerhebung für Teile und Arbeitszeit reparieren oder Ihnen das defekte 
Produkt ersetzen.

Zur Inanspruchnahme der Garantieleistungen müssen Sie als Kunde Blackmagic Design über den Defekt innerhalb der 
Garantiezeit in Kenntnis setzen und die entsprechenden Vorkehrungen für die Leistungserbringung treffen. Es obliegt 
dem Kunden, für die Verpackung und den bezahlten Versand des defekten Produkts an ein spezielles von Blackmagic 
Design benanntes Service Center zu sorgen und hierfür aufzukommen. Sämtliche Versandkosten, Versicherungen, 
Zölle, Steuern und sonstige Ausgaben im Zusammenhang mit der Rücksendung von Waren an uns, ungeachtet des 
Grundes, sind vom Kunden zu tragen. 

Diese Garantie gilt nicht für Mängel, Fehler oder Schäden, die durch unsachgemäße Handhabung oder unsachgemäße 
oder unzureichende Wartung und Pflege verursacht wurden. Blackmagic Design ist im Rahmen dieser Garantie 
nicht verpflichtet, die folgenden Serviceleistungen zu erbringen: a) Behebung von Schäden infolge von Versuchen 
Dritter, die Installation, Reparatur oder Wartung des Produkts vorzunehmen, b) Behebung von Schäden aufgrund von 
unsachgemäßer Handhabung oder Anschluss an nicht kompatible Geräte, c) Behebung von Schäden oder Störungen, 
die durch die Verwendung von nicht Blackmagic-Design-Ersatzteilen oder -Verbrauchsmaterialien entstanden sind, d) 
Service für ein Produkt, das verändert oder in andere Produkte integriert wurde, sofern eine solche Änderung oder 
Integration zu einer Erhöhung des Zeitaufwands oder zu Schwierigkeiten bei der Wartung des Produkts führt. ÜBER 
DIE IN DIESER GARANTIEERKLÄRUNG AUSDRÜCKLICH AUFGEFÜHRTEN ANSPRÜCHE HINAUS ÜBERNIMMT 
BLACKMAGIC DESIGN KEINE WEITEREN GARANTIEN, WEDER AUSDRÜCKLICH NOCH STILLSCHWEIGEND. DIE 
FIRMA BLACKMAGIC DESIGN UND IHRE HÄNDLER LEHNEN JEGLICHE STILLSCHWEIGENDEN GARANTIEN IN 
BEZUG AUF AUSSAGEN ZUR MARKTGÄNGIGKEIT UND GEBRAUCHSTAUGLICHKEIT FÜR EINEN BESTIMMTEN 
ZWECK AB. DIE VERANTWORTUNG VON BLACKMAGIC DESIGN, FEHLERHAFTE PRODUKTE ZU REPARIEREN ODER 
ZU ERSETZEN, IST DIE EINZIGE UND AUSSCHLIESSLICHE ABHILFE, DIE GEGENÜBER DEM KUNDEN FÜR ALLE 
INDIREKTEN, SPEZIELLEN, NEBEN- ODER FOLGESCHÄDEN ZUR VERFÜGUNG GESTELLT WIRD, UNABHÄNGIG 
DAVON, OB BLACKMAGIC DESIGN ODER DER HÄNDLER VON DER MÖGLICHKEIT SOLCHER SCHÄDEN ZUVOR 
IN KENNTNIS GESETZT WURDE. BLACKMAGIC DESIGN IST NICHT HAFTBAR FÜR JEGLICHE WIDERRECHTLICHE 
VERWENDUNG DER GERÄTE DURCH DEN KUNDEN. BLACKMAGIC HAFTET NICHT FÜR SCHÄDEN, DIE SICH AUS 

DER VERWENDUNG DES PRODUKTS ERGEBEN. NUTZUNG DES PRODUKTS AUF EIGENE GEFAHR. 

© Copyright 2014 Blackmagic Design. Alle Rechte vorbehalten. „Blackmagic Design", „DeckLink", „HDLink", „Workgroup Videohub", 
„Videohub", „DeckLink", „Intensity" und „Leading the creative video revolution" sind in den USA und in anderen Ländern eingetragene 
Warenzeichen. Alle anderen Unternehmens- und Produktnamen sind möglicherweise Warenzeichen der jeweiligen Firmen, mit denen sie 
verbunden sind.

Thunderbolt und das Thunderbolt-Logo sind Warenzeichen der Firma Intel Corporation in den USA bzw. in anderen Ländern.

Garantie
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¡Bienvenido!

Ojalá compartas nuestro sueño de transformar la industria televisiva en un sector 
verdaderamente creativo, donde todos tengan acceso a la mejor calidad en materia 
de imagen.

Antes era necesario invertir miles de dólares en equipos para llevar a cabo 
producciones y posproducciones de gran calidad, pero ahora, gracias los productos 
de Blackmagic, es posible trabajar incluso con formatos de 10 bits sin compresión.  
Esperamos que aproveches al máximo tu nuevo UltraStudio, DeckLink o Intensity y te 
diviertas utilizando uno de los programas más populares en el mundo de la televisión.

Este manual de instrucciones contiene toda la información que necesitas para instalar 
los dispositivos de vídeo de Blackmagic. Si es la primera vez que instalas una tarjeta 
PCI Express, te recomendamos solicitar asistencia a un técnico en informática.  Los 
equipos de Blackmagic utilizan formatos de vídeo sin compresión y el volumen 
de transferencia de datos es significativo, por lo cual necesitarás unidades de 
almacenamiento rápidas y un ordenador de alta gama.

Estimamos que la instalación puede completarse en aproximadamente 10 minutos.  
En la página de soporte técnico de nuestro sitio web (www.blackmagicdesign.
com) encontrarás la versión más reciente de este manual y los controladores para 
Desktop Video.  Por último, no olvides registrar los productos al descargar las 
actualizaciones. De esta forma podremos mantenerte al tanto de nuevas versiones y 
características. Quizás hasta puedas enviarnos tus trabajos más recientes realizados 
con nuestros productos y cualquier sugerencia para mejorar el software. Trabajamos 
constantemente para desarrollar nuevas funciones y superarnos, ¡así que nos 
encantaría saber tu opinión!

Grant Petty
director ejecutivo, Blackmagic Design
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Introducción
El programa Desktop Video de Blackmagic Design ha sido diseñado para los dispositivos UltraStudio, DeckLink, 
Intensity o Teranex. Incluye controladores, complementos y aplicaciones tales como Blackmagic Media Express. 
Asimismo, se integra fácilmente con otros programas de Adobe, Apple, Autodesk y Avid.

Este manual brinda información sobre los requerimientos del sistema informático, la instalación del software y los 
dispositivos, y el uso de otros programas desarrollados por terceros. 

Requerimientos del sistema
El ordenador deberá contar como mínimo con una memoria RAM de 4 GB. Las tarjetas PCIe x1 pueden instalarse 
en cualquier ranura. En el caso de las tarjetas PCIe x4, deberá disponer de una ranura con al menos 4 carriles. 

Mac OS X
El programa puede ejecutarse en las versiones Mountain Lion y Mavericks del sistema operativo Mac OS X.

Para instalar el dispositivo en una ranura PCI Express, es necesario contar con un ordenador Mac Pro con 
tecnología Intel. 

Para conectar el dispositivo mediante un puerto Thunderbolt, es necesario disponer de un ordenador Mac con 
tecnología Intel que cuente con este tipo de conexión.

Windows
El programa puede ejecutarse solamente en las versiones de 64 bits que incluyan las actualizaciones más recientes 
del sistema operativo. Es compatible con Windows 7 y Windows 8.

Para conectar el dispositivo de vídeo mediante un puerto Thunderbolt, es necesario disponer de un ordenador 
con tecnología Intel que cuente con este tipo de conexión.

Para conectar el dispositivo de vídeo mediante un puerto USB 3.0, es necesario disponer de una conexión con un 
conjunto de circuitos integrados fabricado por Renesas.

Linux
El programa puede ejecutarse en ordenadores x86 con versiones de 32 y 64 bits del sistema operativo Linux 
2.6.23 (o actualizaciones posteriores). Consulte las notas de publicación para obtener más información sobre la 
compatibilidad con distintas distribuciones, formatos de paquetes y dependencias de software en Linux.  

Primeros pasos
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Instalación del dispositivo
Si el dispositivo se conecta mediante un puerto Thunderbolt, consulte la sección correspondiente más adelante. 
Los nuevos modelos de ordenadores Mac OS X y Windows cuentan con puertos Thunderbolt.

Si el dispositivo se conecta mediante un puerto USB 3.0, consulte la sección correspondiente más adelante.  Para 
utilizar los productos de Blackmagic con conexiones USB 3.0 es necesario disponer de un ordenador Windows 
compatible.

Instalación de la tarjeta PCIe
Paso 1. Desconecte el ordenador de la toma de corriente y elimine la carga electrostática de su cuerpo.

Paso 2. Inserte la tarjeta en una ranura disponible y empújela firmemente hasta que calce en su lugar. Antes de 
instalar una tarjeta DeckLink Optical Fiber, quite el módulo de fibra óptica.

Paso 3. Inserte la chapa metálica para conexiones HDMI (si viene incluida con la tarjeta) en otra de las ranuras 
disponibles. Sujete la tarjeta y la chapa metálica mediante tornillos y a continuación conecte los cables 
HDMI a la parte trasera de la tarjeta. 

Paso 4. Colóquele la tapa del ordenador y conecte el cable multiconector suministrado. Inserte nuevamente 
el módulo de fibra óptica (en el caso de una tarjeta DeckLink Optical Fiber). Conecte la fuente de 
alimentación y encienda el ordenador.

Inserte la tarjeta en una de las ranuras disponibles. La chapa metálica para 
el puerto HDMI puede insertarse en cualquier otra ranura y se conecta a la 
tarjeta mediante los cables suministrados.

Si dispone de un cable multiconector, conéctelo a la tarjeta. Algunos 
modelos incluyen una chapa metálica para el puerto HDMI.
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Conexión del dispositivo mediante Thunderbolt
Paso 1. Si el dispositivo de vídeo incluye una fuente de alimentación externa, conéctela al mismo y enciéndalo.

Paso 2. Conecte el dispositivo al ordenador mediante un cable Thunderbolt. De manera alternativa, puede 
conectar el dispositivo a la matriz de discos del ordenador.

Paso 3. Si Desktop Video ya fue instalado anteriormente y el programa le pregunta si desea actualizar el 
software interno, haga clic en “Update” y siga las instrucciones en pantalla.

Paso 4. Si cuenta con un cable multiconector, conéctelo al dispositivo de Blackmagic y a los equipos de vídeo.

Conexión del dispositivo mediante USB 3.0
Paso 1. Si el dispositivo de vídeo incluye una fuente de alimentación externa, conéctela al mismo y enciéndalo.

Paso 2. Conecte un cable SuperSpeed USB 3.0 desde el dispositivo al puerto USB del ordenador.

Paso 3. Si Desktop Video ya fue instalado anteriormente y el programa le pregunta si desea actualizar el 
software interno, haga clic en “Update” y siga las instrucciones en pantalla.

Paso 4. Si cuenta con un cable multiconector, conéctelo al dispositivo de Blackmagic y a los equipos de vídeo.

Los productos que cuentan con puertos Thunderbolt® se conectan al 
ordenador mediante un único cable Thunderbolt  
o USB 3.0.

El UltraStudio 4K incluye dos puertos Thunderbolt 2®. Si el ordenador solo 
cuenta con uno, se puede utilizar el otro para conectar el equipo a una 
matriz de discos o a cualquier otro dispositivo.

PUSH

PUSH
PUSH
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Instalación del software

Aplicaciones, complementos y controladores
A continuación se detallan las aplicaciones, complementos y controladores que se instalan junto con el programa. 

Mac OS X Windows Linux

Controladores para Desktop Video Controladores para Desktop Video Controladores para Desktop Video

Preferencias del Sistema Panel de Control Panel de Control

Blackmagic Design LiveKey Blackmagic Design LiveKey Blackmagic Media Express

Blackmagic Media Express Blackmagic Media Express Códecs AVI

Códecs QuickTime® Códecs AVI y QuickTime®

Blackmagic Disk Speed Test Blackmagic Disk Speed Test

Preajustes y complementos para 
Adobe® Premiere Pro® CC, After 
Effects® CC y Photoshop® CC

Preajustes y complementos para 
Adobe® Premiere Pro® CC, After 
Effects® CC y Photoshop® CC

Complementos para Final Cut Pro® X Complementos para Avid Media 
Composer

Complementos para Avid Media 
Composer

Complementos para eyeon Fusion
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Instalación en sistemas operativos Mac OS X
Antes de instalar cualquier programa, asegúrese de contar con permisos de administrador.

Paso 1. Compruebe si tiene la versión más reciente del controlador. Visite www.blackmagicdesign.com/
support.

Paso 2. Abra la carpeta “Desktop Video Installer” que se encuentra en el disco o en la imagen de disco 
descargada y ejecute la aplicación “Desktop Video Installer”.

Paso 3. Haga clic en “Continue”, “Agree” y luego en “Install” para instalar el programa.

Paso 4. Reinicie el ordenador para activar los nuevos controladores.

Actualizaciones automáticas
Cuando el ordenador se reinicia, el programa verifica la versión del software interno del dispositivo. En caso 
de no coincidir con la versión del controlador, le indicará que es necesario actualizarlo. Haga clic en “OK” para 
comenzar la actualización y reinicie el ordenador para completar el proceso.

Instalación en sistemas operativos Windows
Paso 1. Compruebe si tiene la versión más reciente del controlador. Visite www.blackmagicdesign.com/

support.

Paso 2. Abra la carpeta denominada “Desktop Video” y ejecute la aplicación “Desktop Video”.

Paso 3. Los controladores se instalarán en el sistema. Aparecerá un aviso preguntándole si desea permitir que 
el programa se instale en el ordenador. Haga clic en “Aceptar” para continuar.

Paso 4. A continuación, aparecerá otro aviso indicando que se ha encontrado un nuevo dispositivo y se 
ejecutará el asistente de instalación. Seleccione la opción de instalación automática para que el 
sistema encuentre los controladores necesarios. Al finalizar la instalación, aparecerá un nuevo aviso 
indicando que el dispositivo se encuentra listo para usar.

Paso 5. Reinicie el ordenador para activar los nuevos controladores.

Actualizaciones automáticas
Cuando el ordenador se reinicia, el programa verifica la versión del software interno del dispositivo. En caso 
de no coincidir con la versión del controlador, le indicará que es necesario actualizarlo. Haga clic en “OK” para 
comenzar la actualización y reinicie el ordenador para completar el proceso.

Desktop Video Installer para Mac

Desktop Video Installer para Windows
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Instalación en Linux
Paso 1. Descargue la versión más reciente del programa para Linux desde el sitio www.blackmagicdesign.

com/support.

Paso 2. Abra la carpeta denominada “Desktop Video” y luego el paquete “Desktop Video” ubicado dentro 
de la misma.

Paso 3. Haga clic en "Install" y aguarde a que el proceso finalice.

Paso 4. Si aparece un mensaje indicando que faltan dependencias, compruebe que estas se hayan instalado 
en forma previa y luego vuelva a ejecutar la aplicación.

Paso 5. Al finalizar la instalación, el programa volverá a la pantalla inicial.

Paso 6. Reinicie el ordenador para activar los controladores o ingrese el siguiente comando:

 # modprobe blackmagic

Si no encuentra un paquete nativo de Desktop Video para su distribución de Linux, o si prefiere realizar la 
instalación mediante comandos, consulte el archivo ReadMe para obtener información más detallada al respecto.

Actualizaciones
Cuando se reinicia el ordenador, los controladores comprueban la versión del software interno del dispositivo. 
En caso de no coincidir con la versión de los mismos, el programa indicará que es necesario actualizarlo. Para 
identificar cuáles tarjetas deben ser actualizadas, abra la terminal e ingrese el siguiente comando:

# BlackmagicFirmwareUpdater status

Aparecerá un mensaje similar al siguiente:

/dev/blackmagic/card0 [DeckLink HD Extreme 3] UPDATED
/dev/blackmagic/card1 [DeckLink HD Extreme 3] NEEDS_UPDATE

Luego de identificar la tarjeta, realice la actualización ingresando el siguiente comando: 

# BlackmagicFirmwareUpdater update <card_id> (1 en este caso)

Instalación de Desktop Video desde el Centro de Software de Ubuntu
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Captura y reproducción de vídeos 
Recomendamos realizar una prueba rápida para verificar si es posible capturar y reproducir vídeos.

Preparación
Paso 1. Conecte un monitor o TV a la salida de vídeo del dispositivo.

Paso 2. Conecte una fuente a la entrada de vídeo del dispositivo.

Paso 3. Seleccione las conexiones de entrada y salida de audio y vídeo en las preferencias del sistema. 
Consulte la sección “Preferencias del sistema” para obtener información adicional.

Prueba de captura de vídeo
Paso 1. Haga clic en Media Express > Preferences en Mac OS X o Edit > Preferences en Windows o Linux y 

seleccione un formato que coincida con el formato de la fuente de vídeo. Asimismo, escoja el formato 
de captura y determine dónde se guardarán los archivos grabados.

Paso 2. Cierre la ventana y haga clic en la pestaña “Log and Capture”. La fuente de vídeo se mostrará en el 
panel de vista previa de Media Express.

Paso 3. Haga clic en “Capture” para comprobar si el dispositivo graba correctamente. Haga clic en “Capture” 
nuevamente para finalizar la prueba.

Prueba de reproducción de vídeo
Paso 1. Haga clic en la pestaña “Playback”.

Paso 2. Haga clic dos veces sobre la secuencia para ver las imágenes en el monitor conectado a la salida de 
vídeo del dispositivo. También es posible monitorizar audio.

Camera Outputs

HDTV

Haga clic en el botón “Capture” para comenzar la grabación.

Conecte una fuente de vídeo y un monitor al dispositivo.
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Acceso a las preferencias del sistema
Desde las preferencias del sistema es posible configurar diferentes parámetros.

 � En Mac OS X, haga clic en “Preferencias del Sistema” y a continuación en el ícono de Blackmagic Design.

 � En Windows 7 y 8, abra el Panel de Control, luego seleccione la categoría “Hardware y sonido” y a 
continuación haga clic en el panel de control de Blackmagic.

 � En Linux, haga clic en “Aplicaciones”, luego en “Sonido y Vídeo” y finalmente dos veces en el panel 
de control de Blackmagic.

Los dispositivos de Blackmagic incluyen diferentes características según el modelo. En las preferencias del sistema 
solo se muestran las opciones disponibles para el dispositivo conectado.

La siguiente sección brinda información sobre los diferentes ajustes.

Preferencias del sistema en Mac OS X Blackmagic Design Control Panel en Windows Blackmagic Design Control Panel en Ubuntu Linux

Preferencias del sistema de Blackmagic
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Pestaña de ajustes

Selección de salidas  
Esta opción permite seleccionar el tipo de señal de audio y vídeo que el dispositivo transmite. En algunos 
modelos es posible seleccionar vídeo compuesto, por componentes o S-Video. Otros modelos disponen de 
salidas de audio que permiten seleccionar entre formatos analógicos y digitales.

Selección de entradas 
Esta opción permite seleccionar el tipo de señal de audio y vídeo que el dispositivo recibe. Dependiendo del 
modelo, el dispositivo puede ser compatible con una o varias de las siguientes combinaciones:

 � vídeo y audio en formato SDI

 � vídeo en SDI y audio digital (AES/EBU)

 � vídeo en SDI y audio analógico (XLR)

 � vídeo y audio en formato SDI por fibra óptica

 � vídeo y audio en HDMI

 � vídeo en formato HDMI y audio digital (AES/EBU)

 � vídeo en HDMI y audio analógico (XLR)

 � vídeo por componentes y audio digital (AES/EBU)

 � vídeo por componentes y audio analógico (XLR)

 � vídeo compuesto y audio digital (AES/EBU)

 � vídeo compuesto y audio analógico (XLR)

 � S-Video y audio digital (AES/EBU)

 � S-Video y audio analógico (XLR)

Niveles de negro en NTSC 
Seleccione la opción 7.5 IRE para vídeo compuesto en NTSC según el formato utilizado en los Estados Unidos y 
otros países. Seleccione la opción 0 IRE en el caso de Japón u otros países que no utilizan el formato anterior. Para 
formatos PAL y en alta definición, no es necesario modificar este parámetro.

Conexiones de salida para audio y vídeo

Conexiones de entrada para audio y vídeo

Seleccione 7.5 IRE o 0 IRE para vídeos compuestos en NTSC.
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Utilizar formato 4:4:4 SDI para la salida de vídeo si es posible 
Seleccione esta opción al transmitir señales de vídeo en formato 4:4:4. El formato de las imágenes en modo 
1080p50/60 es siempre 4:2:2. Nótese que en este modo las siguientes funciones no estarán disponibles:

 � salida simultánea de señales en HD y convertidas a SD
 � salida de señal analógica convertida a un formato de menor resolución

Utilizar SDI 3/6 Gb en vez de Dual Link SDI
Seleccione esta opción para conexiones SDI a 3/6 Gb con un solo enlace al utilizar formatos de gran ancho de 
banda (por ejemplo 1080p60 o 4:4:4) o al trabajar con formatos en resolución 4K.

Utilizar 1080p en vez de 1080PsF
Seleccione esta opción para transmitir la señal de vídeo en modo progresivo en lugar de utilizar fotogramas 
progresivos segmentados.

Eliminar fluctuaciones de campo al pausar el vídeo
Marque la casilla indicada para mostrar un solo campo y eliminar parpadeos en la imagen al pausar el vídeo en 
monitores CRT.  Esta opción no es recomendable para pantallas planas modernas.

Utilizar entrada para código de tiempo longitudinal
Seleccione esta opción para obtener una lectura del código de tiempo desde la entrada LTC en lugar de la señal 
en SDI.

Marque la casilla para transmitir señales de vídeo en formato 4:4:4.

Marque la casilla para utilizar una conexión SDI a 3/6 Gb con un único 
enlace. 

Marque la casilla para transmitir señales de vídeo en formato 1080p.

Marque la casilla para eliminar el parpadeo en monitores CRT.

Marque la casilla para que el código de tiempo se lea desde la entrada 
LTC.
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Seleccionar el formato de vídeo predeterminado
Para monitorizar con Final Cut Pro X, el formato de vídeo seleccionado debe coincidir con el formato del proyecto.

Para capturar vídeo en Windows mediante un programa compatible con el modelo de controladores para 
Windows (WDM), seleccione el formato predeterminado de forma que coincida con el formato de grabación. 
Por lo general, el formato se selecciona en las preferencias del programa. Sin embargo, es posible utilizar el panel 
de control de Blackmagic si surge alguna dificultad.

Al no reproducir vídeos, mostrar...
Esta opción permite determinar si el dispositivo transmite una señal con el último fotograma reproducido (Last 
Frame Played) o en negro (Black) al salir de una aplicación y dejar de reproducir el vídeo.

Algunos modelos incluyen tablas de consulta (LUT) y la opción “Last Played Frame” permite observar el efecto de 
cualquier cambio realizado en las mismas. Nótese que será necesario reiniciar el ordenador al activar o desactivar 
esta función.

Formato tridimensional en HDMI
Este ajuste permite seleccionar el formato 3D para la monitorización en HDMI. Se incluyen las siguientes opciones: 
Frame Packing, Side by Side, Line by Line, Top and Bottom, Left Eye o Right Eye.

Sincronizar la señal de referencia
Si hay una señal de referencia conectada al dispositivo pero la imagen se mueve verticalmente, deslice el control 
hasta que esta quede fija. Las señales de referencia también se conocen como Genlock, Black Burst, House Sync 
o Tri-Sync.

Seleccione el formato 3D para monitorizar en HDMI.

Seleccione el formato de vídeo predeterminado de forma que coincida 
con el del proyecto en Final Cut Pro X o para grabar con un programa 
WDM.

Al detener la reproducción, cuenta con la opción de mostrar el último 
fotograma reproducido o una pantalla en negro.

Deslice el control hasta que la imagen deje de moverse.
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Pestaña de procesamiento

Procesamiento de la señal saliente
Esta opción permite realizar conversiones a formatos de menor resolución durante la reproducción.  Realice la 
selección en el menú desplegable.

Algunos modelos permiten convertir la señal a formatos de menor resolución simultáneamente durante la 
reproducción, por ejemplo de HD a SD o de 2K a SD. Dicha conversión genera un retraso de 2 fotogramas 
en la salida SD-SDI. Ajuste el código de tiempo en el programa de edición para garantizar la precisión de los 
fotogramas al realizar el montaje o la masterización.

También es posible convertir señales de vídeo analógicas. La señal de vídeo por componentes puede transmitirse 
en HD o SD. Para ver vídeos analógicos por componentes en SD, marque la opción “Enable Conversion on 
Analog Output” (permitir conversión en la salida para señales analógicas) cuando la opción “Simultaneous HD 
and SD Output” (salida simultánea en HD y SD) también se encuentra seleccionada.

Procesamiento de la señal entrante
Esta opción permite realizar conversiones a formatos de mayor o menor resolución en tiempo real durante la 
grabación.  Realice la selección en el menú desplegable.

Salida en HD 23.98PsF a HD 59.94i (solo Windows)
Esta opción permite realizar una conversión 3:2 para transmitir secuencias en formato HD 59.94i. La 
frecuencia de imagen de 23.98 f/s es bastante común, aunque generalmente no es compatible con señales 
en SDI o monitores analógicos, y por otra parte casi todos los monitores de alta definición utilizan el 
formato HD 59.94i. 

Referencia VITC para el fotograma A
Esta opción permite ingresar el número del fotograma A al revertir la conversión 3:2 de las imágenes en NTSC 
cuando se graba a 23.98 f/s. Si este valor no es correcto, se generarán errores al mostrar los campos y fotogramas.

Mantener líneas de datos VANC
Estas opciones permiten conservar el código de tiempo, la información del subtitulado o cualquier otro dato 
auxiliar (VANC ) durante la grabación. Marque la casilla correspondiente a la línea de vídeo que desea capturar. 
Nótese que la línea 1 debe estar marcada para habilitar las líneas 2 y 3.

Select the output processing from the menu.

Tick the checkbox to output HD 23.98PsF at HD 59.94i

Set the A-Frame VITC Reference when performing 3:2 pulldown.

Tick the checkboxes to capture lines of VANC data.
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Pestaña de ajustes de vídeo
Calibrar la entrada de vídeo analógico
Estas opciones permiten ajustar la señal de vídeo analógica entrante. Utilice los controles deslizantes para ajustar 
los valores del vídeo, la crominancia, el rojo y el azul. Por lo general, estos parámetros se modifican en conjunto 
con las distintas opciones que ofrece el dispositivo Ultrascope de Blackmagic. Nótese que estos solo estarán 
disponibles si se ha seleccionado la opción “vídeo analógico” como formato de entrada.

Calibrar la salida de vídeo analógico
Estas opciones permiten ajustar la señal de vídeo analógico saliente. Utilice los controles deslizantes para ajustar 
los valores del vídeo, la crominancia, el rojo y el azul. Por lo general, estos parámetros se modifican en conjunto 
con las distintas opciones que ofrece el dispositivo Ultrascope de Blackmagic.

Utilizar valores YUV para Betacam
Los productos de Blackmagic utilizan los estándares para vídeo analógico por componentes determinados por 
la SMPTE de forma predeterminada, ya que dichos parámetros son compatibles con la mayoría de los equipos 
modernos. Al trabajar con dispositivos Sony Betacam SP, marque la casilla “Use Betacam YUV Levels”.

Pestaña de ajustes de audio
Parámetros para señales de audio analógicas entrantes
Estas opciones permiten ajustar la ganancia de las señales de audio analógicas que el dispositivo recibe.  

Parámetros para señales de audio analógicas salientes 
Estas opciones permiten ajustar la ganancia de las señales de audio analógicas que el dispositivo transmite. 

Nivel de referencia para la señal AES/EBU entrante
Estas opciones permiten ajustar la ganancia de las señales de audio AES/EBU que el dispositivo recibe. Aunque 
los parámetros para cada canal de audio analógico pueden ajustarse individualmente, en el caso de señales de 
audio AES/EBU los valores se aplican a todos los canales en forma conjunta.

Nivel de referencia para la señal AES/EBU saliente
Estas opciones permiten ajustar la ganancia de las señales de audio AES/EBU que el dispositivo transmite. 
Aunque los parámetros para cada canal de audio analógico pueden ajustarse individualmente, en el caso de 
señales de audio AES/EBU los valores se aplican a todos los canales en forma conjunta. 

Utilizar niveles para audio de alta fidelidad
Los productos UltraStudio y DeckLink incluyen conexiones XLR con niveles predeterminados para señales de 
audio profesional. Para conectar equipos de audio comunes, marque la casilla “Use HiFi Audio Levels” y utilice 
un adaptador XLR>RCA. 

Los controles deslizantes permiten ajustar distintos parámetros de la señal 
de vídeo analógica. 

Los controles deslizantes permiten ajustar la ganancia de las señales de 
audio. 
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After Effects® CC

Cómo previsualizar vídeos
Para ver las imágenes editadas con Adobe® After Effects® CC en tiempo real mediante el dispositivo de 
Blackmagic, haga clic en Preferencias > Previsualización de vídeo.  Seleccione “Blackmagic Video Output” y 
luego elija el modo de salida más apropiado. De esta forma podrá utilizar un monitor profesional para ver las 
composiciones realizadas con After Effects en un espacio de color adecuado.

Para escuchar el audio, haga clic en “Preferencias del Sistema” en Mac OS X o en el “Panel de Control” en 
Windows y seleccione Blackmagic Audio como dispositivo de salida predeterminado. En After Effects, haga clic 
en Preferencias > Hardware de audio y seleccione “System Default Input/Output” en Mac OS X o “Blackmagic 
Audio” en Windows.

Renderización
Al finalizar la edición, es necesario renderizar el montaje en un formato compatible con el dispositivo de vídeo. Es 
posible utilizar archivos DPX o cualquiera de los siguientes formatos:

Al instalar Final Cut Pro, el usuario tendrá acceso a otros formatos tales como ProRes y DVCPRO HD.

Al instalar Premiere Pro, el usuario tendrá acceso a otros formatos tales como DVCPRO HD y DVCPRO50.

After Effects® CC

Opciones del módulo de salida

Preferencias para la previsualización de vídeos

 � 10 bit 4:4:4 (sin compresión, Blackmagic)
 � 10 bit 4:2:2 (sin compresión, Blackmagic)
 � HD 8 bit 4:2:2 (sin compresión, Blackmagic)

 � SD 8 bit 4:2:2 (sin compresión, Blackmagic)
 � 8 bit MJPEG (sin compresión, Blackmagic)

AVI codecs on Windows

 � RGB 10 bit (sin compresión, Blackmagic)
 � 10 bit (sin compresión, Blackmagic)
 � 8 bit (sin compresión, Blackmagic)

 � Photo - JPEG (comprimido, Apple)
 � DV - NTSC (comprimido, Apple)
 � DV - PAL (comprimido, Apple)

QuickTime codecs on Windows

 � RGB 10 bit (sin compresión, Blackmagic)
 � Uncompressed YUV 10 bit 4:2:2 (Apple)
 � Apple Uncompressed YUV 8 bit 4:2:2

 � Photo - JPEG (comprimido, Apple))
 � DV - NTSC (comprimido, Apple)
 � DV - PAL (comprimido, Apple)

QuickTime codecs on Mac OS X

Uso de programas desarrollados por terceros
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Photoshop® CC

Cómo importar y exportar fotogramas

Importar una imagen en Photoshop®

Paso 1. Haga clic en Archivo > Importar > Blackmagic Image Capture.

Paso 2. Seleccione el formato de entrada del vídeo y la profundidad de color de la imagen.

Exportar una imagen en Photoshop®

Paso 1. Haga clic en Archivo > Exportar > Blackmagic Image Export.

Paso 2. Seleccione el formato de salida del vídeo y luego haga clic en “Export Image”.

Una vez que se hayan seleccionado las opciones para importar y exportar imágenes, la ventana de ajustes 
no se mostrará nuevamente. Sin embargo, es posible acceder a la misma manteniendo presionada la tecla 
“Option” en Mac o “Ctrl” en Windows al hacer clic sobre “Importar” o “Exportar”.

Importar una imagen

Exportar una imagen

Photoshop® CC
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Adobe® Premiere Pro® CC

Cómo crear un proyecto
Paso 1. Elija “Nuevo Proyecto” en la pantalla de bienvenida que aparece cuando se inicia el programa. Haga 

clic en la pestaña “Discos de Trabajo” y seleccione la ubicación y el nombre del proyecto.

Paso 2. Elija la ubicación para guardar los archivos grabados, así como las previsualizaciones de audio y vídeo.

Paso 3. Si la tarjeta gráfica es compatible con el Mercury Playback Engine de Premiere, la opción de renderizado 
estará disponible. Seleccione “Aceleración por GPU de Mercury Playback Engine”.

Paso 4. Elija “Blackmagic Capture” como formato de captura y haga clic en el botón “Ajustes” en Mac o 
“Propiedades” en Windows para ver las distintas opciones del proyecto. Seleccione el estándar y el 
formato del vídeo y haga clic en “OK”.

Paso 5. En la pantalla se abrirá la ventana “Nueva Secuencia”. Seleccione uno de los preajustes, ingrese un 
nombre para la secuencia y haga clic en “OK”. 

Control de dispositivos
Muchos de los dispositivos de captura y reproducción fabricados por Blackmagic Design son compatibles con 
el protocolo RS-422 que permite controlar distintos dispositivos. La opción de control debe seleccionarse cada 
vez que se crea un nuevo proyecto. Haga clic en Preferencias > Control de Dispositivos y seleccione "Blackmagic 
Device Control".

Reproducción
Es necesario seleccionar los ajustes de reproducción al crear un nuevo proyecto. Para ello, haga clic en Preferencias 
> Reproducción. El reproductor predeterminado es Adobe Player, pero es preciso seleccionar “Blackmagic 
Playback” como dispositivo de audio.

En “Dispositivo de vídeo”, marque la casilla “Blackmagic Playback” y compruebe que las demás opciones no 
estén seleccionadas.

Nueva secuencia

Adobe® Premiere Pro® CC
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Captura
Para grabar, haga clic en Archivo > Captura o presione F5.

Para comenzar a grabar inmediatamente o para capturar vídeo mediante un dispositivo no controlable, haga clic 
en el botón rojo [G].

Para marcar puntos de entrada y salida mediante el protocolo de control RS-422, utilice los botones “Definir 
Entrada” y “Definir Salida” o ingrese el código de tiempo en forma manual y luego haga clic en “Registrar 
Clip”. La secuencia se mostrará en la ventana del proyecto. Repita el procedimiento hasta registrar todas las 
secuencias que desea capturar. A continuación, haga clic en Archivo > Captura por Lotes o presione F6. Para 
agregar fotogramas adicionales al comienzo y al final de las secuencias, seleccione la opción de captura con 
selectores e ingrese el número de fotogramas necesarios.

Exportar a cinta 
Para exportar a una cinta mediante el protocolo de control RS-422, seleccione la secuencia y luego haga clic en 
Archivo >  Exportar > Exportar a Cinta.

Al realizar un montaje por inserción, es necesario utilizar un código de tiempo continuo durante todo el proyecto.

En el caso de la edición por ensamblaje, es preciso grabar una señal en negro hasta el punto de comienzo del 
proyecto. Este modo de edición borra el contenido de la cinta antes de la grabación, por lo cual no debe ser 
utilizado si esta contiene otros proyectos luego del punto de salida de la composición.

Al exportar el proyecto a una cinta, el programa se detiene en el primer fotograma y aguarda a que el dispositivo 
comience la grabación en el código de tiempo predeterminado. Si falta dicho fotograma o está repetido, será 
necesario ajustar la reproducción para sincronizar el dispositivo con el ordenador. Al finalizar los ajustes, estos se 
mantendrán, por lo cual solo es preciso llevar a cabo este procedimiento una vez.

Simplemente ingrese el punto de entrada, realice los ajustes necesarios, y haga clic en “OK” en Mac o “Export” 
en Windows.

Captura

Exportar a cinta
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Apple Final Cut Pro X

Apple Final Cut Pro X
Es posible usar la función de monitorización de Final Cut Pro X 10.0.4 (o versiones posteriores) para transmitir la 
señal de vídeo a través del dispositivo de Blackmagic. Asimismo, se pueden utilizar dos monitores para ver la 
interfaz del programa.

Configuración de Final Cut Pro X
Paso 1. Compruebe si cuenta con la versión 10.0.4 de Final Cut Pro X (o posterior) y asegúrese de haber 

instalado las últimas actualizaciones para Mac OS X Mountain Lion o Mavericks.

Paso 2. Abra las preferencias del sistema y luego haga clic en el ícono de Blackmagic Design. En “Set default 
video standard as” seleccione el mismo formato que utilizará en Final Cut Pro X, por ej. HD 1080i59.94. 
Este deberá coincidir con el formato de las secuencias.

Paso 3. Ejecute Final Cut Pro X para crear un proyecto nuevo.

Paso 4. Ingrese el nombre y la ubicación del proyecto.

Paso 5. Modifique el formato, la resolución y la frecuencia de imagen de modo que coincidan con el formato 
de vídeo predeterminado en las preferencias del sistema de Desktop Video.

Paso 6. Modifique las opciones de audio y renderización. En “canales de audio”, elija la opción “estéreo” o 
“surround” (para 6 canales de audio). En “frecuencia de muestreo de audio”, seleccione 48 kHz. Ajuste 
el formato de renderización para que coincida con el formato de las secuencias de vídeo. Final Cut 
Pro X utiliza el formato ProRes en forma predeterminada, pero es posible seleccionar “Uncompressed 
10-bit 4:2:2” de ser necesario. Haga clic en “OK” para finalizar la creación del proyecto.

Paso 7. En el menú “Final Cut Pro”, haga clic en “Preferencias” y luego en la pestaña “Reproducción”. 
Compruebe que en la salida de A/V diga “Blackmagic” y que el formato coincida con el del proyecto.

Paso 8. En el menú “Ventana” seleccione “Salida de A/V” para transmitir la señal de vídeo a través del 
dispositivo de Blackmagic.

Para monitorizar el audio mediante el dispositivo, abra las preferencias del sistema,  haga clic en el ícono 
correspondiente al sonido, luego en la pestaña “Salida” y finalmente seleccione “Blackmagic Audio”.

Paso 6. Modifique las opciones de audio y renderización.

Paso 2. Seleccione el formato de vídeo predeterminado en las preferencias 
del sistema de forma que coincida con el formato del proyecto en Final 
Cut Pro X.
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Reproducción
Paso 1. Importe algunas secuencias desde el proyecto.

Paso 2. Ahora podrá utilizar la línea de tiempo de Final Cut Pro X en la pantalla del ordenador y previsualizar el 
vídeo en los monitores o televisores conectados a las salidas del dispositivo.

Grabación de archivos de audio y vídeo
Mediante el programa Media Express de Blackmagic es posible utilizar el dispositivo para capturar audio y vídeo. 
Luego de grabar las secuencias, se pueden exportar a Final Cut Pro X para editarlas.

Al capturar secuencias con Media Express, asegúrese de seleccionar un formato de vídeo compatible con Final 
Cut Pro X (por ejemplo ProRes 4444, ProRes 422 (HQ), ProRes 422 o Uncompressed 10-bit 4:2:2).

Volcado a cinta
Al finalizar el proyecto en Final Cut Pro X, es posible crear un archivo de película a partir de la composición y luego 
utilizar Media Express para masterizar en cinta mediante el dispositivo de vídeo.

Paso 1. Seleccione las secuencias en la línea de tiempo de Final Cut Pro X.

Paso 2. En el menú “Compartir”, seleccione “Exportar película”

Paso 3. En la ventana emergente, seleccione “Ajustes actuales” y compruebe que el audio y el vídeo estén 
incluidos. Haga clic en “Siguiente”.

Paso 4. Abra Media Express y proceda a importar la secuencia exportada desde Final Cut Pro X.

Paso 5. Para obtener más información sobre el volcado de archivos de audio y vídeo a cintas, consulte la 
sección “Blackmagic Media Express” en este manual.

Paso 3. En la ventana emergente, seleccione “Ajustes actuales” y 
compruebe que el audio y el vídeo estén incluidos.
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Avid Media Composer

Avid Media Composer
El programa Avid Media Composer permite grabar y reproducir material audiovisual en definición estándar y alta 
definición mediante el dispositivo de Blackmagic y es compatible con el protocolo de control RS-422. Al instalar 
Desktop Video, los complementos para Media Composer se instalarán automáticamente si ya existe una versión 
del programa en el ordenador. 

Configuración
Paso 1. Al ejecutar Media Composer aparecerá un cuadro de diálogo para seleccionar el proyecto.

Paso 2. Elija el perfil de usuario correspondiente si ya ha creado uno con anterioridad.

Paso 3. Seleccione la carpeta en la cual se guardará el proyecto (privada, compartida o externa).

Paso 4. Haga clic en el botón “New Project”.

Paso 5. Ingrese el nombre del proyecto y seleccione las distintas opciones para el formato, el espacio de 
color y la estereoscopía. Haga clic en “OK”. Los parámetros correspondientes al espacio de color y la 
estereoscopía pueden modificarse posteriormente en la pestaña “Format” de la ventana del proyecto.  

Paso 6. Haga clic dos veces sobre el nombre del proyecto en el cuadro de diálogo para seleccionar proyectos. 
Se abrirá la interfaz del programa junto con la ventana correspondiente al nuevo proyecto. Ya está listo 
para comenzar a trabajar.

Reproducción
Para comprobar rápidamente que se hayan realizado las conexiones en forma correcta, siga los pasos descritos en 
la sección “Importing Color Bars and Other Test Patterns” (Importar barras de color y otros patrones de prueba) 
en la guía de edición de Media Composer. Haga clic dos veces en el archivo importado para reproducirlo. Las 
imágenes se verán tanto en la pantalla del ordenador como en el monitor conectado a la salida del dispositivo 
de Blackmagic.

Si no es posible ver el vídeo en el equipo conectado al dispositivo, verifique las conexiones nuevamente y 
compruebe que las opciones de salida en las preferencias se hayan configurado correctamente. Para ello, haga 
clic en Herramientas > Configuración de hardware.

Al utilizar el monitor del ordenador solamente, abra las preferencias del 
sistema de Blackmagic Design y seleccione la opción para mostrar una 
imagen en negro cuando no se reproduce ningún vídeo.

Paso 5. Ingrese el nombre del proyecto y seleccione las distintas opciones.
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Captura desde dispositivos no controlables
Muchos equipos de vídeo (inclusive todo tipo de cámaras, grabadores de disco y reproductores de vídeo) no 
cuentan con un dispositivo de control. Para grabar vídeos mediante dichos equipos:

Paso 1. Haga clic en Tools > Capture para abrir la herramienta de captura.

Paso 2. Haga clic en el botón para alternar fuentes ubicado en la parte superior de la ventana de forma que 
muestre un círculo rojo similar al símbolo de “prohibido”. Esto indica que el control ha sido desactivado.

Paso 3. Seleccione “Blackmagic” en las opciones de entrada de audio y vídeo.

Paso 4. Seleccione las pistas de la fuente de audio (A1, A2, etc.) y vídeo (V) que desea capturar.

Paso 5. Utilice el menú “Bin” para seleccionar una carpeta de destino.

Paso 6. En la opción “Res” (resolución), seleccione el codificador/decodificador que desea utilizar para las 
secuencias grabadas. Para formatos sin compresión, seleccione “1:1” o “1:1 10b” para 8 o 10 bits 
respectivamente.

Paso 7. Seleccione la opción de almacenamiento para los archivos grabados. Haga clic en el botón 
correspondiente al modo de almacenamiento (Single/Dual) para determinar si los archivos se 
guardarán juntos en una unidad o en unidades separadas. Seleccione las unidades donde se guardarán 
los archivos grabados.

Paso 8. Haga clic en el botón “Tape Name?” en la parte inferior de la ventana para abrir el cuadro de diálogo 
que permite seleccionar la cinta.  Seleccione la cinta deseada o agregue una nueva y haga clic en 
“OK”.

Paso 9. Compruebe que las fuentes de audio y vídeo estén listas y haga clic en el botón de captura. El botón 
se encenderá en rojo y se apagará en forma intermitente durante la grabación. Para finalizar, haga clic 
sobre el mismo botón nuevamente.

Paso 2. Configuración de la herramienta de captura para grabar vídeos sin 
un dispositivo de control.
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Captura desde dispositivos controlables mediante UltraStudio, DeckLink y Teranex
Si cuenta con un dispositivo que se conecta mediante el protocolo RS-422, será necesario configurar las 
preferencias antes de comenzar la captura.

Paso 1. Desde la ventana del proyecto, seleccione la pestaña de ajustes y luego haga clic dos veces sobre 
“Deck Configuration”.

Paso 2. En el cuadro de diálogo emergente, haga clic en “Add Channel” (agregar canal) y luego seleccione 
“Direct” en la opción para el tipo de canal y “RS-422 Deck Control” para el puerto.  Haga clic en “OK” 
y en “No” cuando el programa le pregunte si desea configurar el canal en forma automática."

Paso 3. Haga clic en “Add Deck” y a continuación seleccione la marca y el modelo del dispositivo desde 
los menús desplegables. Asimismo, seleccione el tiempo previo antes del comienzo de la grabación 
(preroll).   Haga clic en “OK” y luego en “Apply”.

Paso 4. En la pestaña de configuración (Settings), haga clic dos veces en “Deck Preferences”.

Paso 5. Para realizar una edición por ensamblaje, marque la opción “Allow assemble edit & crash record for 
digital cut”. Si esta opción no se encuentra seleccionada, solo será posible llevar a cabo el montaje por 
inserción.

Paso 6. Marque la opción “Relax coincidence point detection” y modifique los restantes parámetros según 
sea necesario.  Haga clic en “OK”. La configuración del dispositivo está lista.

Para comprobar si es posible controlar el equipo de vídeo a distancia, conecte el dispositivo de Blackmagic al 
mismo mediante un cable serial.    Seleccione el modo de mando a distancia en el equipo. Abra la herramienta 
de captura y verifique si es posible controlar el equipo mediante las teclas J, K y L. Si aparece el mensaje “NO 
DECK” o el nombre del equipo en letra cursiva, haga clic en el menú y seleccione “Check Decks” hasta que el 
nombre figure en letra normal y se restablezca el control. 

Para realizar la grabación sin marcar puntos de entrada y salida:

Paso 1. Haga clic en Tools > Capture para abrir la herramienta de captura.

Paso 2. El botón que permite alternar entre el modo de captura y registro ubicado en la parte superior de la 
ventana debe indicar “CAP”. Haga clic sobre el mismo para cambiarlo si fuera necesario.

Paso 3. El botón siguiente, ubicado a la derecha, debe mostrar un ícono con un dispositivo. Si ve un símbolo 
de “prohibido”, haga clic sobre el mismo para habilitar el control del dispositivo.

Paso 4. Seleccione las entradas y pistas de audio y vídeo, la carpeta para guardar los archivos grabados, la 
resolución, la unidad de destino y el nombre de la cinta de la forma descrita anteriormente en la 
sección “Captura desde dispositivos no controlables”.

Paso 5. Utilice la ventana de control de dispositivos en la herramienta de captura para preparar la cinta y 
comenzar la reproducción.

Paso 6. Haga clic en el botón “Capture”. El botón se encenderá en rojo y se apagará en forma intermitente 
durante la grabación. Para finalizar, haga clic sobre el mismo botón nuevamente.

Paso 6. Marque la opción “Relax coincidence point detection”.

Compruebe los ajustes para el control de dispositivos.  Utilice la ventana 
de control para preparar la cinta y comenzar la reproducción.
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Captura múltiple con UltraStudio y DeckLink
Para realizar una captura de varias secuencias:

Paso 1. Haga clic en Tools > Capture para abrir la herramienta de captura.

Paso 2. Haga clic sobre el botón “Capture/Log” de modo que indique “LOG”.

Paso 3. Seleccione las entradas y pistas de audio y vídeo, la carpeta para guardar los archivos grabados, la 
resolución, la unidad de destino y el nombre de la cinta de la forma descrita anteriormente en la 
sección “Captura desde dispositivos no controlables”.

Paso 4. Utilice la ventana de control del dispositivo o las teclas J, K y L para retroceder, pausar o adelantar la 
cinta y localizar el vídeo que desea digitalizar.

Paso 5. Haga clic sobre el botón “Mark IN/OUT” situado a la izquierda del botón “Capture/Log”. Este botón 
cambia entre “IN” y “OUT”, de modo que solo es necesario hacer clic sobre el mismo una sola vez 
para marcar todos los puntos de entrada o salida.  Esto puede resultar más conveniente que utilizar 
los botones “Mark IN” y “Mark OUT” individuales en la ventana de control del dispositivo. También es 
posible marcar puntos de entrada y salida mediante las teclas “I” y “O”.

Paso 6. Al finalizar, abra la carpeta de registro y seleccione las secuencias que desea capturar.

Paso 7. Haga clic en Clip > Batch Capture, seleccione las opciones deseadas en el cuadro de diálogo 
emergente y finalmente haga clic en “OK”.

Grabación en cintas con UltraStudio y DeckLink
Luego de capturar la secuencias, arrastrarlas a la línea de tiempo, editarlas y aplicar los efectos, el proyecto 
finalizado puede grabarse en una cinta.

Paso 1. Haga clic dos veces en una secuencia para abrirla en la ventana de la línea de tiempo.

Paso 2. Haga clic en Output > Digital Cut para abrir la herramienta correspondiente.

Paso 3. En “Output Mode”, seleccione la opción “Real-Time”. La profundidad de color debe ser de 10 bits. 
Asimismo, seleccione la opción “Remote” en “Deck Control”.

Paso 4. Desde el menú “Edit”, seleccione “Insert Edit” o “Assemble Edit” para editar en forma precisa a partir 
de una cinta con código de tiempo. De manera alternativa, seleccione “Crash Record” para grabar 
directamente. Si la única opción es “Insert Edit”, haga clic en la pestaña de ajustes del proyecto, luego 
dos veces en “Deck Preferences” y marque la opción “Allow assemble edit & crash record for digital 
cut”.

Paso 5. Si aparece el mensaje “NO DECK” o el nombre del equipo en letra cursiva, haga clic en el menú y 
seleccione “Check Decks” hasta que el nombre figure en letra normal y se restablezca el control.

Paso 6. Haga clic en el botón con el triángulo rojo para grabar la secuencia en la cinta.

Paso 5. Haga clic en el botón “Mark IN/OUT” o utilice las teclas “I” y “O” 
para marcar puntos de entrada y salida.

La herramienta de edición digital se utiliza para grabar en cintas.
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Autodesk Smoke

Autodesk Smoke 2013 Extension 1
Autodesk Smoke ofrece la posibilidad de editar imágenes, realizar composiciones y añadir efectos 
tridimensionales desde una misma área de trabajo. El programa permite grabar y reproducir material audiovisual 
en definición estándar y alta definición mediante el dispositivo de Blackmagic y es compatible con el protocolo 
de control RS-422. Compruebe si el dispositivo de vídeo y los controladores de Blackmagic Design se han 
instalado correctamente antes de proceder a la instalación de Autodesk Smoke.

La herramienta de monitorización de Smoke permite transmitir señales de vídeo a través del dispositivo de 
Blackmagic.

Instalación
Paso 1. Al ejecutar el programa, se abrirá una ventana para seleccionar el proyecto y el perfil de usuario. 

Establezca un nuevo proyecto y perfil si no han sido creados anteriormente.

Paso 2. Modifique los distintos parámetros del proyecto de forma que coincidan con el formato de entrega 
(por ej. 1080 HD). La mayoría de estos ajustes pueden cambiarse posteriormente durante la sesión.

Paso 3. Seleccione el formato intermedio para los contenidos del proyecto (por ej. ProRes o Uncompressed). 
Recuerde seleccionar un formato compatible con la unidad de almacenamiento.

Paso 4. Haga clic en el botón “Create”.

Preparación del dispositivo
Siempre es recomendable seguir los pasos descritos a continuación al prepararse para la grabación.

Paso 1. Conecte las salidas de la videograbadora a las entradas del dispositivo de Blackmagic. Conecte las 
salidas del dispositivo a las entradas la videograbadora.

Paso 2. Conecte un cable serial (RS-422) desde la videograbadora al puerto del dispositivo. 

Paso 3. Seleccione el modo de control remoto en la videograbadora. 

Paso 4. Conecte un sincronizador a la entrada correspondiente de la videograbadora para garantizar la 
precisión de los fotogramas durante la captura. Si se utiliza un dispositivo de audio independiente, 
también será necesario emplear una señal de sincronización para el mismo.

Ingrese el nombre del proyecto y seleccione las distintas opciones.
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Configuración de la videograbadora
Antes de ejecutar Autodesk Smoke, deberá valerse de un programa utilitario denominado “Smoke Setup” para 
seleccionar el modelo de la videograbadora y las diferentes resoluciones que empleará en el proyecto.

Paso 1. Haga clic en Aplicaciones > Autodesk > Smoke > Utilities y ejecute “Smoke Setup”.

Paso 2. En la pestaña “General”, compruebe que en las opciones “Video Device” y “Audio Device” se haya 
seleccionado “BMD”.

Paso 3. En la pestaña “VTR”, seleccione el modelo de la videograbadora y las resoluciones que utilizará en 
Autodesk Smoke. Marque las filas que contengan “live NTSC” o “live PAL” para poder grabar en 
forma instantánea o transmitir en directo. 

Paso 4. Haga clic en “Apply” y cierre el programa.

Captura desde dispositivos controlables mediante UltraStudio y DeckLink
Autodesk Smoke puede configurarse para capturar vídeos desde videograbadoras controlables mediante el 
protocolo RS-422.

Paso 1. Seleccione la carpeta donde desea guardar la secuencia capturada.

Paso 2. Haga clic en File > Capture from VTR. A continuación se abrirá el módulo de captura.

Paso 3. Avance la cinta hasta el primer fotograma de la secuencia que desea capturar.

Paso 4. Seleccione los canales de audio y vídeo que desea grabar. Los botones en rojo indican las pistas 
activas.

Paso 5. Ingrese los puntos de entrada y salida en los campos correspondientes.  

Paso 6. Haga clic en “Capture” para comenzar. El campo del código de tiempo se iluminará en verde para 
indicar que la captura se está llevando a cabo.

Paso 7. Para finalizar, haga clic en cualquier parte de la ventana de vista previa. La secuencia se guardará 
automáticamente en la ubicación seleccionada con anterioridad.

Compruebe que en “Video Device” y “Audio Device” se haya 
seleccionado la opción “BMD”.

Seleccione los formatos en la pestaña “VTR” del programa Smoke Setup.

Las pistas de audio y vídeo que se indican en rojo están listas para ser 
capturadas desde la videograbadora.
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Grabación en cintas con UltraStudio y DeckLink
Seleccione una secuencia en el módulo “VTR Output” e indique los puntos de entrada y salida. De ser necesario, 
también es posible habilitar las opciones para retrasar el primer fotograma o utilizar un formato apaisado.

Paso 1. Haga clic en File > Output to VTR.

Paso 2. Seleccione las secuencias en la biblioteca de medios. También es posible seleccionar una carpeta para 
trabajar con todos sus contenidos en una sola sesión. A continuación se abrirá el módulo de captura.

Paso 3. Seleccione la videograbadora en el menú correspondiente al nombre del dispositivo. La ventana de 
vista previa mostrará el vídeo de la cinta en la videograbadora seleccionada.

Paso 4. Compruebe que se hayan activado los botones correspondientes a las pistas de vídeo y canales de 
audio que se grabarán en la cinta.

Paso 5. Seleccione o desactive la opción “All Audio” en el menú “Clip Output”. Cuando esta función se 
encuentra activada, todos los canales de audio (no solo aquellos habilitados) se convertirán al formato 
seleccionado para la cinta.

Paso 6. Haga clic en “Preview” para ver la secuencia antes de transferirla.

Paso 7. Para transferir la secuencia a la cinta comenzando desde cualquier otro fotograma que no sea el 
primero, ingrese el código de tiempo inicial en el campo “Start Offset”.

Paso 8. Marque los puntos de entrada y salida para la secuencia.

Paso 9. Para transferir la secuencia a la videograbadora, seleccione “Insert” en el menú desplegable. Las 
secuencias seleccionadas se grabarán en la cinta. Al transferir las secuencias, el estado de cada una se 
indica en la ventana (pendiente, exportando o lista).

Paso 10. Avance la cinta hasta el código de tiempo de entrada y luego seleccione “Play” para comprobar que 
la transferencia se haya realizado correctamente.

Paso 11. Al finalizar, haga clic en “EXIT Output Clip” para cerrar el módulo.

Paso 3. Seleccione la videograbadora en la lista desplegable.

Las secuencias seleccionadas para la transferencia aparecen en una lista 
que indica el estado de las mismas. 

Seleccione los puntos de entrada y salida y luego haga clic en “Insert”. 
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Grabación instantánea y salida en directo
Autodesk Smoke permite capturar una señal de vídeo en directo o grabar una secuencia en forma instantánea 
utilizando un estilete para comenzar y detener el registro o transferencia de la secuencia. Al elegir este modo de 
captura, Autodesk Smoke comprueba el espacio disponible en la unidad de almacenamiento. La cantidad de 
espacio puede variar en función del formato intermedio preferido.

Asimismo, cuando utilice un dispositivo no compatible con el protocolo RS-422, seleccione “Live NTSC” o “PAL” 
al realizar la captura y “Live Video” al transferir secuencias.

Para grabar una señal de vídeo en forma instantánea:
Paso 1. En la biblioteca de medios, elija la carpeta donde se guardará la secuencia.

Paso 2. Haga clic en File > Capture from VTR. A continuación se abrirá el módulo de captura.

Paso 3. En “VTR Device”, seleccione “Live NTSC” o “Live PAL”. La señal de vídeo entrante aparecerá en la 
pantalla de vista previa.

Paso 4. Seleccione el modo “Start On Pen”. Finalice la captura mediante las opciones “Stop On Pen” o “Stop 
On Frames”. Autodesk Smoke fue diseñado para permitir el uso de estiletes. Por esta razón, se utiliza 
la terminología “Start On Pen”.

Al seleccionar “Stop On Pen” como modo de detener la captura, los campos correspondientes al punto de 
salida y la duración se actualizarán para indicar la secuencia más larga que puede grabarse en la unidad de 
almacenamiento. La captura finalizará al hacer clic en cualquier lugar de la pantalla o cuando la unidad de 
almacenamiento esté llena.

Paso 5. Ingrese el nombre de la secuencia y marque las pistas de vídeo y canales de audio que desea capturar.

Paso 6. Compruebe que la señal de vídeo en directo se esté recibiendo correctamente.

Paso 7. Presione “Play” en el equipo de vídeo.

Paso 8. Haga clic en “Process” para comenzar la digitalización.

Paso 9. Haga clic en cualquier parte de la pantalla para finalizar el proceso en el modo “Stop On Pen”. 

Marque las filas que contengan “live NTSC” o “live PAL” para poder 
grabar en forma instantánea o transmitir en directo.
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Para transmitir una señal de vídeo en directo:
Paso 1. Haga clic en File > Output to VTR.

Paso 2. Seleccione las secuencias en la biblioteca de medios. También es posible seleccionar una carpeta para 
transmitir todos los contenidos de la misma. A continuación se abrirá el módulo de captura.

Paso 3. En “VTR Device”, seleccione “Live NTSC” o “Live PAL”.

Las opciones para seleccionar el modo de comienzo no estarán disponibles. Al transmitir una señal de vídeo 
en directo, es necesario utilizar el modo “Start On Pen”. Para finalizar la transmisión, puede utilizar las opciones 
“Stop On Pen” o “Stop On Frames”.

Paso 4. Seleccione las opciones de salida. Por ejemplo, ingrese el nombre de la secuencia y marque las pistas 
de vídeo y canales de audio que desea capturar. 

Paso 5. En el dispositivo que recibe la señal, comience la grabación o lleve a cabo las acciones necesarias para 
permitir la recepción de la señal transmitida desde Autodesk Smoke.

Paso 6. Haga clic en “Process” para comenzar la transmisión.

Paso 7. Haga clic en cualquier parte de la pantalla para finalizar el proceso en el modo “Stop On Pen”.

Utilice el modo “Start On Pen” para la transmisión.

Al transmitir una señal de vídeo en directo, seleccione “Live PAL” o “Live 
NTSC”.
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DaVinci Resolve 10

Seleccione el formato deseado en el menú “Video capture and playback”.

DaVinci Resolve 10 y Live Grading
Desktop Video 10 permite capturar y reproducir contenidos simultáneamente mediante los dispositivos 
UltraStudio 4K y DeckLink 4K Extreme. Esto es ideal para aquellos usuarios que desean utilizar herramienta de 
etalonaje en tiempo real (“Live Grading”) de DaVinci Resolve 10, ya que de esta forma no es necesario contar 
con dos dispositivos por separado.

Al utilizar esta herramienta durante el rodaje, simplemente conecte el dispositivo de Blackmagic a la salida de 
la cámara.  Luego conecte un monitor a la salida del dispositivo para poder ver las imágenes y evaluar el color 
durante el rodaje.

Configuración
Paso 1. Abra Resolve y en el menú “Preferences” haga clic en la pestaña “Video I/O and GPU”. Seleccione el 

dispositivo en la opción “For Resolve Live use”. Guarde la configuración y reinicie Resolve para aplicar 
los cambios.

Paso 2. Comience un proyecto y en la ventana “Project Settings” seleccione la resolución y la frecuencia de 
imagen para que coincidan con la cámara.

Paso 3. En la pestaña “Deck Capture and Playback”, seleccione el formato deseado en el menú “Video 
capture and playback”.

Paso 4. En el módulo de edición, haga clic con el botón derecho en la ventana de la línea de tiempo y 
seleccione “Create New Timeline”.

Paso 5. En el menú “Color”, seleccione “Resolve Live On/Off”. La imagen en directo aparecerá en el visor y 
sobre la misma notará un botón rojo brillante (”Resolve Live”).

Cómo utilizar Resolve Live
Paso 1. El botón “Freeze” (que tiene el ícono de un copo de nieve) en el modo “Resolve Live” permite 

congelar la imagen para evitar que el movimiento que ocurre durante el rodaje distraiga al usuario al 
corregir el color. Luego de llevar a cabo los ajustes necesarios, puede continuar la reproducción para 
posteriormente capturar la imagen.

Paso 2. Una vez que esté satisfecho con los cambios, haga clic en el botón “Snapshot” (que tiene el ícono de 
una cámara) para guardar la imagen mostrada en el visor, el código de tiempo de la señal entrante y la 
gradación en la línea de tiempo. La imagen capturada es simplemente una secuencia de un fotograma.

Para obtener más información sobre Resolve Live, consulte el manual de DaVinci Resolve 10.
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¿Qué es Blackmagic Media Express?
El programa Media Express viene incluido en los productos UltraStudio, DeckLink e Intensity, H.264 Pro Recorder, 
Teranex Processor y Universal Videohub, así como en los distintos modelos de mezcladores ATEM y cámaras de 
Blackmagic. Es una herramienta ideal para capturar, reproducir y transferir señales de vídeo sin la complejidad 
de un software de edición no lineal.

Grabación de archivos de audio y vídeo

Configuración del proyecto
Antes de grabar secuencias de vídeo con Media Express, es necesario seleccionar los diferentes parámetros del 
proyecto.  

Paso 1. Haga clic en Media Express > Preferences en Mac OS X, o Edit > Preferences en Windows o Linux.  Los 
formatos disponibles varían en función de la compatibilidad del dispositivo con distintas características 
(por ejemplo, resolución Ultra HD 4K o vídeo estereoscópico tridimensional).

Paso 2. Seleccione un formato comprimido o sin compresión, o incluso una secuencia DPX a partir del menú 
desplegable en la opción “Capture File Format”. El vídeo se grabará en el formato seleccionado y se 
guardará en un archivo QuickTime.

Paso 3. Seleccione la ubicación donde se guardarán los archivos grabados. 

Paso 4. Seleccione si desea detener la grabación o reproducción si se detectan fotogramas faltantes.

La relación de aspecto de los proyectos en definición estándar es 4:3, a menos que marque la opción “Use 
Anamorphic SD 16:9”. 

Por lo general las aplicaciones de vídeo detienen la reproducción al minimizarlas. Para que Media Express 
continúe la reproducción al abrir otra aplicación, marque la opción “Continue playback when in the background”.

Las opciones finales corresponden a videograbadoras compatibles con el protocolo de control RS-422 y permiten 
agregar fotogramas antes de la grabación o compensar los tiempos.

Utilice la ventana de preferencias para seleccionar el formato del vídeo y 
los archivos, la ubicación de los mismos y otros parámetros.

Blackmagic Media Express
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Captura
Para grabar secuencias basta con conectar una fuente de vídeo, seleccionar las preferencias y hacer clic en el 
botón “Capture”.

Paso 1. Comience conectando la fuente de vídeo a una de las entradas del dispositivo y compruebe que el 
tipo de señal seleccionado en las preferencias del sistema sea el mismo (por ej. SDI, HDMI o analógica).

Paso 2. Abra Media Express y modifique las preferencias según el formato que se utilizará para la grabación y 
el montaje.

Paso 3. Haga clic sobre la pestaña “Log and Capture” e ingrese una descripción en el campo “Description”.

Paso 4. Haga clic sobre el botón [+] para usar la misma descripción como nombre de la secuencia en el campo 
“Name”. Haga clic sobre el mismo botón en cualquiera de los demás campos para agregar dicha 
información al nombre de la secuencia.

 � Para incrementar el valor en cada uno de estos campos, haga clic sobre el ícono de la claqueta. 
También es posible ingresar los datos directamente en cualquiera de los campos.

 � El texto que aparece en el campo automático “Name” se aplicará a las secuencias que se graben.

 � Para marcar el vídeo como favorito, haga clic sobre la estrella ubicada a la derecha del nombre de 
la secuencia.

 � Para confirmar el nombre de la secuencia antes de cada grabación, haga clic sobre el símbolo de 
exclamación ubicado a la derecha del nombre de la secuencia.

Paso 5. Seleccione los canales de audio que desea incluir en la grabación.

Paso 6. Para comenzar, haga clic sobre el botón “Capture”. Para finalizar la grabación y guardar la secuencia, 
haga clic sobre el mismo botón nuevamente. También es posible oprimir la tecla [Esc], tras lo cual 
aparecerá un cuadro de diálogo que le permitirá guardar o borrar la secuencia. Las secuencias 
grabadas se agregan a la lista de medios.

Selección de secuencias antes de la grabación
Conecte un cable serial (RS-422) desde el dispositivo de Blackmagic a la videograbadora.     Compruebe que el 
interruptor “Remote/Local” en el equipo se encuentre en la posición “Remote”. Utilice las teclas J, K y L para 
retroceder, pausar o adelantar la cinta.

Haga clic sobre el botón “Mark In” o utilice la tecla [I] para marcar un punto de entrada.

Haga clic sobre el botón “Mark Out” o utilice la tecla [O] para marcar un punto de salida.

Haga clic sobre el botón “Log clip” o utilice la tecla [P] para registrar la secuencia. El registro aparecerá en la lista 
de medios con una cruz roja indicando que el medio aún no está disponible.

Seleccione los canales de audio que desea incluir en la grabación.

Ingrese la descripción del vídeo.

Haga clic sobre el botón “Capture” para comenzar la digitalización.
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Captura múltiple
El botón “Clip” permite digitalizar la secuencia luego de registrarla.

Para digitalizar varias secuencias, marque distintos puntos de entrada y salida.

Seleccione las secuencias en la lista de medios y a continuación realice una de las siguiente acciones:

 � Haga clic sobre el botón “Batch”.

 � Haga clic con el botón derecho sobre la secuencias y seleccione “Capture”.

 � En el menú “File”, seleccione “Batch Capture”.

Media Express digitalizará las secuencias según los puntos de entrada y salida en el código de tiempo.

Grabación de archivos DPX
Para grabar un archivo en formato DPX, abra las preferencias de Media Express y seleccione “DPX 10-Bit RGB” 
en la opción “Capture File Format”.

 � Genere un nuevo proyecto seleccionando DPX como formato de digitalización.

 � Realice la captura.

Al finalizar la digitalización aparecerá una imagen en miniatura en la lista de medios que representa la totalidad 
de la secuencia. El archivo se guardará en su propia carpeta en la unidad de almacenamiento. El audio se grabará 
en un archivo WAV en la misma carpeta.

Se asume en forma predeterminada que la digitalización se realiza a partir de un modelo YUV. Para capturar 
contenidos desde una señal RGB, compruebe que la opción “Capture to DPX from a YUV source” no esté 
marcada.

Para que los números de fotogramas en el archivo DPX se basen en el código de tiempo de la fuente original en 
lugar de comenzar desde cero, marque la opción “Use absolute frame numbering when capturing DPX”.

Si las secuencias digitalizadas no son demasiado extensas, es posible reducir la cantidad de ceros en los 
números modificando la cantidad de dígitos en la opción “When capturing DPX files, use (2-8) digit numbers 
in the frame count”.

Preferencias para la grabación de archivos en formato DPX
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Digitalización en 3D
Al utilizar Media Express con un dispositivo de Blackmagic compatible con formatos tridimensionales,  es posible 
crear secuencias de vídeo en 3D grabando dos señales simultáneas en HD-SDI.

 � Comience un nuevo proyecto en 3D y compruebe que el formato coincida con la frecuencia de imagen 
de la fuente tridimensional.

 � Verifique que el dispositivo cuente con dos entradas separadas para señales en HD-SDI.

 � Realice la captura.

Al capturar las dos señales de vídeo simultáneas en formatos tridimensionales con Media Express, el nombre de 
la secuencia se aplicará al archivo correspondiente al ojo izquierdo. El archivo correspondiente al ojo derecho se 
denominará de la misma forma, pero además se le agrega el texto “_right” al final del nombre.  Por ejemplo, si el 
nombre de la secuencia tridimensional es “Clip 1”, el archivo “Clip 1.mov” corresponde al ojo izquierdo, mientras 
que el archivo “Clip 1_right.mov” corresponde al ojo derecho.

La secuencia tridimensional aparece con un indicador azul en la lista de medios:

 � Cuando se muestran las imágenes en miniatura, las secuencias correspondientes a cada ojo aparecen 
unidas mediante un ícono ubicado entre ambas.

 � Cuando se muestra la lista de códigos de tiempo, las secuencias correspondientes a cada ojo aparecen 
en dos líneas unidas mediante el indicador “3D”.

Seleccione un formato en 3D para capturar secuencias estereoscópicas 
tridimensionales.

Cuando se muestran las imágenes en miniatura, las secuencias 
correspondientes a cada ojo aparecen unidas mediante un ícono ubicado 
entre ambas.

Cuando se muestra la lista de códigos de tiempo, las secuencias 
correspondientes a cada ojo aparecen en dos líneas unidas mediante el 
indicador “3D”.
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Reproducción de archivos de audio y vídeo

Cómo importar secuencias
Los archivos de audio y vídeo se pueden reproducir luego de importar los medios desde Media Express de las 
siguientes maneras:

 � Haga clic dos veces sobre cualquier parte vacía de la lista de medios.

 � Haga clic con el botón derecho sobre cualquier parte vacía de la lista de medios y seleccione “Import 
Clip” en el menú desplegable.

 � Haga clic en el menú “File”, seleccione “Import” y luego “Media Files”.

A continuación seleccione las secuencias que desea importar en el cuadro de diálogo “Open Video Clip”. Las 
secuencias se transferirán a la carpeta “Scratch” en la lista de medios. Si ha creado sus propias carpetas, también 
es posible arrastrar las secuencias a cualquiera de ellas.

Para transferir medios directamente a una carpeta, haga clic con el botón derecho sobre la misma y seleccione 
“Import Clip” en el menú desplegable.

Si el tamaño y la frecuencia de imagen de los archivos importados no coincide con el de las secuencias existentes 
en la lista de medios, deberá guardar el proyecto y crear uno nuevo.

Media Express también permite importar archivos de audio con múltiples canales grabados a 48 kHz en formato 
WAVE o AIFF sin compresión.

Otra forma de importar medios es utilizar un archivo XML creado en Final Cut Pro. Haga clic en el menú “File”, 
seleccione “Import” y luego “Final Cut Pro XML”. Al abrir el archivo XML seleccionado, las carpetas y medios del 
proyecto creado en Final Cut Pro aparecerán en la lista de medios.

Media Express también permite importar archivos CMX EDL desde otros programas de vídeo para digitalizar 
múltiples secuencias.  Haga clic en el menú “File”, seleccione “Import” y luego “CMX EDL”. Seleccione y abra el 
archivo EDL.  La información de la secuencia aparecerá en la lista de medios. Seleccione las secuencias registradas 
y a continuación realice la captura de las mismas.

Reproducción de secuencias
Para reproducir una sola secuencia, haga clic dos veces sobre la misma en la lista de medios. De manera alternativa, 
seleccione la secuencia y presione la barra espaciadora en el teclado o haga clic sobre el botón de reproducción.

Para reproducir varias secuencias, selecciónelas en la lista de medios y presione la barra espaciadora en el teclado 
o haga clic sobre el botón de reproducción.

Las imágenes se verán en el panel de vista previa de Media Express y en cualquier equipo conectado a las salidas 
de vídeo del dispositivo de Blackmagic. Durante la reproducción, los canales de audio monitorizados se pueden 
habilitar o deshabilitar mediante los botones “track enable/disable”.

Los medios se pueden importar directamente o mediante archivos en 
formato XML o EDL.

Los controles permiten reproducir la secuencia, detenerla, pasar a la 
siguiente o la anterior y reproducir las imágenes en forma continua.
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Exploración de medios

Imágenes en miniatura
Este modo de visualización constituye la forma más intuitiva de mostrar las secuencias. Mueva el puntero del 
ratón hasta la imagen en miniatura y haga clic en el ícono que aparece sobre la parte inferior derecha de la misma. 
Para ocultar la información, haga clic sobre el texto.

Lista
Las secuencias también pueden mostrarse en una lista de códigos de tiempo haciendo clic sobre el botón 
correspondiente en la parte superior derecha de la lista de medios. Utilice la barra de desplazamiento horizontal 
para ver todas las columnas que contienen información sobre las secuencias.

Cómo crear y utilizar carpetas
Para crear una carpeta o “bin”, haga clic con el botón derecho del ratón en cualquier lugar vacío de la lista de 
medios y seleccione “Create Bin”.  Ingrese un nombre para la nueva carpeta.

Es posible mover las secuencias a una carpeta determinada simplemente arrastrándolas hacia la misma.  Para 
guardar la misma secuencia en varias carpetas, es necesario importarla nuevamente haciendo clic con el botón 
derecho sobre la carpeta deseada. A continuación, seleccione “Import Clip”.

Las secuencias registradas se almacenan en forma predeterminada en la carpeta “Scratch”. Para cambiar 
la ubicación donde se guardan las secuencias, haga clic con el botón derecho sobre la carpeta deseada y a 
continuación seleccione “Select As Log Bin”.

Marcar secuencias como favoritas
En la pestaña “Log and Capture”, haga clic sobre el ícono de la estrella para marcar la secuencia como favorita.

En la pestaña “Playback”, seleccione la secuencia en la lista de medios y haga clic sobre el ícono de la estrella. 
Para cancelar, haga clic nuevamente sobre este.

Las secuencias marcadas como favoritas se indican con una estrella amarilla en ambos modos de visualización.

Para ver solo las secuencias favoritas, haga clic en el botón “Show only favorites” en la parte superior de la lista 
de medios. El ícono de la estrella se encenderá para indicar que se muestran las secuencias marcadas como 
favoritas. Las demás secuencias permanecerán ocultas. 

Vincular archivos de audio y vídeo
Para vincular archivos de audio y vídeo en la lista de medios:

 � Seleccione una secuencia sin canales de audio.

 � Haga clic sobre la misma con el botón derecho y seleccione “Link Audio File” en el menú que aparece.

De este modo podrá reproducir las imágenes con el audio o masterizar la secuencia combinada.

Seleccione el modo de visualización preferido en la lista de medios. Haga 
clic sobre el botón “favorites” para que se muestren solo las secuencias 
favoritas. Utilice el campo “Search” para buscar secuencias por su nombre.

Haga clic en el ícono que aparece sobre la imagen en miniatura para ver la 
información de la secuencia.

En la pestaña “Log and Capture”, haga clic sobre la estrella para marcar la 
secuencia como favorita.
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Seleccione un formato para el proyecto en 3D.

La secuencia tridimensional se indica claramente en la lista de medios.

Utilice el campo “Search” para buscar vídeos por su nombre.

Los archivos de audio y vídeo vinculados se indican claramente en la lista 
de medios.

Borrar secuencias y carpetas
Para borrar una secuencia, selecciónela y presione la tecla “Av Supr”. Este procedimiento solo borrará las 
secuencias de la lista de medios sin afectar los archivos en el dispositivo de almacenamiento.

Para borrar una carpeta, haga clic con el botón derecho sobre la misma y luego seleccione “Delete Bin”. Esta 
opción permite borrar la carpeta y todos sus contenidos. Este procedimiento solo borrará las secuencias de la 
lista de medios sin afectar los archivos en el dispositivo de almacenamiento.

Creación de secuencias tridimensionales
Para agregar una secuencia estereoscópica tridimensional a la lista de medios:

 � Seleccione un formato para el proyecto que coincida con la frecuencia de imagen de la secuencia 
en 3D.

 � Importe el archivo correspondiente al ojo izquierdo desde la lista de medios.

 � Haga clic con el botón derecho sobre dicho archivo y seleccione “Set Right Eye Clip” en el menú que 
aparece. El nombre del archivo correspondiente al ojo derecho finalizará en “_right” si fue grabado 
utilizando Media Express. 

La secuencia tridimensional se indica claramente en la lista de medios. En la ventana de vista previa, ambos 
archivos se muestran juntos para indicar que la secuencia es tridimensional.

Si los archivos de la secuencia tridimensional no se han importado correctamente:

 � Haga clic sobre la secuencia en la lista de medios.
 � Seleccione “Swap Eyes” en el menú contextual.

Búsquedas en la lista de medios
Para buscar secuencias de vídeo en un proyecto, basta con ingresar el nombre en el campo “Search” situado en 
la parte superior de la ventana. Si el ícono de favoritos está activado, la búsqueda incluirá solo los vídeos favoritos 
y la lista de resultados será menor.
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masterización 
en cintas

modos de grabación activar/desactivar 
canal de audio

puntos de entrada y salida
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Masterización
Vale aclarar que el término “masterización” se emplea en forma general, independientemente de si la copia se 
realiza en una cinta o un disco.  Para masterizar una secuencia:

 � Seleccione las secuencias que desea masterizar.

 � Haga clic sobre la pestaña “Edit to Tape”.

 � Marque el punto de entrada y seleccione el tipo de montaje.

 � Realice la masterización.

Selección de secuencias
Seleccione las secuencias que desea masterizar en la lista de medios. Incluso es posible insertar secuencias de 
audio con varios canales para remplazar la pista principal en la cinta maestra. Para seleccionar solo secuencias 
favoritas, haga clic sobre la estrella en la parte superior de la lista de medios. A continuación seleccione las 
secuencias que desea masterizar.

Montaje por inserción y ensamblaje
Haga clic sobre la pestaña “Edit to Tape”.Para definir el punto de entrada en la cinta, ingrese el código de tiempo 
en el campo correspondiente o avance la cinta hasta al punto deseado mediante los controles de reproducción 
y luego haga clic sobre el botón “Mark In”.

Si no se ingresa un punto de salida, Media Express determinará la duración según la longitud de las secuencias 
en la lista de medios. Si se ha definido un punto de salida, Media Express detendrá la grabación al alcanzar dicho 
punto aunque todavía queden secuencias por transferir.

Seleccione el modo de masterización. A continuación, haga clic sobre el botón “Master”.

El modo de previsualización simula el proceso de transferencia pero no realiza la grabación. Este modo permite 
verificar los puntos del montaje. Es recomendable llevar a cabo la previsualización en monitores conectados 
directamente al dispositivo. De esta forma podrá ver tanto la nueva secuencia como aquellas grabadas con 
anterioridad. 

Media Express mostrará una notificación si la opción “Record Inhibit” está activada al hacer clic sobre el botón 
“Master”. Desactive dicha opción antes de intentar nuevamente.

Seleccione los canales de audio y vídeo que desea grabar utilizando los botones correspondientes. Desactive el 
canal de vídeo si solo desea transferir el audio.

Para mostrar la secuencias favoritas solamente, haga clic sobre la estrella 
en la parte superior de la lista de medios.

Se han seleccionado dos secuencias para la masterización.

Seleccione los canales de audio que desea incluir en la grabación.
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¿Qué es Blackmagic Disk Speed Test?
Blackmagic Disk Speed Test mide la velocidad de lectura y escritura del dispositivo de almacenamiento. Se 
incluye en forma gratuita al instalar cualquier producto de Blackmagic Design, o de manera alternativa puede 
descargarse desde el sitio web de la empresa. Para acceder a las distintas opciones del programa, haga clic sobre 
el ícono del engranaje situado encima del botón “Start”.

Selección de la unidad
Haga clic en “Select Target Drive” y compruebe si cuenta con los permisos correspondientes.

Captura de pantalla
Haga clic en “Save Screenshot” para realizar una captura de pantalla con los resultados. 

Stress
Esta opción permite seleccionar el nivel entre 1 y 5 GB. El valor predeterminado es 5 GB, ya que proporciona 
resultados más precisos.

Ayuda
Haga clic sobre “Disk Speed Test Help” para abrir el archivo PDF que contiene el manual del programa.

Acerca de Disk Speed Test
Haga clic sobre “About Disk Speed Test” para comprobar la versión del programa.

Comienzo
Haga clic sobre el botón “Start” para comenzar la prueba en la unidad seleccionada. Disk Speed Test continuará 
analizando la velocidad de lectura y escritura hasta que se detenga la ejecución del programa haciendo clic en el 
botón “Start” nuevamente.

Compatibilidad
El panel “Will it Work?” muestra los formatos de vídeo más comunes indicando si pueden ser utilizados con un 
visto o una cruz según el rendimiento de la unidad.  Realice varias pruebas para asegurarse de que los formatos 
son totalmente compatibles. Si el mismo formato alterna entre un visto y una cruz al realizar varias pruebas, 
significa que la unidad no es completamente compatible con el mismo.

Velocidad
El panel “How Fast?” indica la velocidad que puede alcanzar la unidad y sus resultados deben interpretarse 
conjuntamente con los del panel “Will it Work?”. Si el primero muestra un visto verde para el formato 2K 
1556@25fps en  YUV 4:2:2 a 10 bits pero el segundo indica que la velocidad máxima es de 25 f/s, probablemente 
el rendimiento de la unidad no sea del todo confiable.

Abra el menú de opciones haciendo clic sobre el ícono del engranaje.

Blackmagic Disk Speed Test
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Velocidad 

Este panel muestra los 
resultados en fotogramas 
por segundo (f/s).

Opciones 

Haga clic sobre este 
botón para acceder a 
las opciones antes de 
comenzar la prueba.

Compatibilidad

Este panel indica los 
formatos de vídeo 
compatibles con la unidad 
según su rendimiento.

START

Haga clic sobre este 
botón una vez para 
comenzar la prueba. 
Haga clic sobre el mismo 
nuevamente para finalizar.
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Cómo obtener ayuda
La forma más rápida de obtener ayuda es visitando las páginas de soporte técnico en el sitio web de Blackmagic 
Design, donde podrá acceder al material de apoyo más reciente disponible para los dispositivos.

Páginas de soporte técnico de Blackmagic Design
En www.blackmagicdesign.com/support podrá encontrar las versiones más recientes del software, el manual y el 
material de apoyo.

Cómo ponerse en contacto con Blackmagic Design para obtener ayuda
Si no es posible encontrar la ayuda que necesita, envíenos un correo electrónico mediante el botón "Enviar 
solicitud" ubicado en la página de soporte correspondiente al dispositivo. De manera alternativa, puede 
comunicarse con la oficina de asistencia técnica más cercana (ver www.blackmagicdesign.com/company).

Cómo comprobar la versión del software instalada
Para comprobar la versión de Desktop Video instalada en el ordenador, abra las preferencias del sistema. El 
número de versión aparecerá en la barra del título.

 � En Mac OS X, haga clic en “Preferencias del Sistema”, donde encontrará el ícono de Blackmagic 
Design. Haga clic sobre el mismo para ver el número de versión.

 � En Windows 7 y 8, abra el Panel de Control y haga clic en la categoría “Hardware y sonido”. A 
continuación, haga clic sobre el ícono de Blackmagic Design para ver el número de versión.

 � En Linux, haga clic en “Aplicaciones” y luego en “Sonido y Vídeo”. A continuación, abra el panel de 
control de Blackmagic Design para ver el número de versión.

Cómo obtener las últimas actualizaciones
Luego de verificar la versión del programa instalada en el ordenador, visite el Centro de Soporte Técnico en 
www.blackmagicdesign.com/support para comprobar si hay actualizaciones disponibles. Aunque siempre 
es recomendable instalar las versiones más recientes del software, evite realizar actualizaciones durante 
proyectos importantes.

Ayuda

http://www.blackmagicdesign.com/support


Información para desarrolladores244

Desarrollo de aplicaciones personalizadas
Las herramientas de desarrollo de DeckLink permiten controlar los dispositivos de vídeo de Blackmagic mediante 
programas personalizados. Dichas herramientas son compatibles con los productos UltraStudio, DeckLink, 
Multibridge e Intensity.

Este conjunto de herramientas brinda la posibilidad de realizar modificaciones tanto a nivel del código como 
la interfaz, permitiendo a los desarrolladores realizar tareas comunes con gran facilidad. Las herramientas son 
compatibles con las siguientes tecnologías:

 � QuickTime (Apple)

 � DirectShow (Microsoft)

 � Core Media (Apple)

 � DeckLink API

Cómo descargar las herramientas de desarrollo
Las herramientas están disponibles en www.blackmagicdesign.com/support/sdks.

Cómo suscribirse a la lista de desarrolladores de Blackmagic Design
Esta lista de distribución ha sido creada para resolver dudas técnicas relacionadas con las herramientas de 
desarrollo, codificadores/decodificadores, APIs y tecnologías utilizadas por Blackmagic Design, tales como 
QuickTime, Core Media, DirectShow. Constituye un foro donde los desarrolladores pueden discutir diferentes 
ideas con otros colegas y resolver problemas. Cualquier persona suscrita puede intervenir en las distintas 
discusiones, y los ingenieros de Blackmagic Design responderán cuando resulte apropiado. Para suscribirse, 
visite la página http://lists.blackmagicdesign.com/mailman/listinfo/bmd-developer.

En ocasiones es necesario proporcionar una breve descripción del software utilizado por el desarrollador, si no 
resulta evidente a partir del nombre de dominio. La lista ha sido creada específicamente para desarrolladores 
y tratamos de evitar todo tipo de correos que no sean relevantes, así como el uso de la misma por parte de 
agencias de empleo y vendedores para promocionar productos.. 

Cómo obtener asistencia
Si desea realizar preguntas sin intervenir en la lista de distribución, póngase en contacto con nosotros a través 
de developer@blackmagicdesign.com.

Información para desarrolladores
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Caution: Risk of Electric Shock
On the UltraStudio 4K enclosure you will see a yellow warning label marked ‘Caution: Risk of Electric Shock’. 
This is intended to warn users that there may be the presence of uninsulated “dangerous” voltage within 
the UltraStudio 4K enclosure which may be of sufficient magnitude to constitute a risk of electric shock to 
the user. Blackmagic Design advises you not to open the UltraStudio 4K unit, but rather contact your nearest 
Blackmagic Design service center should assistance be required.

Advertencia: Riesgo de descarga eléctrica
Dentro del UltraStudio 4K encontrará una etiqueta de advertencia amarilla que dice: “Advertencia: Riesgo 
de descarga eléctrica”. Esto significa que en el interior del dispositivo podría producirse un voltaje no 
aislado de una magnitud suficiente como para generar una descarga eléctrica en el usuario.  Blackmagic 
Design recomienda no abrir el dispositivo y ponerse en contacto con el Centro de Servicio Técnico más 
cercano si necesita asistencia

Caution label

Advertencias

Advertencia
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Garantía limitada
Blackmagic Design garantiza que los productos UltraStudio, DeckLink y Multibridge no presentarán defectos 
en los materiales o en su fabricación por un período de 36 meses a partir de la fecha de compra del mismo 
(a excepción de conectores, cables, ventiladores, módulos de fibra óptica, fusibles, teclados y baterías, cuya 
garantía por defectos materiales o de fabricación es de 12 meses a partir de la fecha de la compra). Blackmagic 
Design garantiza que los productos Intensity adquiridos no presentarán defectos en los materiales o en su 
fabricación por un período de 12 meses a partir de la fecha de compra de los mismos. Si un producto resulta 
defectuoso durante el período de validez de la garantía, Blackmagic Design podrá optar por reemplazarlo o 
repararlo sin costo alguno por concepto de piezas y/o mano de obra.

Para acceder al servicio proporcionado bajo los términos de esta garantía, el Cliente deberá dar aviso del defecto 
a Blackmagic Design antes del vencimiento del período de garantía y encargarse de los arreglos necesarios para 
la prestación del mismo. El Cliente será responsable por el empaque y el envío del producto defectuoso al centro 
de servicio técnico designado por Blackmagic Design y deberá abonar las tarifas postales por adelantado. El 
cliente será responsable de todos los gastos de envío, seguros, aranceles, impuestos y cualquier otro importe 
que surja con relación a la devolución de productos por cualquier motivo. 

Esta garantía carecerá de validez ante defectos o daños causados por un uso indebido o por falta de cuidado y 
mantenimiento. Blackmagic Design no tendrá obligación de prestar el servicio estipulado en esta garantía para 
(a) reparar daños provocados por intentos de personal ajeno a Blackmagic Design de instalar, reparar o realizar 
un mantenimiento del producto; (b) reparar daños resultantes del uso de equipos incompatibles o conexiones 
a los mismos; (c) reparar cualquier daño o mal funcionamiento provocado por el uso de piezas o repuestos no 
suministrados por Blackmagic Design; o (d) brindar servicio técnico a un producto que haya sido modificado o 
integrado con otros productos, cuando dicha modificación o integración tenga como resultado un aumento de 
la dificultad o el tiempo necesario para reparar el producto.  ESTA GARANTÍA OFRECIDA POR BLACKMAGIC 
DESIGN REEMPLAZA CUALQUIER OTRA GARANTÍA, EXPRESA O IMPLÍCITA. POR MEDIO DE LA PRESENTE, 
BLACKMAGIC DESIGN Y SUS DISTRIBUIDORES RECHAZAN CUALQUIER GARANTÍA IMPLÍCITA DE 
COMERCIALIZACIÓN O IDONEIDAD PARA UN PROPÓSITO PARTICULAR. LA RESPONSABILIDAD DE 
BLACKMAGIC DESIGN EN CUANTO A LA REPARACIÓN O SUSTITUCIÓN DE PRODUCTOS DEFECTUOSOS 
CONSTITUYE UNA COMPENSACIÓN COMPLETA Y EXCLUSIVA PROPORCIONADA AL CLIENTE POR 
CUALQUIER DAÑO INDIRECTO, ESPECIAL, FORTUITO O EMERGENTE, AL MARGEN DE QUE BLACKMAGIC 
DESIGN O SUS DISTRIBUIDORES HAYAN SIDO ADVERTIDOS CON ANTERIORIDAD SOBRE LA POSIBILIDAD 
DE TALES DAÑOS. BLACKMAGIC DESIGN NO SE HACE RESPONSABLE POR EL USO ILEGAL DE EQUIPOS 
POR PARTE DEL CLIENTE. BLACKMAGIC DESIGN NO SE HACE RESPONSABLE POR DAÑOS CAUSADOS POR 
EL USO DE ESTE PRODUCTO. EL USUARIO UTILIZA EL PRODUCTO BAJO SU PROPIA RESPONSABILIDAD.

© Copyright 2014 Blackmagic Design. Todos los derechos reservados. “Blackmagic Design”, “DeckLink”, “HDLink”, “Videohub Workgroup”, 
“Videohub", “DeckLink”, “Intensity” y “Leading the creative video revolution” son marcas registradas en los EE.UU. y en otros países. Todas las 
demás marcas comerciales y nombres de productos pertenecen a sus respectivas compañías.

El nombre Thunderbolt y el logotipo respectivo son marcas comerciales de Intel Corporation en los Estados Unidos y otros países.

Garantía
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欢迎使用Desktop Video！

我们的梦想是希望人人都能拥有最优质的视频设备，从而使电视业成为真正充满创
意的行业。

高端电视制作和后期制作的硬件经费往往动辄上百万，而Blackmagic视频硬件的诞
生改变了这一现状，如今，即使优质的10bit无压缩视频文件也加入了平民化行列。
我们希望您成为新款UltraStudio、DeckLink或Intensity的忠实用户，尽情享受各款全
球知名的广电设计软件！

本操作手册包含安装Blackmagic视频硬件所需之全部信息。如果您之前并没有为电
脑安装过硬件卡，我们建议您请专业的技术人员帮您安装PCI Express卡。由于
Blackmagic视频硬件使用的无压缩视频格式具备较高的数据速率，请相应配备快速
磁盘存储设备及高端电脑。

安装过程大约需要10分钟。安装Blackmagic视频硬件之前，请登陆我公司网站www.
blackmagicdesign.com，点击支持页面下载本手册最新版本以及Desktop Video驱动
软件。最后，请在下载软件更新时为您的Blackmagic视频硬件注册，以便我们能第
一时间为您提供软件和功能更新信息。欢迎您向我们提供使用Blackmagic视频硬件
完成的作品，并就软件改进给出宝贵意见。我们将不断致力于产品的功能开发和改
进，因此我们热忱期待您的意见和建议！

Grant Petty
CEO Blackmagic Design
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Desktop Video简介
Blackmagic Design的Desktop Video软件可与UltraStudio、DeckLink、Intensity或Teranex硬件结合使
用。Desktop Video软件包括驱动、插件以及Blackmagic Media Express等应用程序。Desktop Video可以
与Adobe、Apple、Autodesk和Avid等多款常用软件无缝整合！

本手册将对电脑系统要求、硬件和软件安装以及使用您喜爱的第三方软件等内容进行逐一介绍。

系统要求
计算机至少安装有4GB的随机存取内存（RAM）。PCIe x1卡适用于任何插槽。PCIe x4卡需要4x或更快的
插槽以发挥性能。

Mac OS X
Desktop Video软件支持Mac OS X系统最新的Mountain Lion版本或者Mavericks版本。

如果您的Blackmagic视频硬件通过PCIe插槽与您的电脑连接，建议使用基于Intel的Mac Pro。

如果您的Blackmagic视频硬件通过Thunderbolt与您的电脑连接，建议使用具备Thunderbolt™端口并基于
Intel的Mac。

Windows
Desktop Video只能在安装了最新服务包的64位版Windows计算机上运行。支持Windows 7和Windows 8。

如果您的Blackmagic视频硬件通过Thunderbolt与您的电脑连接，建议使用具备Thunderbolt端口的基于Intel
的个人电脑。

如果您的Blackmagic视频硬件通过USB 3.0与您的电脑连接，建议使用配备瑞萨芯片USB 3.0端口的电脑。

Linux
Desktop Video支持32位和64位x86Linux 2.6.23或安装更高版本Linux操作系统的计算机。有关支持最新的
Linux版本、包格式和软件依赖性详情，请关注官网发行说明。

入门
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安装Blackmagic视频硬件
如果您的Blackmagic视频硬件通过Thunderbolt连接，请直接跳到Thunderbolt章节。最新Mac OS X和
Windows计算机都具备Thunderbolt端口。

如果您的Blackmagic视频硬件通过USB 3.0连接，请直接跳到USB 3.0章节。Blackmagic的USB 3.0视频产
品要求使用兼容的Windows PC。

安装Blackmagic PCIe卡
第一步： 拔出电脑电源，确保静电已释放。

第二步： 将Blackmagic PCIe卡插入电脑的插槽，按紧并固定。如果您有DeckLink Optical Fiber卡，请先移除
光纤模块再进行安装。

第三步： 如果您的Blackmagic PCIe卡具备HDMI支架，请将该支架插入另一个插槽。用螺丝将PCIe卡和
HDMI支架固定好，将HDMI线缆绕到其他已妥善安装的卡上并插入DeckLink卡后方的插口。

第四步： 将机箱盖板盖好，并插上辫子线。如果您有DeckLink Optical Fiber卡，请将之前移除的光纤模块插
回原位。连接电源并启动电脑。

将Blackmagic PCIe卡安装到空的插槽。HDMI支架可安装到任
何空的端口，并使用内附的HDMI数据线连接卡后侧的接口。

如Blackmagic卡内附辫子线，请连接该辫子线。部分型号还包
含上图所示HDMI支架。
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连接配备Thunderbolt接口的Blackmagic视频硬件
第一步：如果您的Blackmagic视频硬件自带外接电源，请连接电源并开启设备。

第二步：使用Thunderbolt线缆将设备连接到电脑的Thunderbolt端口，或者连接电脑的Thunderbolt磁盘阵列。

第三步：如果已安装Desktop Video软件并弹出内部软件更新信息，请点击Update并根据屏幕提示完成更新。

第四步：如备有辫子线，请使用辫子线连接Blackmagic视频硬件和视频设备。

连接配备USB 3.0接口的Blackmagic视频硬件
第一步：如果您的Blackmagic视频硬件自带外接电源，请连接电源并开启设备。

第二步：使用SuperSpeed USB 3.0数据线连接设备和电脑上的USB 3.0端口。

第三步：如果已安装Desktop Video软件并弹出内部软件更新信息，请点击Update并根据屏幕提示完成更新。

第四步：如备有辫子线，请使用辫子线连接Blackmagic视频硬件和视频设备。Thunderbolt™和USB 3.0产品可通过单根Thunderbolt或USB 
3.0数据线连接到您的电脑。

UltraStudio 4K配备两个Thunderbolt 2™端口，因此如果您的电
脑只具备一个Thunderbolt™端口，您可以将另一个端口用于连
接RAID阵列或其他设备。

PUSH

PUSH
PUSH
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安装Blackmagic Design软件

应用程序、插件以及驱动
下表列出了Desktop Video软件将安装的应用程序、插件以及驱动。

Mac OS X Windows Linux

Blackmagic Desktop Video驱动 Blackmagic Desktop Video驱动 Blackmagic Desktop Video驱动

Blackmagic系统偏好 Blackmagic Design Control 
Panel

Blackmagic Design Control Panel

Blackmagic Design LiveKey Blackmagic Design LiveKey Blackmagic Media Express

Blackmagic Media Express Blackmagic Media Express Blackmagic AVI编解码器

Blackmagic QuickTime™编解码器 Blackmagic AVI和QuickTime™编
解码器

Blackmagic Disk Speed Test测 
速工具

Blackmagic Disk Speed Test测
速工具

Adobe® Premiere Pro® CC、After 
Effects® CC、Photoshop® CC预
设以及插件

Adobe® Premiere Pro® CC、After 
Effects® CC、Photoshop® CC预
设以及插件

Apple Final Cut Pro™ X插件 Avid Media Composer  
插件

Avid Media Composer 
插件

eyeon Fusion插件
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在Mac OS X系统下安装
您需要具备管理员权限方可安装软件。

第一步：请确保您的驱动是最新版本。请登录www.blackmagicdesign.com/support查看版本。

第二步：双击硬盘图标或下载完成图标，到“Desktop Video Installer”文件夹中运行“Desktop Video Installer”安装 
 程序。

第三步：点击Continue（继续）、Agree（同意）和Install（安装）按钮安装该软件。

第四步：重启电脑，使新软件生效。

自动更新
当您的Mac重启时，该软件会检查硬件的内部软件版本。如果内部软件版本与驱动版本不符，系统会弹出
信息提示您更新内部软件。点击OK开始更新，并重启Mac完成更新步骤。

在Windows系统下安装
第一步：请确保您的驱动是最新版本。请登录www.blackmagicdesign.com/support查看版本。

第二步：打开“Desktop Video”文件夹，运行“Desktop Video”安装程序。

第三步：驱动将被安装到您的系统上。然后会出现有以下字样的提示框：“Do you want to allow the following  
 program to install software on this computer?”（您允许以下程序在这台电脑上安装软件吗？） 点击Yes 
  （是）继续。

第四步：您会看到写有“找到新硬件”气泡对话框弹出，然后会出现硬件向导。选择 “install automatically”（自 
 动安装）后，系统会找到需要的Desktop Video驱动。接下来会弹出另一个气泡对话框，显示“your new  
 hardware is ready for use.”（新硬件已安装并可使用。）

第五步：重启电脑，使新软件生效。

自动更新
当您的电脑重启时，该软件会检查硬件的内部软件版本。如果内部软件版本与驱动版本不符，系统会弹出
信息提示您更新内部软件。点击OK开始更新，并重启电脑完成更新步骤。

Mac版Desktop Video Installer安装程序

Windows版Desktop Video Installer安装程序
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在Linux系统下安装
第一步：请到www.blackmagicdesign.com/support页面下载适用于Linux的最新版Desktop Video软件。

第二步：在名为“Desktop Video”的文件夹中找到适用于您的Linux系统的“Desktop Video”程序包并打开。

第三步：点击“Install”按钮后，安装进度条会显示安装进度，请耐心等待。

第四步：如弹出有关缺少软件依赖性的消息框，请确保先安装这些软件，然后重新运行Desktop Video安装程序。

第五步：完成后，安装程序会返回到相同画面。

第六步：重启电脑使驱动程序生效，或键入以下命令：

 # modprobe blackmagic

如果无法找到适合您的Linux版本的本地Desktop Video程序包，或者如果您希望从命令行安装，请查阅
ReadMe自述文件获得详细的安装说明。

更新
重启电脑后，驱动程序会检查Blackmagic视频硬件的内部软件版本。如果内部软件版本与驱动版本不
符，Desktop Video会弹出信息提示您更新内部软件。请打开终端并键入以下命令获取需要更新的卡的ID：

# BlackmagicFirmwareUpdater status

系统会弹出类似以下信息：

/dev/blackmagic/card0 [DeckLink HD Extreme 3] UPDATED

/dev/blackmagic/card1 [DeckLink HD Extreme 3] NEEDS_UPDATE

请记下需要更新的卡的ID，并键入下列内容更新固件：

# BlackmagicFirmwareUpdater update <card_id>（例如此处应使用1）

从Ubuntu Software Center安装Desktop Video软件。
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采集和回放视频 
我们建议您对视频采集和回放进行快速测试以确保运行正常。

准备工作
第一步：将视频监视器或电视机连接到Blackmagic视频硬件的视频输出接口。

第二步：将一路视频源连接到Blackmagic视频硬件的视频输入接口。

第三步：使用Blackmagic系统偏好为视音频接口设置输入和输出。详情请参阅“使用Blackmagic系统偏好”章节。

测试视频采集
第一步：在Mac OS X下，依次进入Media Express>Preferences；在Windows或Linux下，依次进入 
 Edit>Preferences，然后选择一个与您的视频源匹配的项目格式。请同时选择采集文件格式及保存位置。

第二步：关闭Preferences并点击Log and Capture选项卡。您的视频源会出现在Media Express的预览窗格中。

第三步：点击Capture开始采集测试。再次点击Capture结束测试。

测试视频回放
第一步：点击Playback选项卡。

第二步：双击测试素材后，视频会出现在与Blackmagic视频硬件的视频输出接口连接的监视器上。此操作可同时监 
 测音频输出。

Camera Outputs

HDTV

点击“Capture”按钮开始录制。

将视频监视器和视频源与Blackmagic视频硬件连接。
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打开Blackmagic系统偏好
Blackmagic系统偏好为配置设置提供了中央平台。

 � 在Mac OS X下，打开系统偏好并点击Blackmagic Design图标。
 � 在Windows 7和Windows 8下，打开控制面板，点击“硬件和声音”目录，然后点击Blackmagic Design 

Control Panel。
 � 在Linux下，进入“应用程序”下的“声音和视频”选项，双击Blackmagic Control Panel。

不同型号的Blackmagic视频硬件具备不同的功能。只有您的硬件型号支持的系统偏好选项才可使用。

接下来，本手册将详细介绍如何调整Blackmagic系统偏好。

Mac OS X下的Blackmagic Design系统偏好 Windows下的Blackmagic Design Control Panel Ubuntu Linux下的Blackmagic Design Control Panel

使用Blackmagic系统偏好



使用Blackmagic系统偏好258

Settings设置选项卡

Set output（设置输出）
该选项可设置Blackmagic视频硬件的视频和音频输出。部分型号可选择分量模拟视频、S-Video或复合模拟视
频。部分型号可切换音频输出，因此您可在模拟或AES/EBU之间选择。

Set input（设置输入）
该选项可设置Blackmagic视频硬件的视频和音频输入。您的硬件可能支持部分或全部以下组合：

 � SDI Video & SDI Audio（SDI视频和SDI音频）
 � SDI Video & AES/EBU Audio（SDI视频和AES/EBU音频）
 � SDI Video & Analog XLR Audio（SDI视频和模拟XLR音频）
 � Optical SDI Video & Optical SDI Audio（光纤SDI视频和光纤SDI音频）
 � HDMI Video & HDMI Audio（HDMI视频和HDMI音频）
 � HDMI Video & AES/EBU Audio（HDMI视频和AES/EBU音频）
 � HDMI Video & Analog XLR Audio（HDMI视频和模拟XLR音频）
 � Component Video & AES/EBU Audio（分量视频和AES/EBU音频）
 � Component Video & Analog XLR Audio（分量视频和模拟XLR音频）
 � Composite & AES/EBU Audio（复合和AES/EBU音频）
 � Composite & Analog XLR Audio（复合和模拟XLR音频）
 � S-Video & AES/EBU Audio（S-Video和AES/EBU音频）
 � S-Video & Analog XLR Audio（S-Video和模拟XLR音频）

Use video setup in NTSC（使用NTSC的视频黑电平设置） 
美国等使用NTSC复合视频的国家请选择7.5 IRE。日本等其他不使用7.5 IRE黑电平的国家请选择0 
IRE。PAL和高清格式不使用此设置。

视频和音频输出接口。

视频和音频输入接口。

为NTSC复合视频选择7.5 IRE或0 IRE黑电平。
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Use 4:4:4 SDI on video output when possible（条件允许时使用4:4:4 SDI视频输出） 
输出4:4:4视频时请勾选此项设置。1080p50/60视频将始终以4:2:2输出。选择输出4:4:4视频时将无法使用
以下功能：

 � 同时输出HD和下变换SD视频
 � 下变换模拟视频输出

Use 3/6Gb SDI not Dual Link SDI output（使用3/6Gb SDI，不使用双链路SDI输出）
当使用1080p60和4:4:4等高带宽格式或4K格式时，勾选此项设置可使用单链路3G或6G SDI。

Use 1080p not 1080PsF（使用1080p，不使用1080PsF）
勾选此项设置可输出真正的逐行扫描视频，而不是逐行分段传输。

Remove field jitter when video is paused（消除视频暂停时的场抖动现象）
勾选此项设置可通过显示单场以消除老式CRT监视器上暂停隔行扫描视频时产生的场抖动现象。不建议在
纯平显示器上使用这一选项。

Use LTC Timecode input（使用LTC时间码输入）
勾选此项设置可从LTC输入上读取时间码信息，不从SDI信号上读取。

勾选图中复选框输出4:4:4视频。

勾选图中复选框使用单链路3G或6G SDI。

勾选图中复选框输出真正的1080逐行扫描视频。

勾选图中复选框消除CRT监视器上的场闪烁。

勾选图中复选框从LTC输入上读取时间码信息。
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Set default video standard as（设置默认视频格式）
如果使用Final Cut Pro X进行广播级监看，请根据您的Final Cut Pro X项目设置相应的视频格式。

如在Windows系统下使用支持Windows Driver Model（WDM）的程序采集视频，请根据采集的格式相应设
置默认视频格式。一般情况下，您可以使用WDM程序的系统偏好设置视频格式。如果遇到问题，请尝试使
用Blackmagic Design Control Panel控制面板。

When not playing video, send（选择不播放视频时发送的信号）
当您退出应用程序并停止播放视频时，您可以通过这一设置使硬件输出Last Frame Played（最后一帧画
面）或Black（黑场）。

部分Blackmagic型号含有Look Up Tables（LUTs），即查找表，因此您可以选择Last Frame Played选项
查看更改LUT后的效果。启用或禁用此项功能需重启电脑方可生效。

Display HDMI 3D as（HDMI 3D显示格式）
此项设置可选择HDMI监看时的3D格式。有以下几种格式选项：Frame Packing（帧封装）、Side by Side（
并排）、Line by Line（分行）、Top and Bottom（上下）、Left Eye or Right Eye（左眼或右眼）。

Set Reference output timing（同步输出时间校准设置）
如果您连接了同步信号，而画面依然滚动，请调整滑块直至画面稳定。同步信号也称为同步锁相
（Genlock）、BB、同步（House Sync）或三电平同步（Tri-sync）。

为HDMI监看选择3D格式。

请根据Final Cut Pro X的项目设置默认视频格式，或使用WDM
程序进行采集。

不播放视频时，您可以选择发送Last Frame Played（最后一帧
画面）或Black（黑场）信号。

调整同步时间校准滑块直至画面稳定。
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Processing处理选项卡

Select output processing（输出处理设置）
此项设置可在回放画面时实时下变换。请从下拉菜单点选合适的选项。

部分硬件型号支持在输出上同时进行下变换，如HD & SD或2K & SD。同时下变换会使SD-SDI输出出现2帧
的延迟。请调整剪辑软件的时间码偏移，以便在母带制作过程中进行组合编辑和插入编辑时可确保帧的准确
性。

模拟视频输出也经过下变换。分量模拟视频可在HD或SD输出之间切换。如要查看分量模拟SD视频，请点
选“Enable Conversion on Analog Output”（在模拟输出上启用转换），并同时选择“Simultaneous HD 
and SD Output”（同时输出HD和SD）。

Select input processing（输入处理设置）
此项设置可在采集画面时实时上下变换。请从下拉菜单点选合适的选项。

Output HD 23.98PsF at HD 59.94i (Windows only)（将
HD 23.98PsF输出为HD 59.94i，仅限Windows）
此项设置可应用3:2下拉序列，使HD 23.98 PsF视频输出为HD 59.94i。这是因为虽然23.98 fps为常用电影
帧率，但是支持此帧率的SDI和模拟监视器较为少见，而HD 59.94i是绝大多数HD监视器都支持的格式。

Set A-frame VITC reference（设置A帧VITC同步信号）
当以23.98fps的帧率采集并从NTSC视频移除3:2下拉时，此选项用于输入A帧号码。错误的A帧会显示不正
确的场和帧。

Capture VANC input line（采集VANC输入行）
此项设置可在采集时保留3行时间码、VITC字幕信息或任何其他VANC数据。要保留VANC数据，请勾选所
采集视频行对应的复选框。为使第2行和第3行正常工作，请启用第1行。

请从下拉菜单选择输出处理。

勾选图中复选框使HD 23.98PsF输出为HD 59.94i。

执行3:2下拉操作时设置A-Frame VITC同步信号。

勾选图中复选框采集VANC数据行。
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Video Levels视频电平选项卡

Calibrate Analog Video In（校准模拟视频输入）
这些设置可调整模拟视频输入。使用滑块调整Video（视频）、Chroma（色度）、Cb以及Cr电平。建议结
合使用Blackmagic Ultrascope示波器来调整这些设置。在Settings选项卡中将“Set input”（设置输入）
设置为“analog video input”（模拟视频输入）后方可使用Calibrate Analog Video In选项。

Calibrate Analog Video Out（校准模拟视频输出）
这些设置可调整模拟视频输出。使用滑块调整Video（视频）、Chroma（色度）、Cb以及Cr电平。建议结
合使用Blackmagic Ultrascope示波器来调整这些设置。

Use Betacam YUV Levels（使用Betacam YUV电平） 
由于几乎所有现代视频设备都使用SMPTE电平，Blackmagic产品也默认使用SMPTE分量模拟电平。使用
Sony Betacam SP录机时，请勾选“Use Betacam YUV Levels”选项。

Audio Levels音频电平选项卡

Set Analog Audio Input Levels（设置模拟音频输入电平）
这些设置可调整模拟音频输入的增益设置。 

Set Analog Audio Output Levels（设置模拟音频输出电平） 
这些设置可调整模拟音频输出的增益设置。 

Set AES/EBU Input Ref Level（设置AES/EBU输入同步电平）
这些设置可调整AES/EBU音频输入的增益设置。模拟音频各通道可独立调整，而AES/EBU音频各通道为
同步调整。

Set AES/EBU Output Ref Level（设置AES/EBU输出同步电平）
这些设置可调整AES/EBU音频输出的增益设置。模拟音频各通道可独立调整，而AES/EBU音频各通道为
同步调整。

Use HiFi Audio Levels（使用HiFi音频电平）
专业模拟音频电平以及XLR接口是UltraStudio和DeckLink机型的标配。如要连接消费级音频设备，请启
用“Use HiFi Audio Levels”并使用XLR转RCA转接头。

使用滑块调整模拟视频的视频和色度电平。

使用滑块调整模拟及AES/EBU音频的增益设置。
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After Effects® CC

如何预览视频
要在Blackmagic硬件上实时显示After Effects® CC合成画面，请到Preferences（首选项）> Video 
Preview（视频预览）下设置。选择Blackmagic Video Output并选择相应的Output Mode（输出模式）。 
然后您就能在广播级监视器上以正确的视频色彩空间监看After Effects® CC的合成画面了。

如要通过Blackmagic硬件监听音频，请到Mac OS X的系统偏好或者Windows的控制面板中将Blackmagic
音频设置为默认声音输出设备即可。在After Effects® CC界面中，到Preferences（首选项）>Audio 
Hardware（音频硬件）下，Mac OS X用户请将音频输出设置为System Default Input/Output（系统默认输
入/输出），Windows用户请设置为Blackmagic Audio（Blackmagic音频）。

渲染
完成画面合成后，您需要将任务渲染到Blackmagic视频硬件支持的编解码器。您可以渲染一组DPX图像序
列或以下任何一种编解码器：

如果安装了Final Cut Pro，您还能获得ProRes和DVCPRO HD等其他编解码器。

如果安装了Adobe® Premiere Pro® CC，您还能获得DVCPRO HD和DVCPRO50等其他编解码器。

After Effects® CC

“Output Module Settings”输出模块设置渲染选项

“Video Preview”视频预览首选项  � Blackmagic 10 bit 4:4:4（无压缩）
 � Blackmagic 10 bit 4:2:2（无压缩）
 � Blackmagic HD 8 bit 4:2:2（无压缩）

 � Blackmagic SD 8 bit 4:2:2（无压缩）
 � Blackmagic 8 bit MJPEG（压缩）

Windows系统的AVI编解码器

 � Blackmagic RGB 10 bit（无压缩）
 � Blackmagic 10 bit（无压缩）
 � Blackmagic 8 bit（无压缩）

 � Apple Photo - JPEG（压缩）
 � Apple DV - NTSC（压缩）
 � Apple DV - PAL（压缩）

Windows系统的QuickTime编解码器

 � Blackmagic RGB 10 bit（无压缩）
 � Apple无压缩YUV 10 bit 4:2:2
 � Apple无压缩YUV 8 bit 4:2:2

 � Apple Photo - JPEG（压缩）
 � Apple DV - NTSC（压缩）
 � Apple DV - PAL（压缩）

Mac OS X系统的QuickTime编解码器

使用您喜爱的第三方软件
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Photoshop® CC

如何导入和导出视频帧

将图像导入Photoshop® CC
第一步： 在Photoshop® CC中，选择File（文件）> Import（导入）> Blackmagic Image Capture。

第二步： 选择“Video Input Format”（视频输入格式）和“Image Bit Depth”（图像位深），然后点击Image 
Import导入图像。

从Photoshop® CC中导出图像
第一步： 选择File（文件）> Export（导出）> Blackmagic Image Export。

第二步： 选择Video Output Format（视频输出格式）并点击Export Image导出图像。

选择“Import（导入）”或“Export（导出）”选项后，之后的导入和导出操作将不会显示设置窗口。但
是，在选择导入或导出时，您依然可以通过按住Mac计算机上的Option键，或者按Windows计算机上的Ctrl
键来更改设置。

导入图像

导出图像

Photoshop® CC
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Adobe® Premiere Pro® CC

创建Blackmagic Design项目
第一步： 选择New Project（创建新项目）并点击Scratch Disks（暂存盘）选项卡，设置项目的保存地址和名称。

第二步： 为采集到的视频、音频、视频预览和音频预览设置保存地址。

第三步： 如果Adobe® Premiere Pro® CC的Mercury Playback Engine支持您的图形卡，那么您就可以使用Renderer
渲染器选项，并将其切换到“Mercury Playback Engine GPU加速”。

第四步： 将Capture Format（采集格式）设置为Blackmagic Capture，并点击Mac计算机上的设置，或Windows计 
算机上的属性按钮，调出该项目的Blackmagic Capture Settings采集设置界面。设置相应的Video 
Standard（视频制式）和Video Format（视频格式），并点击OK确定。

第五步： 屏幕会出现New Sequence（新建序列）窗口。选择相应的Blackmagic预设，为该序列命名，然后点击OK
确定。

设备控制
Blackmagic Design的许多采集和回放设备都具备RS-422录机控制功能。每次创建新项目时，都需要选择
Blackmagic Device Control设备控制。请到Preferences（首选项）> Device Control（设备控制）菜单中
选择“Blackmagic Device Control”。

回放
每次创建新项目时，都需要到Preferences（首选项）> Playback（回放）菜单中选择回放设置。Adobe 
Player为默认播放器。但Audio Device（音频设备）需要切换到“Blackmagic Playback”。

在"Video Device"（视频设备）菜单下，勾选“Blackmagic Playback”复选框，确保未勾选其余复选框，
然后点击OK确定。

新建序列

Adobe® Premiere Pro® CC
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采集
请依次进入以下菜单执行采集操作：File（文件）> Capture（采集）[F5]

如要立即开始采集，或从不可控设备上采集，请点击红色录制按钮[G]。

如果您需要使用RS-422录机控制，请使用Set In（入点）和Set Out（出点）按钮设置相应的入点和出点，
或手动输入时间码并点击Log Clip（记录剪辑）。空白片段会出现在Project（项目）窗口中。重复上述操
作，直至所有批量采集片段都记录完毕。然后，请依次进入以下菜单：File（文件）> Batch Capture（批
量采集）[F6]。如要在片段上使用过渡帧，请启用Capture with handles（带过渡帧采集）选项，并在每个
片段首尾键入所需额外的帧数。

导出到磁带  
如果要通过RS-422录机控制导出到磁带，请选择相应的序列并依次进入File（文件）> Export（导出）> 
Tape（磁带）菜单进行操作。

插入编辑需要整段项目具备完整连贯的时间码，以便编辑到磁带上。

组合编辑模式下，录像带在项目开始前只需使用“黑场”即可。组合编辑会擦去该记录起始位置之后录像
带上的全部记录，因此如果您不希望录像带之前录下的内容被覆盖，请勿使用组合编辑。

编辑到磁带时，该软件会等到您的项目的第一帧出现时以预定时间码从录机上进行记录。如果在编辑到磁
带的过程中发现节目的第一帧出现重复或丢失的现象，您需要调整回放偏移以确保录机和电脑同步。任何
录机和电脑的组合进行同步之后，系统都会保留正确设置。

接下来，请根据需要键入片段入点及偏移，并按OK（Mac计算机）或Export（Windows计算机）即可导出。

采集

导出到磁带
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Apple Final Cut Pro X

Apple Final Cut Pro X
您可以通过Blackmagic视频硬件输出视频，以便使用Final Cut Pro X 10.0.4及更高版本的广播级监看功能。此
外，您还能在两台计算机监视器上使用Final Cut Pro X界面。

设置Final Cut Pro X
第一步：请确保您运行的是Final Cut Pro X 10.0.4或更高版本，并确保您的计算机为最新版Mac OS X Mountain Lion 
 或Mavericks。

第二步：打开系统偏好并点击Blackmagic Design。到Setting选项下，找到“Set default video standard as”选项，将 
 视频格式设置为和Final Cut Pro X中使用的相同格式，如HD 1080i59.94。该格式需和您的素材视频格式相符。

第三步：运行Final Cut Pro X并创建新项目。

第四步：为新项目键入名称，并选择保存位置。

第五步：将Video Properties（视频属性）设置为Custom（自定义），然后将Format（格式）、Resolution 
 （分辨率）和Rate（帧率）设置为和Blackmagic Design Desktop Video系统偏好中设置的默认视频格式相符 
  的选项。

第六步：Audio and Render Properties（音频和渲染属性）设置为Custom（自定义）。在Audio  
 Channels（音频通道）中选择Stereo（立体声），或者您也可以为6个音频通道选择Surround（环绕声）。 
 在Audio Sample Rate（音频采样率）中选择48kHz电视采样率。将Render Format（渲染格式）设置为与您 
 的视频片段相同的格式。Final Cut Pro X默认使用ProRes压缩格式，您可以更改为Uncompressed 10-bit  
 4:2:2格式，获得无压缩工作流程。点击OK完成项目新建。

第七步：到Final Cut Pro菜单下，选择Preferences（偏好），并点击Playback（回放）选项卡。检查A/V Output（视/ 
 音频输出）菜单是否选择了“Blackmagic”并使用与您的项目相同的视频格式，然后关闭Preferences。

第八步：到Window（窗口）菜单下，选择A/V Output，以便视频通过Blackmagic视频硬件输出。

如果您需要通过Blackmagic视频硬件监听音频，请打开System Preferences（系统偏好），选择Sound 
（声音）图标，点击Output（输出）选项卡后，再选择“Blackmagic Audio”作为声音输出。

第六步：将Audio and Render Properties（音频和渲染属性）
设置为Custom（自定义）。

第二步：请在System Preferences（系统偏好）中将视频格式
设置为和Final Cut Pro X中的项目相符的格式。
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回放
第一步：将片段导入新建项目。

第二步：您可以在您的电脑上使用Final Cut Pro X时间线，并可以在连接了Blackmagic Design视频硬件输出接口的电 
 脑监视器或电视机上查看视频预览。

采集视频和音频
您可以结合使用Blackmagic Media Express和Blackmagic Design视频硬件采集视频和音频。完成片段采集
后，您可以将它们导入Final Cut Pro X进行剪辑。

使用Media Express进行采集时，请确保您选择的是Final Cut Pro X支持的视频格式，如：Apple ProRes 
4444、Apple ProRes 422 (HQ)、Apple ProRes 422或Uncompressed 10-bit 4:2:2。

编辑到磁带
在Final Cut Pro X中完成项目后，您可以将项目渲染为电影文件，然后使用Blackmagic Media Express和
Blackmagic Design视频硬件制作母带，将电影编辑到磁带上。

第一步：在Final Cut Pro X的时间线上选择片段。

第二步：到Share（共享）菜单下，选择Export Movie（导出电影）。

第三步：在Export Movie窗口中，将Export（导出）设置为“Current Settings”（当前设置），将Include（包括）设 
 置为“Video and Audio”（视频和音频）。点击“Next”（下一步）。

第四步：打开Media Express，导入从Final Cut Pro X导出的片段。

第五步：请参考本手册Blackmagic Media Express章节中的“将视频和音频文件编辑到磁带”部分获得详细信息。

第三步：在Export Movie窗口中，将Export（导出）设置
为“Current Settings”（当前设置），将Include（包括）设置
为“Video and Audio”（视频和音频）。
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Avid Media Composer

Avid Media Composer
Avid Media Composer可结合Blackmagic视频硬件采集和回放标清和高清视频及音频，并支持RS-422录机控
制。如果安装Desktop Video软件之前安装Media Composer，那么用于Media Composer的Blackmagic插件会
自动安装。

准备工作
第一步：运行Media Composer，系统会弹出Select Project（选择项目）对话框。

第二步：如果之前创建过用户文件，请选择您想要的User Profile（用户配置文件）。

第三步：在名为Private（专用）、Shared（共享）或External（外部）文件夹中选择一个创建项目。

第四步：点击New Project（新建项目）按钮。

第五步：键入项目名称，并设置Format（格式）、Color Space（色彩空间）和Stereoscopic（立体）等项目选项。 
 点击OK。色彩空间和立体选项可在该项目的Format（格式）选项卡中进行更改。

第六步：在Select Project（选择项目）对话框中双击项目名称后，会出现Media Composer界面以及新建项目的窗口。 
 至此项目设置完毕。

回放
如需快速测试以确保一切连接正确，请参考Media Composer编辑指南中名为“导入彩条和其他测试模式”的
章节完成操作。双击导入文件后，该文件会在弹出的监视器窗口中播放。此时，您应该可以在电脑屏幕上以
及Blackmagic输出上查看到画面。

如果您无法从Blackmagic输出上查看到画面，请再次检查确保连接无误，并在Media Composer里依次进入
Tools（工具）> Hardware Setup（硬件设置）菜单检查和确保Blackmagic Design系统偏好中的输出设置正确
无误。

如果使用单个电脑监视器，请打开Blackmagic Design系统偏
好，并选择不播出视频时输出Black信号。

第五步：键入项目名称并设置项目选项。
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从不可控设备上进行采集
许多视频源，包括所有现代摄影机、硬盘录机，以及老式摄影机和VHS在内，并不具备设备控制功能。 
不使用录机控制进行采集步骤如下：

第一步：依次进入Tools（工具）> Capture（采集）菜单，打开Capture Tool（采集工具）。

第二步：点击Toggle Source（源触发器）按钮后，录机按钮图标应显示为圆形红色禁止图标。该图标表示录机控 
 制已被禁用。

第三步：将Video和Audio视音频输入分别设置为“Blackmagic”。

第四步：选择您要采集的视频源轨道（V）以及音频源轨道（A1、A2等）。

第五步：使用Bin（库）菜单从素材库分组中选择Target Bin（目标库）。

第六步：从Res（分辨率）菜单中选择您采集的片段需要使用的压缩或无压缩编解码器类型。如果是无压缩8-bit视 
 频，请选择“1:1”；如果是10-bit，请选择“1:1 10b”。

第七步：为采集到的视频和音频选择硬盘存储。使用Single/Dual Drive Mode按钮可将视频和音频存储在同一个盘 
 上或分开保存。到Target Drives（目标驱动器）菜单中为采集到的媒体选择一个或多个保存位置。

第八步：点击窗口底部的“Tape Name?”（磁带名称）按钮打开Select Tape（选择磁带）对话框。选择磁带，或添 
 加新磁带并点击OK。

第九步：确保您的视频和音频源准备就绪，然后点击Capture（采集）按钮。录制时，Capture按钮会闪烁红光。再 
 次点击Capture按钮停止采集。

第二步：在Capture Tool菜单框中，点击Toggle Source按钮可
不使用录机控制采集视频。
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使用UltraStudio、DeckLink以及Teranex从可控设备进行采集
如果您的录机通过RS-422连接，您需要在采集之前先对其进行配置设置。

第一步：点击项目窗口中的Settings选项卡并双击Deck Configuration（录机配置）。

第二步：在Deck Configuration对话框中点击Add Channel（添加通道），并将Channel Type（通道类型）设置为 
 Direct，将Port（端口）设置为RS-422 Deck Control。点击OK，在弹出“Do you want to autoconfigure the  
 channel now?”（是否现在就自动配置该通道？）问题时，请点击“No”。

第三步：点击Add Deck（添加录机），从Device（设备）菜单中选择录机的品牌和型号，并同时设置Preroll（预滚 
 动）。点击OK，然后点击Apply（应用）。

第四步：到Settings（设置）选项卡下，双击Deck Preferences（录机首选项）。

第五步：如果您想要在磁带上使用组合编辑，请启用“Allow assemble edit & crash record for digital cut”（允许组合 
 编辑和手动录制数码剪辑）选项。如果取消勾选该选项，您只能执行插入编辑。

第六步：启用“Relax coincidence point detection”选项，并根据需要相应设置其他选项。点击OK。至此，录机的 
 RS-422连接已设置完毕。

如要测试遥控连接，请使用RS-422串行电缆连接Blackmagic视频硬件和录机。将录机设置为Remote 
（遥控）。打开Capture Tool（采集工具）并使用标准的J、K、L快捷键控制录机。如果录机名称以斜体显
示或显示“NO DECK”字样，点击菜单并选择Check Decks，直到录机名字不再显示为斜体并重新建立录
机控制。

使用录机控制进行即时采集：

第一步：依次进入Tools（工具）> Capture（采集）菜单，打开Capture Tool（采集工具）。

第二步：Capture/Log Mode按钮应显示CAP图标。如果该按钮显示LOG图标，点击该按钮切换到采集模式，此时应 
 可显示为CAP图标。

第三步：Toggle Source按钮应显示为录机图标。如果出现圆形红色禁止图标，请点击该按钮以启用录机控制，该红 
 色图标便会消失。

第四步：参照“从不可控设备上进行采集”章节中的介绍，完成视频与音频输入、视频与音频源轨道、目标库、分 
 辨率、目标驱动器和磁带名称等选项的配置。

第五步：使用Capture Tool下方的Deck Controller（录机控制器）窗口调整好磁带并开始播放。

第六步：点击Capture按钮。录制时，Capture按钮会闪烁红光。再次点击Capture按钮停止采集。

第六步：在Deck Preferences（录机首选项）中，启用“Relax 
coincidence point detection”选项。

设置CAP和Toggle Source按钮，以便使用录机控制。使用录
机控制窗口调整好磁带并开始播放。
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使用UltraStudio和DeckLink批量采集
录入多个片段用于批量采集的步骤如下：

第一步：依次进入Tools（工具）> Capture（采集）菜单，打开Capture Tool（采集工具）。

第二步：点击Capture/Log Mode按钮，直至该按钮显示LOG图标。

第三步：参照“从不可控设备上进行采集”章节中的介绍，完成视频与音频输入、视频与音频源轨道、目标库、分 
 辨率、目标驱动器和磁带名称等选项的配置。

第四步：使用录机控制窗口或标准的J、K、L快捷键控制录机的后退、暂停和向前等操作找到需要采集的视频。

第五步：点击位于LOG按钮左边的Mark IN/OUT标记出入点按钮。图标会在IN和OUT之间切换，因此按一个按钮就可 
 以标记所有入点和出点。使用录机控制窗口中的专设的Mark IN和Mark OUT按钮获得可更快捷的控制。此 
 外，使用键盘上的“i”和“o”键也可以标记入点和出点。

第六步：完成入点和出点录入后，打开录入库选择想要采集的片段。

第七步：依次进入Clip（片段）> Batch Capture（批量采集）菜单，在对话框中选择相应的选项，然后点击OK。

使用UltraStudio和DeckLink录制到磁带
片段采集完成后，将它们拖放到时间线上进行剪辑，使用特效并进行渲染后，再将项目完整地录制到磁带上。

第一步：双击项目库中的某段序列，打开其时间线窗口。

第二步：依次进入Output（输出）> Digital Cut（输出到磁带）菜单，打开Digital Cut Tool（数码剪辑工具）。

第三步：将Output Mode（输出模式）设置为Real-Time（实时）；Bit Depth（位深）设置为10-bit；Deck Control 
 （录机控制）设置为Remote（遥控）。

第四步：到Edit（剪辑）菜单下，选择Insert Edit（插入编辑）或Assemble Edit（组合编辑），以便在添加了时间码 
 的磁带上进行精确剪辑，或者选择Crash Record，获得更便捷的录制操作。如果只有Insertg Edit（插入 
 编辑）选项可选，请到该项目的Settings（设置）选项卡下双击Deck Preferences（录机首选项）并启 
 用“Allow assemble edit & crash record for digital cut”（允许组合编辑和手动录制数码剪辑）。

第五步：如果录机名称以斜体显示或显示“NO DECK”字样，点击菜单并选择Check Decks，直到录机名字不再显 
 示为斜体并重新建立录机控制。

第六步：按Play Digital Cut按钮（红色三角形图标）将序列录制到磁带上。

第五步：点击Mark IN/OUT出入点标记按钮或使用键盘上
的“i”和“o”键来标记入点和出点。

Digital Cut Tool（数码剪辑工具）可用来录制到磁带。
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Autodesk Smoke

Autodesk Smoke 2013 Extension 1
Autodesk Smoke可将剪辑、合成和3D效果整合到一个工作区域。这款软件可以结合Blackmagic视频硬件采集
和回放标清和高清视频及音频，并支持RS-422录机控制。安装Autodesk Smoke之前，请确保Blackmagic 
Design驱动和您的视频设备已妥善安装。

您可以使用Smoke的广播级监看选项卡通过Blackmagic硬件输出视频。

安装
第一步：运行Smoke后，会弹出Project and User Settings（项目和用户设置）窗口。如果您已创建项目和用户，请 
 在Project和User栏相应做出选择。如果您未曾创建项目和用户，请新建项目和/或用户。

第二步：完成项目各项设置，使其符合您的交付要求，如1080HD。大部分设置可随后更改。

第三步：为项目生成的媒体文件选择剪辑格式，比如ProRes 422甚至Uncompressed无压缩格式。请根据您的内存选 
 择适当的格式。

第四步：点击Create按钮。

设置硬件
使用VTR时，请依照以下步骤进行：

第一步：将VTR的输出接口连接到Blackmagic采集和回放设备的输入接口上。将Blackmagic采集和回放设备的输出接 
 口连接到VTR的输入接口上。

第二步：使用RS-422录机控制线缆将VTR的串行端口与Blackmagic Design采集和回放设备的遥控端口连接。

第三步：将VTR设置为遥控控制。

第四步：将同步信号发生器连接到VTR的同步输入上，确保精确采集。如果您还有一台音频设备，请再连接一路音 
 频同步信号。

键入项目名称并设置项目选项。
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设置VTR
开始使用Autodesk Smoke之前，您必须使用名为Smoke Setup的实用程序选择您所使用的VTR的型号以及
适当的Timing（分辨率和帧率）设置。

第一步：依次进入Applications>Autodesk>Smoke>Utilities菜单，打开Smoke Setup。

第二步：在General选项卡中，检查Video Device和Audio Device视音频设备是否都设置为BMD。

第三步：在VTR选项卡中，勾选相应VTR型号以及Autodesk Smoke的Timing（分辨率和帧率）设置。勾选Live NTSC 
 行或Live PAL行以启用Crash-Record手动录制或现场输出。

第四步：点击Apply并关闭Smoke Setup。

使用UltraStudio和DeckLink从可控设备进行采集
Autodesk Smoke可以从支持RS-422录机控制的可控VTR进行采集，具体配置步骤如下：

第一步：在Media Library中选择用于保存采集到的片段的文件夹。

第二步：依次进入File（文件）>Capture from VTR（从VTR采集）菜单，调出VTR Capture界面。

第三步：将磁带调整到采集视频的第一帧。

第四步：选择想要录制的视音频通道。被选中的轨道对应的按钮会变成红色，以便您明确所选对象。

第五步：在In和Out栏中分别键入入点和出点。

第六步：点击Capture开始采集。时间码栏会变成绿色，以表示正在采集。

第七步：点击Preview（预览）窗口的任意位置可随时停止采集。片段会自动保存到您之前在第一步所选的文件夹中。

确保Smoke Setup实用程序中的Video Device（视频设备）和
Audio Device（音频设备）都设置为BMD。

使用Smoke Setup实用程序中的VTR选项卡为您的VTR选择
Timing（分辨率和帧率）设置。

VTR上被选中作为采集对象的视频和音频轨道对应的按钮会变
成红色。
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使用UltraStudio和DeckLink录制到磁带
将片段加载到VTR输出界面，然后为输出片段设置入点和出点。如有需要，您还可以对输出启用起始帧偏
移选项，并应用Letterbox（信箱式）叠加。

第一步：依次进入File（文件）>Output to VTR（输出到VTR）菜单。

第二步：从Media Library（媒体库）中选择输出的一个或多个片段。您还可以选择一个文件夹，一次性输出文件夹内
所有内容。然后调出VTR Output界面。

第三步：从Device Name（设备名称）框内选择VTR。预览窗口会显示选中VTR中的磁带视频。

第四步：确保选中正确的视频轨道和音频通道按钮，使相应的视频轨道和音频通道输出到磁带上。

第五步：启用或禁用Clip Output（片段输出）菜单中的All Audio（所有音频）选项。当启用All Audio选项时，除了您
选中的音频通道外，所有音频通道都将被转换为磁带上所使用的格式。

第六步：输出前，点击预览来查看片段。

第七步：如果不从所选片段的第一帧开始输出，请在Start Offset（起始偏移）栏中键入起始时间码。

第八步：设置片段输出的In和Out点。

第九步：要将片段输出到VTR，请选择Output（输出）框中的Insert（插入）选项。选中了Status的片段将被输出到
磁带。输出过程中，每个片段的状态会依次更新为Pending（等待中）、Output（输出）和Done（完成）。

第十步：调整到入点时间码，然后选择Play，并检查设置是否成功。

第十一步：完成后，点击EXIT Output Clip关闭窗口并退出界面。

第三步：您可以在下拉列表中选择VTR。

您选中输出的片段会出现在列表中，并标明各自的输出状态。

设置In和Out点，然后在Output下拉菜单中选择Insert。



使用您喜爱的第三方软件276

使用您喜爱的第三方软件
Autodesk Smoke可采集现场视频信号，也可对一个片段进行手动录制，通过使用手写笔或鼠标控制片段输
入和输出过程的起止。以此类方式进行采集时，Autodesk Smoke会检查Autodesk Media Storage存储设备
上的可用空间，空间大小取决于您所选择的剪辑格式。

此外，如果您使用摄影机和VCR等不支持RS-422遥控控制的设备，请使用Live NTSC或PAL选项进行采
集，并使用Live Video选项输出视频片段。

如何手动录制现场视频信号：
第一步：到Media Library（媒体库）中选择一个文件夹用来存放采集片段。

第二步：依次进入File（文件）>Capture from VTR（从VTR采集）菜单，调出VTR Capture界面。

第三步：到VTR Device菜单框中选择Live NTSC或Live PAL选项。接收到的现场视频信号会出现在预览窗口中。

第四步：选择Start On Pen模式。使用Stop On Pen或Stop On Frames停止采集。以前，Autodesk Smoke是通过平板
电脑和手写笔操作，因此会沿用Start On Pen这一术语。

当选择使用Start On Pen停止采集这一模式时，出点和持续时间的时间码栏将更新显示Autodesk Media 
Storage设备可采集的最长片段。您可以点击屏幕上任何地方停止采集，或者，当存储已满时采集也会停止。

第五步：键入片段名称，选择想要采集的视频轨道和音频通道。

第六步：确保您接收的是现场视频信号。

第七步：点击视频设备上的Play按钮。

第八步：点击Process开始采集。

第九步：点击屏幕上任何地方停止Stop On Pen采集模式。

勾选Live NTSC行或Live PAL行以启用Crash-Record手动录制
或现场输出。
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如何输出现场视频信号：
第一步：依次进入File（文件）>Output to VTR（输出到VTR）菜单。

第二步：从Media Library（媒体库）中选择输出的一个或多个片段。您还可以选择一个文件夹，输出该文件夹内所有
内容。然后调出VTR Output界面。

第三步：到VTR Device菜单框中选择Live NTSC或Live PAL选项。

Start Mode选项不可用。您必须在Start On Pen模式下才能使用Live Video现场视频输出。使用Stop On 
Pen或Stop On Frames停止输出。

第四步：设置输出选项。例如，键入片段名称，选择您想要采集的视频轨道和音频通道。

第五步：在接收信号的设备上开启录制，或执行相应操作使设备接收来自Autodesk Smoke的信号。

第六步：选择Process开始Autodesk Smoke上的输出。

第七步：点击屏幕上任何地方停止Stop On Pen模式输出。
输出现场视频时请使用Start On Pen模式。

输出现场视频信号时，请选择Live PAL或Live NTSC。
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DaVinci Resolve 10

在“Video capture and playback”（视频采集和回放）菜单中
选择您需要使用的格式。

DaVinci Resolve 10和实时调色
Desktop Video 10可在DeckLink 4K Extreme和UltraStudio 4K上同时采集和回放，因此无需为输入和输出各设
一台设备。这一特性对于需使用DaVinci Resolve 10的Live Grading实时调色功能的用户来说十分有帮助。

当使用现场实时调色功能时，只需要简单地将摄影机的输出和Blackmagic硬件的输入连接即可。然后，再将
硬件的输出连接到现场监视器上用于调色和查看。

准备工作
第一步：运行Resolve，到Preference（偏好）菜单下，选择“Video I/O and GPU”（视频输入/ 输出及GPU）选项 
 卡，并在“For Resolve Live use”选项中选择您的硬件。保存偏好设置，重启Resolve以应用更改。

第二步：打开一个项目，到Project Settings（项目设置）窗口中设置与您的摄影机匹配的分辨率和帧率。

第三步：在Project Settings窗口中，找到“Deck Capture and Playback”（录机采集和回放）选项卡，从“Video  
 capture and playback”（视频采集和回放）菜单中选择您需要的格式。

第四步：到Edit（剪辑）页面中右击Timeline（时间线）窗口，再选择“Create New Timeline”创建新的时间线。

第五步：到Color（调色）菜单中，选择“Resolve Live On/Off”。此时，您可以从Viewer中查看到现场视频，视频上 
 会出现明亮的红色“Resolve Live”按钮。

使用Resolve Live
第一步：在Resolve Live模式中，Freeze按钮（雪花图标）可冻结当前接收到的视频帧，让您调色时不会受到动态的

拍摄画面的影响。调色完毕后，您可以解冻回放画面，以便保存快照。

第二步：如果您对调色结果满意，请点击Snapshot按钮（摄影机图标），将当前Viewer中显示的画面截图、时间码 
 信息以及调色方案保存到时间线。快照即单帧素材。

更多Resolve Live详情请参考DaVinci Resolve 10使用手册。
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什么是Blackmagic Media Express？
UltraStudio、DeckLink和Intensity，以及所有型号的ATEM切换台、Blackmagic Camera摄影机、H.264 
Pro Recorder、Teranex Processor处理器和Universal Videohub视频矩阵都自带Blackmagic Media 
Express软件。如果您只需采集、回放并将片段输出到磁带，并不想使用复杂的NLE非编软件，那么Media 
Express 3便是您的首选工具。 

采集视频和音频文件

创建项目
在使用Media Express采集片段之前，您需要先选择项目设置。

第一步：依次进入Media Express>Preferences菜单；或进入Edit>Preferences菜单（Windows或Linux系统）。可选的 
 项目格式列表取决于您的Blackmagic视频硬件是否支持Ultra HD 4K视频或立体3D视频等功能。

第二步：在Capture File Format下拉菜单中选择各类压缩或无压缩采集格式，甚至DPX图像序列等格式。视频会以选 
 定的格式进行采集并保存为QuickTime电影。

第三步：为采集到的视频和音频选择保存位置。

第四步：选择检测到丢帧情况时是否停止采集或回放。

如果未勾选Anamorphic SD 16:9复选框，标清项目会使用4:3宽高比设置。

通常，将程序转到后台之后，该程序会停止播放视频。如果您希望在打开另一个程序时Media Express依然
在后台继续播放视频，请勾选“Continue playback when in the background”（在后台继续播放）复选框。

最后几个选项适用于支持RS-422录机控制，并带预卷及时间码偏移功能的磁带机。

使用Preferences窗口设置视频格式、文件格式、保存位置以及
其他设置。

Blackmagic Media Express
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媒体列表 搜索栏时间码列表、缩略图和收藏夹视图 VTR/录机时间码 视频预览

片段分组 采集选项 播放控制抓取静帧项目名称、视频格式和帧率 遥控指示灯录入信息标记入点/出点 音频表音频通道启用/禁用
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采集
采集视频十分简便，您只需连接到视频源，完成Media Express偏好设置并按下Capture（采集）按钮即可。

第一步：首先，请将视频源连接到Blackmagic视频硬件的输入上，并检查Blackmagic系统偏好设置为相同的视频输
入，如SDI、HDMI或模拟。

第二步：打开Media Express，完成项目视频格式和采集文件格式的偏好设置。

第三步：点击红色的Log and Capture选项卡，在Description栏中键入一段描述。

第四步：点击Description边上的“+”按钮将其添加到Name自动命名栏内。点击任意栏右边对应的“+”按钮可将录
入信息添加到Name自动命名栏内。

 � 点击各栏相应的场记板图标可添加信息。您还能直接在各栏内输入信息，自定义名称和编号。

 � Name自动命名栏内的内容会用于即将采集的片段。

 � 点击Name栏旁边的星形图标可收藏相应片段。

 � 若要在每次采集前跳出确认片段名称的提示信息，请点击Name栏旁边的“!”图标。

第五步：选定所要采集的音频通道号码。

第六步：点击“Capture”按钮开始录制。要停止采集，请再次点击“Capture”按钮，或按esc键，系统会询问您是
否删除或保存片段。采集到的片段会被添加到Media List（媒体列表）中。

录入片段
请使用RS-422串行电缆连接Blackmagic视频硬件和录机，并且将录机的Remote/Local开关设为Remote状
态。使用标准的j、k、l快捷键控制后退、暂停和前进。

点击Mark In按钮或使用快捷键“i”标记入点。

点击Mark Out按钮或使用快捷键“o”标记出点。

点击Log Clip按钮或使用快捷键“p”录入片段。出入点时间码信息会出现在Media List列表中，并标以红
色“X”表示该媒体尚未被采集。

选定所要采集的音频通道号码。

输入视频描述。

点击“Capture”按钮开始采集。
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批量采集
录入片段后，您可以按Clip按钮采集单个片段。

要采集多个片段，请继续录入片段用于批量采集。

在Media List列表中选择录入的片段，并执行以下其中一项操作：

 � 点击Batch图标。
 � 右击选项并选择Batch Capture（批量采集）。
 � 到File（文件）菜单下，选择Batch Capture。

Media Express将采集片段时间码上入点到出点的部分。

DPX采集
如果您想要采集DPX图像序列，而不是电影文件，请打开Media Express Preference偏好设置，将Capture 
File Format（采集文件格式）设置为DPX 10-Bit RGB。

 � 通过将采集文件格式设置为DPX来新建DPX项目。
 � 采集。

采集完成后，Media List列表中会以缩略图来表示整段图像序列。这组DPX图像序列将被保存在其位于硬盘
上的指定文件夹内。音频将作为.wav文件被保存在同一个文件夹内。

DPX采集默认为来自YUV信号源。如果您需要从RGB信号源进行采集，请禁用“Capture to DPX from a 
YUV source”选项。

如果您需要DPX帧号码根据采集视频的时间码而定，而不是从零开始，请启用“Use absolute frame 
numbering when capturing DPX”选项。

如果您无需进行较长的DPX采集，只需选择“When capturing DPX files, use (2-8) digit numbers in the 
frame count”就可以减少帧号码中的零的个数。

DPX采集偏好
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3D采集
当Media Express和支持双通道3D的Blackmagic视频硬件结合使用时，您可以通过同时采集2通道HD-SDI
视频创建左右眼3D视频片段。

 � 创建与您的双通道3D视频源帧率相匹配的3D项目 。
 � 确保您将2路HD-SDI视频输入连接到Blackmagic视频硬件。
 � 采集。

使用Media Express采集和录入双通道3D文件时，片段名称会应用到左眼视频。右眼视频会被附上“_
right”字样。例如，您将某个立体视频片段命名为“Clip 1”，左眼片段会被命名为“Clip 1.mov”，右眼
片段则会被命名为“Clip 1_right.mov”。

Media List可将采集的3D片段醒目表示：

 � 在Thumbnail（缩略图）列表视图中，左眼和右眼视频片段通过一个3D标识连接起来，并以一个大图标
表示。

 � 在Timecode List（时间码列表）视图中，左眼和右眼视频片段会分两行显示，并以3D标识连接。

选择一个名字中带“3D”字样的项目视频格式就可以采集双通
道立体3D视频片段。

在Thumbnail（缩略图）列表视图中，左眼和右眼视频片段通
过一个3D标识连接起来，并以一个大图标表示。

在Timecode List（时间码列表）视图中，左眼和右眼视频片段
会分两行显示，并以3D标识连接。
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选择收藏抓取静帧片段信息 音频通道启用/禁用

媒体列表 搜索栏时间码列表、缩略图和收藏夹视图 VTR/录机时间码 视频预览

片段分组项目名称、视频格式和帧率 标记入点/出点 播放控制 遥控指示灯音频表
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回放视频和音频文件

导入片段
将视频和音频文件导入Media Express后便可回放这些文件。文件导入方法有以下几种：

 � 双击媒体列表的空白区域。
 � 右击媒体列表的空白区域，从上下文菜单中选择Import Clip（导入素材）。
 � 到File（文件）菜单下，选择Import（导入），再选择Media Files（媒体文件）。

从Open Video Clip（打开视频短片）对话框中选择您想要导入的视频和音频素材片段。这些片段会出现在
Media List媒体列表的Scratch草稿区。如果您在媒体列表中创建了自己的分组，您可以将片段直接拖放到
想要的分组中。

如果您想直接将片段导入媒体分组中，请在该组右击并从上下文菜单中选择Import Clip（导入片段）。

如果导入的文件和当前媒体列表中的素材帧率和大小不匹配，系统会弹出对话框提醒您创建新项目并保存
当前项目。

Media Express还支持导入多通道无压缩WAVE（.wav）和AIFF（.aif）48kHz纯音频文件。

此外，您还可以使用从Final Cut Pro导出XML文件。到File（文件）菜单下，选择Import（导入），再选择
Final Cut Pro XML。打开相应的XML文件，Final Cut Pro项目的所有分组和媒体会出现在媒体列表中。

Media Express还支持导入CMX EDL文件，以便使用来自其他视频软件的EDL文件进行批量采集。到File 
（文件）菜单下，选择Import（导入），再选择CMX EDL。选择EDL并打开。录入信息会出现在媒体列表
中。选择录入的片段，执行批量采集，导入录机中的片段。

回放单个和多个片段
回放单个片段，请双击媒体列表中的片段。或者，您还可以选中媒体列表中的片段，然后按键盘上的空格
键或播放控制中的播放按钮来执行这一操作。

如要回放多个片段，请选中媒体列表中的多个片段，然后按键盘上的空格键或播放控制中的播放按钮。

您选中的视频就可以在Media Express的视频预览窗格以及Blackmagic视频硬件中回放。回放时，您可使
用Enable（启用）或Disable（禁用）按钮开启或关闭监听的音频通道。

您可以直接导入媒体，也可以使用XML或EDL导入。

您可使用播放控制按钮来播放、停止、跳到下一个片段或回到上一 
个片段，或者循环播放片段。
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浏览媒体文件

Thumbnail（缩略图）视图
缩略图可以最直观的方式显示片段。请将鼠标停留在缩略图上，然后点击缩略图右下角跳出的信息图标。
点击信息框即可将其隐藏。

List（列表）视图
若要以时间码列表视图查看片段，请点击媒体列表右上角的Timecode List时间码列表图标按钮。使用横向
滚动条浏览片段的各栏信息。

创建和使用媒体分组
若要创建分组，请右击媒体列表中的空白区域，并选择“Create Bin”（创建分组）。为新分组命名。

您可以通过拖放片段图标将片段移动到想要的分组中。如果您希望将某一片段保存在多个分组中，请右击
分组并选择“Import Clip”（导入片段）将同一段片段再次导入到分组中即可。

默认情况下，录入的片段会保存在名为“Scratch”的草稿区。如果您希望将录入的片段保存在新的分组，
请右击新分组并选择“Select As Log Bin”即可。

创建和使用收藏夹
若要将录入的片段标记为收藏，请在Log and Capture（录入和采集）选项卡中点击Name名称栏右边的星
形图标。

在媒体列表中选中某一片段，然后在Playback（回放）选项卡中点击该片段对应的星形图标即可将其收
藏。再次点击星形图标可取消收藏。

在时间码列表视图和缩略图视图模式下，标记为收藏的片段图标中会带有黄色星形标志。

如果您有收藏的片段，点击媒体列表顶部的“Show only favorites”按钮后，该星形图标会显示为黄色，
此时媒体列表中只会显示标记为收藏的片段。

将音频片段和视频片段关联
将媒体列表中的音频片段和视频片段设为关联步骤如下：

 � 选择一个不含音频通道的视频片段。
 � 右击该视频片段后，从上下文菜单中选择“Link Audio File”（关联音频文件）。

然后，您就可以回放合并后的片段或将其输出到磁带制作母带。

请在媒体列表中选择时间码列表视图或缩略图视图模式进行浏
览。点击收藏按钮显示标记为收藏的片段。在Search搜索栏中
输入信息查找您收藏的片段。

点击缩略图上弹出的信息图标来浏览信息框。

若要将录入的片段标记为收藏，请在Log and Capture（录入和
采集）选项卡中点击Name名称栏右边的星形图标。
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删除片段和分组
如要删除片段，请选中不需要的片段，按键盘上的向前删除Delete键。此操作只删除媒体列表中的片段，
并不会删除存储在硬盘上的片段。

要删除分组，请在该分组区域内右击，然后选择“Delete Bin”即可。此操作会删除分组及其包含的所有片
段。此操作只删除媒体列表中的片段，并不会删除存储在硬盘上的片段。

创建3D片段
在媒体列表中添加立体3D片段步骤如下：

 � 选择一个和您的3D文件帧率相同的3D项目格式。
 � 将“左眼”文件导入媒体列表。
 � 右击左眼文件，在上下文菜单中选择“Set Right Eye Clip”（设置右眼片段）。如果Media Express之

前已经采集了右眼视频片段，右眼视频会附上“_right”字样。

媒体列表可将导入的3D片段醒目表示。左右眼视频片段并排显示在Video Preview预览窗口，表示这是3D
视频项目。

如果您发现左右眼3D立体视频片段加载时误换了位置，请通过以下途径进行纠正：

 � 右击媒体列表中的3D片段。
 � 从上下文菜单中选择“Swap Eyes”（互换两眼通道）。

搜索媒体列表
您可以在媒体列表顶部的Search搜索栏中输入片段名称即可轻松找到某一项目中的片段。当您结合使用收
藏夹功能进行搜索时，系统会在被收藏的片段范围内进行搜索，从而获得更短的匹配结果。

选择一个3D项目视频格式。

媒体列表可将导入的3D片段醒目表示。

在Search搜索栏中输入片段信息。

媒体列表可将关联在一起的视频和音频片段醒目表示。
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制作母带录制模式 音频通道启用/禁用标记入点/出点
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将视频和音频文件编辑到磁带
虽然我们常说将文件编辑到“磁带”，但是您的录机可以使用磁带或硬盘。母带录制方法如下：

 � 选择想要编辑到磁带的片段。
 � 点击蓝色的Edit to Tape按钮。
 � 设置In（入点）和编辑类型。
 � 制作母带。

选择要制作为母带的片段
到Media List媒体列表中选择想要制作为母带的片段。您也可以插入多个纯音频片段的通道，覆盖母带上的
音轨。如果您只想将收藏的片段编辑到磁带，请点击媒体列表上方的星形收藏标志，使列表只显示您收藏
的片段，并隐藏其余片段。然后，从收藏列表中挑选您想要编辑到磁带的片段。

插入和组合编辑到磁带
点击蓝色的Edit to Tape按钮。在In栏中键入表示磁带入点的时间码，或使用播放控制走带至想要的位置
后，按Mark In按钮标记入点。

如果未在Out（出点）栏内键入任何信息，Media Express会将剪辑时长设为媒体列表中所有片段的全长。如
果设置了出点，不论选中的片段是否已全部输出，Media Express都将按照出点栏设置的时间码停止录制。

选择Assemble（组合）或Insert（插入）编辑方式编辑到母带。然后按Master按钮。

预览模式可模拟编辑过程，但并不会录制到磁带上。该模式可用来检查编辑点。请始终在与录机输出连接
的监视器上检查预览编辑操作，以便同时查看已被录制到磁带上的视频以及未录制的视频。

如果录机或磁带上启用Record Inhibit（录制保护），Media Express会在您点击Master按钮时弹出提示。
禁用Record Inhibit后再次尝试录制。

通过点击Enable（启用）和Disable（禁用）按钮选择您想要输出的视频和音频通道。如果您只需要输出音
频，请取消勾选相应的视频通道。

点击媒体列表上方的星形收藏标志，使列表只显示您收藏的片段。

两个片段被选中输出到磁带。

选按需要用来制作母带的音频通道号码。



Blackmagic Disk Speed Test测速工具290

什么是Blackmagic Disk Speed Test？
Blackmagic Disk Speed Test可根据视频的帧尺寸来检测存储媒介的读写性能。所有Blackmagic Design产
品安装到Mac OS X和Windows电脑上时，都自带Disk Speed Test。您也可以到本公司官网免费下载该程
序。点击位于Start（开始）按钮上方的Settings按钮（齿轮图标），进入Disk Speed Test设置。

Select Target Drive（选择目标驱动器）
点击Select Target Drive并确保您有读写权限。

Save Screenshot（保存屏幕截图）
点击Save Screenshot来保存当前测试结果。

Stress（压力）
压力等级可在1GB到5GB之间设置，以1GB为单位递增。5GB为默认设置，可提供最准确的测速结果。

Disk Speed Test Help
点击Disk Speed Test Help运行Disk Speed Test的PDF版操作手册。 

About Disk Speed Test
About Disk Speed Test可显示您所运行的Disk Speed Test版本。

Start（开始）
点击Start按钮开始测速，Disk Speed Test会在目标驱动器上写入和读取一个临时文件。Disk Speed Test
会保持读写状态，直到您再次按下Start按钮后停止测速。

Will it Work？（适用哪些格式？）
“Will it Work？”结果表会列出几种常见视频格式，并以勾和叉表示硬盘性能是否足以应对该种格式。请
进行多轮测试，以便找到硬盘可处理的临界视频格式。如果经过几轮测试后，某一视频格式结果并非每次
都打勾，这说明被测硬盘并不完全保证支持此类视频格式。

How Fast?（速度如何？）
“How Fast?”结果表会列出您的硬盘可达到的帧率，请结合左侧的“Will it Work?”列表得出综合结果。
如果在“Will it Work?”结果表中，2K 1556@25格式在10 Bit YUV 4:2:2栏内显示为支持，而“How 
Fast?”结果表中显示最大支持帧率为25fps，那么此类格式已达到该硬盘的性能临界点。点击齿轮图标打开Settings菜单。

Blackmagic Disk Speed Test
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How Fast?（速度如何？） 

此结果表可以每秒帧数
（fps）显示速度

设置  

开始硬盘测速前，请点击
此按钮进行设置。

Will it Work？ 
（适用哪些格式？）

此结果表可列出您的硬盘
存储支持的各类视频格式

START

单击此按钮开始硬盘测
速。再次点击结束测试
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获得帮助
获得帮助最快捷的途径是登陆Blackmagic Design在线支持页面并查看相关硬件的最新支持信息和材料。

Blackmagic Design在线支持页面
请登陆网址www.blackmagicdesign.com/support获得最新版操作手册、软件以及技术答疑文章。

 联系Blackmagic Design支持中心
如果我们提供的支持信息无法解答您的疑问，请到支持页面下选择相应的硬件型号，并进入该型号的支持
中心页面，点击“Send request”（发送请求）按钮即可给我们发送电子邮件。或者您也可以向您所在地
区的Blackmagic Design办事处致电垂询，具体联系方式请登陆网站www.blackmagicdesign.com/company

查看当前安装的版本
要检查您电脑上安装的Desktop Video软件版本，请打开Blackmagic Design Desktop Video系统偏好。版
本号会显示在标题栏内。

 � Mac OS X用户请打开系统偏好，并点击Blackmagic Design图标即可查看版本号。
 � Windows 7和Windows 8用户请打开控制面板，点击“硬件和声音”目录，点击该目录下的Blackmagic 

Design Control Panel图标即可查看版本号。
 � Linux用户请到“应用程序”中的“声音和视频”子菜单下找到Blackmagic Control Panel。打开该控制

面板即可查看版本号。

如何获得更新
检查完电脑上安装的Desktop Video版本后，请登陆网址www.blackmagicdesign.com/support访问
Blackmagic支持中心查看最新更新。请关注版本更新，但切勿在重要项目制作过程中升级软件。

帮助

http://www.blackmagicdesign.com/support
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使用Blackmagic Design硬件自定义软件开发
开发人员可以使用DeckLink SDK定制自己的软件来控制Blackmagic视频硬件。DeckLink SDK支持
UltraStudio、DeckLink、Multibridge和Intensity系列产品。

DeckLink SDK可提供底层硬件控制，同时具备高级通信能力，让开发人员轻松执行常见任务。DeckLink 
SDK支持以下技术：

 � Apple QuickTime
 � Microsoft DirectShow
 � Apple Core Media
 � DeckLink API

免费下载Blackmagic Design SDK
请到www.blackmagicdesign.com/support/sdks/页面下载DeckLink SDK。

加入Blackmagic Design开发人员论坛
Blackmagic Developer论坛专门用于和Blackmagic Design相关的技术问题，如QuickTime、Core 
Media、DirectShow、编解码器、API以及SDK。这一免费论坛为开发人员提供了经验交流的平台。所有订
阅者都可以回复，并且，Blackmagic Design的工程师也会予以适当的答复。请到http://lists.
blackmagicdesign.com/mailman/listinfo/bmd-developer页面订阅并加入论坛。

如果您的域名并未明示您的开发人员身份，我们可能会要求您提供一份您开发的软件简介。由于本论坛仅
限开发人员，我们会努力营造一个无垃圾邮件和无病毒的交流环境，谢绝与软件开发无关的问题、招聘中
介以及销售人员。

联系Blackmagic Design Developer Assistance获得帮助
如果您要询问该论坛的相关事宜，请发送邮件到以下地址：developer@blackmagicdesign.com

开发人员信息
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Caution: Risk of Electric Shock
On the UltraStudio 4K enclosure you will see a yellow warning label marked ‘Caution: Risk of Electric Shock’. 
This is intended to warn users that there may be the presence of uninsulated “dangerous” voltage within 
the UltraStudio 4K enclosure which may be of sufficient magnitude to constitute a risk of electric shock to 
the user. Blackmagic Design advises you not to open the UltraStudio 4K unit, but rather contact your nearest 
Blackmagic Design service center should assistance be required.

警告：小心触电
UltraStudio 4K机身外壳上贴有黄色警示标签，上面标有“警告：小心触电”字样。这是为了警告使用者
UltraStudio 4K内部可能存在非绝缘潜在“危险”电压，其强度可能引发触电。Blackmagic Design建议您
请勿自行拆解UltraStudio 4K设备，如遇问题请联系您所在地区的Blackmagic Design服务中心获得帮助。

Caution label

警示标签

警告
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有限保修
Blackmagic Design保证UltraStudio、DeckLink及Multibridge系列产品自购买之日起36个月内不会有材料和
工艺上的缺陷；自购买之日起12个月内，接口、线缆、冷却扇、光纤模块、保险丝、键盘及电池不会出现
材料或工艺上的缺陷。Blackmagic Design保证Intensity系列产品自购买之日起12个月内不会有材料和工艺
上的缺陷。若本产品在保修期内出现质量问题，Blackmagic Design可选择为产品提供免费修理或更换零部
件，或者更换缺陷产品。

为确保消费者有权享受本保修条款中的服务，如遇产品质量问题请务必在保修期内联系Blackmagic Design
并妥善安排保修事宜。消费者应将缺陷产品包装并运送到Blackmagic Design的指定服务中心进行维修，运
费由消费者承担并预先支付。若消费者因任何原因退货，所有运费、保险费、关税等各项税务以及其他费
用均由消费者承担。

本保修条款不适用于任何因使用、维护不当或保养不周造成的缺陷、故障或损坏。根据本保修服
务，Blackmagic Design的保修服务范围不包括以下内容：1. 对由非Blackmagic Design专门人员进行的安
装、维修或保养所造成的损坏进行维修，2. 对因使用不当或连接到不兼容设备所造成的损坏进行维修，3. 
对因使用了非Blackmagic Design生产的零部件所导致的损坏或故障进行维修，及 4. 对经过改装或和其他
产品进行组装的产品进行保养维修（因为产品经改装或组装后会增加保养维修所需时间或保养难度）。本
保修条款由BLACKMAGIC DESIGN提供，它可取代所有其他明示或隐含的保修。BLACKMAGIC DESIGN
及其供应商对任何有关适销性及就特定用途的适用性等隐含保证不作任何担保。BLACKMAGIC DESIGN
负责为消费者提供缺陷产品的维修或更换服务是完整和排他性补救措施，不论BLACKMAGIC DESIGN或
其供应商是否事先获悉发生间接、特殊、偶然或必然损坏等损坏的可能性。若消费者对本设备进行非法使
用，BLACKMAGIC DESIGN概不负责。对因使用本产品造成的损失，BLACKMAGIC DESIGN概不负责。
本产品的操作风险由用户自行承担。

© Copyright 2014 Blackmagic Design. 版权所有。“Blackmagic Design”、“DeckLink”、“HDLink”、“Workgroup Videohub”、 

“Multibridge Pro”、“Multibridge Extreme”、“Intensity”以及“Leading the creative video revolution”在美国及其他国家均为注册

商标。所有其他公司名称及产品名称可能是其他所有者的注册商标。

Thunderbolt及其商标为英特尔公司在美国和/或其他国家的商标。

保修
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